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Intro to Get Started

Intro to Get Started
This section provides the basic information you need to get started using TWS, including how to:
l

Log In to TWS

l

Add Market Data

l

Add a Quote Monitor

l

Create an Order

l

Modify an Order

l

Transmit an Order

l

Cancel an Order

l

Pause Execution

l

Use the TWS Search Field
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Log In to TWS

Log In to TWS
You can run the TWS from your Internet browser (recommended), or download the software to your
PC and launch it directly from your desktop as a standalone application.
The browser-based version:
l

l

l

Allows you to access your account and execute trades from any Java™-enabled internet
browser.
Is always running the latest release.
Allows you to save your settings from your primary machine to a server so that your TWS will
look exactly the same regardless of what Internet machine you use to log in.

The standalone version uses less memory and may run faster, but requires you to download each
release to take advantage of new features. To download to your PC, see the Installation
Instructions on the website.

To log in from your browser
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1. From the Login menu, select Trader Workstation from the drop-down list.

If you are a first-time user, select Account Management, enter your username and password, and click
Login.
2. In the Login box, enter your username and password, and click Login.
Options:
l

l

l

l

l

l

The color palette allows you to choose a new color skin for TWS. If you select a palette and
want to change it once you have logged in, use the Display> Style page in Global Configuration.
Settings Directory - By default, TWS files are saved in C:\Jts. If you would like to change the
location of your settings files, use the Browse button to specify a new directory.
Use/store settings on server - This option allows you to save your settings, including market
data, pages etc., on our server instead of on your local machine. If checked, your workstation
will have the same data and look regardless of your login location. If unchecked, settings are
only saved on the computer you are currently using.
Use SSL - Your identity and trading information are always protected. Checking the Use
SSL option gives added privacy and integrity to your order information as it travels over the
Internet. Minor performance impacts may be experienced depending on the capabilities of your
PC.
Click Show all fields to select a different language for TWS and to have the system migrate settings that you may have saved under a different user name.
Mouse-driven login - Click the Keyboard icon in the title bar to enter your username and password using the mouse instead of your computer keyboard. Use the mouse to click the appropriate keys on the clickable keyboard display.

To log in from your desktop
1. Double-click the application icon on your desktop.
2. Enter your username and password.
3. If you are prompted to install the free Java™ Runtime plug-in, see the Java™ PlugIn installation document.

For help logging in with your secure device, click to watch the video.
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Add Market Data

Add Market Data
When you first open TWS, a sample Quote Monitor displays several sample lines of data. Before you
trade an asset, you’ll want to be able to see streaming data for the asset. A market data line represents an individual ticker, and displays the product type, order destination, ask and bid prices, and
any other defining attributes. You can add a market data line by typing a symbol directly into the Contract column of the Quote Monitor.

Enter security definitions by entering the exchange contract class or contract symbol in the Contract field. Enter
forex pairs using the syntax xxx.yyy in the Contract field.

To add market data to the Quote Monitor
1. Click in the Contract field in an empty row.
2. Enter an underlying symbol and press ENTER.
3. Select an asset type from the picklist on the trading screen. For instruments that require an
expiry, choose a month and year, or select All to open the contract selection box.

TWS Users' Guide

33

Intro to Get Started

If you choose Smart as the exchange (rather than selecting Directed and then picking a destination) the market data is aggregated and the default order routing is Smart. From a display
perspective, ticker lines that use aggregated Smart data do not display Smart in the data line.
TWSwill only show the exchange if you elect to direct route. When you create an order, regardless of the market data selection you can modify the order routing destination on a per-order
basis using the Destination field.

TWS Users' Guide

34

Intro to Get Started

Add Market Data

4. In the Contract Selection box, select a contract(s) and click OK. You can limit the contracts
displayed in the right pane by selecting criteria from the Filter section. Choose Smart as the
exchange to use SmartRouting.

Notes about Market Data use
l

l

l

l

A market data line is considered “active” when visible.
Each alarm always uses one line of market data whether or not you are viewing the asset that
contains the alarm.
Market data requested through an API has top priority, followed by data requested by alarms,
and finally basic market data display. This means that if you are viewing a trading page that
includes 100 lines of market data, and you also have price-activated alarms set for 6 other contracts, those 6 contracts will receive market data, and your trading page will only show data for
94 contracts.
The option chains in the OptionTrader do not count against available market data lines.

For details on market data fees and allocation rules, see the Market Data and News Subscriptions
overview on the IB web site.

If you add a market data line for a derivative instrument, will ask if you want the underlying symbol added to the
page. If you answer yes, it will be included above its derivative.
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Create an Order
There are many ways to create an order in TWS. This topic shows you how to create and transmit an
order directly from a ticker line in the Quote Monitor.

To create and transmit an order from the Quote Monitor
1. Click the Ask or Bid in a market data line to create an order line directly below the selected
ticker.
l

Click the Ask to create a Buy order.

l

Click the Bid to create a Sell order.

2. On the Order line, modify the order parameters including Time in Force, Action, Quantity, Price,
Order Type, or Destination, if needed.

To trade more efficiently by using default values, create order Preset strategies using the Order Presets in
Global Configuration.
3. To transmit your order, click “Transmit” (or “T” if you have reduced the size of the Transmit
field).

Show Orders
By default, a working order will display on any page that has the ticker. You can modify where you
want working orders to display using the Page settings.
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Create an Order

4. Right click a tabbed title and select Settings.
l

l

Show only orders created on this page - Regardless of the tickers, only the orders you create
from this page will display on this page.
Show inactive orders only, move active orders to Pending page - Shows deactivated or nontransmitted orders only. Working orders created from this page will only display on the Pending
page.
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Modify an Order
You can modify an order up until the time it fills. Until this occurs, the order remains visible and editable.
Using Mosaic

Working orders appear in the Orders panel, and can be edited by clicking the appropriate field.
Using Advanced Order Entry
The order line appears below the ticker on the page on which it was created, and on the Pending page.
An order is “working” if the order status is green.
Note: VWAP orders are accepted immediately and cannot be modified.

To modify a working order
1. On an order line, click in the field you want to modify, and make your change.
Note: Orders that have child orders associated with them, such as bracket or
scale orders, cannot have the order side flipped. Orders than can be
flipped will note this using (Reverse) next to the opposite-side action in
the Action drop-down. When you flip the order side, a cancel request is
sent for the original order and both the original with the cancel request
and the new reversed order are displayed.
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Modify an Order

2. Click Update in the Transmit column to transmit your modified order.
To undo changes before you transmit, right-click and choose Discard Modifications.

You may receive a fill on the original order before your modified order has replaced it on the exchange. Please
see the Customer Agreement for specific details on modifying and canceling orders.
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Transmit an Order
Once you have verified the order parameters on an order management line, you are ready to transmit your order.

To transmit an order
l

Click Transmit (or “T” if you have reduced the size of the field) in the Transmit field, or

l

Use the right-click menu on the order line and select Transmit.

When an order is accepted at the destination, it becomes a “working” order. All working orders
appear on the Pending page. A red tab title indicates that the page holds a working order.
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Transmit an Order

To transmit multiple orders
l

From the Trade menu select Transmit, and then select:

l

Transmit Selected Orders to submit the orders you have selected on the current page

l

l

Transmit All Orders on Page to send all of the orders on the current page. The dollar value in
parenthesis reflects the total value of all orders on the page.
Transmit All Orders to submit all orders in TWS.
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Cancel an Order
For a working order, the Cancel command sends a cancellation request to the order destination. See
the Order Status Colors page for the meaning of status colors on an order management line.
For a non-transmitted order, use the right-click Discard command to delete the selected order(s)
from your trading screen.
You can cancel any working order up until the time it has been executed at an order destination. You
can also choose to cancel all orders on a page or all orders on your workstation.

To cancel a working order
1. From the Trade menu select Cancel, and then select:
l

l

l

Cancel Selected Orders to submit a cancel request for the order(s) you have selected on
the current page
Cancel All Orders on Page to cancel all working and non-submitted orders on the current
page.
Cancel All Orders to submit a cancel request for all orders in TWS.

Or,
2. Click Cancel (or “C” if you have reduced the field size) in the Cancel field.
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Cancel an Order

For information on the colors displayed in the Status field, see the Order Status Colorstopic.

Your working order is not confirmed CANCELED until the status field turns red. Please see the appropriate Customer Agreement for further information on order confirmation/cancellation.
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Add a Quote Monitor
There is no limit to the number of Quote Monitors you can create in TWS. You can enter as many lines
of market data as you want, but at any one time you will only be able to see 100 active market data
lines at a time. For details, see Notes about Market Data use. Use the Quote Monitors to sort your
assets by instrument type, exchange, or your own trading system categories. You can navigate
through the tabbed pages without the mouse by using the Ctrl key along with the Page Up and Page
Down keys.
l

To detach a page, simply click the tab and drag the page away from the tabset.

l

To create a new page, click the “+” sign and select Quote Monitor

l

To delete a page, click the X.

l

To rename a page, right-click the page title and select Rename Page.

You can also use a page-level feature called Quick Stock Entry, which will automatically complete a
market data line for a stock using the set of order destinations you set up.
To add a Portfolio Page
You can create a system-maintained Quote Monitor that includes a data line for each position in your
portfolio. Use the right-click menu from the “+” sign and select Portfolio Window. The portfolio page
can only be created once.
This creates a page with the same positions that are displayed in the Portfolio section of the Account
window. Each time you take a position, the Portfolio page is automatically updated to include market
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Add a Quote Monitor

data for the new position. When you zero out a position, the market data line remains on your Portfolio page. You can remove zero position tickers from this and other pages using the right-click menu
on a page and selecting Clear Zero Position Rows.
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Add and Remove Fields
You can quickly add and remove fields from the Quote Monitor by holding your mouse over the field
name to invoke the plus/delete editing icons.

To add or remove columns from the window
1. Hold your mouse over a field to invoke the quick add/remove icons.
2. Click the “+” icon to pick a field from the dropdown picklist which will be insert to the left of the
selected field.
3. Click the “x” icon to remove the field from the page. You can re-add the field at any time.
You can choose not to see these icons by deselecting the feature Show icons on column headers to
add or remove columns on the General page of Global Configuration.
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Pause Execution

Pause Execution
When you pause a working order, a cancel request is submitted to the exchange, but the order
remains on the Orders panel (Mosaic) or Quote Monitor (Advanced Order Management) for you to
resubmit.

To pause execution on an order
l

Right-click an order management line and select Pause Execution.

Use the DTC time in force to deactivate a day order that has not executed by the close of the market.
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Use the TWS Search Field
The interactive search field in the top right corner of TWSlets you search for tools and features in the
application as well as for contracts to add to your trading pages. Select from the list of findings to go
directly to your destination, or add a contract directly to your trading page.

Search for a feature or contract
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Use the TWS Search Field

1. Enter the name of the feature, contract or type of contract you are looking for.
2. Check Application, Contract or both.
3. Click the return that matches your search criteria.
The TWS search will open and focus in on the feature, or begin adding the contract to the trading
page.
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The Mosaic Interface
The Mosaic workspace is completely customizable, with a drag and snap functionality that lets you easily align
new windows to the default workspace. The "grouped window"layout allows you to size and move the Mosaic
workspace as a single unit, and the workspace remains locked until you deliberately unlock it to add, move or
delete windows. See Workspace Modes for more information.
Windows are linked by the colored grouping block in the upper right corner of each window, and groups can be
changed while the workspace is locked. Grouped windows all reflect the same underlying.
The Mosaic workspace provides comprehensive order entry and order management functionality that includes
charts, watchlists, quote details, market scanners, and your account information. If you want to add a window,
simply unlock the workspace and open the window from the Toolbox or New Window drop-down. Drag the window alongside the Mosaic; it automatically snaps into place. Be sure to lock the workspace when you have finished editing to avoid inadvertently deleting or moving a window.
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Use the TWS Search Field

You can add windows by unlocking the workspace and using the New Window drop down list and the
Toolbox.
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The Mosaic Interface
The Mosaic workspace is completely customizable, with a drag and snap functionality that lets you easily align
new windows to the default workspace. The "grouped window"layout allows you to size and move the Mosaic
workspace as a single unit, and the workspace remains locked until you deliberately unlock it to add, move or
delete windows. See Workspace Modes for more information.
Windows are linked by the colored grouping block in the upper right corner of each window, and groups can be
changed while the workspace is locked. Grouped windows all reflect the same underlying.
The Mosaic workspace provides comprehensive order entry and order management functionality that includes
charts, watchlists, quote details, market scanners, and your account information. If you want to add a window,
simply unlock the workspace and open the window from the Toolbox or New Window drop-down. Drag the window alongside the Mosaic; it automatically snaps into place. Be sure to lock the workspace when you have finished editing to avoid inadvertently deleting or moving a window.

TWS Users' Guide

52

The Mosaic Interface

Use the TWS Search Field

You can add windows by unlocking the workspace and using the New Window drop down list and the
Toolbox.
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The Anchor Window
The Anchor Window is the control center of the workspace. Grab and drag the title bar to move the
entire workspace. Use the buttons to add windows and tools, and use the menus to configure, exit and
choose a new workspace.

The Mosaic workspace provides a grouped selection of windows that function as a unit within the locked Mosaic
layout. With this grouped workspace paradigm:
l

l

l

Only a single icon is displayed in the windows system tray (versus as many icons as there were
separate windows in the previous version).
Windows within the workspace cannot be inadvertently closed or repositioned.
When the Mosaic is resized all included windows will resize and scale appropriately within the
layout.

While you can't modify or move individual windows while Mosaic is locked, you can maximize and minimize
windows by double-clicking the title bar.
The Mosaic has two editing modes: Locked and Unlocked.
By default, the Mosaic workspace is in "locked" mode when you launch the tool. When the workspace is locked,
it acts as a single, grouped unit. You cannot add, remove, resize or move any component windows, but you can
resize the entire workspace, and each component within will be scaled accordingly. Note that you can, however,
modify windows grouping assignments. When the workspace is locked, the potential for inadvertently closing or
moving Mosaic windows is negated.
If you want to rearrange the windows, add or remove windows, or resize individual component windows, click
the Lock icon to unlock the workspace.
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The Anchor Window

Layout Locked

When the Mosaic layout is locked, the workspace is outlined in black and the lock label indicates the status.
Keep the layout locked until you need to add, remove or resize individual windows.
To unlock the layout for editing
l

Click the "lock" icon located to the left of the search field.

Layout Unlocked

When the Mosaic layout is unlocked, the workspace is outlined in green and the lock label indicates the status.
When unlocked, windows within the workspace frame act as separate, ungrouped windows, and you are able to
remove them, resize them, and add new windows to the layout frame.
Note: Be sure to always lock the workspace when you have finished editing to avoid
unwanted changes or deletions to the Mosaic. You will not be allowed to exit
the application if the workspace is unlocked.
To lock the layout
l

Click the "lock" icon
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Option Strategy Lab
Enter your price or volatility forecasts for an underlying and the Option Strategy Lab will return a list of single
and complex option strategies that will potentially profit based on the forecast.
To open the Option Strategy Lab
l

From within Mosaic, use the New Window drop-down and select Option Strategy Lab.

l

From within legacy TWS, use the Trading Tools menu and select Option Strategy Lab.

When you first open the Option Strategy Lab, the Strategy Scanner opens to allow you to enter your forecast
data.

To populate the Option Strategy Lab
1. In the Strategy Scanner, enter the underlying.
2. Define your forecast, including:
l

The range, between now and a selected expiration date.

l

Price or Volatility as the forecast driver.
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l

l

The predicted action of the price or volatility. Choose from:
l
Drop
l

Rise

l

Be rangebound

l

Move at least

The increment and unit (choose from value or percentage)

3. If desired, filter your results by Premium, Delta, Strike or Expiry. You can select multiple filters
and define multiple values within each filter.
4. Click Done to populate the lab.
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Order Entry

The strategy selected in the scanner populates the Order Entry panel. Each time you select a new strategy the
Order Entry panel is repopulated.

Modify order parameters in the Order Entry section at the bottom of the panel, and click Submit to trade the
strategy. Before you submit the order, you can analyze the forecast-based strategy using the charts and graphs.
Analyze Strategies in the Scanner

Based on your forecast, the scanner returns a list of options or complex option strategies that will potentially
profit if your forecast is correct. Some fields in the scanner include:

Return/Risk Ratio - the ratio of the max potential gain to the max potential loss.
Probability of Profit - the market implied probability of any gain.
Maximum Potential Gain
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Option Strategy Lab

Maximum Potential Gain as a Percentage of your Investment
Maximum Potential Loss
Maximum Potential Loss as a Percentage of your Investment
Break Even Point - the underlying price(s) required for a strategy to break even.
Sharpe Ratio - the measure of excess return (the risk premium) per unit of deviation for the strategy.
Hold your mouse over a value in any field to see the definition. Add more fields by clicking the Configure
wrench icon and then selecting Configure Columns.
Analyze the Price Target

The Price Target chart shows the current underlying price highlighted in yellow, and the target price based on
your forecast in red.

The blue shaded area represents the estimated price range to one standard deviation. Drag the dotted line to
change the expiration date.
Compare Strategy Performance

Each strategy checked in the scanner is represented in the comparison chart.
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By default the chart is set to today's date, but you can choose the expiration date you specified in your forecast or
any date between today and the expiration date.
Strategy Detail

The Performance Details charts provide a close-up look at the option or strategy selected in the scanner. Use the
selector to change the comparison category.
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Option Strategy Lab

The expiration date is driven by the date in your forecast, and can be changed by changing the date in the Performance Comparison, or by dragging the date line in the Price Target chart.
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Probability LabSM (Patent Pending)
Use the Probability Lab to customize the Probability Distribution based on your price or volatility forecast for the
underlying ticker. Analyze and trade any of the option combinations suggested from your probability distribution.
To open the Probability Lab
l

From within Mosaic, use the New Window drop down.

l

From within TWS, use the Trading Tools window.

To use the Probability Lab
1. Enter a ticker and select an expiration date. The market defined Probability Distribution (PD) is
built.
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Probability LabSM (Patent Pending)

2. In the Probability Distribution Builder, grab the red bar in any price interval and pull it up if
you believe there is a higher probability of the stock price ending up in that price interval at the
expiration date specified. Pull it down if you believe there is a lesser probability of the stock
price ending up in that interval at the expiration date specified.
Note: All probabilities must add up to 1.00 so you will see the other levels adjust
when you make changes in any price interval.
You can also adjust the probability using the up/down arrow icons near the values, or by dragging the hand icon to the left or right within the distribution graph.
3. When you are satisfied with your custom PD, specify desired parameters, select the minimum
number of legs you want in your option strategy and click Build Strategy.
a. Roll Existing Positions - When applicable, allows you to select existing positions
in the underlying to include in the strategy. The Strategy Builder will attempt to create a strategy that gets you out of the selected position. Only positions the expire
before the selected expiry will be displayed, and only two positions can be rolled. If
the user-defined max number of legs below is too small, it will be adjusted. Cannot
be used in conjunction with Incorporate Existing Positions feature.
b. Incorporate Existing Positions - Check to have your existing positions in the
underlying included in the computation used to build a strategy. Once you have built
the strategies, you can view the data for the strategies both with and without the
selected existing positions being included by checking/unchecking the "Existing Positions" feature in the blade of the Strategy Scanner. Cannot be used in conjunction
with Roll Existing Positions feature.
c. Delta Neutral - Check to only build strategies that are delta neutral.
d. Include Stock Leg - Check to have the underlying stock included as a leg in the returned

strategies.
The Strategy Scanner (in the panel below the PD Builder) will display three potential combination
option strategies that complement your customized PD. For each strategy (and based on your custom
PD) the selector displays the Expected Profit, Sharpe ratio (which shows the ratio of expected profit
to variability of outcome), net debit or credit, percent likelihood of profit, max potential profit and
loss and the associated probabilities, and the margin requirement if you were to trade the strategy.
4. To create an order, in the Strategy Scanner select the strategy. To view color-coded representations in the Strategy Performance Detail graph, check the strategy.
a. Probability Basis - Choose the probability basis for calculations using the drop
down selector.
b. Existing Positions - If you have elected to Include Existing Positions when building strategies, you now have the option to view data (including P&L in the performance details graph and data point in the strategy scanner) both including and
excluding your existing positions in the underlying using the Existing Positions
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checkbox that will display next to the Probability Basis drop down list. Check to
include; uncheck to exclude.
5. In the Strategy Adjustment/Order Entry panel, adjust any parts of the strategy by clicking in
a field in the leg you want to modify. For any leg, you can modify the action, ratio, expiry, strike
or type.
6. Once the legs are defined, use the Order Entry line to modify any order parameters. Use the
advanced order area to create a hedging stock order and to attach order attributes including iceberg and all or none.
7. When the order is ready to be sent, click Submit.
8. Use the Strategy Performance Detail graph to see the predicted profit or loss that would result from the selected trade if your forecast is accurate, along with the associated probability that
corresponds to each price point. Use the drop down list to select Delta, Gamma, Vega, Theta or
Rho for display.
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Volatility Lab

Volatility Lab
A comprehensive toolkit of volatility tools providing a snapshot of past and future readings for: volatility on a
stock, its industry peers and some measure of the broad market.The Volatility Lab comprises three tabbed workspace snapshots for Implied Volatility, Historical Volatility and Industry Comparison.
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To open the Volatility Lab
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l

From within Mosaic, use the New Window drop down.

l

From within TWS, use the Trading Tools window.

Volatility Lab

Implied Volatility Tab

The Volatility Lab opens to the Implied Volatility layout by default. Move between layouts (Implied Volatility,
Historical Volatility, Industry Comparison) using the tabset along the bottom frame. The Implied Volatility layout
comprises five windows:

Implied Volatility Window
This displays the measure of anticipated volatility of the stock using the prevailing option premium.
The plot allows the user to display the IV reading for as many or as few of the available expirations.
Each expiry is color-coded with the reading for implied volatility measured on the right axis and the
stock price is traced using the grey line. This look back view of IV can be plotted for 1 week, one, two
and six months, one year or a custom period. The user may be able to immediately tell from the readings whether or not implied volatility is relatively high in any given month, possibly caused by expected earnings announcements or uncertainty over possible changes to dividend payments.

Volatility Profile Window
Shows the Historical and Implied readings of volatility side-by-side, over time. Either measure can be
removed from the screen by clicking on the checkbox. Compare actual stock volatility to the forward
measure apparent through option premium, and gauge how far the two measures deviate over time
in response to market shocks, or as the underlying share prices track higher or lower. The window
allows the user to look back over a one-year period. Use the Configure Wrench icon to change modes.
In the Volatility Profile window the default view compares historic and implied readings of volatility
but the alternate mode, Volatility Profile Comparison, shows the readings of implied volatility on
industry comparable stocks.

Multi-Expiry Skew
Displays the “volatility smile” created by the premium paid for options at selected expirations.
Because an option’s premium is significantly comprised of the reading of implied volatility, an option
trader is concerned by the respective cost of calls and puts at strike prices above and below the prevailing price of the underlying shares. When investors are more willing to pay higher premiums for
in-the-money calls or out-the-money puts, the volatility curve may show a skew to price points below
the prevailing share price. Conversely if options are priced higher for out-of-the-money calls and inthe-money puts, the volatility curve might be skewed higher to points above the prevailing share
price. Use the Configure Wrench icon to change between Multi-expiry Skew, Time Lapse Skew
(described in #4 below) and Skew Comparison (which allows the user to view the skew on a specified
expiration date for the ticker and its industry comparables, any of which can be unchecked above the
plot. Because we could be viewing stocks or an index with hugely different prices, the x-axis defaults
to Moneyness rather than any individual share price).
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You change the display for Multi-expiry and Time Lapse skews to compare Moneyness or Strike.
Moneyness is the position of the strike to the underlying, while the Strike option will display the actual
set of available strike prices on the x-axis. Use the Custom Calendar drop-down menu in the upper
right of the screen to drive the same view to any available prior date. The user can then compare how
long a particular condition may have been in place. Note also that the display can be changed
between Moneyness and Strike using the Configure Wrench icon.

Time lapse Skew
An option trader may be interested in knowing how such a price skew has evolved. By using the Time Lapse
Skew panel, the user can plot the current volatility skew for a selected expiration and compare to any prior
period reading of one day, one, two and three weeks and one month ago. This allows investors to identify changing conditions in the option market or perhaps to identify a catalyst that caused skew to occur or disappear.

Open Interest
view current or historic open interest for available contract months and strikes. Choose any available
expiry and view the combined put and call reading of open interest. The plot can be restricted to specific strikes or will default to open interest across all strikes. Open interest measures investor enthusiasm for a particular stock and also identifies strikes where most or least liquidity might be
available. Note also that in the upper right corner there is a calendar drop-down menu that allows the
user to view open interest on chosen months or strikes from prior dates. Just pick the time period and
select that date.
Use the Configure Wrench icon to change modes between Open Interest and Option Volume. The
Chart allows the user to determine whether to see volume or open interest for Puts and Calls combined in one chart (Puts + Calls) or broken out into bull and bear contracts in two charts (Puts &
Calls). Use the calendar dropdown to review activity or positioning from any prior calendar date.
Historical Volatility Tab
This tab comprises the Historical Volatility window, along with the Volatility Profile and Time Lapse
Skew, both of which are described above (#2 and #4).
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Volatility Lab

Historical Volatility
This plot defaults to the 30-day reading of both implied and historical volatility plotted against the

TWS Users' Guide

71

The Mosaic Interface

share price over a custom period. By clicking on the plus arrow the user can select from an array of
calculations to view historical volatilities. Investors may want to see how high and for how long volatility measures rise or fall when they suffer significant swings driven by aberrations to the trend for
the underlying share price. The grey line in the background plots the reading for the underlying share
price.
Industry Comparison

The five-window Industry Comparison workspace provides comparison of a stock’s volatility measures
against those of comparable companies in the same industry group.
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Custom Comps
The company is grouped in the upper pane along with its competitors with a share price and volatility
comparison. Check related companies to see their data reflected across all windows.

Implied Volatility Comparison
The measure of volatility for each of the selected companies appears below in the Implied Volatility
Comparison window along with the share price of the company under analysis, which is plotted as a
gray line in the background. Click the "+" sign to add competitors or the comparison to the S&P 500
index. Note also that you can add a company that is not considered a competitor by TWS by entering
its ticker symbol into either of the Custom input fields. This feature allows you to compare the implied
volatility display on an industry against that of a stock in another field. The default time frame for this
chart is two-months. Use the Time Period drop-down menu to choose from the available time frames
to tailor the view. Use the Configure Wrench icon to change modes.

Underlying Price
In addition to displaying volatility comparisons, this tab allows the user to compare the share price
performance of the chosen underlying with its peer group, the S&P 500 index, and other customdefined companies. Any tickers you may have entered in the Volatility Comparison plot will show up
here, but these can be removed by deselecting them above the chart. Note also that the time period
is configurable by selecting the drop-down menu in the upper right of the chart.

Skew Comparison
This plot is discussed above.

Volatility Profile Comparison
This plot is discussed above.
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Option Chains

Option Chains
The Mosaic option chains present a scaled-down version of features found in the full OptionTrader tool. The
Option Chains are designed to fit into the smaller Mosaic workspace while still providing relevant option chain
data and trading capability. Use the Strategy Builder to create option combos from within the Option Chain window.
To open the Option Chains
l

From the Order Entry window click Option Chain.

The Option Chain opens populated with the active group underlying.
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To create an option order using the Option Chain
1. Click the Ask or Bid price for a call or put.
Note: Calls are on the left, puts are on the right. Once you click a bid or ask price
the order displays in the Order Entry window.
2. In the Order Entry window, modify the option price, quantity and order type as needed.
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Option Chains

3. Click Submit to send the order, or click Advanced to check the margin impact, save the order or
attach a hedge or other advanced order attribute.
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Strategy Builder
Use the Strategy Builder to quickly build options combo orders directly from the option chain display.

To open Strategy Builder
l

From within Mosaic use the New Window drop-down and select Strategy Builder.

l

From within the Option Chain window, click Strategy Builder in the lower right corner.
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Strategy Builder

To create a spread
1. Within the Option Chain area, click the bid or ask for a call or put to add it as a leg to the Spread
Builder.
Note: The spread displays below the leg in the Spread Builder window, and is
updated each time you add a leg. Options used in the spread are highlighted
in the Option Chain.
2. Once the strategy is defined, modify order parameters as needed, including order type, quantity,
price, time in force and more.
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3. Click Submit to send the order. Use the drop-down arrow on the Submit button to save the order
and transmit at a later date.
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FX Matrix

FX Matrix
The FX Matrix provides IBIS subscribers with a convenient way to view FOREX pairs in bulk. The tool comes
preloaded with a set of currencies and the currency list is customizable. Currencies are listed down the left and
across the top; find the intersect of the desired currencies for the most current fx price.

To open the FX Matrix
l

From within Mosaic, from the New Window drop-down select FX Matrix.

l

From within the Advanced Order tool, from the Trading Tools menu select FX Matrix.
Note: The FX Matrix is an information-only tool. To trade fx, use the
FXTrader.
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Charts
Our interactive charts are customizable and support studies and trendlines.

TWS Users' Guide

82

The Mosaic Interface

Charts

Color Grouping Windows

Assign windows to a "group" to link ticker actions. Add a window to a group by selecting a colored
chain link from the group drop down list at the top of all eligible windows.
All windows with the same color are part of the same group. When you change the ticker on one of
the group's "Source" windows, all destination windows in the group reflect the change.
Any window that can be part of a group will display the chain link icons. A window can be part of only
one group at a time. When you log out all groups are saved, but If you close a window, its group affiliation is erased.
Windows that allow grouping fall into one of three categories:
Source - this is a controlling window and can only SEND instructions.
Destination - this is a receiving window, and can only RECEIVE instructions from a window
with Source privileges.
Source/Destination - this is a multi-tasking window which can both SEND instructions to and
RECEIVE instructions from other windows in the group.
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Workspace Modes
The Mosaic and other Window Group workspaces support a group of selected windows that function as a unit
within the locked Mosaic framework. With this grouped workspace paradigm:
l

l

l

Only a single icon is displayed in the windows system tray (versus as many icons as there were
separate windows in the previous version).
Windows within the workspace cannot be inadvertently closed or repositioned.
When the Mosaic frame is resized all included windows will resize and scale appropriately
within the layout.

While you can't modify or move individual windows while Mosaic is locked, you can maximize and minimize
windows by double-clicking the title bar.
The Mosaic has two editing modes: Locked and Unlocked.
By default, the Mosaic workspace is in "locked" mode when you launch the tool. When the workspace is locked,
it acts as a single, grouped unit. You cannot add, remove, resize or move any component windows, but you can
resize the entire workspace, and each component within will be scaled accordingly. Note that you can, however,
modify windows grouping assignments. When the workspace is locked, the potential for inadvertently closing or
moving Mosaic windows is negated.
If you want to rearrange the windows, add or remove windows, or resize individual component windows, click
the Lock icon to unlock the workspace.
Layout Locked

When the Mosaic layout is locked, the workspace is outlined in black and the lock label indicates the status.
Keep the layout locked until you need to add, remove or resize individual windows.
To unlock the layout for editing
l

Click the "lock" icon located to the left of the search field.
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Layout Unlocked

When the Mosaic layout is unlocked, the workspace is outlined in green and the lock label indicates the status.
When unlocked, windows within the workspace frame act as separate, ungrouped windows, and you are able to
remove them, resize them, and add new windows to the layout frame.
Note: Be sure to always lock the workspace when you have finished editing to avoid
unwanted changes or deletions to the Mosaic. You will not be allowed to exit
the application if the workspace is unlocked.
To lock the layout
l

Click the "lock" icon

TWS Users' Guide

85

The Mosaic Interface

Mosaic Fonts
Quickly make the Mosaic windows font larger or smaller.

To adjust font size throughout Mosaic
1. From the Anchor window, click the Font Size Adjustment icon.
2. Click "Smaller" or "Larger" until the font size is correct. Notice that the font size changes in the
Mosaic as you click the button.
3. If "Adjust window & column widths" is checked, the Mosaic windows will size automatically to
keep the same font:window ratio. If unchecked, only font size will change.
4. Click Close when done.

TWS Users' Guide

86

The Mosaic Interface

Charts

Daily Lineup
Designed to be viewed first thing in the morning, the Daily Lineup provides a birds-eye view of upcoming market
events. IBIS subscribers will see the Daily Lineup when they first log in, and can view the summary at any time
during the day by selecting Daily Lineup from the New Window > Event Calendar menu.
The Daily Lineup updates in realtime throughout the day. Thumbnail charts in the World Markets change based
on the selected contract. In the News sections, click a headline to view the full story.
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The Quote Details Window
The Mosaic Quote Details window provides quick-glance data on a specific underlying.

For more information on the Mosaic, see The Mosaic Interface topic.
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Market Depth
The Market Depth window is a minimized version of the full TWS Market Depth Trader. Note that when you
open the Market Depth from within the Mosaic, it is automatically linked to the primary Mosaic windows group
and is populated with that underlying.

To open the Market Depth
l

Mosaic: from the Toolbox click Market Depth.

l

TWS: From the Trading Tools menu select Market Depth.

Market Depth lines are shaded by price group for easy distinction. It's easy to create an order at a specific price
level by simply clicking a price in the Bid (left) or Ask (right) column.

To create a Market Depth order
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1. To create a Sell order, click a price in the Bid column. To create a Buy order, click a price in the
Ask column.
2. In the Order Entry window, the order line is populated with the default Bid or Ask price.
3. If you clicked a Bid price, the red Sell button is active. If you clicked an Ask price, the blue Buy
button is active.
4. Modify the order parameters as desired and click the Sell or Buy button to transmit the order.
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Time and Sales Data
You can elect to view the Time & Sales for any underlying.

To open Time & Sales in the Mosaic
1. From the New Window dropdown select Time & Sales.
2. To change the underlying, select a new ticker in a grouped window, or enter the ticker symbol
in the entry field.
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To search for a date and time from a chart, use the "Select from chart" from the Search button.
Select from chart
1. From the Time & Sales Search menu, choose Select from chart. The chart for the active underlying opens with the cursor in "Time and Sales" mode.
2. Click on the time/date you want reflected in the Time & Sales window.

TWS Users' Guide

92

The Mosaic Interface

Charts

The Order Entry Window
Use the Order Entry window to submit an order. The Orders window is linked via windows grouping to other windows, which means that when you choose an underlying on another window in the group, the Orders window is
"loaded" with the underlying and ready to submit a buy or sell order. It's easy to change the underlying by selecting from the list of typing in a new ticker.

The first time you submit an order via the Order Entry window, you will receive a confirmation message which
you can optionally turn off. If you turn off the confirmation message the Order Entry panel will instantaneously
submit the order when you click Buy or Sell.
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Advanced Orders Panel
Click the "advanced" icon from the Order setup line to use stop loss, profit taker and bracket orders, set up Iceberg, One Cancels Other and hedge orders, and apply other advanced order attributes.
Click an area or button below to get more information.

Use the Advanced Orders panel to:
What?

How?

Routing

Click SMART and choose
a destination from the
drop-down list.

Select a new routing destination.

Back to top
Iceberg

Create an iceberg order, which displays only a user-specified order size to
the market.
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What?

Charts

How?
ity will be displayed to
the market.

Back to top
Order Reference

Add a reference number that helps you track the order through its lifecycle.

Click in the field to
make it editable then
enter a reference number.

Back to top
All or None Attribute

Specify that either all of the order executes or none of it executes.

Check to apply the "All
or None" attribute to
the order.

Back to top
Attach a Stop Loss

Attach a Stop Loss order to the original order.

1. Click "Attach Stop
Loss/Profit Taker/Bracket."
2. Check the "Stop
Loss" box only.
3. In the STOP field,
modify the stop
type (stop, stop
limit or trailing
stop) as needed.

Back to top
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What?

How?
price.
5. In the DAY field
modify the time in
force as needed.
6. Click "more" to
modify the routing
destination and/or
add an order reference.

Attach a Bracket

Attach a Bracket order to the original order. This brackets the order with
two opposite-side orders, and is designed to help limit loss and lock in a
profit.

1. Click "Attach Stop
Loss/Profit Taker/Bracket."
2. Check "Bracket."
The Profit Taker
and Stop Loss
boxes will be
checked automatically.
3. Modify the child
orders.

Profit Taker Child
Back to top

1. Specify Limit or
Relative as the
opposite-side
Profit Taker order
type.
2. Enter a limit price.
For a relative
order, this is the
price cap.
3. For relative
orders, enter the
offset if desired.
4. Specify the time
and force and
other parameters
as needed.
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What?

Charts

How?

Stop Loss Child
1. In the STOP field,
modify the stop
type (stop, stop
limit or trailing
stop) as needed.
2. In the STP PRC
field enter the stop
price.
3. In the DAY field
modify the time in
force as needed.
4. Click "more" to
modify the routing
destination and/or
add an order reference.
Attach a Profit Taker

Attach a profit taker child order to the original order. The profit taker is an
opposite-side limit or relative order.

1. Click "Attach Stop
Loss/Profit Taker/Bracket."
2. Check the "Profit
Taker" box.
3. Specify Limit or
Relative as the
opposite-side
Profit Taker order
type.

Back to top

4. Enter a limit price.
For a relative
order, this is the
price cap.
5. For relative
orders, enter the
offset if desired.
6. Specify the time
and force and
other parameters
as needed.
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What?
One Cancels Other

Include the order in a one-cancels-other order group.

How?
1. Click "One Cancels
Other" to expand
the panel.
2. Change the order
side if necessary.
By default, the
order side is the
same as that of the
original order.
3. Click "Contract"
and enter the
underlying.

Back to top

4. Specify the order
type, quantity,
price and time in
force.
5. To use the Iceberg
attribute or assign
an order reference
number, click the
"More" icon at the
end of the order
line.
6. To add more
orders to the
group, click +Add
Order and follow
steps 2 - 5 above.
7. If an order completely fills, other
orders in the group
are canceled. The
On Fill: box
instructs TWS what
to do if an order in
the group is partially filled. Use
the drop down
selector to choose
the action:
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What?

Charts

How?
a. Reduce
other
orders:
Reduces
the
quantity of
other
orders in
the
group
by
the
partially
filled
quantity of
the
order.
b. Reduce
other
orders,
overfill
protection:
Reduces
quantity of
other
orders in
the in
the
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What?

How?
group
by
the
partially
filled
quantity of
the
order, and
specifies
that
only
one
order
at a
time
will
be
submitted to
avoid
multiple
orders
filling
(overfill).
c. Cancel
other
orders:
All
orders in
the
group
will
be
can-
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What?

Charts

How?
celed.

Attach Hedging Order

Attach a hedging order to the parent order. Choose from Beta, FX, or Pair
Trade hedge. The hedging order will transmit when the parent order fills.

1. Click "Hedge" to
expand the panel.
2. In the drop down
list, select the
hedge type and
check the box next
to the order type
field.
a. Beta Hedge - specify the hedging
contract, the
order type (limit,
market or relative), the beta
(change default
beta if required),
and the time in
force.

Back to top

b. FX Order - specify
the forex pair, the
order type (limit,
market or relative), and the
time in force.
c. Pair Trade - specify the hedging
contract, the
order type (limit,
market relative,
or RPI (available
if the contract is
listed on NYSE),
the offset
(required for
RPI order), the
ratio (the original
contract is "1" so
if you enter "2"
the hedging order
quantity will be
twice that of the
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What?

How?
original order, or
2:1) and the time
in force.

Check Margin

Click "Check Margin."

Check the margin requirements for the order before you submit it.

Back to top
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Monitor Panel
The Mosaic Monitor Panel provides one-stop access to your Portfolio, Market Scanners and Watchlists.

The mosaic Portfolio window, which is one of the tabs included in the Monitor Panel along with the Mosaic Market Scanners and the Watchlists, provides key account information. The Portfolio window is a "source" for windows grouping, which means that the underlying selected in the positions list will change the focus of the
underlying on all linked windows in the group, including the Order Entry panel.
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Select from Predefined or custom Mosaic Market Scanners.
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The Watchlist is split into two columns. Each line shows the symbol, last trade price and change since the last
trade (as both a value and a percentage). Colored tick dots indicate whether the value has increased (green) or
decreased (red).
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The Portfolio
The mosaic Portfolio window, which is included in the grouping of Monitor Panel tabs along with the Mosaic
Market Scanners and the Watchlists, provides key account information. The Portfolio window is a "source" for
windows grouping, which means that the underlying selected in the positions list will change the focus of the
underlying on all linked windows in the group, including the Order Entry panel.
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Mosaic Market Scanners
Create, customize, edit and view Mosaic Market Scanners from within the Mosaic workspace. You can create a
new custom scanner, or choose from a Predefined Mosaic Market Scanner.

To create a Mosaic Market Scanner
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1. From within Mosaic, click the "+" sign in the Watchlist Plus window and select Mosaic Market
Scanner.

2. In the Scanner Library, enter a name for the scan.

TWS Users' Guide

108

The Mosaic Interface

Charts

3. Define the scan "Universe" including the product(s), region(s), exchange(s), type(s) for stock,
and optional industry filters. Click the item to include/exclude. Items in green are included. You
can see the market scanner results in the scanner pane as you define the universe.

4. Use the Fields section to add, remove, and manage each displayed value. Use Dual Sort on one
field to show the scanner sorted in both directions on the selected field. To change the order in
which fields are displayed in the scan, drag and drop fields into the desired order.

Each field provides a "Display" and "Sort" selection. Use these selectors to customize and organize scan data.
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"Display" Field Information
The Display selections let you specify how and if you want the values in the field displayed. Use the
"Bar" and "Gradient" graphical indicators to provide at-a-glance information on the on the tickers in
your market scan. Choose from the following:
l

l

l

l

l

l

l

l

Values - This selection will show the expected numerical value appropriate for the field. This is
the default display.
Gradient - The Gradient uses a filled, colored circle with different shades to provide information on the field value. Red shades identify a downward move and green shows upward movement. Hold your mouse over a gradient to see the color-shading key.
Bar - The Bar chart displays the field value graphically using a colored bar to indicate the direction and degree of change. Red indicates negative and green indicates positive. The length of
the bar indicates the degree of change (the value). Bars that have values outside the handpicked range will display a very bright section at the end of the bar to signify values outside the
range.
Line The Line chart displays the field value graphically using a colored line. You can elect to
view up to three fields that use the Line chart view. Mouse over the "Lines ?" display in the scanner to see the key to the Line colors.
Values + Gradient - Displays two fields for a single value; one with the numerical value and
one with the gradient.
Values + Bar - Displays two fields for a single value; one with the numerical value and one
with the bar chart.
Values + Line - Displays two fields for a single value; one with the numerical value and one
with the line chart.
None - The value for the field will not display. You can use the combination of a "none" value
with a sort specification for a field to have the scanner search on and sort by a field without
showing the field value, for example, Market Cap. If you set the sort to descending, the scan
will return tickers with the highest market cap but will not show you the actual market cap.

"Sort" Field Information
The Sort field allows you to specify sort criteria AND determine the field on which the scan will be
based. You can only select sort criteria for ONE field. Sort selections include:
l

l

l

l

Unsorted - This means that the field values are not ordered and that this field does not drive
the scan.
Low to High - This means that the fields values are sorted ascending from lowest to highest,
and that the scanner is driven by this field.
High to Low - This means that the fields values are sorted descending from highest to lowest,
and that the scanner is driven by this field.
Dual Sort - This selection splits the scanner into two columns, with one column showing values
sorted from Low to High, and the other showing values sorted
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Click Done to complete the scan. Click Edit Scanner at the top right of the scan window to modify the
scan at any time.
Note: To ensure that your new scanners are saved, be sure to exit TWS while the
Mosaic window is still open. If you close the Mosaic before you log out your
changes will be lost.
To open or edit an existing scanner
l

Click a tab on the Watchlist Plus window.

You can export the scan results to an Excel spreadsheet to allow you to use and manipulate the data.
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To export scanner results

1. Complete defining the scanner criteria (or "Edit" the scanner).
2. At the bottom of the scanner window, click Export Results.
3. Enter a name for the file, and modify the Save in location if desired. Click Save.
The scan data is now saved in a .csv file. \
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Predefined Mosaic Market Scanners
Delete this text and replace it with your own content.
To create a Predefined Scanner

1. From within Mosaic, click the "+" sign on the Watchlist Plus window and select Mosaic Market
Scanner.
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2. In the Predefined Scans section of the Scanner Library, select a region and choose a predefined
scan, or use the Search field to find scans based on a keyword. Available scans are shown
below:
Stock Scanners
Future Scanners
Index Scanners
Option Scanners

US

Europe

Asia

US Movers
A dual-sorted scan that displays stocks with the
greatest negative percent change (left side) and
greatest positive percent change (right side).

Europe Movers

Asia Movers
A dual-sorted scan that displays stocks with the
greatest negative percent
change (left side) and
greatest positive percent
change (right side).
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US

Europe

Asia

US Active
Displays stocks with the greatest daily volume,
today.

Europe Active
Displays stocks with the
greatest daily volume, today.

Asia Active
Displays stocks with the
greatest daily volume,
today.

US FUT Movers
A dual-sorted scan that displays futures with the
greatest negative percent change (left side) and
greatest positive percent change (right side).

Europe FUT Movers
A dual-sorted scan that displays futures with the greatest
negative percent change (left
side) and greatest positive percent change (right side).

Asia FUT Movers
A dual-sorted scan that displays futures with the
greatest negative percent
change (left side) and
greatest positive percent
change (right side).

US INDEX Movers
A dual-sorted scan that displays indexes with
the greatest negative percent change (left side)
and greatest positive percent change (right side).

Europe INDEX Movers
A dual-sorted scan that displays indexes with the
greatest negative percent
change (left side) and
greatest positive percent
change (right side).

Asia INDEX Movers
A dual-sorted scan that displays indexes with the
greatest negative percent
change (left side) and
greatest positive percent
change (right side).

US ROE
Scans for major US corporations with the
strongest return on equity over the past 12
months.

Dividend Yield
Lists equities with the richest dividend yields.
Imbalance
A dual-sorted scan that lists the largest auction
imbalances to buy and sell. Only displays values
during NYSE and NASDAQ auctions.
Reg Imbalance
A dual-sort scan listing the largest ratio of Regulatory Imbalance to Average Daily Volume.
Only displays values during NYSE closing auctions.
Russia ET
Displays the set of US ETFs whose holdings
focus solely on Russian equities.
P/C Volume
A dual-sorted scan that displays equities with
the highest and lowest put/call ratios.
IV/HV
A dual-sorted scan that identifies equities whose
options currently have the highest and lowest
implied volatilities vs. their historical 30-day
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US

Europe

Asia

volatilities.
Alternative Energy
Displays the list of US publicly traded corporations in the alternative energy industry.
Option Volume
Displays equities with the highest option volume
today.
IPO Stocks
Displays equities sorted by their IPO date.

IPO Stocks
IPO Stocks
Displays equities sorted by Displays equities sorted by
their IPO date.
their IPO date.

Complex Orders and Trades
Returns all complex strategies on a specific
underlying that has a native bid/ask quote
or that has traded today. To find the
strategy that has traded the most today,
sort the results by Volume (click on the
Volume column to sort).
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Activity Panel
The Mosaic Activity Panel comprises the Orders, Trades, Portfolio and Trades Summary windows, each of
which are accessible from the drop-down pick list in the upper left corner of the window.

The Orders tab provides a running list of all live, canceled and/or completed orders. Use the drop down list to filter the orders that display.

The Trades window shows the day's trades by time and underlying.
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The Trades Summary window shows all Buys and Sells for the day, grouped by underlying.
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The Orders Window
The mosaic Orders window is one of the tabs in the Activity Panel, and provides a running list of all live, canceled and completed orders.

Click the display drop-down (ALL in the above image) to specify which order types to displayi n the Orders window. Choose from:
l

ALL ORDERS

l

LIVE ORDERS

l

CANCELED ORDERS

l

COMPLETED ORDERS
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News Panel
The News panel groups all of your newsfeeds, including the market news, Portfolio or Watchlist news, companyspecific news, filtered general news, Market Signals, Broad Tape (which includes all subscribed services) and
Today's Top Ten together in a single, multi-tabbed, easy-to-navigate window.
By default we display Market (Broad Tape) news, Portfolio news and company-specific news which is linked by
windows grouping. You can easily add more news tabs by clicking the "+" sign at the end of the tabbed row.
Market News

Market news aggregates all subscribed news feeds into a single tab.

Use the Settings to modify highlighting of breaking news, bolding of new headlines and more.
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Portfolio or Watchlist News

Use the Settings to specify how tickers for headlines are determined. Show news for:
l

l

l

Companies in your portfolio, plus news relating to competitors or those companies.
All companies listed in your Watchlists and in the Quote Monitor in TWS, plus news relating to
competitors of those companies.
A custom-defined list of companies.

Company Specific News

See news for a specific company based on the selected ticker in the linked group.
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Today's Top Ten News
IBISsubscribers with a Dow Jones news subscription can elect to view the DJ Today's Top Ten items by adding
Top Ten from the News panel.

Click a top news headline to view the full content.
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Filtered Feed
View real-time streaming general news that you can filter by subject. Add Market Signals as part of
your integrated news headlines. Note that the Filtered News window cannot be part of a windows
group.

To add the filtered feed
1. From the News panel, click the "+" sign.
2. Select Filtered news (filter by subject or feed).
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Market Signals
IB's data servers continuously scan the markets for irregular price and volume actions and transmit these notifications directly to your TWS in the form of Market Signal alerts. Available market signals include price spikes,
irregular volume spikes, new 52 week highs/lows, put/call ratio spikes, trading halts and more.

Market Signals can be integrated into the general news headlines in the Filtered News window, or viewed as a
separate feed in the Market Signals window. By default, the Market Signal alert "Gap On Open" is active in the
Filtered News window.

To add Market Signals to Filtered News
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1. From the Filtered News title bar, click the Configure wrench icon.
2. Ensure that Filtered News is selected in the left pane.
3. In the right pane, select General News and click Configure Subject Filter next to IB Market Signals.
4. Select the signals to add using the checkboxes and apply.

To use the Market Signals window
1. From the News panel, click the "+" sign and select Market Signals.
2. From the Market Signals title bar, click the wrench-shaped Configure icon and then click
Settings.
3. In the right pane of Global Configuration under Market Signals, click Configure Subject Filter.
4. Select the signals to add using the checkboxes, and apply.
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Trading Tools
TWS provides a comprehensive collection of specialized trading tools that function separately as
stand-alone windows, and in conjunction with other TWS tools. Our expanding family of order management applications include:
l

The Watchlist

l

BasketTrader

l

BookTrader

l

Pre-Borrow Shares for Shorting

l

Stock Borrow/Loan

l

Yield Optimizer

l

TWS Blotter

l

ChartTrader

l

ComboTrader

l

Market Depth

l

FXTrader

l

Rebalance Portfolio

l

The Integrated Stock Window (ISW)

l

OptionTrader

l

Write and Rollover Options

l

The Order Ticket

l

Calculate Order Quantity

l

Rapid Order Entry

l

SpreadTrader

l

Merger Arb

l

Relevant EFPs

l

Update Orders

l

See Volatility Trading for more information.
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The Watchlist
Introduction
l

The Watchlist
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The Watchlist
The Watchlist allows you to view many contracts in a small window that can be moved anywhere on
your desktop. Although the default presentation shows two contract columns, you can expand the
number of contract columns by stretching the width of the window. You can create multiple named
Watchlist windows.

To create a Watchlist
1. From the Trading Tools menu select Watchlist.
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To rename a Watchlist
1. Click the Configure wrench icon in the title bar of the window to access the Watchlist section of Global

Configuration.
2. In the left pane, expand the Windows section, and select the Watchlist you want to rename.
3. Enter a name in the Name field and click OK.

Features of the Watchlist
l

l

l

l

l

Display the TWS menus by clicking the Watchlist Settings page in Global Configuration
and checking Display pull-down menus.
Populate the Watchlist by entering the underlying symbol in the Contract column, or by
dragging and dropping a ticker line from another TWS window into the Watchlist.
If you drag a Group Header into the Watchlist, the header and all contracts in that section will be copied into the Watchlist.
Add more Contract/Last/Change columns by dragging to expand the width of the window.
Customize fields in the column using the Watchlist Layout page in Global Configuration.
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BasketTrader

BasketTrader
Introduction

Use the BasketTrader to manage groups of orders on multiple products, and to easily create an order
group modeled on a popular index. This section shows you how to:
l

Send a Basket Order

l

Create a Basket File in TWS

l

Manually Create a Basket File

l

Create a Sample Excel Basket File

l

Use the IndexTrader
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Send a Basket Order
Before you can select and transmit a basket order, you must create and save the basket file.
You can modify a basket order before you send it by adding or removing assets, changing the multiplier and quantities, and reversing the order sides and then converting limit orders to market or relative orders. You can also elect to create a basket file based on a selected index using the index
composition or statistical composition. Use the criteria selections to fine-tune your index basket. If
you choose to base your index basket on the index composition, the system automatically keeps the
basket in line with the index composition as it changes.
When you send a basket order, each order in the basket is cleared individually. If your account does
not meet margin requirements, it is possible that only a portion of the basket order will execute.

To send a basket order
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BasketTrader

1. On the Tools menu, select BasketTrader, or click the Basket icon on the trading toolbar.
2. In the Basket File field, use the drop-down list to select a basket, or click the Browse button to
find a basket file that doesn't appear in the list. Use the IndexTrader panel to create a basket
based on an index or a portion of an index.
3. Modify the Multiplier if necessary. This value multiplies the quantity of each order in the basket.
4. Click Load to populate the Orders tab with the orders in the basket.
5. Modify order parameters if necessary, and click Transmit in the Execute Basket panel to transmit the entire basket order. You can transmit individual orders within the basket using the market data lines in the Orders tab and clicking the "T" in the status field.
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Create a Basket File in TWS
TWS will automatically create a basket file from a group of non-transmitted orders on a trading page.
When you want to trade or manage baskets, open the basket file from the BasketTrader. You can also
create a basket file manually, outside of TWS, but we recommend using the TWSautomated process
to get the file started.

TWScreates a basket file from orders on a single trading page. You can easily combine orders from multiple
files into one using MS Excel.
To automatically create a basket file
1. Create orders to include in the basket file.
l
Click the Ask Price on a market data line to create a BUY order.
l

Click the Bid Price on a market data line to create a SELL order.

2. Modify order parameters and define order attributes.
3. On the Trade menu, select Save Orders as Basket.
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BasketTrader

Note: If Save Orders as Basket is not visible, click the Hidden Features arrow at the
bottom of the menu to display the command.
4. In the dialog box, review or rename the file and use a .csv extension (i.e. stocks.csv) and click
OK.

The system uses the Trading page name as the default basket name.
5. Cancel the orders you created. Use the Trade menu and select Cancel then Cancel All Orders on Page.
The BasketTrader supports Bracket orders, but baskets that include brackets will have the Reverse
and Cancel and Reverse features disabled. Remember to create the bracket order(s) on the Quote
Monitor and then save the brackets as a basket file. You cannot create bracket orders within the BasketTrader itself.
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Manually Create a Basket File
We highly recommend that you first create a TWS basket file from a trading page using several different order types and products. Then open the sample file in Excel and use this as your starting point
to edit the fields and create new rows. The key to the basket file is the relationship between the
header row and order rows. The header fields can occur in any order as long as the values in the
order rows correspond to the Header field.
The basket file is formatted as follows, where the top row is the Header row, and subsequent rows
are orders rows. The Header Row includes field titles for each order value. The Order Row includes
order values that correspond with the required field title for that order type.
Field 1

Field 2

Field 3

Field 4

Field 5

value

value

value

value

value

value

value

value

value

value

value

value

value

value

Field 6

Field 7

value

value

Field 8

value
value

value

value

value

For example:

The Sample Excel Basket File topic shows how a basket file with multiple order types would look in
Excel.

Notes about creating basket files:
l

l

l

Valid Header Row fields include all TWS fields.
Child values in the order row fields must match the fields in the parent Header Row in content.
For example, if your Header Row field is Symbol and you enter the value STK in that field of the
order row, your file will not be readable.
Basket files created in a text editor must be saved as a .csv (preferred) or .bsk file.

Although not recommended for new files, the .bsk file extension is still supported in the new basket layout.
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l

l

l

l

l

BasketTrader

For basket files created in a text editor, do not leave a space between a value and its comma,
or TWS will not be able to read the file.
If you create your basket file in Excel, enter only one value (or no value) per cell and DO NOT
use commas.
Save your Excel basket file as a .csv file.
Fields in the Header Row need not be in any specific order as long as they have a corresponding
correct value in the order row field.
If the order does not require a field value, that field can be left blank.

The major differences between the original and improved basket file formats include:
Old Basket File

New Basket File

Old version supported only limited
number of pre-defined fields.

New version supports all TWS fields.

Old version required you to enter
order values in a specific sequence.

New version does not require any specific order
sequence for fields.

Old version required only order values (since the "header" fields were
hard-coded into TWS).

New version requires a header row with order-specific field titles. Use multiple header rows in a
single basket for order types that require different
field values.

Old version required blank placeholders for values that were not
required.

New version requires an exact one-to-one relationship between a header field and an order value;
you cannot leave an order field blank if there is a
header field defined.

Old version was saved as .bsk
(TWS-specific) file.

New version uses .csv (generic) file extension.
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Sample Excel Basket File
The picture below gives you an idea of how orders will look in the Excel .csv file. Note that different
order types require different fields, and blank fields in an order row are accepted.

The bold font in the header row is used for illustrative purposes only, and will not display in your
Excel basket file.
Accepted Fields

The following order fields can be used to create a basket file:
Field Name
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BasketTrader

IndexTrader
The IndexTrader helps you create a basket order based on an index. Use the IndexTrader as a standalone window, or as the Index Panel in the BasketTrader window.

To open the IndexTrader
l

From the Trading Tools menu, select IndexTrader from the Multi Contract group.
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Pre-Borrow Shares for Shorting
If you plan on putting on a short sale, you can choose to pre-borrow shares to decrease your chances of being
bought in on settlement date.
l

About Pre-Borrows

l

Create a Pre-Borrow Order

l

Transactions and Positions

l

Pre-Borrow Returns
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Pre-Borrow Shares for Shorting

About Pre-Borrows
Eligibility
l

l

Pre-Borrow for Shorting is only available for Portfolio Margin customers.
To enable this program, you must log into Account Management and check Pre-Borrow Program
in the Trading Programs section of the Trading Permissions area.

The Pre-Borrow Market
l

Pre-borrow orders are accepted from 6:45 - 14:45 ET.

l

Generally the most active time for pre-borrows occurs between 9:00 and 11:00 a.m.

Rates and Fees
l

l

The indicative rate displays in the data line for the stock in the Lend field. The actual rate to borrow that stock (our standard borrow rate) is computed at the end of the day and will be available on your activity statement.
Rates are subject to change based on availability of the underlying stock. Standard borrow
rates are computed each night and will be available on your activity statement.

l

You will pay additional borrow fees for any stock held in excess of your short position.

l

The borrow rate is applied to the collateral to calculate the daily borrow fee.

l

l

l

The borrower is responsible for the daily borrow fee and for collateral on the transaction. The
collateral is equal to the settlement price x quantity. The settlement price is 102% x mark price
rounded up to the nearest 1.00 with a 1.00 minimum.
Collateral is returned to the borrower when the borrowed shares have been returned to the
lender.
In the case of dividend-paying shares, since shares are only being lent (not sold) by the lender,
dividends paid during the borrow belong to the lender who actually owns the shares. The borrower of the shares must pay dividends to the lender in what is called Payment in Lieu of
Dividends.

Transaction Information
l

l

A pre-borrow is presumed to anticipate a short sale. If no short sale trade executes within four
days of the pre-borrow transaction, a non-purpose borrow results and the shares are returned.
If the pre-borrow is not followed by a short sale and a previous short on the same underlying
exists, the pre-borrow will be applied to the existing short on the following day.

l

Only US and Canadian stocks are available to pre-borrow.

l

Orders are only eligible to fill during regular trading hours.

l

There is an order minimum of 100k USD for all pre-borrow transactions.

l

Only market orders are supported for pre-borrow orders.
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Create a Pre-Borrow Order
You can initiate a pre-borrow order from US stock market data line or directly from within the Stock/Borrow
Loan window.
Note: Before you can pre-borrow you will need to enroll in the program via the Trading Programs area in Account Management.

To create a pre-borrow order
1. Right-click the stock underlying you want to pre-borrow and select Trade then select Pre-borrow
shares for Shorting.
2. Select the contract/destination as xyz SBL@PREBORROW.
Note: Answer "Yes" to the message offering to change the order type to MARKET.
You will receive this message for every pre-borrow order if you have the
default order type set to any type other than MARKET.
3. For the pre-borrow order you can only modify the quantity, which should correspond to the anticipated short sale.
4. Transmit the order.
Short Sales on a Pre-Borrow

Once the pre-borrow order is contracted, the quantity available to short will be shown in the Private Locate
field.

Display the Private Locate field
Hold your mouse over any market data field until the "Insert Column" option appears. Click "Insert Column" and
select Stock Borrow/Loan and then Private Locate.
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Pre-Borrow Shares for Shorting

For details on using the pre-borrow feature, see the About Pre-Borrows topic.
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Transactions and Positions
As with all TWS transactions, you can view executions in the Trades window, and monitor the Borrow/Loan positions in your portfolio from the Account Information window.

To view transactions
1. From the toolbar, click the Trades icon.
2. All transactions are displayed in the Trades tab. The Description field identifies Borrow/Loan trans-

actions, and the borrow rate is shown in the Price field.
Note: For pre-borrows, the rate shown is the indicative rate. The actual,
standard borrow rate is calculated at the end of the day and is shown on
your account statement.
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Pre-Borrow Shares for Shorting

To view Portfolio
1. On the toolbar, click the Account icon.
2. The Portfolio section at the bottom of the page shows all positions including borrows. The Market Price

shows the borrow rate.
Note: Borrow positions will also display on the system-generated Portfolio trading
page.
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Pre-Borrow Shares for Shorting

Pre-Borrow Returns
The Return/Recall panel displays any returns and recall requests (you must be logged in), and allows you to send
return requests.
Once you borrow shares, you can return them using the Return order function, or the lender can recall
the shares at any time. When borrowed shares are recalled, they are removed from your account,
you are notified in the Return/Recall panel of TWS, and the recall will show up in the Borrow Activity
section of your Activity Statement.
Please note that if you have borrowed to cover a short position and then purchase the shares and no
longer need to maintain the borrow position, the borrowed shares are not automatically returned; you
must return the shares. Returns cannot be made the same day (you can return the next day), and
must be entered by 10:50 am.
To view the Return/Recall panel, click the Show Return/Recall Requests icon on the right-hand tab of
the trading page.

To return borrowed shares
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1. Right-click the ticker and select Trade then select Return Shares.
2. Confirm the order parameters and transmit the order by clicking the ‘T’ in the Status field.
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Stock Borrow/Loan

Stock Borrow/Loan
Introduction

Customers who have been approved for Portfolio Margin can use the Stock Borrow/Loan feature to
borrow and lend US stocks electronically via the AQS® electronic stock loan and borrow marketplace.
l

About Stock Borrow/Loan

l

Access Stock Borrow/Loan

l

Borrow/Loan Fields

l

Borrow/Loan Transactions

l

Returns/Recalls/Rerates

l

Transactions and Positions
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About Stock Borrow/Loan
Eligibility
l

l

Stock Borrow/Loan is available for Portfolio Margin customers.
To enable stock/borrow permissions, you must log into Account Management and from the Manage Account menu select Trade Configuration and then Permissions. From the Trade Permissions section, enable United States (AQS Stock Lend Borrow) from the Stocks column.

The Borrow/Loan Market
l

The market’s regular hours are from 6:45 - 15:00.

l

Most active time for borrow/lend occurs between 9:00 and 11:00 am.

Recalls and Rerates
l

As a borrower, if you request a rerate on the borrow, the lender has 25 minutes in which to
respond. If there is no response or if the rerate request is rejected, the transaction is closed
and borrowed shares are returned to the lender.

Rates and Fees
l

l

The borrow and lend rates display in the data line for the stock underlying in the Borrow and
Lend fields.
When you hover your mouse over the borrow rate, you see the Total rate, which is:
Interest Rate - Borrow Rate

l

The interest rate is always the current opening Fed Funds Effective rate.

l

The borrow/lend rates change based on availability of underlying contract.

l

The borrow rate is applied to the collateral to calculate the daily borrow fee.

l

l

l

The borrower is responsible for the daily borrow fee and for collateral on the transaction. The
collateral is equal to the settlement price x quantity. The settlement price is 102% x mark price
rounded up to the nearest 1.00 with a 1.00 minimum.
Collateral is returned to the borrower when the borrowed shares have been returned to the
lender.
In the case of dividend-paying shares, since shares are only being lent (not sold) by the lender,
dividends paid during the borrow belong to the lender who actually owns the shares. The borrower of the shares must pay dividends to the lender in what is called Payment in Lieu of
Dividends.

Transaction Information
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l

l

l

l

Stock Borrow/Loan

Orders are only eligible to fill during regular trading hours.
There is a price minimum of 200k for borrow transactions of easy-to-borrow shares. This minimum is in effect from the market’s open at 6:45 am up until 11:00 am. Shares are considered
easy-to-borrow if the borrow rate is less than or equal to 0.00.
To lend, you must own the shares outright, and they must be physically available and held at
the DTC. The quantity you have available to lend is shown in the Loanable Quantity field. If
your account has a margin balance, you may not be able to lend out all of the shares in a position. IB’s segregation algorithm determines which shares are available to lend.
Only day limit orders are supported.
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Access Stock Borrow/Loan
The Stock Borrow/Loan page has been configured specifically to support all of the borrow/loan fields
and functionality.

To open Stock Borrow/Loan
l

From the Trading Tools menu, select Stock Borrow/Loan.

The Stock Borrow/Loan window opens as a blank trading page.
To add tickers
1. Enter a stock symbol in the Underlying field and hit enter.
2. Choose the market, AQS and/or AQS_P.

Only agent lenders can lend or borrow in the primary (_P) markets.
In addition, you can manage borrow/loan transactions on a regular trading page by first entering the
underlying stock symbol and then selecting SBL as the instrument type. You will need to manually add
the relevant borrow/loan fields using the Layout manager.
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Borrow/Loan Fields
The Stock Borrow/Loan window includes fields used specifically for stock loan and borrow transactions. You can add any of these fields to other trading pages using the Layout manager. TWS trading pages display both ticker lines and order lines. When you create an order, the order line appears
directly below its ticker line. Accordingly, the field labels are also laid out in a top/bottom row format.

To make labels appear as a single large label like the Underlying field, you must add the same field from both
the Market Data and the Order Columns tabs.
To view the Stock Borrow/Loan and other fields that can be added to a trading window, right-click anywhere within the field titles and select Customize Layout. The fields below are displayed by default in
the Stock Borrow/Loan page.
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Column

Stock Borrow/Loan

Description

Underlying

The underlying stock symbol of the stock being borrowed or lent.

Position

Your current position. In the LoanBorrowTrader, this represents your current stock
position. This field is used for all asset types, it is not unique to the borrow/loan
page.

Loanable
Quantity

Shows the current position in the stock that is eligible for lending.
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Avg Rate

The average borrow rate of your current Borrow/Loan positions.

Auction
Borrow
Size

The volume of shares being bid for at the Auction Borrow rate.

Auction
Borrow

This value represents the best rate quoted to lend the underlying shares.

Click the Auction Borrow field to create a Lend order.
Auction
Lend

This value represents the best rate quoted to borrow the underlying shares.

Click the Auction Lend field to create a Borrow order.
Auction
Lend Size

The volume of shares available to borrow at the Auction Lend rate.

Auction
Price

The indicative rate for the next scheduled auction. Auctions occur every 15 minutes
while the Borrow/Loan market is open.

Borrow
Size

The volume of shares being bid for at the last auction rate during continuous trading.

Borrow

The last auction rate that was established during continuous trading.

Lend

The last auction rate that was established during continuous trading.

Lend Size

The volume of shares available to borrow at the last auction rate during continuous
trading.

Auction
Volume

The total number of shares available for the next auction.

Previous
Auction
Volume

The total number of shares that were available for the previous auction.
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Stock Borrow/Loan

Borrow/Loan Transactions
You can borrow and lend shares directly from the data line.
l

To borrow, click the Lend or Auction Lend field.

l

To lend, click the Borrow or Auction Borrow field.

Borrowing Shares

Borrow requests are eligible to fill in either the continuous or auction market, based on price.
l

l

If you initiate a borrow by clicking the Auction Lend field, the limit price reflects the current
best Lend rate.
If you initiate a borrow by clicking the Lend field, the limit price defaults to the last auction
price.
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You can modify the transaction type on the order line using the Borrow/Lend drop-down in the Action field.
Continuous trading runs throughout the day, stopping for 5 minutes prior to each 1 minute auction. If
your transaction does not fill during continuous trading, it will be held and entered in the next auction.

The Borrow Rate and Interest Rate

The borrow rate differs by symbol based on how difficult a stock is to borrow. The harder a stock is to
borrow, the higher the borrow rate. The borrow rate includes the interest rate which is the same for
all symbols and is equal to the day’s opening Fed Funds rate. Shares are considered “easy-to-borrow”
if a reasonable assurance can be made at trade date that the shares will be available for borrowing on
settlement date. Oftentimes the borrow rate on such shares is equal to or less than 0.00.
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Stock Borrow/Loan

There is a collateral minimum of 200k to borrow easy-to-borrow shares. This minimum is in effect from the market’s open at 6:45 am up until 11:00 am.
The collateral amount is the price per share of the underlying x quantity. The borrow rate is applied to
the collateral amount to calculate the daily IB Carry Charge that the borrower will pay for the privilege of borrowing the stock. The collateral represents the cash put up by the borrower to cover the
borrow transaction, and is the underlying stock price times the quantity of the borrow transaction.
The collateral is returned to the borrower when the shares are returned to the lender.
The daily IB Carry Charge is:

Quantity x Stock Price x Borrow Fee/360
For example, if you are borrowing 500 shares of a $20.00 stock with a borrow fee of 0.38, the daily IB
Carry Charge on the transaction is:

500 x $20.00 x .0038/360 = 0.18*
To see the total rate, which is the interest rate - borrow fee, hold your mouse over a rate field.
*The IB Carry Charge is subject to minimum/maximum amounts as described on the AQS Commissions page on the IB web site.
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Preview Orders

Before you transmit the order, right-click and select Preview Order/Margin. The Order Description
box shows the order parameters, and displays the amount that will settle, calculated as 102% * mark
price, rounded up to the nearest $1, with a minimum of $1.
Note: This preview is a current projection only and is subject to change.

Borrow Limits
You can borrow up to the amount you would be eligible to short based on the Net Liquidation Value in
your account.
Lending Shares

To lend shares, you must own the shares (they cannot be long on margin) and the DTC must be holding them. The quantity of shares available to lend is shown in the Loanable Quantity field.
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l

l

Stock Borrow/Loan

If you initiate a lend order by clicking the Auction Borrow field, the value in your order
reflects the current best Borrow rate.
If you create a lend order by clicking the Borrow field, the rate defaults to the auction equilibrium rate.

You can manually modify the rate at which you want to lend directly in the order line.
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Returns/Recalls/Rerates
The Return/Recall panel displays any return or recall requests when you are logged in, and allows you
to send rerate and return requests.

Borrowing
Once you borrow shares, you can return them using the Return order function, or the lender can recall
the shares at any time. When borrowed shares are recalled, they are removed from your account,
you are notified in the Return/Recall panel of TWS, and the recall will show up in the Borrow Activity
section of your Activity Statement. If you would like to negotiate a better rate on your borrowed
shares, you can initiate a Rerate request order. If the rerate request is rejected, your shares are
immediately returned to the lender.
Please note that if you have borrowed to cover a short position, and then purchase the shares and no
longer need to maintain the borrow position, the borrowed shares are not automatically returned; you
must return the shares.

Lending
As a lender of shares, you can recall your shares at any time except on the same day that you lent
them, using the Recall order function.
The borrow may want to negotiate the borrow rate by submitting a rerate request. You will be notified
of a rerate request only if you are logged into TWS. If you receive a rerate request, you must respond
within 25 minutes; if you do not, the request is automatically rejected and all shares are returned to
you. This time limit applies regardless of whether or not you are logged into TWS.
The borrower may return the shares to you at any time. You will be notified of a customer return in
the Return/Recall panel.
In the case where you have lent a quantity of your fully-paid shares and subsequently sell the shares,
IB will automatically recall the shares the following day. If IBdoes not receive the shares from the
borrower in time for settlement of the stock sale, the stock sale will be completed but the loan will
remain open until the shares are returned.
Rerate and recall requests from the counter party to whom IBhas lent your shares will display in the
Return/Recall panel.

TWS Users' Guide

162

Trading Tools

l

Stock Borrow/Loan

To view the Return/Recall panel, click the Show Return/Recall Requests icon on the
right-hand tab of the trading page.

To return borrowed shares
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1. Right-click the ticker and select Trade then select Return Shares.
2. Confirm the order parameters and transmit the order by clicking the ‘T’ in the Status field.

To request a rerate on borrowed shares
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Stock Borrow/Loan

1. Right-click the ticker and select Trade then select Rerate.
2. Enter the rate you would like to receive in the Lmt Price field.
3. Transmit the order by clicking the "T" in the Status field.
Note: If your rerate request is rejected, the transaction automatically becomes a
return and your borrow position is reduced by the size of the request.

TWS Users' Guide

165

Trading Tools

Transactions and Positions
As with all TWS transactions, you can view executions in the Trades window, and monitor the Borrow/Loan positions in your portfolio from the Account Information window.

To view transactions
1. From the toolbar, click the Trades icon.
2. All transactions are displayed in the Trades tab. The Description field identifies Borrow/Loan trans-

actions, and the borrow rate is shown in the Price field.
Note: For pre-borrows, the rate shown is the indicative rate. The actual,
standard borrow rate is calculated at the end of the day and is shown on
your account statement.
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Stock Borrow/Loan

To view Portfolio
1. On the toolbar, click the Account icon.
2. The Portfolio section at the bottom of the page shows all positions including borrows. The Market Price

shows the borrow rate.
Note: Borrow positions will also display on the system-generated Portfolio trading
page.
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Yield Optimizer

Yield Optimizer
Introduction

Use the Yield Optimizer to compare rates for borrowing and lending stock, and see the return you
could receive if you invested the unused cash sitting in your account in an EFP.
l

Open the Yield Optimizer

l

Compare Borrow Rates
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Open the Yield Optimizer
The Yield Optimizer allows you to compare the borrow rates for hard-to-borrow stocks using different
strategies, including EFPs (where you would buy the stock and sell the stock future, essentially “borrowing” the shares), borrowing via the AQS marketplace, or having IB borrow shares for you.
Open the Yield Optimizer
l

From the Trading Tools menu, select Yield Optimizer.

Use the optimizer to Compare Borrow Rates.
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Yield Optimizer

Compare Borrow Rates
The Yield Optimizer opens and displays all tickers in which you currently hold a short position. If you
are considering putting on a short position and want to compare rates for the borrow transaction, use
the Borrow Shares section of the Yield Optimizer.

Borrow Shares - Fields
Field

Description

Net Position

This is your aggregate net stock and SSF short position.

First
EFP

Shows the rate you would pay to borrow shares by selling the
EFP with the nearest SSF expiration. When you sell the EFP,
you buy the stock and sell the SSF - this temporary purchase is
in essence a borrow.
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Next
EFP

Shows the rate you would pay to borrow shares by selling the
EFP with the next closest SSF expiration. When you sell the
EFP, you buy the stock and sell the SSF - this temporary purchase is in essence a borrow.

AQS
Rate

Shows the rate you would pay to borrow shares via the AQS
marketplace.

IB Rate

Shows the rate you would pay to borrow the shares from IB. If
you hold a short position and have not borrowed shares using
any other method, this is the rate you are currently paying.

To compare borrow rates
1. Enter the underlying for the stock you want to short.
2. Compare borrow rates between First EFP, Next EFP, AQS Borrow Rate and IB Borrow Rate.
3. Select a row to view the details in a sub-panel.
Note that the contract details panel displays all four available EFPs.
To borrow shares using one of the Yield Optimizer methods, click the desired Borrow Rate from the
contract panel.
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TWS Blotter
Introduction
l

Using the TWS Blotter

l

Understand the Blotter Interface

l

Manual Ticket Entry

l

Advisor Allocations

l

Receive Electronic Tickets

l

Use Windows Grouping to Link Blotter

l

Using the Tickets Panel

l

Using The Orders Panel

l

Manage Orders with TWS Algos and Tools

l

Intra-Desk Routing

l

Reading the Trades Panel

l

Display Orders by Filter Criteria

l

Order Sharing Modes

l

Configure the Blotter Panels
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Using the TWS Blotter
The Blotter is part of our suite of specialized order management tools, and is the foundation of the IB
OMS. Log into TWS to access the Blotter and other OMS functionality.

To open the Blotter
1. Log in to TWS.
l

From the Trading menu, select Blotter.

l

Or, click the Blotter icon on the trading toolbar.
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Understand the Blotter Interface
Traders use the Blotter window to receive and create tickets, and to create and manage orders.

The Blotter comprises these main sections:
l

l

The Manual Ticket Entry/Rapid Ticket Entry panel, used to manually create new tickets.
The Tickets panel which displays manually created and electronic tickets, and the ongoing
order status.

l

The Orders panel, used to modify and submit client orders.

l

The Trades panel, which displays summary and drill-down execution reports.
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Electronic tickets via FIX are accepted via a pop-up notification box, and other tickets can be entered
manually by the trader using the Manual Ticket Entry panel. Once an order is accepted or added,
you can manage all aspects of your clients’ orders from this single Blotter window.

TWS Users' Guide

176

Trading Tools

TWS Blotter

Manual Ticket Entry
You can enter manual tickets from the Blotter by typing an underlying or contract symbol in the
Underlying field of the Manual Ticket Entry panel. You can also enable ticket entry from other TWS
windows, or add tickets to the Manual Ticket Entry panel from the right-click menu on a market data
line.
To enter a manual ticket from the Blotter
1. Enter the underlying symbol in the Contract field, and hit Enter.

2. Use the Contract Selection list and Contract Selection box to define the contract.
3. In the Account field, select the beneficial account for the order. Select the Action (BUY or
SELL), the Quantity and the order Type (Limit or Market for the parent order).
4. Click Add to put the order into the Tickets panel.
If you know the contract symbol you can enter a ticket quickly using symbol shorthand.
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To enter a ticket using symbol entry
l

In the Underlying field, enter the contract symbol and routing choice as: symbol#routing

You can also instruct TWS to create blotter tickets for orders you initiate on other TWS windows.

To enable ticket entry from other TWS windows
1. From the Edit menu select Global Configuration.
2. In the left pane, select Orders.
3. In the right pane, check Create ticket for all orders.
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Checking this feature tells TWSto send all of your orders to the Blotter for order management, regardless of the window from which the order originated.

To create a manual ticket entry from the right-click menu in another window
1. Select the market data line for which you want to create a ticket.
2. From the right-click menu, select Trading Tools and then select Blotter.
The Manual Ticket Entry panel of the Blotter now displays the contract.
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Advisor Allocations
An allocation method can be defined during manual ticket entry, and this designation is retained with
the order and applied when the order fills.

To allocate shares
1. From the Manual Ticket Entry panel, create a ticket.
2. In the Allocation field, use the drop-down picklist to choose an allocation group, profile, or a
single account.
As the order is processed, the assigned allocation remains and is applied when the order fills.
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Receive Electronic Tickets
You are notified of incoming FIX tickets by a pop-up order notification window.

l

Click Accept for a single order to put a single ticket into the Tickets panel.

l

Click Accept All to put all tickets into the Tickets panel.

l

Click Reject to cancel a single ticket.

l

Click Reject All to cancel all tickets.

If you are not logged in when a ticket is received, it is sent to the next available trader.
You can assign sounds to specific events to help you recognize receipt of an electronic ticket, modification request of a electronic ticket, and a cancel request for an electronic ticket.
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To assign sounds to events
1. On the Configure menu select Global Configuration.
2. In the left pane select Sound Manager, and in the right panel check the events to which you want to assign

a notification sound.
3. Use the down arrow to display and select from available system sounds. Use the Browse button to find a

sound file to apply.
Note: Click the “Play” arrow to hear the sound you have chosen.
4. In the Repeat Count field, modify the default setting if you want to notification to play more than once.
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Use Color Grouping to Link Blotter Windows
Creating a windows group that includes the Blotter provides a shortcut for creating manual tickets.
For example, assume you want to create an options order on IBM. Without grouping, you’d need to
create the line in the Manual Ticket Entry of the Blotter, then enter IBM into the OptionTrader to get
the option chains. With the windows, grouped, as soon as you enter IBM in the Blotter, the
OptionTrader receives this entry and is populated with IBM chains automatically.

Assign windows to a "group" to link order and ticker actions. You assign a window to a group using the
colored blocks on the top right of the title bar. All windows with the same color are part of the same
group. When you change focus on one of the group's "Source" windows, all destination windows in the
group reflect the change.
Any window that can be part of a group will display the blocks. A window can be part of one group at a
time. When you close the window, its group affiliation is erased.

The window's designation is displayed in a mouse-over tooltip when you hover over the Group icon. A
window can be a:
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Source - this is a controlling window and can only SEND instructions. The Blotter window is a
source-only window.
Destination - this is a receiving window, and can only RECEIVE instructions from a window
with Source privileges.
Source/Destination - this is a multi-tasking window which can both SEND instructions to and
RECEIVE instructions from other windows in the group. The OptionTrader window is both a
Source and Destination window.
Create a Blotter group
1. From the top corner of the Blotter window, display the Group dropdown and select a group.
2. Open a window you want to group, for example the OptionTrader, and select the same group
number/color.
The OptionTrader and Blotter windows are now grouped. Open the windows side-by-side. In the Blotter, enter an underlying in the Manual Ticket Entry panel, and see how the OptionTrader data automatically changes to reflect the Blotter entry.
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Using the Tickets Panel
Accepted electronic orders are staged in the Tickets panel. Only limit and market orders can be
accepted.
You create orders from the ticket lines in the Tickets panel.

To create an order from a ticket
1. Right-click a ticket and select Create Order, or
2. Click the Action (Buy or Sell) on the ticket line.
You can open other TWS trading tools from the ticket and modify order parameters within the other
tool.

Manage Orders
Orders are created from the Tickets panel and display in the Orders panel for modification and transmission. These orders are "child orders" of the original ticket, and must stay within any price, type or
Time in Force limitations defined in the parent order.
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l

Cancel the entire ticket.

l

Cancel all child orders associated with the ticket WITHOUT cancelling the ticket.

l

Monitor the order status for each ticket.

Orders are displayed in the Orders panel (see below) with a default Quantity. You can modify the
quantity per order, and change the default for specific products using the Order Preset Strategies in
Global Configuration.

To cancel a ticket
l

Right-click the ticket line and select Cancel this ticket, or

l

Click the yellow “C” in the Cancel field and then click Cancel this ticket.

Canceling from the Tickets panel cancels the entire client order and any working components. Clients receive a
cancelled order notice. To cancel a single child component of the order, cancel directly from the child order in
the Orders panel.
To cancel all child orders
l

Right-click the ticket line and select Cancel open orders for this ticket.

The child orders are canceled but the original order ticket is not canceled.
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Using The Orders Panel
The Orders panel is where you actively manage orders.

The relationship between parent/child orders is shown via the Key field in the Tickets, Orders and Trades panels
. Every new child order is numbered sequentially and colored to indicate its relationship to the original order.
You can modify the following parameters for a child order:
l

l

Order Quantity, which can be modified to be equal to or less than the quantity in the Leaves
status field for the order in the Tickets panel.
Limit Price (with restrictions) - you cannot adjust the price to be more aggressive than the client’s original price, i.e. you cannot increase the price for a buy order, or decrease the price for
a sell order.

l

Order Type (with restrictions) including:

l

Limit tickets can only be sent as a limit or relative orders.

l

l

Market orders can be submitted as: market, limit, stop, stop limit, trailing stop, trailing stop
limit and volatility. For more information on IB order types, see the Order Types page on the
web site.
Time in Force - use the drop-down menu to choose from Day, GTC, OPG, IOC or GTD.
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You must set the TIF for a child order equal to or shorter than that of the parent. Otherwise, the TIF of
the parent order will override that of the child order.
l

Destination - choose a new routing destination for the order, create a new “Away” destination,
or route to another desk within your firm.

To transmit an order
1. Modify order parameters by clicking in the appropriate field and selecting or entering a new
value.

Use the price or size “wand” to set a parameter by clicking and holding the mouse button in a field.

2. Click the “T” in the red Status field to transmit the order.
To cancel an order
l

Transmitted child orders show a “C” in the yellow Status field. Click to cancel the order.

To create a new order, right-click the original ticket in the Tickets panel.
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What is an Away Destination?
For order management purposes, the Blotter allows you to manually create “Away” destinations and
to manually report trades executed away from IB. This data will be reflected in the order status fields
and the Trade reports.

To create an Away destination
1. From an order in the Orders panel, click the Destination field dropdown.
2. Choose Add/Edit destination at the bottom of the list.
3. In the Away Destinations box, enter the title that will display in the Destination list, and the
Exchange/Destination to which the order will be sent.
4. Click OK. The new destination now appears in the dropdown list and is the selected destination
for the current order.
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The order quantity transmitted to your away exchange is reflected in the order status columns of the
Tickets panel. In the example above, a quantity of 12 was routed to the best ex away exchange. The
status reflects 12 routed, 25 still left, and 12 working.
Note: It is important to note that orders “transmitted” to your away destinations are
not handled by IB. An away destination is simply an order-management tool
that allows a place-holder within the Blotter for orders you will manage away
from IB.

Add “Away Trade” Data to Blotter
To help manage your orders, the Blotter allows you to manually include trade data from orders filled
away from IB.
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To report away trades
1. Highlight the Away trade order line in the Orders panel. Note that you will only see the Report
Trade command if you are on an Away trade order line.
2. From the right-click menu, select Report Trade.
3. In the Report Trade box, enter the quantity, price, destination, exchange and time of execution. This information will be used by the Blotter to display trade data.
4. Click Accept. The information you specified is now incorporated into both the Order Status data
in the Tickets panel and the execution data in the Trades panel.
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Manage Orders with TWS Algos and Tools
Manage client orders using sophisticated TWStrading tools and algos. The IB OMS supports order management using the following tools and algos:

l

l

Accumulate Distribute (for stocks)
ScaleTrader (for stocks and options; market orders only; no support for profit taking child
orders)

l

IB Stock algos including Arrival Price, Percentage of Volume Strategy, TWAP and VWAP

l

IB Option algos including Balance Impact and Risk, and Minimize Impact

l

BookTrader

l

Market Depth

l

ChartTrader
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l

The Integrated Stock Window (ISW)

l

The Order Ticket

TWS Blotter

To manage a Blotter ticket from a different tool
1. Select the ticket and use the right-click menu to select Trading Tools.
2. Choose the trading tool. The tool will open, populated with the selected ticket information.
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Reading the Trades Panel
Filled sub orders are removed from the Orders panel, and the parent order is removed from the Tickets panel once the entire order has filled. The Trades panel displays real time trade reports with a
drill-down feature to view a breakdown of executions at each price level.

Use the Filter panel to view only those orders that meet the filter criteria.
Check Show filled and canceled orders to display these orders.
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Display Orders by Filter Criteria
Although associated orders are visually linked by color and number Key, as shown in the picture
below, you may want to have only a single order family on the screen, or you may need to view a specific subset of orders based on other criteria, for example all orders for Client A, or all orders on
underlying ABC. The Blotter provides two filtering strategies:
l

l

To filter out all orders except for one order family, the Key field for the relevant child order in
the Orders panel. Click the child key again to clear the filter and show all order families.
To filter out all orders except those that meet other criteria, use the Filter panel to specify display criteria.

Find the Filter panel at the bottom of the Blotter window. Use these fields to filter by criteria other
than a group of associated orders (the Key). Filtering criteria applies across order information in all
panels, including the Tickets, Orders and Trades panels.

To use the filter panel
1. Enter the filter criteria, such as a client name, underlying symbol or action, and hit Enter.
2. To remove the filter and see all orders, click Clear Filter.
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Order Sharing Modes
Depending on the sharing properties defined for your trading group, you may have permission to view
and manage orders received by other traders as well as manage your own orders. You may be
enabled for one of three possible modes:
l

Full sharing - this mode displays all orders for all traders in the Orders panel of your
blotter. Display the Submitter field to see who last touched each order.

To display the Submitter field
1. In the Orders panel, right-click in the column headings and select Customize Layout.
2. Click the Order Columns tab, and in the Available Columns list expand the Status category.
3. Select Submitter and use the “Add +” button to move the field to the Shown Columns list.

Note: Use the Up and Down arrows to position the location of the field relative to the other order fields.
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l

l

Login sharing - this mode requires you to log in to another user’s Blotter before you
can access their orders. A separate tab is created for each login, and that users
orders are displayed only on their tab.
No sharing - this mode only allows you to view and manage the orders you accepted or
created.

To log into another user’s Blotter
1. Right-click the My Blotter tab.
2. Select Open Blotter for Another User, and enter the user’s IB username.
Click OK. The other user’s interface opens under a new tab in your Blotter window.

TWS Users' Guide

198

Trading Tools

TWS Blotter

Configure the Blotter Panels
You can hide or display columns in the Blotter panels using the panel-specific layout manager in
Global Configuration.

To show or hide Blotter columns
1. From the top left of any panel, click the Configure wrench icon.
2. In the right pane, select the tab for the columns you want to modify. You can choose Market
Data Columns or Order Columns.
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3. Field in the Shown Columns list are visible on your trading panel. To display other fields on your
trading panel, select from the Available list and add to the Shown list.
4. To remove columns from the trading panel, select fields from the Shown list and remove to the
Available list.

Bolded titles indicate columns that cannot be removed from the panel display.
You can change the order in which the fields are presented on a panel using the vertical up and down
arrows in the Shown Columns list. In the picture below, I’ve moved the Key field to the right on my
Tickets panel so that it displays next to the Total Quantity field.
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To change the column order
1. In the Shown Columns list, click on the field that you want to move.
2. Click the arrows to move the column:
l

Moving the field UP in the list moves it to the left on the screen.

l

Moving the field DOWN in the list moves it to the right on the screen.

Panels that use the double-row layout can also be moved directly from the screen by dragging and
dropping a column to a new location.
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BookTrader
Introduction
l

Open BookTrader

l

Trade with BookTrader

l

BookTrader Order Handling

l

BookTrader Hotkeys

l

BookTrader Buttons

l

BookTrader Colors
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Open BookTrader
Create an order at any price, including the best bid and ask, with a single click in the BookTrader
price ladder. BookTrader displays as a separate window for whichever contract you select. It shows
a series of prices above and below the best bid and ask in the price ladder.
To open BookTrader
1. Select a contract on the trading page.
2. Right click and select Trading Tools, then select BookTrader.

Orders transmitted from BookTrader are displayed on the Pending page and in the Orders panel of
the BookTrader.
NOTES:
l

The number of deep book data windows that you can display at one time (including BookTrader,
ISW and Market Depth) is equal to 1 for every 100 allowed lines of market data, with a minimum of three and a maximum of 30. Market data allowance is based on commissions,
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available equity and other criteria. So a client with the minimum allowance of 100 lines of market data will be able to open 3 deep book windows. A client with an allowance of 500 lines of
market data will be able to open 5 unique deep book windows . For details on how market data
allowances are calculated, see the Market Data and News overview page on the IB website.
l

l

l

l

l

l

When subscription deep book data is at its window limit, additional windows will display aggregated top level data, and the Deep Button panel will be hidden.
By default, BookTrader uses specific colors to convey information. You can customize these colors by clicking the Configure button on the toolbar, and then selecting BookTrader Colors.
The current Cumulative Bid and Ask sizes are displayed at the top of the Bid Size and Ask Size
columns. To turn this feature off, use the Configure > Settings page.
When the inside market (or last trade price) moves outside the display area, the ladder will
automatically re-center on the inside market (or last trade price). When the user is scrolling the
ladder using either the Up/Down arrow keys or the scrollbars, and the inside market (or last
trade price) falls outside of the display area, auto-recentering will occur five seconds after the
user has completed scrolling. This five-second time period is counted down visually using an
optional animated progress bar which is configurable in the Re-center panel of the BookTrader
Settings page.
By default, clicking in any size field initiates an order. If the order hasn't filled and you click
another size, the current unexecuted order is canceled and replaced with the new order. You
can modify the way multiple same-side orders are handled from the Settings page in
BookTrader configuration.
You can open a blank BookTrader window by clicking the BookTrader icon on the trading toolbar. Use the Underlying field to initiate contract selection.

TWS Users' Guide

204

Trading Tools

BookTrader

Trade with BookTrader
To trade with BookTrader, click the Bid Size or Ask Size at a certain price level in the price ladder.
The first time you submit an order, you will be asked to confirm the order parameters. In this box you
have the option not to show the confirmation box again, and if you elect this option your orders will
transmit instantaneously from that point forward.
Default mouse actions are described below. You can modify the default settings that control how
orders are handled using the Settings page in BookTrader configuration.
By default, the option to Use context cursors in armed mode is activated on the BookTrader Settings
configuration page. This feature displays helpful order-related information when you hold your cursor
over the Bid Size or Ask Size field in the price ladder.

To create a SELL Limit order in BookTrader
l

In the price ladder, click the Ask Size at the desired price level.

A limit order is created at the selected price level. You can manage the transmitted order from the
Orders panel at the top of the price ladder.
To create a BUY Limit order in BookTrader
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l

In the price ladder, click the Bid Size at the desired price level.

A limit order is created at the selected price level. You can manage the transmitted order from the
Orders panel at the top of the price ladder.

BookTrader Default Click Actions
The bullets below define the mouse click actions based on where you click:
l

Click on any Bid size to create a Buy Limit order at the selected price.

l

Click on any Ask size to create a Sell Limit order at the selected price.

l

Right-click on any Bid size to create a Buy Stop order.

l

Right-click on any Ask size to create a Sell Stop order.

l

Hold the Alt key and click on any Bid or Ask size to create a Bracket order.

Note: The default click actions do not apply IF you have selected one of the BookTrader Order Type Select buttons.

For details on all system-configured BookTrader shortcuts, open the BookTrader Hotkeys window in
Global Configuration.
Default order information comes from the active order presets for the contract or instrument. For
information on using presets, see the Configure Order Defaults and Presets topic.
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BookTrader Order Handling
Use the Configure>Settings area in BookTrader to change the way orders are handled and how the
order status is displayed. For details see the Configure BookTrader topic.
When you select Show separate status column for each order in the Price Ladder Status Column
area of the Settings configuration page, BookTrader works in Advanced Mode. This enables several
key features:
l

l

l

First, it allows you to control BookTrader using only your keyboard. The mouse will still work to
navigate, but for users who don't want to take the time to move from the keyboard to the
mouse and back again, advanced mode gives you 100% keyboard control.
Second, when you create an order, a new Order column is created in which all parts of the
order (parent and child orders) are visible and can be modified. The new Order column appears
to the right of the price column for SELL orders (which you initiate by clicking in the
Ask Size field) and to the left of the price column for BUY orders (which you initiate by clicking
in the Bid Size field).
Third, the order type select buttons become available for activation.

You can click in the Order column to create child orders that belong to the parent order in the Order column.
For example, if you create a buy Limit order, and then select the Target Limit order type button, when you click
at a different price level in the Order column (rather than in the Size column) the target limit order is created as
a child of the original limit order. If you click the Ask Size or Bid Size column, a new Order column is created
with another order.
Each new Order column may contain up to 4 elements:
l

The parent order (LMT)

l

The stop order (STP)

l

The stop limit (SLMT)

l

The target limit order (TLMT) - this is the limit order created as part of a bracket order, or a
stand-alone opposite-side limit order.

There are three ways to modify the price of an order; via the keyboard, by dragging with the mouse,
or by using the mouse click.
To modify order price via the keyboard
1. Tab through the application until you are in the Price Ladder.
2. Use the up/down arrows to highlight the order line in the price ladder.
3. Use the left/right arrow keys to navigate to the order you want to modify.
4. Depress the Shift key to grab the order, and use the up/down arrow keys to move the order to
a new price level.
5. Release the Shift key to transmit the new order.
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To move parent and child orders together, for example a bracket or stop limit order, depress and hold the Alt key
instead of the Shift key.
To modify order price by dragging with the mouse
1. Hold the mouse over the order until it becomes a two-headed arrow.
2. Click the order or suborder and drag it to a new price level.
3. Release the mouse key to create the order.

To move parent and child orders together, for example a bracket or stop limit order, press and hold the Alt key
while you click and drag.
To modify order price with a mouse click
1. Click the order and press and hold the Shift key.
2. Click in the desired price level and release the Shift key to create the order.

To move parent and child orders together, for example a bracket or stop limit order, press and hold the Alt key
instead of the Shift key in 1) above.

The size of the order can be modified in the Order Confirmation box, or by clicking in the row header
and entering a new quantity as shown above.
Suborders can be canceled by right clicking on them (default) or using a hotkey. The bracket can be
can canceled by clicking the C on the row header.
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BookTrader Hotkeys
This topic discusses the hotkeys that are specific to BookTrader or that have customizable options specific to BookTrader.
For information on hotkeys that appear in the BookTrader hotkeys box but are available to all TWS
windows, see the general Hotkeys topic.
Hotkey
Action

Description

BookTrader
Cancel Sub
Order

This hotkey will cancel an order in the Price Ladder.

Decrease
BookTrader
Order Size

Set a left or right mouse-click event for a specific field that will decrease
the order size of any BookTrader order by whatever number of ticks you
define.

Increase
BookTrader
Order Size

Set a left or right mouse-click event for a specific field that will increase
the order size of any BookTrader order by whatever number of ticks you
define.

Re-center

Set a hotkey to recenter the focus to either the last traded price, or the midpoint bid/ask price. Set the re-center focus using the Settings page in the
BookTrader configuration area.

Create Orders
Add Auto
Stop Order

Attaches an opposite-side stop order to the selected order.

Add Trailing
Stop Order

Attaches an opposite-side trailing stop order to the selected order.

Attach
Bracket
Orders

Attaches a pair of orders (a limit and a stop order) to bracket the selected
order.

Buy

Creates a buy order for the selected asset.

Buy or Sell
Specific
Product

Create a hotkey to buy or sell a specific product with it's own default order
type, limit price, stop offset, time in force. etc. Use the Customize tab of
the Configure Hotkey box to set product-specific details.
If you select BookTrader Price for any of the price configurations, you will
only be able to set a mouse-click shortcut since using the BookTrader Price
requires you to click on a price in the price ladder.

Close Pos-
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tract.

Reverse Position

Creates an opposite-side order to reverse the position on the selected contract. By default you need to transmit the order manually, but you can elected to have this hotkey transmit reverse position orders instantaneously by
checking the feature in the Customize area of the Configure Hotkey box.

Sell

Creates a sell order for the selected asset.

Modify/Transmit Orders
Change
Order to Market

Changes the order type of the selected order to a market order.

Decrease
Price or Size

Decreases the order price or order quantity by a specified value.

Increase
Price or Size

Increases the order price or order quantity by a specified value.

Modify Order
Type

Displays the Type dropdown list to let you select a different order type for
the active order.

Modify
Time-inForce

Displays the Time in Force dropdown list to let you select a different Time
in Force for the active order.

Order Ticket

Opens the Order Ticket. If you've highlighted a ticker, the order ticket will
be populated with that product.

Transmit
Order

Transmits the selected order.

Update Limit
Prices

Updates the limit price of the active, unexecuted order to reflect the
price/offset you define on the Customize page of the Configure Hotkey
box.

Cancel Orders
Cancel All
Orders

Cancels all orders on all pages in TWS.

Cancel Contract's Orders

Cancels all orders associated with a specific asset.

Cleanup
orders

Removes orders from the page. Use the customize area of the configure
Hotkey box to define whether to remove cancelled, filled and/or untransmitted (including deactivated) orders from either the active pages or all
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pages.

Deactivate

A deactivated order is cancelled but remains on the page ready to be transmitted.

Delete
Rows/Cancel
Orders

This hotkey can be configured to either delete rows, or delete and cancel
orders.

Tools
Add to Rebalance Window

Used to add a contract to the Rebalance window. This hotkey does not
open, close or adjust any positions.

Arbitrage
Meter

Opens the Arbitrage Meter for the active index market data line.

Integrated
Stock Window

Opens the ISW.

Show
FXTrader

Opens the FX Trader module.

Show Market
Depth

Opens the Market Depth module.

Show
OptionTrader

Opens the OptionTrader.

Show Rebalance Window

Opens the portfolio Rebalance window.

Show
SpreadTrader

Opens the SpreadTrader.

Realtime Activity Monitoring
Alarms

Opens the Alarm Settings box for the active contract.

View Alerts

Opens the Alerts window where you can view, edit or create an alert.

Analysis
Model Navigator

Opens the Model Navigator window.

Show Fundamentals

Opens a Reuters Fundamentals page for the contract.

Show IB

Opens the IB Risk NavigatorSM, our real-time price/risk analytics tool.
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Risk NavigatorSM
Show Option
Analytics

Opens the Option Analytics with focus on the selected options contract.

Show realtime charts

When you have a contract selected, this opens the New Chart window
where you can set parameters for the active contract to create a real-time
chart.

Miscellaneous
Clear Log

Clears the Log panel.

Configure
Order Presets

Opens the Presets configuration page for the active strategy.

Help Chat

Opens the customer service Chat area of the Account Management screen.

Minimize all
windows

Minimizes all open windows and puts them on the bottom of the status bar.

Msg Center

Opens the customer service message center.

Request
Trade Cancellation

Logs you into the Customer Service area of the Account Management
screen.

Search TWS

Displays the Search field which you can use to find contract and application
information.

Show
Description

Displays the Description box for the selected contract.

Show Details

Displays contract details for the selected contract.

Show Earnings Estimate

For the selected contract, displays the Earnings estimate.

Show Positions

For the selected contract, shows the account number and the current position.

View
Account

Opens the Account window.

View Trades

Opens the Trades window.
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BookTrader Colors
BookTrader displays a lot of information in a small space using colors and numbers.

Market Data Colors
The market data colors display after BookTrader is armed but before any order is transmitted.
l

l

l

The Bid Size column is yellow until you create an order. Values in this column represent the
size of an order at the specific price, and help show market depth.
The Ask Size column is green until you create an order. When a size appears in an ask size
field, this indicates the current best ask.
The Status field remains gray until you submit an order.

Price Field - Background Colors
l

l

The current best bid price is shown by a Yellow background, with the size next to it in the
Bid Size field.
The current best ask price is shown by a Green background, with the size next to it in the
Ask Size field

l

The Last transaction is highlighted by a Slate Blue background.

l

The High price is highlighted by a Bright Blue background.

l

The Low price is highlight by a Red background.

l

The Average Cost (including commissions) is indicated by a highlight across the entire row. You'll only
see this if you hold a position in the active contract.

BookTrader Colors

Column
Name

Possible Color

Notes

Status

Once you transmit an order, the status colors change. See
Order Status Colors table below.

Bid Size

Indicates the size of the current best bid.
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Indicates that a limit order has been transmitted (by clicking
in the field).

Indicates a stop order has been transmitted (by right-clicking
in the field).

Price

No color

One in a range of prices displayed for the contract.
The current best bid price.

The current best ask price.

The price at which the last order executed, and the size of the
order.

The current high price.

The current low price.

Ask Size

Indicates the size of the current best ask.

Indicates that a limit order has been transmitted (by clicking
in the field).
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Indicates a stop order has been transmitted (by right-clicking
in the field).
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Order Type Select buttons

When you configure the Price Ladder Status Column to Show separate status column for each
order from the Settings configuration page, the Order type select buttons function becomes available.

These buttons override the default mouse click functions of BookTrader to create only the order type
selected. For example, if you click the LMT order type select button, any mouse click you perform in
the price ladder, even a right-click, creates a limit order.
To release the order type function and return to the default click actions, click None.
Basic Buttons panel

The BookTrader toolbar also includes a basic buttons panel.
l

Cancel All - cancels all orders on the active BookTrader.

l

Clear Log - clears all order information from the white log area just above the buttons.

l

Re-center- click to keep the best bid/ask price or last traded price always visible in the center
of the BookTrader screen. Use the Configure menu to elect to have the ladder recenter around
the midpoint of the bid/ask, or the last price.

l

Configure- opens the Configuration dialog box.

l

Hotkey Details - displays a list of all current hotkeys for BookTrader.

l

Default size - displays the default order size based on the Preset for the instrument, and
allows you to change the default order size for BookTrader orders without re-configuring the
Preset.

Deep Book buttons

Use the Deep Book Buttons to filter out market data from the price ladder. De-select a button to filter
out that data.

TWS Users' Guide

216

Trading Tools

BookTrader

The Others button includes data from exchanges that don’t offer deep data; Level I data from deep
exchanges you have elected to filter out, and Level I data for exchanges that offer deep data but to
which you do not subscribe. Hold your mouse over the button to see the exchange’s data included.
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ChartTrader
Introduction

Use the ChartTrader to send orders directly from any real-time chart.
l

Open ChartTrader

l

Create and Transmit Chart Orders
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Open ChartTrader
You can trade directly from a real-time chart using ChartTrader, which you display from the
ChartTrader menu from within a chart. Send instantaneous orders by clicking directly in the chart, or
create and modify an order from the Quote panel.

To open ChartTrader
1. First open a real-time chart by selecting a contract on the trading screen and using the rightclick menu to select Charts, then New Chart.
2. From the View menu, select ChartTrader.
3. The ChartTrader is activated and displays the Orders, Log, Trades and Portfolio panels.
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Create and Transmit Chart Orders
ChartTrader is designed to instantaneously transmit orders created with a single click within the
chart. Order parameters are picked up from the active order preset. Button actions and order defaults
can be set from the Chart configuration page

Instantaneously transmit an order
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1. Open the chart Configuration page, and choose Buttons.
2. Select a button and click Edit.
3. Check the red Transmit order instantaneously checkbox and click OK.
4. On the button panel, click the button you set up for instantaneous transmit to arm your cursor.
Note: Any buttons set for instantaneous transmit will have an asterisk (*) next to
their name.
5. Move your cursor into the chart and position the broken blue (for Buy) or red (for Sell) line at
the order price you want. Note that your exact price is displayed along the price axis.
6. Click to transmit an order. Your order appears in the Quote panel, and the broken line becomes
solid.
You can also create orders that do not transmit instantaneously.
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Create a Non-Instantaneous Order
l

From the Quote panel, click Bid (sell) or Ask (buy) to create an order in the Orders panel.

Note that you can also configure the ChartTrader buttons to create a modifiable order by unchecking the red
Transmit order instantaneously checkbox on the button configuration page.
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ComboTrader
Introduction

Create combination orders that include options, stock and futures legs (stock legs can be included if
the order is routed through SmartRouting).
Note that only US option-stock and option-option combo orders are guaranteed by IB to fill.
l

About Combination Orders

l

Create a Combination Order

l

Using the ComboTrader

l

Transmit a Combination Order

l

Notes on Combination Orders

TWS Users' Guide

223

Trading Tools

About Combination Orders
Create combination orders that include options, stock and futures legs (stock legs can be included if
the order is routed through SmartRouting). Although a combination/spread order is constructed of separate legs, it is executed as a single transaction if it is routed directly to an exchange. For combination orders that are SmartRouted, each leg may be executed separately to ensure best execution.
You can also create a futures EFP (Exchange of Futures for Physical) spread.
For details on using the VOL order type for combination orders, see the list of criteria in the Volatility
Trading topic.

You can create a unique combination by manually defining an order leg by leg on the Pair of Leg-byLeg tab, or create an order or group of orders with a named strategy using a template, on either the
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Multiple or Strategy tab. You can find a template to construct the following named combination
strategies:
l

l

l

l

l

l

l

l

l

Box - An order to simultaneously purchase and sell two synthetics in identical numbers at different strike prices.
For example: Buy 1 April02 95 call, Sell 1 April02 95 put, Sell 1 April02 100 call, Buy 1 April02
100 put.
Butterfly - An order to simultaneously purchase an option with one strike price, purchase an
option with a second strike price, and sell two options with a third strike price that is midway
between the prices of the first two options. The ratio for a butterfly is always 1 x 2 x 1.
For example: Buy 10 March02 95 calls, Sell 20 March02 100 calls, Buy 10 March02 105 calls.
Buy Write - An order to simultaneously purchase (sell) a stock and sell (purchase) a call
option of the same underlying.
Purchase a Buy Write: Sell 1 XYZ April06 95 call, Buy 100 shares XYZ
Sell a Buy Write: Buy 1 XYZ April06 95 call, Sell 100 shares XYZ
Calendar spread - An order to simultaneously purchase and sell options with different expiration dates, where both have the same underlying, right (call or put) and strike price. This
spread is sometimes referred to as a time spread. A calendar spread whose options have different expiration dates and different strike prices is sometimes referred to as a diagonal
spread.
For example: Buy 1 June02 100 call, Sell 1 March02 100 call.
Collar - An order to simultaneously buy (or sell) a put option and sell (or purchase) a call
option in identical numbers where both have the same underlying and expiration date, but the
call generally has a higher strike price, and buy (or sell) the underlying stock.
Purchase a collar: Sell 1 XYZ APR 17 '14 190 CALL, Buy 1 XYZ APR 17 '14 185 PUT, Buy 100
share of XYX
Sell a collar: Buy 1 XYZ APR 17 '14 190 CALL, Sell 1 XYZ APR 17 '14 185 PUT, Sell 100 share of
XYX
Conversion - An order to simultaneously sell (or purchase) a call option and purchase (or sell)
a put option in identical numbers where both have the same underlying, expiration date and
strike price, and purchase stock of the same underlying.
Purchase a conversion: Sell 1 XYZ April04 75 call, Buy 1 XYZ April04 75 put, Buy 100 shares
XYZ
Sell a conversion: Buy 1 XYZ April04 75 call, Sell 1 XYZ April04 75 put, Sell 100 shares XYZ
Delta Neutral - An order to simultaneously buy (or sell) options contracts and sell (or buy) a
delta amount of the underlying. The quoted price is calculated as follows: effectiveOptionPrice
= optionPrice + delta x (inputStockPrice - stockPrice).
Diagonal spread - An order to simultaneously purchase and sell options with different expiration dates and different strike prices, where both have the same underlying and right (call or
put).
For example: Buy 1 June03 100 call, Sell 1 Sept03 105 call.
Iron Condor - An order to simultaneously purchase an out-of-the-money put bull spread, and
sell an out-of-the-money call bear spread, where all legs have the same expiry.
Purchase an iron condor: Buy 1 XYX JAN08 25.0 PUT, Sell 1 XYZ JAN08 27.5 PUT, Sell 1 JAN08

TWS Users' Guide

225

Trading Tools

30.0 Call, Buy 1 JAN08 32.5 Call.
Sell an iron condor: Sell 1 XYX JAN08 25.0 PUT, Buy 1 XYZ JAN08 27.5 PUT, Buy 1 JAN08 30.0
Call, Sell 1 JAN08 32.5 Call.
l

l

l

l

l

l

l

l

l

l

Reversal- An order to simultaneously purchase (or sell) a call option and sell (or purchase) a
put option in identical numbers where both have the same underlying, expiration date and
strike price, and sell stock of the same underlying.
Purchase a reversal: Buy 1 XYZ April04 75 call, Sell 1 XYZ April04 75 put, Sell 100 shares XYZ
Sell a reversal: Sell 1 XYZ April04 75 call, Buy 1 XYZ April04 75 put, Buy 100 shares XYZ
Risk Reversal- An order to simultaneously purchase (or sell) a put option and sell (or purchase) a call option in identical numbers where both have the same underlying and expiration
date, but the call generally has a higher strike price.
Purchase a risk reversal: Buy 1 XYZ April04 75 put, Sell 1 XYZ April04 95 call
Sell a risk reversal: Sell 1 XYZ April04 75 put, Buy 1 XYZ April04 95 call
SSF/OPT - An order to simultaneously buy (or sell) one contract of a single stock future (SSF)
and buy (or sell) a stock option of the same underlying.
For example: Sell 1 Oct06 60.0 call, Sell 1 Aug06 SSF.
Straddle - An order to simultaneously purchase (or sell) a call and a put in identical numbers,
where both have the same underlying, expiration date and strike price.
For example: Sell 1 Dec02 90 call, Sell 1 Dec02 90 put.
Strangle - An order to simultaneously purchase a call and a put with different strike prices,
where both have the same underlying and expiration date. In the case where both the call and
the put are out of the money, this order is referred to as an inside strangle.
For example: Buy 1 June02 95 put, Buy 1 June02 105 call.
Stk/Opt - An order to simultaneously purchase (or sell) one stock contract and purchase (or
sell) one options contract.
For example: Sell 1 Jan07 55.0 put, Sell 100 shares of the underlying.
Synthetic - An order to simultaneously purchase a call and sell a put in identical numbers (or
sell a call and purchase a put in identical numbers), where both have the same underlying,
expiration date and strike price.
Purchase a synthetic: Buy 1 April02 100 call, Sell 1 April02 100 put.
Sell a synthetic: Sell 1 April02 100 call, Buy 1 April02 100 put.
Synthetic Put - An order to simultaneously purchase (or sell) a call option and sell (or purchase) stock where both have the same underlying.
Purchase a synthetic put: Buy 1 XYZ April03 75 call, Sell 100 shares XYZ
Sell a synthetic put: Sell 1 XYZ April03 75 call, Buy 100 shares XYZ.
Synthetic Call - An order to simultaneously purchase (or sell) a put option and purchase (or
sell) stock where both have the same underlying.
Purchase a synthetic call: Buy 1 XYZ April03 75 put, Buy 100 shares XYZ
Sell a synthetic put: Sell 1 XYZ April03 75 put, Sell 100 shares XYZ.
Vertical spread - An order to simultaneously purchase and sell options at different strike
prices, where both have the same underlying, right (call or put) and expiration date. This
spread is sometimes referred to as a price spread.
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Call vertical spread example: Buy 1 June02 100 call, Sell 1 June02 105 call.
Put vertical spread example: Buy 1 March02 105 put, Sell 1 March02 95 put
For more information on combination orders and margin requirements for combination orders, see
U.S. Equity Options Margin Requirements on the IB website.
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Create a Combination Order
You can create any kind of combination spread order using the Combination Composition box,
including multiple leg combos, futures spreads and EFPs, and inter-market Smart combos.

To create a combo order
1. Enter an underlying on a blank line and select Combinations, then choose from the available
combo selection types, including Smart option combos, Futures Spreads and EFPs.
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2. From the Pair or Leg-by-Leg tab, define each leg.
3. After you have added all desired legs click OK, and the spread appears as a market data line on
your quote monitor.
The implied price is calculated based on the underlying price of each leg, and changes with variations
in the price of each underlying. Based on the implied price, SmartRouting will route each leg of the
order separately to get the best price.
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To see individual leg prices for a combination or spread order, open the Execution reports window by clicking
the Trades icon on the Trading Toolbar. Double-click the desired combination execution report line in the Execution window (or right-click on the line and select Show Legs) to open the Execution Window for Legs.
To create an EFP combo
1. Enter an underlying on a blank line and select Combinations, then select EFPs.
2. Click the Single tab at the top of Combo Selection box.

3. Choose Futures as the leg type, and Future EFP as the strategy.
4. Select the expiry on the futures leg and click OK.

EFP combos created using the template are Smart-routed.
To create a combination strategy
1. Right-click on a blank line and select Generic Combo, or create a market data line with the
instrument type Comb.
2. In the Leg Query section, enter the underlying symbol for the first leg of the order.
3. Use the Combo Template tab to select a strategy.
4. Select data for all legs of the order and click OK. The combination order strategy appears on
your trading screen as a market data line.
Guaranteed and Non-Guaranteed Combo Orders

IB supports both guaranteed (where executions are guaranteed to be delivered simultaneously for each leg and in
proportion to the leg ratio) and non-guaranteed combo orders. To understand the differences between guaranteed
and non-guaranteed combination orders, please see the knowledgebase article.
Notes on using Futures legs
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l

ComboTrader

Intermarket combos that contain futures legs are supported for contracts on the following
exchanges: Globex, One Chicago, CFE, EurexUS.
Only US contracts are supported for Smart combos.
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Using the ComboTrader
ComboTrader provides three tabbed interfaces to help you create multi-legged spreads for futures
and options.
Multiple combos

Use the Multiple tab to create a group of individual combination orders on the same underlying at
the same time. For certain strategies including Diagonals, boxes, Strangles, Risk Reversals, and Vertical Spreads you can filter by Point Spread.

Strategy combo

Use the Strategy tab to select a recognized combination order and define the necessary parameters.
Note that for exchanges that list both American and European style options, a Trading Class field
presents a dropdown list of available classes.
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Description

Underlying

Enter the underlying symbol.

Type

Select the instrument type for the strategy. Choose Options or Futures.

Strategy

Combination strategies are listed based on the Leg Type you selected. For
descriptions of all combination strategies, see the Combination Orders topic.
Use the Help button for strategy descriptions.

Multiplier

Select the contract multiplier.

Worksheet

Select Sell Combo or Buy Combo in the graph drop-down to see what the combination order looks like.
The worksheet categories display drop-down list boxes each time you need to
make a selection. Move through the worksheet and select choices as needed.

Reset

Click Reset to start over, either by selecting another strategy or editing the legs
of the chosen strategy.

Request
market
data for

Check to create a market data line for each leg of the order, to be displayed on
the trading screen.
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legs
Pair or Leg-by-Leg Combo
Use the Pair or Leg-by-Leg tab to create the combination one leg at a time.
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Transmit a Combination Order
To create a combination order
Before you transmit a combination order, carefully review your order parameters on the order management line, or from the Order Ticket window by clicking Accept.

1. From the market data line, click the "Ask" or "Bid" price for the combination order you want to create.
l

Click the Ask Price to create a Buy order.

l

Click the Bid Price to create a Sell order.

2. On the Order Management line, modify order parameters, if needed.
Note on Pricing: If you buy a spread and you owe cash (debit spread), enter a positive limit
price. If you buy a spread and you receive cash (a credit spread), you must enter a negative limit price. Conversely, if you sell a spread and receive cash, enter a positive limit
price. If you sell a spread and owe cash, you must enter a negative limit price.
For example, an April 20 xyz call shows a BID price of 6.60 and an ASK price of 6.70. An April
30 xyz call shows a BID price of 0.15 and an ASK price of 0.20.
If you buy a "debit" call vertical spread with the following legs:
Buy 1 OPT APR02 20.0 CALL (6.70)
Sell 1 OPT APR02 30.0 CAL L (0.15)
For this transaction you pay: 6.55 (a debit transaction)
If you buy a "credit" call vertical spread with the following legs:
Sell 1 OPT APR02 20.0 CALL (6.60)
Buy 1 OPT APR02 30.0 CALL (0.20)
For this transaction you receive 6.40 (a credit transaction; enter a negative limit price).
3. Transmit the order.
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Notes on Combination Orders
This page contains notes and tips on creating and transmitting combination orders.
l

l

l

Use SmartRouting to execute legs separately to ensure you get the best price on all legs of your
order.
Some exchanges that currently support native combination orders (which means they execute
the legs together as one transaction) include:
n ISE
n

ONE

n

DTB (Euro)

Note on pricing: If you buy a spread and you owe cash (debit spread), enter a positive limit
price. If you buy a spread and you receive cash (a credit spread), you must enter a negative limit price. Conversely, if you sell a spread and receive cash, enter a positive limit
price. If you sell a spread and owe cash, you must enter a negative limit price.
For example, an April 20.0 xyz call shows a BID price of 6.60 and an ASK price of 6.70. An April
30 xyz call shows a BID price of 0.15 and an ASK price of 0.20.
If you buy a "debit" call vertical spread with the following legs:
Buy 1 OPT APR02 20.0 CALL (6.70),
Sell 1 OPT APR02 30.0 CALL (0.15)
For this transaction you pay: 6.55 (a debit transaction)
If you invert the legs and buy a "credit" call vertical spread with the following legs:
Sell 1 OPT APR02 20.0 CALL (6.60)
Buy 1 OPT APR02 30.0 CALL (0.20)
For this transaction you receive 6.40 (a credit transaction, enter a negative price)

l

Before you transmit a combination order, carefully review the order parameters from the Order
Management line.
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Market Depth
Introduction

View the alternative bids and offers away from the inside quote to help you better gauge market
liquidity. When using the Market Depth Trader for bonds, see the best bid and offer from away platforms (using Total Price) along with the best bid and ask from the IB book.
l

Market Depth Trader

l

Market Depth Trader for Bonds

l

Market Depth window

l

Market Depth Buttons Panel

l

Create an Order
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The aggregated Market Depth window displays the alternative bids and offers away from the inside
quote to allow you to better gauge market liquidity. Create an order by clicking a price level in the Bid
or Ask column. Transmit orders from the Orders panel.
Add or remove Level II data using the Deep Book Buttons. The Others buttons displays Level I data
from exchanges that don’t offer deep data, for which you don’t have market data permissions, or for
those to which you subscribe but haven’t selected.
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NOTES
l

l

l

l

l

The number of deep book data windows that you can display at one time (including BookTrader,
ISW and Market Depth) is equal to 1 for every 100 allowed lines of market data, with a minimum of three and a maximum of 60. Market data allowance is based on commissions, available equity and other criteria. So a client with the minimum allowance of 100 lines of market
data will be able to open 3 deep book windows. A client with an allowance of 500 lines of market data will be able to open 5 unique deep book windows . For details on how market data
allowances are calculated, see the Market Data and News overview page on the IB website.
When subscription deep book data is at its window limit, additional windows will display aggregated top level data, and the Deep Button panel will be hidden.
We cannot guarantee that every price quoted for a particular security/commodity will be displayed in the Market Depth window.
Cumulative size represents the total contract size available at a particular price or better. In
the image above, the cumulative size available on the bid at $12.03 is 106.
Average Price is the average execution price received when transacting the cumulative contract size. You receive multiple executions as your order goes through the order book. Executions will appear in the Trades panel.

Use the Market Depth Trader for bond trading to view the minimum trade size for net bond prices and calculate
net bond prices based on your desired size.
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Use the Market Depth trader to see the minimum trade size for net bond prices and calculate net bond prices
based on your desired size.

To take advantage of the Minimum Trade Size data and Quantity calculator, you need to configure bond pricing
to use Net pricing mode. The Market Depth Trader shows the Minimum Trade Size available for a given price
level and side in the market data. It also displays a Quantity field above the aggregated market depth data. Enter
a quantity at which you would like to see the net prices calculated. This information may help you to control execution costs by showing the market data in net price terms at the size you would like to trade.
To open Market Depth Trader
l

From the Trading Tools menu, select Market Depth Trader.
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Market Depth Buttons Panel
The buttons panel provides action buttons that allow you to:
l

l

l

Close Position - select an underlying in the quote panel, and click Close Position to have an
opposite side closing order automatically created in the Orders panel. Transmit the order or
modify any order parameters and then transmit.
Reverse Position - create an opposite side order with sufficient quantity to reverse your position from long to short or short to long.
View Account - opens the Account Information window.

You can set the buttons to transmit the order instantaneously by arming the button panel. Buttons
with instantaneous transmit on will display an asterisk in their title.

To activate Instantaneous Transmit
1. Check the Armed checkbox on the top right corner of the Buttons panel.
2. Read and agree to the disclosure message.
The asterisk in the button title indicates that these action buttons will instantaneously transmit an
order when used.
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Create an Order
Create orders from the Market Depth window by clicking the bid/ask at a specified price level. Be
sure to confirm the order size before transmitting a Market Depth order.
The order size is based on default settings associated with the contract’s Preset. If the preset uses the
Use cumulative size for Market Depth, the order size equals the cumulative size on that line x default
order size. For example, if the default order size is 100 and you click the ISE $12.03 price level
(below), the order size will be 10,600. If you click the same price level at the ARCA line, the order
size will be 6,300. If the above box is not checked, the order size will be the default order size. You
can modify the order size before transmitting the order.
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To create an order from Market Depth
1. Click on a price level in the Bid column for a Sell order, in the Ask column for a Buy order.
2. The order displays in the Orders panel. Modify parameters if necessary and transmit by clicking
the “T” in the status column.
3. To transmit your order, click the "T" in the Status field of the order line.
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FXTrader
Introduction

Designed specifically for Forex traders, the customizable FXTrader window displays quote pairs with
the emphasis on the key price component.
l

The FXTrader Window

l

The FXTrader Trading Cell

l

Using the FXTrader
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The FXTrader Window
FXTrader displays a 3x3 grid of "trading cells" designed to complement the way an FXTrader operates, with the standard elements of our order management modules (Orders, Log, Execution and Portfolio pages) provided at the top. The page is completely customizable, allowing you to increase or
decrease the number of cells in the grid, invert a quote, change colors, and modify the way price and
size is shown.

To configure the FX Trader, click the Configure icon in the toolbar or in any trading cell.
For details on the many levels of configuration you can set for the FXTrader, see the FX Trader Configuration topic.

TWS Users' Guide

245

Trading Tools

The FXTrader Trading Cell
The trading cell in FXTrader includes many helpful features, including color coding to distinguish
between upward and downward price and size movement; a cancel icon to cancel all orders for the
currency pair, quick access to the FX Trader configuration windows, quick-click to view inverted
quotes, a message line to describe order details, a book icon with mouse-over information that displays when there is a price improvement opportunity for small orders, optional display of position and
P&L information, and access to right-click TWS features from the Contract Label area.

To open the FX Trader
1. Click the FXTrader icon on the Trading toolbar.
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2. FXTrader displays populated with the most common FX pairs.
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Using the FXTrader
When you select a trading cell, that currency pair populates the Quote Panel at the top of the window.
You can create an order using the traditional TWS method of clicking the Bid or Ask from the Quote
Panel. You can also create an order from within the trading cell.

To create an order from the trading cell
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1. Click the Bid to create an order to sell the base (and buy the quote). Click the Ask to create an
order to buy the base (and sell the quote).
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Rebalance Portfolio
Use the Rebalance window to redistribute percentages of positions in your portfolio that make up
your current (signed) net liquidation value.
Introduction
l

The Rebalance Portfolio Window

l

Import and Export Positions to Rebalance
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The Rebalance Portfolio Window
The application automatically opens and closes positions to rebalance your portfolio based on the new
percentages you enter. You can add contracts and create orders just as you would from the main trading screen.

To rebalance your portfolio
1. From the Trading Tools menu, select Rebalance Portfolio.
2. The Rebalance Portfolio window shows three columns that are different from those on your
trading screen:
l
Deliverable Value - this is the deliverable value of the position. For stocks, this is the
value of the stock, which is the same as the Market Value for the position shown in the
Portfolio section of the Account window. For options, futures, and single stock futures
(SSFs) it is the underlying stock or index value.
l

Current % - this is the current signed percent of the position to your net liquidation
value shown in the Balance section of the Account window. This figure is calculated by
dividing the DLV by the NLV (Net Liq. Value).
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l

Rebalanace % - use this field to enter a new percentage of the NLV that you want the position to have.

3. In the Rebal % field for one or multiple positions, enter the percent of the Net Liquidation Value
that you want the position to have.
4. Click the Create Orders button to instruct the application to automatically create the orders to
achieve the percent change.
5. Use the Transmit All button to send all orders, or click "T" on an order line to transmit a single
order.

For options, the rebalance % is based on the value of the underlying stock prices.
To open positions from the Rebalance window
1. Click Add Line from the buttons panel, and enter an underlying symbol into the blank row and
hit Enter. Define the contract.
2. Enter a value in the Rebal % column and click the Create Orders button.
3. Transmit the order.
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Import and Export Positions to Rebalance
Customers who prefer to work in Excel can export the Rebalance file and modify the current percentage to reflect the percent of net liquidation they want to their positions to have, then import the
modified file back into Rebalance Portfolio.
Advisors can also use this feature to import a modified file to a new account to easily bring this
account to the new percentages.

To export a portfolio
1. Click the Export icon at the top of the Rebalance Portfolio window.
2. Modify the location and file name if desired (leaving the .csv extension), and click OK. You may
want to modify the generic file name to help identify it.
For example, you could change the default C:\jts\rebalance.csv to C:\clients\smithPortfolio.csv.
3. Click OK from the file export confirmation message.

The directory path must exist for the Export functionality to work. You cannot create a new folder while exporting.
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To rebalance the position’s percent of NLV from Excel
1. Open the exported .csv file in MS Excel.

Note that each line of the spreadsheet represents a position. The last column represents the current percent of Net Liquidation Value that the position holds. This exported value is equivalent to the value in the
Current % field of the Rebalance Portfolio window.
2. Change the current % of NLV to the new percent you want. Do this for as many lines as needed
and click Save.
For example, if you want to rebalance your portfolio so that AAPL STK holds 5% of NLV instead
of 16.20478 as shown above in line 2, you would change 16.20478 to 5.0. This modified value is
imported in the Rebalance Portfolio as the new Rebal % value.
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To import a rebalance portfolio
1. Click the Import icon at the top of the Rebalance Portfolio window.
2. Navigate to the modified .csv file you want to import and click Open. You will see the new Rebal
% values in the modified position lines.
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To complete the rebalance, create and transmit the orders.
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Rebalance for Advisors
Advisors can elect to have TWS automatically Rebalance ALL accounts, a single subaccount, or a
user-defined Account Group, which includes a subset of accounts, by redistributing percentages of positions in their subportfolio(s) that make up the current (signed) net liquidation value. TWS opens and
closes positions to rebalance the selected accounts' portfolio based on the new percentages you
enter. You can add contracts and create orders just as you would from the main trading screen.

Rebalance a SubPortfolio
1. Open the Rebalance window by clicking the Rebalance icon on the trading toolbar.
2. In the Account dropdown, select: All to rebalance All accounts; Master to rebalance the master
account, an account number to rebalance that account, or an Account Group to rebalance all
accounts in the group.
3. The Rebalance window shows three columns that are different from those on your trading screen:
l

l

l

Deliv Value - this is the deliverable value of the position, which is the same as the Market
Value for the position shown in the Portfolio section of the Account window.
Current % - this is the current signed percent of the position to your net liquidation
value shown in the Balance section of the Account window. This figure is calculated by
dividing the DLV by the NLV (Net Liq. Value).
Rebal% - Percentages are entered in terms of deliverable value.

Please note that puts have a negative deliverable value since they deliver a short position. Consequently,
to increase your put position, you must enter a negative deliverable value percentage.
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4. In the Rebal % field, enter the new percent of the Net Liquidation Value that you want the position to have.
Note: If you have selected "All" in the Account dropdown, the rebalance percent for the instrument will be applied to all of your sub accounts' portfolios.
5. Click the Create Orders button to instruct the application to automatically create the orders to
achieve the percent change.
6. Use the Transmit All button to send all orders, or click "Transmit" on an order line to transmit
a single order.

For options, the rebalance% is based on the value of the underlying stock price.
Open positions from the Rebalance window
1. First, add a ticker line to the Rebalance window by selecting the market data line on your trading screen, and then clicking the selection arrow attached to the Rebalance icon on the trading
toolbar. Click Add to Rebalance Window. Or, enter an underlying symbol into a blank row on the
Rebalance screen as you would on the main trading window.
2. Enter a value in the Rebal % column and click the Create Orders button.
3. Transmit the order.
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The Integrated Stock Window (ISW)

The Integrated Stock Window (ISW)
Introduction
l

Quote Panel

l

Book Data Panel

l

ISW Buttons Panel

l

Order Entry Panel (OEP)

l

Auto Orders

l

ISW Order Entry Sub Panels
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The Integrated Stock Window (ISW)

Quote Panel
The Quote Panel displays market data for the selected stock symbol. By default, the Quote Panel uses
the single-row view used to show all TWS ticker lines.
l

l

To hide the Quote panel, on the View menu uncheck Quote Panel.
Use the Switch View icon in the top left corner of the panel to toggle between singlerow view and ticker view.

To add a symbol to the Quote Panel
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1. Enter a symbol in the Underlying field and hit Enter.
2. Select a stock from the contract list.
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Book Data Panel
The Book Data Panel displays both Level I and Level II subscription and non-subscription quotes on
either side of a real-time, configurable chart. Click a button to add data from a market center the
book data panel.

l

l

To add data, click a market center button. Bids are displayed to the left of the chart, asks to the
right.
See your own order highlighted in the depth by checking Show pending orders in the book on
the ISW Configuration Settings page.
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l

l

l

l

l

When you click a bid/ask price from the Book Data components, the price data is reflected in
the Order Entry Panel order line, from which you transmit orders.
Modify the chart parameters using the Chart menu. Select Chart Parameters to change the time
period, bar intervals and other data options.
If you elect to display the Others button, click it to include Level I data from market centers
that don’t offer Level II data, market centers to which you don’t hold Level II subscriptions, and
subscribed exchanges whose buttons are not currently selected. Show or hide the “Others” button from the Deep Book Buttons section of the Settings page.
The number of deep book data windows that you can display at one time (including BookTrader,
ISW and Market Depth) is equal to 1 for every 100 allowed lines of market data, with a minimum of three and a maximum of 30. Market data allowance is based on commissions, available equity and other criteria. So a client with the minimumallowance of 100 lines of market
data will be able to open 3 deep book windows. A client with an allowance of 500 lines of market data will be able to open 5 unique deep book windows . For details on how market data
allowances are calculated, see the Market Data and News overview page on the IB website.
When subscription deep book data is at its window limit, additional windows will display aggregated top level data, and the Deep Button panel will be hidden.
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ISW Buttons Panel
The ISW includes three Button panels which you can hide or display using the View menu. The Left
panel creates new order in the order line of the OEP, the Right panel provides single-click access to
other TWS order tools, and the lower panel is used to modify orders, both new and working, in the
order line. All buttons are configurable and can be armed for Instantaneous Transmit by clicking
the Armed checkbox and agreeing with the warning disclosure.

Buttons names include an asterisk (*) when they are set to Instantaneously Transmit the order when clicked.
To remove this attribute, de-select the Armed checkbox in the button panel.
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Order Entry Panel (OEP)
Enter orders by clicking a price level in the Level II panels then using the BUY or SELL buttons to transmit. Use the Order Entry Panel to:
l

Create and submit basic orders;

l

Modify a working order;

l

Apply order attributes such as hidden, discretionary, OCA;

l

Create and submit advanced orders such as algo, scale, adjustable and bracket.

To create an order in ISW
1. Click a price level in one of the Level II components.
2. Edit the order parameters using the dropdown boxes and text entry fields below the order line.
3. Click the BUY or SELL button to transmit the order.
To modify a working order
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The Integrated Stock Window (ISW)

1. Select the order you want to modify using the dropdown list on the order line.

2. Modify order parameters using the dropdown lists and text entry fields or the bump Buttons.
3. Click Rep to cancel and replace the current working order with the modified order.
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Auto Orders
Use the Auto order in the Type field to have TWS select the order type based on the price values you
enter. This feature is a short-cut to save you the step of having to choose the order type first and then
define the price criteria.

By default, the (Auto) order appears in the Type field. Click to view the current list of supported auto
order types from which TWS will choose. The chosen order type will display in the order description
line. It is important to note the following:
l

l

Only the order types listed under the (Auto) entry are eligible to be selected as an Auto order.
All other order types must be selected manually from the Type dropdown list.
The Auto order appears in the Type field only for NEW orders. Working orders will display the
actual order type in the Type field.

The Auto order type selection is made according to the rules as illustrated in the image below.
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ISW Order Entry Sub Panels
Use the sub-panels to create advanced orders and apply order attributes. Use the Destination list to
select an algo exchange and define an algo order.

To use the sub-panels
1. Click the sub-panels dropdown to display the list of available attributes and advanced order
types.
Note: Note that this menu is context-sensitive, so that only the order types that are
valid for the order parameters you have defined will be shown. For example,
if your order type is Stop, the Scale sub-panel will not be shown in the dropdown list for that order since the Scale attributes can only be applied to Limit
and Relative orders.
2. Check the order attributes you want to apply to open the sub-panel(s) for that order type.
3. Enter values for the selected order type.
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To enter an algo order
1. From the DEST drop-down list, select an algo destination under the Algorithms section.
2. In the new algo-specific panel, enter algo parameters.
See the TWS Users’ Guide topics for details on setting up algo orders:
l

IBAlgos

l

CSFB Algos

l

Jefferies Algos
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OptionTrader
Introduction

This configurable standalone screen shows market data for the underlying, lets you set up option
chains based on the underlying, gives you access to your options orders, executions and portfolio
information, drives the data for the Model Navigator and Options Analytics windows, and lets you create combination Spread orders.
l

Using the OptionTrader

l

Loading Option Chains

l

Combo Orders

l

OptionTrader Statistics

l

Configure OptionTrader

l

Create/Edit Buttons
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Using the OptionTrader
OptionTrader is a robust trading tool that lets you view and trade options on an underlying. Display
option chains on the underlying based on the criteria you define, including strike, expiry and
exchange, and view the Greeks for each option. Use the Model Navigator to modify the values used to
calculate option prices and the Greek risk dimensions. For real-time market risk management, use
the IB Risk NavigatorSM.
To open OptionTrader
l

Right-click an underlying and select Trading Tools, then select OptionTrader.

The OptionTrader opens for the selected underlying. The OptionTrader is divided into sections. The
toolbar, buttons panel and statistics panel can be hidden using the toggle buttons. Panels can also be
contracted/expanded using the down/up arrows. The different sections are identified in the image
below which corresponds to the following list:
1. The toolbar.
2. The Quote Panel which shows the underlying asset. You can create orders on the underlying
by clicking the Bid (sell) or Ask from the Quote Panel.
3. Set of toggle buttons to hide/show the toolbar, button panel and statistics panel.
4.

The Statistics panel, which displays option-related statistical data.

5. The Buttons panel, which holds custom action buttons that you can use to initiate common
actions. Once you arm the panel, any button that you had defined for instantaneous transmit in
the button panel will be identified by an asterisk (*) next to the button name.
6. The Trading Panel which includes tabbed pages for orders, activity log, filled trades for the day
on that underlying, the Portfolio for the underlying, and the Combo tab that lets you create a
combination spread without leaving the OptionTrader.
7. Option chains for the underlying. Specify the strike(s), expiry(ies) and exchange(s).
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For information on loading option chains and configuring buttons and panels, see the TWS Users'
Guide topics.
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Loading Option Chains
Use OptionTrader to create and manage option chains. When you specify an underlying, chains load
automatically. Use the Strikes, Expiries and Exchanges lists to modify criteria and automatically load
a new set of option chains.
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Load option chains
Use Load My Chains to load chains on any option on the underlying in which you hold a position. Or,
define the strike, expiry and exchange criteria to view specific option chains.
l

Use Strike, Expiry and Exchange buttons to define the options to include in the option chain.
If you select a single strike, expiry or exchange, the button labels change to display the information. If you have selected multiple strikes, expiries or exchanges, hold your mouse over the
button to see the complete list of your selections.

l

To create an order, click the Bid or Ask price on the desired option chain line.

You can add pages for other contracts by clicking the Add Tab icon on the toolbar. After you click the
Add Tab button, define an underlying by entering a symbol in the Underlying field on the quote panel.
Hit Enter, then select an instrument type and then a specific contract. The new underlying will be
reflected in the tab name.

Option chain orders are displayed on the Orders page of the of the Trading panel.
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Combo Orders in the OptionTrader
Use the Combos tab to define and submit combination orders that use stock and option legs, based on
the current OptionTrader underlying.

To create a combo order
1. Select the Combo tab from the Trading tabset.
2. Add legs by clicking the desired option in the Option Chains area.
l

Click on the right "Call" side to add calls. Click on the left "Put" side to add puts.

l

Click the Bid price to add a Sell leg; click the Ask price to add a Buy leg.
Note: You can quickly modify the Action, Expiry, Strike or Put/Call designation using
the drop-down arrow in the Combo window.

3. Use the optional feature buttons as needed:
l

l

Use "Add Stock" to add a stock leg.
Use "Make Delta Neutral" to add a stock leg with the delta quantity based on the system generated delta.

l

Use "Add to Quote Panel" to set up the quote line for transmission at a later time.

l

Use "Transmit" to submit the combo order using the order parameters shown.
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To make the combo delta neutral
1. Click Make Delta Neutral at the top of the combo window.
Note: The stock leg is added at the bottom of the window, and the hedging quantity
is generated automatically using the system calculated delta. If you modify
the delta the stock leg quantity will change, and if you modify the stock leg
quantity the delta value will update.
2. Modify the prices if needed. The Net Option Price is the limit price for the combo's option legs
only. The Stock Price is displayed separately.
3. Choose to Transmit the delta neutral combo, or add the combo line to the Quote Panel.
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The Button Panel
Many of the trading tools provide a configurable Buttons panel that you can elect to hide or display,
and which lets you create new and edit buttons that perform the defined trading action with a single
click.

To configure the buttons panel
1. From within the current tool, click the configure wrench to open Global Configuration for the
tool.
2. Select Buttons in the left pane.

The existing buttons and their actions are displayed at the top of the page.
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3. Click Newto create a new button/action, or select a button and click Editto modify an existing
button.
4. Use the Button Appearance section to change the label, the text color and the background color.
5. Select an action to associate with the button using the Select Action dropdown.
6. Fine-tune the action by entering data in the Customize Action area. For example, for the
action Increase price or size, you can specify the price or size field to which the button applies,
and set the interval by which to increase the field value.

NOTE: If you check the instantaneous transmit feature, the button will display an asterisk next to its name in the
Buttons panel.
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OptionTrader Statistics
An optional Statistics panel displays option-related statistical data for contracts with a stock underlying. You can elect to display the following statistics:

Field
Name

Description

Bid Exch

Identifies the exchange(s) that are posting the best bid price on the options contract.

Model

The option model price is calculated using the underlying price, the interest rate,
dividends and other data using the Model Navigator.
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Ask Exch

Identifies the exchange(s) posting the best ask price on the options contract.

Historical
Vol

Displays the 30-day historical volatility for an option. Right-click the field header to
toggle between Daily or Annual.

Opt
Implied
Vol

A prediction of how volatile an underlying will be in the future. The IB 30-day volatility
is the at-market volatility estimated for a maturity thirty calendar days forward of the
current trading day, and is based on option prices from two consecutive expiration
months.

Opt Open
Interest

Charts the total number of options that were not closed.

Opt
Volume

The total number of contracts traded over a specified time period.

Vol
Change

Change in volatility from the previous day's close.

Opt
Volume
Change

Change in option volume from the previous day's close.

Put/Call
Volume

Put option volume for the day divided by call option volume for the day.

Call/Put
Volume

Call option volume for the day divided by put option volume for the day.

Put/Call
Open
Interest

Put option open interest for the day divided by call option open interest for the day.

Call/Put
Open
Interest

Call option open interest for the day divided by put option open interest for the day.

Open
Interest
Change

Change in open interest from the previous day's close.
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To display the OptionTrader Statistics panel
l

Click the "s" icons in the toggle panel located in the top right corner of the OptionTrader.
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OptionTrader
Use the OptionTrader configuration page to define basic settings, order presets, hotkeys, buttons and
to control the visibility of column fields.
To define OptionTrader configuration settings
1. Click the Configure wrench from any window.
2. Click OptionTrader in the left pane and then click Settings.
3. Use the right pane to set these parameters:

Settings
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Components
l

Display menu - check to see the OptionTrader menu.

l

Display toolbar - check to see the Option Trader toolbar.

l

Display Quote panel - check to display the Quote Panel, which displays a single line of market
data for the asset. You can create an order from the Quote panel by click the bid or ask price.

l

Display user-configurable buttons - hide or display buttons you create using the Buttons panel.

l

Display Statistics - a configurable, optional panel that shows option-related data and statistics.

Miscellaneous
l

l

Jump to order- automatically puts the cursor on the newly created order in the Orders panel.
Allow multiple untransmitted orders - if checked, you can create more than one order in the
Underlying panel. Otherwise, only one untransmitted order is allowed.

l

Show all orders - check to view all orders for the underlying.

l

Show option prices in volatility - check to view volatility instead of dollar prices.

l

l

l

Show expiration headers - check to sort option chains using a single header for the expiry
followed by a list of strike prices. This helps save room in the option chain Description column.
Order Ref - a user-defined reference name to help identify where the order originated.
Order Presets - OptionTrader-specific default order settings. The OptionTrader preset is
linked to the selected Order Ref. above. Create a preset for both Stock and Options with the
same title and link to the Order Ref by selecting it or by creating a new preset. These presets
will control the default order parameters for any stock and options orders created from the
OptionTrader. If you do not create a stock preset for the OptionTrader, the default stock preset
will be used for stock orders created in the OptionTrader.

Auto-Loading
OptionTrader automatically loads option chains based on the criteria you set in this area.
l

l

l

Assume underlying is a SMART stock - uses smart instead of a specific exchange.
Quick stock entry - check to auto load stock and bring up the exchange dialog immediately
when you enter an underlying.
Load the closest N strikes to the money - choose a number to limit how many options load in
the chain.

l

Load the nearest N expiries - only shows you those options with the N closest expiries.

l

Load specific months - hard-code the exact months whose options you want to see.
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Write and Rollover Options
Introduction

Use the Write Options tool to sell calls against long stock positions and sell puts against your short
stock positions. Use the Rollover Options tool to roll over options that are about to expire to a similar
option with a later expiration date.
l

Write Options

l

Write Options - Option Chains

l

Rollover Options
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Write Options
Advisors can use the Write Options tool to quickly see all of their sub-account’s long and short positions and to write options orders against their uncovered stock.

Open the Write Options tool
l

From the Trading Tools menu, select Write Options.

Advisors will see the Select Account dropdown that lists all of their Account Groups and individual
sub-accounts.
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To use the Write Options tool
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1. Select an Account Group, an individual sub-account, a Model or All accounts.
2. Describe the options to buy and sell:
l
If you are writing covered calls on your long stock positions, note that you can also
choose to buy protective puts to create a collar combo.
l

If you are writing covered puts on short positions, you can also elect to buy protective
calls to create a collar combo.

3. Confirm or modify any conditions on the options and click Refresh to update the list of options
to write.
4. The Review Options to Write list includes any positions for the account(s) you selected, the
quantity of the position that is uncovered (has no options written against it) and the options that
meet the criteria specified. Note that all options are selected by default. Click a check box to
deselect the option for any account.
5. Click the pencil icon next to the option to open the Option Chains and select a different option to
buy or sell.
6. Review or change the Order Type and price information and click Create Orders.
7. Orders will display in the Orders panel; click Transmit All to submit, or submit one order at a
time using the Transmit button in the Status field.
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Write/Roll Options: Option Chains
To select different options to buy or sell in the Write Options tool, click the pencil icon on the line you
want to change and use the Option Chains to select a new contract.

To select a new option to buy or sell
1. From the Review Options to Write list, click the pencil icon on the far right of the option line
you want to change.
The Option Chains window opens with the currently selected call and/or put contracts highlighted. Calls display to the left of the Description column and puts display to the right.
2. To select a new call option, click the desired description on the left side. You will see the call
option highlighted. To select a put, click the description on the right side.
3. Click OK when the new options have been selected.
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Rollover Options
Quickly see all of your sub-account’s options that are about to expire and roll them over to the a similar option with a later expiration date.

To roll over options
1. Open the Rollover Options tool:
l
From within Mosaic, use the New Window dropdown to select More Advanced Tools at
the bottom of the list, then Rollover Options.
l

From with Classic TWS, use the Trading Tools menu and select Rollover Options.

Advisors will see the Select Account dropdown that lists all of their Account Groups and individual
sub-accounts.
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To use the Roll Options tool
1. Advisors Only: Select an Account Group, an individual sub-account, or All accounts.
2. Choose whether you want to write calls on long stock positions, or write puts on short stock positions.
3. Use the default description or modify any conditions on the options, and click Refresh.
The list of Options to Roll includes any option positions for the account(s) you selected and the
roll-to option that meets the criteria specified.
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Write and Rollover Options

4. Click the pencil icon next to the option to open the Option Chains and select a different option to
buy or sell.
5. Review or change the order information and click Create Orders.
6. Orders will display in the Orders panel; click Transmit All to submit.
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The Order Ticket
Introduction

The Order Ticket is available as an alternative form of order entry for users who prefer to set all
order attributes from a single tabbed window.
l

Basic

l

Advanced Combo Routing

l

Adjustable Orders

l

Scale Orders via ScaleTrader

l

Pegged Orders

l

Volatility Trading

l

Conditional Orders

l

Miscellaneous
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Basic
The Basic tab includes the basic order and time in force information, all based on the contract shown
in the Quote Panel. The fields are context-sensitive, which means that only valid selections will be active. For example, if you select TRAIL LIMIT as the order type, the Stop Price, Trailing amount and Lmt
Offset fields become active. In addition, selections you make on this page affect the composition of
the tabset. For example, if you select a stop or trailing order type, the Adjust tab becomes available;
if you choose VOL as the order type, the Volatility tab is displayed, etc.
For combo orders, the Basic tab also includes Advanced Combo Routing.

To remove tabs and view all fields on a single large page, select
theComprehensive view.
Field

Action
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Notes
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Quantity
Quantity

The number of units in the order.

Display size

Enter a display size to create an
Iceberg order.

Min. Quantity

Enter the minimum quantity that must be
available for the order to execute.

For options routed through
Smart.

Order Description
Order Type

Select an order type. Valid order types are
determined by the underlying, exchange and
security type selected.

Limit Price

Enter the limit price if the order type requires
it.

Aux. Price

For Stop and Stop limit orders, this is the
Stop election price.
For Options relative to stock orders, this
is the starting price.
For trailing stop orders, this is the trailing amount.

Trailing
amount

The amount used along with the market price
to calculate the initial stop price.

Percent Offset

For Relative orders, sets the offset amount
based on a percentage of the bid price for
Buy orders or the Ask price for sell orders.

Discretionary
Amount

The amount off the limit price at which the
order is still eligible to execute.

Enter an amount to create a
Discretionary order.

Destination

Specifies the order destination.

To create CSFB or Jefferies
algo, select CSFBALGO or
JEFFALGO from this list.

Field

Time in Force

Description

The time period during which your order
will remain active. Choose from the
selections presented, including:
•
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product, order type and destination.
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• GTC (order remains active until it is
cancelled)
• OPG (market or limit at the open
order)
•

IOC (immediate or cancel)

• GTD (order remains working until the
date/time specified in the End Time field
below.)
• DTC (day 'till cancelled, is cancelled
at the end of day like a day order, but
remains on your trading screen deactivated to let you resubmit easily).

Start Time

Set the start time (and date) for the order.

End Time

Set the end time and date for the order.

Only valid for GTD times in
force.

Trading Hour Attributes

The next three settings allow you to specify the hours during which orders are eligible to execute. By
default, orders are set to trade during Regular Trading Hours only.
Note: Elections to trade outside regular trading hours may not be available for particular
products that are not listed on an exchange. IB customers are solely responsible for ensuring that
these parameter are valid for the product(s) involved.

Allow this order to be
filled outside of regular trading hours.

Check this box if you want to allow
orders to trigger or fill outside of regular
hours.

You can also set this feature from
the TIF dropdown on an order line
in the trading window.
Valid for US stocks listed on
major exchanges. Not available
for IOC, OPG (MOO and LOO),
FOK, MOC or LOC orders.

Allow order to be
routed and executed
during pre-open session.

Check to allow orders to participate in
the pre-open session from 4:00 - 8:00 am.

Can be applied to orders set for
Regular Trading Hours only.

Ignore opening auction.

Check to ignore the opening auction
which takes place at the open.

Can be applied to orders set for
Regular Trading Hours only.
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This attribute cannot be used if
you have configured Smart Routing to participate in Pre-open Reroute.

VWAP Time
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Modify the VWAP cut-off time if desired
by clicking the Calendar selection tool.
Otherwise, the Soonest cut-off time is
used.

VWAP orders are automatically
routed and accepted immediately
after being transmitted. VWAP
orders cannot be cancelled.
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Advanced Combo Routing
To control routing for large-volume, Smart-routed combination orders, use the Advanced Combo Routing features on the Basic tab of the Order Ticket. Define advanced combo routing for both guaranteed
and non-guaranteed combination orders routed to Smart. Selections displayed are based on the
combo composition and order type.
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To use advanced combo routing
1. Create the Smart combination strategy.
2. From the combo line on the Quote Monitor, click the Bid or Ask price to create a (sell or buy)
order.
3. Right-click the order line and select Modify then select Order Ticket.
Based on the combo composition and the Order Type, the Advanced Combo Routing selections are
displayed. You can monitor the progress of the combo order by holding your mouse over the Status
field of the order line.
Advanced Combo Routing Fields (available based on selected Order Type):

Field Name

Description

Order Type

Choose from the basic order types as well as:
Relative + Market, Limit + Market, Trailing Relative + Market and Trailing Limit + Market.

Select leg to fill first

For orders that are being legged-in, the chance
exists that only the first leg of the combo will
fill and you will be left with one unexecuted leg.
Use this field to specify which leg is submitted
and potentially filled first. Use the dropdown
list to pick.

Maximum leg-in combo size:

The order is submitted in pieces, or segments.
This is the maximum size of each segment.

Do not start next leg-in if previous Specify whether or not the system should
leg-in did not finish:
attempt to fill the next segment before the current segment fills.
Convert second leg order to
market order if...

These settings allow you to specify when (if
ever) the second leg should be changed to a
market order to fill right away, in cases where
the first leg fills and the second leg does not
and ends up sitting as a non-marketable limit
order at the exchange,

...or if the price backs off by... Provides a way to specify a stop-loss to fill the
unexecuted leg of a combo by changing the leg
to a market order if the price backs off by the
specified amount.
Discretionary Amt

TWS Users' Guide

In cases where one leg fills and the other
doesn't, the discretionary amount indicates
how much you are willing to pay to fill the
combo.
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Adjustable Orders
Use the Adjust tab to define a one-time adjustment to a stop, stop limit, trailing stop or trailing stop
limit order. This tab will only become active one of those orders types is selected.

To remove tabs and view all fields on a single large page, select the Comprehensive view.

Field
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Notes
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When you select an adjusted order type, the stop
order you're adjusting will
not trigger when the stop
price is hit. Instead, it will
be changed to this order
type, and use the other
parameters below.
Select one of the stop
order types. When your
current stop price is penetrated, it will change to
this order type and use the
instructions you set in the
following fields.

The following example continues to unfold for each
field.
You buy 100 shares of XYZ for $31.00/share, and submit a sell stop order with a trigger price of $30.00. This
means that if the price hits $30.00, TWS will send a sell
market order to the exchange.
Now let's modify this scenario. In addition to the above
Stop order, you decide to create an adjustable Stop
Limit order to help lock in a profit if the stock price
begins to rise. Now imagine the price starts going up.
When it hits the trigger price (see next field below)
TWS will cancel the Stop order and create a new Stop
Limit order with the characteristics you set in the following fields.

Trigger
Price

This price will trigger the
adjusted order you defined
in the Adjusted Order
Type.

Set the adjustable trigger price to $34.00

Adjusted
Stop
Price

When the trigger price is
hit, the adjusted stop price
is implemented for the new
order.

Set the adjusted Stop Price to $33.50. When the stock
rises above the $34.00 trigger price you set above, you
original Stop order is cancelled and replaced with a Stop
Limit order with a stop trigger price of $33.50.

Adjusted
Stop
Limit
Price

Used for Stop Limit and
Trailing Stop Limit orders.
This value will be the limit
price of the order if it is
triggered and submitted.

Set the Stop Limit to $33.00 to ensure your order will not
execute below this price.

Adjusted
Trailing
Amount

Used for Trailing Stop and
Trailing Stop Limit orders.
This value will replace the
original trailing amount if
the adjusted order is
triggered.

If you had a trailing stop order with a trailing amount of
$1.00, you could set the adjusted trailing amount to $.50.
If the adjustment trigger is hit, the trailing amount is
modified.
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Scale Orders via ScaleTrader
Scale orders are designed to help prevent larger sized trades from being subject to increasingly
deteriorating prices by scaling your order into smaller, incrementally priced components based on
user-specified price and size instructions. In addition to scaling your order, you can also define a
profit offset amount which instructs TWS to automatically submit opposite-side profit taking orders
against the individual components of the original order.
Click Open ScaleTrader from the Scale tab to set all scale parameters.
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Set time in force parameters for the Scale order. See the Basic page for details.
See the ScaleTrader topic for details on creating a scale order.
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Pegged Orders
Select from the available fields to create an order. The fields are context-sensitive, which means that
only valid selections will be active. For example, if you are creating any kind of order other than a
Pegged to Stock options order routed through BOX, this page will be inactive.

Field

Description

Stock Ref
Price

Enter a stock price.

Underlying
Range

Define the lower portion of the stock range outside
of which your order will be cancelled.
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If you do not enter
a value, the midpoint of the NBBO
at the time of the
order is used.
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(Lower)

Underlying
Range
(Higher)

Define the higher portion of the stock range outside of which your order will be cancelled.

Delta

Enter a value (which will be used as a percent, ie.
".5" equal 50%) that will be multiplied by the
change in the underlying stock price. The product
is added to the starting price to determine the
option price.
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Volatility Trading
The VOL order type allows you to trade volatility, and provides ways to dynamically manage your
options orders.

To trade Volatility
1. From the Trading Tools menu, select Volatility Trader. The fields used to define and dynamically manage volatility orders are on the new page.
2. Create market data lines. Note that Bid and Ask price fields display in volatility rather than as a
dollar amount. Market data for stock tickers will still display the bid and ask price.
3. Select Annual or Daily volatility using the Volatility Type dropdown list.
4. Create an order by clicking the Ask volatility for a Buy order, or the Bid volatility for a Sell
order. The order type defaults to VOL.

You can use the VOL order type for equity options, index options and combination orders. Hold your
cursor over the option's volatility to see the option price, based on that volatility.
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Please note the following requirements for transmitting a VOL combination order:
l

l

l

l

Combo VOL orders must be Smart-routed.
All legs must be on the same underlying, and each leg must independently be eligible to
use the VOL order type. For example, a BuyWrite order could not be sent as a VOL order
since its stock leg would not allow this order type.
All VOL orders must be DAY orders.

You can elect to price a Smart-routed Index Option order using reverse futures premium calculations by selecting a futures contract from the Reference Contract field.
Note: If you have changed the reference contract in the Model Navigator, VolatilityTrader will used the new contract as the default
reference contract.

5. To have the workstation calculate a limit price for the option or combination order based on
your volatility input, enter a value in the Order Volatility field. The value shown in the Imp
Vol field is calculated via the Model Navigator.
6. To transmit the order, click the "T" in the Transmit field, or the Transmit icon on the trading
toolbar.
Field

Description

Volatility

If desired, enter a volatility to use in calculating a limit price for the option. If
blank, the calculation will use the volatility derived via Option Analytics.

Volatility
Type

Select from Daily or Annual volatility.

Hedge
Order
Type

Select an order type. The application will send an order against the executed
option trade to maintain a delta neutral position. Use the Hedge Aux. Price field to
set a price for orders that require one. Note that for index options, you will need to
select a futures contract for use in a hedge delta trade.
Alternately, you can use the right-click menu to attach a Delta Hedge order and
set the hedging attributes from the new order line.
Please note that if you select Continuous Update, the system will use the delta
associated with the parent order, which is calculated from the user-defined Implied
Volatility specified at the time of the most recent order modification or price
update, instead of using the current delta of the option based on market data at the
time of trade.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the
time the parent order fills, and the best available price is used as the limit price
(best ask for a buy and best bid for a sell).

Hedge Aux.
Price
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Used in conjunction with the Hedge Order Type field. If you have selected an
order type that requires you to define a price, for example a relative order, use this
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field to set the price.
Continuous
Update

Check this selection to continuously update the price of the order if the price of the
underlying instrument changes significantly. Note that you can only check
Continuous Update for three active orders at a time.
You will be subject to cancellation fees for order modifications that are made by
the system when you have the Continuous Update mode enabled.

Reference
Price Type

Elect to use the NBB (bid) when buying a call or selling a put; the NBO (ask)
when selling a call or buying a put; or the average of the best Bid and Ask. This
price is also used to compute the limit price sent to an exchange (whether or not
Continuous Update is selected), and for stock range price monitoring.

Stock Price
Monitoring

Undrl. Range (Low) - enter a low end acceptable stock price relative to the selected option order. If the price of the underlying instrument falls BELOW the lower
stock range price, the option order will be cancelled. Merely touching the price
does not cancel the order.
Undrl. Range (High) - enter a high end acceptable stock price relative to the
selected option order. If the price of the underlying instrument rises ABOVE the
upper stock range price, the option order will be cancelled. Merely touching the
watermark does not cancel the order.

Reference
Contract
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Used for smart-routed Index Option volatility orders. This field allows you to
select the futures contract to use for calculating the implied volatility. To activate
this feature, use the Volatility and Analytics page in Global Configuration and
selectPrice index options relative to futures contract.
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Conditional
A conditional order is an order that will automatically be submitted or cancelled ONLY IF specified criteria for one or more defined contracts are met. You can use stocks, options, futures or security
indexes to trigger a conditional order.

To create a conditional order
1. Select an order line.
2. From the right-click menu, select Modify and then select Condition.
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3. From the Conditional tab on the order ticket click Add Condition.
4. Enter contract information for the contingent asset in the Conditional Order box.
5. Enter the trigger information for the contingent asset:
l

l

l

Select the trigger method.
Select whether the price of the contingent asset should be less than or equal to
(<=) or greater than or equal to (>=) the trigger price.
Enter the trigger price.
Note: If you select the double bid/ask trigger method, the greater than
or equal to operator (>=) will use the BID price and the less than
or equal to operator (<=) will use the ASK price.

6. Click OK. The condition appears in the Current Conditions list.
To set multiple conditions, use the Add Condition button and click AND or OR in the Current Conditions area.
Field/Button

Description

Add Condition

Invokes the Conditional Order entry box.

Delete

Deletes the selected condition.

Modify

Opens the Conditional Order entry box for the selected condition to allow you to make changes.

Allow condition to
be satisfied...

Lets the selected condition activate the order if it is satisfied
outside of regular trading hours.

Action to take...

If selected conditional order is satisfied, you can elect to have
the primary order submitted OR cancelled.
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Miscellaneous
Use the Miscellaneous order fields to apply order attributes and set specific rules for OCA groups.

OCA group names must be unique to ensure proper handling of OCA orders. Once you use a name, you cannot
use it again even after the order executes or is canceled.

Field

Order Ref
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Large Shareholder

For large shareholders trading Canadian products. Use the dropdown selection list to
appropriately mark your order.

Trigger
Method

Select a new trigger method for the order. To modify the default trigger method use
the Global Configuration tool and select Orders>Order Defaults.

ISE Midpoint Match

Choose from Standard or SOI for an ISE MPM order.

Req Market
Data

Check to request market data for the order.

Block Order

Check to create a block order.

Sweep to
Fill

Check to create a sweep-to-fill order.

Hidden

Check to create a hidden order.

All or None

Check to create an All or None order.

Non-Guaranteed

Checking this box indicates that you will take all the risk for partially-executed Smart
routed combination orders. Note:Only Smart-routed US stock-option and optionoption combinations are guaranteed.

Preserve
Time Priority

Check to keep your order in the queue and prohibit from canceling and resubmitting
orders intermittently. This feature is used on exchanges that charge a handling fee for
orders that remain on the order book for a specified period of time.

Hide Pennies

When checked, hides the penny pricing of your options order.

Consider
Cost

If checked, Smart routing will consider the total cost of executing the order, including
commissions and other fees, when deciding where to route the order. If unchecked,
only the exchange price is considered.

For smart-routed European stocks.
Post only

If checked, when there is non-displayed liquidity at the same price point, the order
price is adjusted low (for a buy) or higher (for a sell) by one penny to avoid taking
that liquidity. If the order comes in at a price higher (for a buy) or lower (for a sell)
than an order already sitting on the book, it becomes an IOC (immediate-or-cancel)
order at the better price.

Deactivate

Check to deactivate the order, which cancels the order

Seek Price
Improvement

If checked, Smart routed orders sweep certain exchanges for hidden liquidity at more
favorable prices, then checks the dark pools as usual before routing to an exchange.

TWS Users' Guide

317

Trading Tools

Note that activating this feature may result in slower executions.

Bypass market cap

If checked, the IB price cap/price floor will not be enforced. Please note that this
may result in an execution price outside of what is considered fair or consistent with
an orderly market.

Imbalance
only

Submits the order only to take the imbalance from an opening or closing auction.

OCA Group
Group Name

If the order is part of a one-cancels-all order, enter the OCA name in this field. All
orders with the same name in the OCA field become part of an OCA order. Once
you use a name, you cannot use that name again even after the order executes or is
canceled.

Partially
filled instructions

Set instructions on how to behave when order is partially filled. The default is to have
other orders in the OCA group proportionately reduced in size based on the quantity
of the filled portion.

Overfill Protection

Dictates that only one order in the group will be routed to an exchange at a time. This
completely removes the possibility of an overfill.
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Quantity Calculator
Introduction
l

Determine Order Quantity

l

Calculate Order Quantity
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Determine Order Quantity
When you create an order, you can define the order size several different ways. You can set a general
default order size hat is used for all orders. You can set specific default sizes for instrument types, for
example a quantity of 500 for all stock orders. You can even get more specific and set the default
order size for a specific contract, for example set the quantity for all stock orders for underlying XYZ
to 1000.

Alternatively, you can set a default currency amount that will be used to calculate the order size. For
example, set the default amount for stocks to $5000.00. The order quantity is then calculated based
on the stock price, and is rounded to the nearest 100 for U.S. stocks.
You can also have the workstation calculate the order quantity by Deliverable value amount, a percent of your Net Liquidation value, or based on a percentage of your current position.
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Calculate Order Quantity
Use the Quantity Type and Quantity Value fields to calculate your order quantity based on:

l

Currency- assumes the base currency

l

DLV Amount - Deliverable Value

l

% of NLV - percent of Net Liquidation Value

l

% Change in Position - percent of the change for your position in the underlying.

For example, say you have a Net Liquidation Value of 40,000. XYZ shows a current ask price of 80.00.
If you create a buy order for XYZ, select "% of NLV" as the Quantity Type and enter "20" in the Quantity Value field, you're telling the application to calculate the number of shares you could buy for 20%
of $40,000 or $8000.00, based on the Ask price of $80.00. The calculated Order Quantity value of
"100" is then displayed in the Quantity field.
To display the Quantity Type and Quantity Value fields
1. Right-click on any column name in the Order Management section of the trading screen, and
click Customize Layout.
2. Click the Order Columns tab. In the Available Columns list in the Quantity section select Quantity Type and Quantity Value and Add them to the Shown columns list.
To calculate order quantity by currency
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1. Create an Order by clicking the bid or ask price.
2. In the Quantity Type field, select the currency type. This field assumes the base currency.
3. In the Quantity Value field, enter a currency amount. For a buy order, enter the amount you
want to spend. For a sell order, enter the amount you want to make. Based on the current
bid/ask, your value gets rounded up or down.
The order quantity is calculated and displayed in the Quantity field.
To calculate order quantity by Deliverable Value (DLV Amount)
1. Create an Order by clicking the bid or ask price.
2. In the Quantity Type field, select DLV Amount.For stocks, the deliverable value is the value of
the stock converted to the base currency. For options, it is the value of the underlying stock represented in base currency (i.e. stock price * options multiplier).
3. In the Quantity Value field, enter the dollar amount of your deliverable value you want to use
to calculate the order quantity.
The order quantity is calculated and displayed in the Quantity field.
To calculate order quantity as a % of your Net Liquidation Value (% NLV )
1. Create an Order by clicking the bid or ask price.
2. In the Quantity Type field, select % NLV The Net Liquidation value is the first value in the
upper left Balance area of the Account window.
3. In the Quantity Value field, enter a percent value that will multiplied by your NLV to calculate
a dollar amount.
The order quantity is calculated and displayed in the Quantity field.
To calculate order quantity as a % of position change
1. Create an Order by clicking the bid or ask price.
2. In the Quantity Type field, select % Change in Position.If you do not hold a position in the
selected underlying, you will not see this selection.
3. In the Quantity Value field, enter a percent value that will multiplied by your position to calculate the order quantity.

If your position is negative, you must enter a negative percent value to calculate a positive order quantity.
The order quantity is displayed in the Quantity field.
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Rapid Order Entry
Introduction
l

Enter Orders using Rapid Order Entry

l

Configure Rapid Order Entry

l

Update Orders

l

Create "Instantaneous Transmit" Hot Key

TWS Users' Guide

323

Trading Tools

Enter Orders using Rapid Order Entry
The Rapid Order Entry panel, which is visible by default at the top of each trading page, allows you
to quickly transmit an order without having to open an order ticket or click in a market data line. You
simply tab through the fields, enter your order parameters, and click Trade. You can also enter the
local or root underlying symbol, just as you can on the trading screen.

Rapid order entry can be set for Stocks, Options, Stock or Options and Combo orders.
To use the Rapid Order Entry panel
1. If the panel is hidden, from the View menu select Rapid Order Entry.

The panel displays the instrument setting in the title, for example (Stocks). With this setting, you can
only create stock orders.
To change the instrument type
1. Right-click in the panel, and select Rapid Order Entry, then select the instrument type setting.
Select Stocks/Options to allow entry of either type.
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Once you have transmitted an order using Rapid Order Entry, the details of the order appear in the
Order Management panel of the trading page. Any modifications to your order must be made on this
order management line.

Using the Stock/Options Setting
You can choose to set the panel to Stocks/Options if you enter both.

If you enter the Expiry, Strike, and P/C fields, the Rapid Order Entry panel creates an option order. If
yuo leave this fields blank, it creates a stock order.
For the Option and Stock/Option layouts, you can set a default in Global Configuration to populate
with the nearest at-the-money option , but if you set this for the Stock/Options layout you will always
need to delete information to create a stock order.
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Update Orders
You can automatically update the limit price for an order (or all orders) to coincide with the ask, bid,
midpoint, closing or last price.
Automatically update the limit price
1. On the Trade menu select Modify Multiple Orders.
2. Set update parameters:

Which orders - All selections apply only to orders on the active trading page. Specify whether to
update attributes for:
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l

All orders on the page - Including working orders, non-transmitted orders, etc

l

Open orders only - This includes all orders working on the current page.

l

l

Rapid Order Entry

Selected orders - This includes all orders (working or not) on the active page that you deliberately select.
Inactive orders - This includes all orders on the active page that are created but have not yet
been transmitted.

Set Type and Time in Force

For the subset of orders specified above, instruct TWS to change to the selected order type, and to
the selected time in force. Check Convert Market to Limit to have all market orders automatically
changed to limit orders. Buy limit orders will use the Ask as the default limit price; sell limit orders
will use the Bid as the default limit price.
Set Price Parameters

Define the update price parameters for Buy orders and include an offset amount if desired.
Set the update price parameters for Sell orders. If you check Mirror image of buy orders, parameters
are set reversed from the Buy orders selections. The mirror images of Midpoint, Last and Close would
be the negative values for each of these prices.
Validation

If one or more of the orders marked for update cannot be updated, the Validation selection checked
here will be used.
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Create "Instantaneous Transmit" Hot Key
You use hot keys to perform common trading functions, such as creating specific order types. Once
you have created an order, you must still select Transmit to send the order. You now have the option
to enhance the Buy and Sell hot keys by adding "instantaneous transmit" functionality.
To add instantaneous transmit functionality to a hotkey
On the Edit menu, select Global Configuration and then select Hotkeys in the left pane.
1. In the Configured Shortcuts table, select the Buy or Sell action.
2. Click Configure, and open the Customize tab.
3. At the bottom of the page check Transmit the order instantaneously and click OK.
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To use this feature, you will be asked to sign an agreement stating that you understand its implications. Under the
terms of the Customer agreement, you are responsible for all orders entered in your account. Consider carefully
whether setting a hot key to instantaneously transmit orders is the best for the way you trade.
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EFPs
Introduction
l

Relevant EFPs

l

EFP Futures Spreads
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EFPs

Relevant EFPs
Introduction

Using an Exchange of Futures for Physical (EFP), which allows the swap of a long or short stock position for a Single Stock Future (SSF) could help to reduce your trading costs. The Relevant EFPs Market Scanner scans the US market and returns all EFPs relevant to you based on the stock and single
stock futures positions you currently hold. You can access this tool from the toolbar, or by selecting
US EFPs as the Instrument and Relevant EFPs as the Parameter in the Market Scanner page.

For more details on how using EFPs could reduce your trading costs, see the EFPs Product Highlights.
To view Relevant EFPs
1. On the trading toolbar, click the Relevant EFPs icon.
The Relevant EFPs scanner page opens with all fields populated with the correct EFP
selection.
2. Click Search if no values have been returned.
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Note that this page is for display only. To trade one of these EFPs, click and hold, then drag it
onto your trading page, or right-click and select Edit then select Copy. Open a trading page and
use the right-click menu to select Edit then select Paste.
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EFP Futures Spreads
An EFP (Exchange for Physical) is a combination order to sell/buy stock and buy/sell an SSF (single
stock future).

To create an EFP in SpreadTrader
1. From the Trading Tools menu select SpreadTrader.
2. Enter a symbol in the underlying field and hit Enter.
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3. Select EFPs for xxx and then select the routing destination, either SMART, IBEFP or ONE.

The spread matrix at the bottom of the window is populated with a list of all single stock futures
legs on the left, and the stock across the top.
4. Click a bid or ask price at the intersection of two legs to create the EFP spread.
5. To transmit the order, click the "T" in the Status field of the Orders panel.

Please note that smart-routed EFPs are not guaranteed.
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SpreadTrader

SpreadTrader
Introduction
l

Create Futures Spreads

l

EFP Futures Spreads

l

Create Option Spreads
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Create Futures Spreads with SpreadTrader
Use the SpreadTrader to quickly create and trade calendar spreads for futures.
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SpreadTrader

Create a futures spread
1. Open SpreadTrader by right-clicking a contract on the trading screen and selecting Tools and
then SpreadTrader.
2. Enter the underlying symbol and and then select Futures Spreads for xxx, then choose the routing.
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3. In the SpreadTrader leg matrix at the bottom of the screen, click a bid or ask price at the intersection of two legs to create the calendar spread.

The SpreadTrader matrix automatically structures the spread to sell the nearby month and buy the distant
month.
4. Transmit the order from the Orders panel by clicking "T" in the Status field.

Background Colors in Quote Panel
The colors in the Description field of the Quote panel show you how far out from the current year the
contract's maturity date is, at a glance. Industry-standard colors are defined below:
Number of Years Out

Background Color

>1

White

2nd

Red

3rd

Green

4th

Blue

5th

Gold

6th

Purple

7th

Orange

8th

Pink

9th

Silver

10th

Copper
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SpreadTrader

EFP Futures Spreads
An EFP (Exchange for Physical) is a combination order to sell/buy stock and buy/sell an SSF (single
stock future).

To create an EFP in SpreadTrader
1. From the Trading Tools menu select SpreadTrader.
2. Enter a symbol in the underlying field and hit Enter.
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3. Select EFPs for xxx and then select the routing destination, either SMART, IBEFP or ONE.

The spread matrix at the bottom of the window is populated with a list of all single stock futures
legs on the left, and the stock across the top.
4. Click a bid or ask price at the intersection of two legs to create the EFP spread.
5. To transmit the order, click the "T" in the Status field of the Orders panel.

Please note that smart-routed EFPs are not guaranteed.
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SpreadTrader

Create Option Spreads in SpreadTrader
Use the option combo facility in SpreadTrader to create a matrix of variations on an option strategy
for a single underlying, from which you can create and transmit multiple combination orders with two
clicks of the mouse. The Option Wizard helps you to define exactly how you want the combo lines displayed in the matrix by allowing you to assign either a column position, row position or fixed value to
each parameter. You can also use filters to help specify exactly which contracts you want to display in
the matrix.
To create an Options Spread Matrix
1. Open the SpreadTrader by clicking the SpreadTrader icon on the trading toolbar.
2. Enter an underlying symbol in the Underlying field and hit Enter.
3. With your mouse, select Options Combos for XXX, and then select an exchange/currency.
4. In the Option Spreads window, select a combination strategy. Once you do this, every available
spread for that underlying is displayed in the right panel.

The number of parameters shown under the Filter section; Some have two (such as a conversion or Buy Write)
while others, like the Butterfly, have 5 or more. You can use these filters to limit the number of combinations
that appear in the right panel.
5. Hit the Next button at the bottom of the window to see the Configure Table Variables box.
Each variable is represented by a section in the box, with Column Variable, Row
Variable or Fixed Value choices. A variable means that the combination parameter can
use multiple valid values. For example, for a Calendar spread there are two variables for
the right: put and call. If you select Call (which filters out the puts) it's no longer a variable, it's a fixed value. In that case, you won't see P/C in the variables list.
6. For each variable, check a radio box to instruct it to display as a row or column, or be used as a
fixed value. Checking Row will create a row for every possible combination of row variables.
Checking Column will display a column for every possible combination of column variables.
Checking Fixed value will invoke another selection box where you choose a single value for the
parameter.
For example, our Calendar spread has five parameters: Front month, Back month, P/C, Duration, and Strike. We filter out all but two Front months (20061020 and 20061117) and two
Back months (20061117 and 20070119) and all but six potentially valid strike prices, and leave
everything else as is. Since the only valid duration is one month, the Duration parameter is no
longer considered a variable. That leaves two variables in the P/C category (put and call) and
multiple strike variables.
Hit Next to lay out our matrix using the four variables, and choose Column Variable for the
Front month and the Strike, and Row Variable for the Back month and the right. When you
click Finish you'll see something like this, where the Back month and the rights comprise the
rows, and the Front month and Strikes comprise the columns.
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What are you looking at?
Each row is divided into sections of market data for the column variables you picked, in this case for
the front month and strike. If you could scroll across in this picture, you'd see the first of two Front
months we picked (20061020) occurring in six blocks, once with each different strike price. Then
you'd see the second front month, again once with each different strike price.
You see all the rows that are available, since our variables included only two back months and
call/put. If you want to make any changes to the layout and combinations displayed, click the Options
Wizard button on the toolbar.

If you receive a message saying you have too many combos to subscribe to market data, and you don't go in and
filter your results further, the prices will not update, and the matrix title will read "...Snapshot" instead of "...Realtime."
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Merger Arb

Merger Arb
Introduction
l

Merger Arbitrage Window
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Merger Arbitrage Window
Use the Merger Arbitrage window to create a combination order for an anticipated merger between
two companies.

To create a Merger Arb combo
1. From the Trading Tools menu, select Merger Arbitrage.
2. Enter contract conversion information in the Contract Selection area.
3. In the Order Selection area, enter the desired profit as an absolute amount or a percent of
the last price of the stock of the company being acquired (the acquiree).
Note: Pink fields are required.
4. Click Create Order to create a combination order line on the trading screen. You can also
choose to manage your order from within one of our advanced algo trading tools, Accumulate
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Merger Arb

Distribute or the ScaleTrader.

The Scale market and order display feature scales the market data to display the price of the combination per share of acquiree, and the order price will also be entered and displayed in these units.
This is checked by default. Note that if the calculated size of the acquiree is one, this checkbox has no
effect.
The combo order as entered above, and then opened in Accumulate/Distribute looks like this:
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The remainder of the Accumulate Distribute window allows you to specify detailed and sophisticated
order management criteria to help ensure that you receive the best price without being noticed.
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Volatility Orders

Volatility Orders
Introduction for Users
l

Volatility Trading

l

Attach a Delta Hedge Order

l

Volatility Trading via the Order Ticket
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Volatility Trading
The VOL order type allows you to trade volatility, and provides ways to dynamically manage your
options orders.

To trade Volatility
1. From the Trading Tools menu, select Volatility Trader. The fields used to define and dynamically manage volatility orders are on the new page.
2. Create market data lines. Note that Bid and Ask price fields display in volatility rather than as a
dollar amount. Market data for stock tickers will still display the bid and ask price.
3. Select Annual or Daily volatility using the Volatility Type dropdown list.
4. Create an order by clicking the Ask volatility for a Buy order, or the Bid volatility for a Sell
order. The order type defaults to VOL.

You can use the VOL order type for equity options, index options and combination orders. Hold your
cursor over the option's volatility to see the option price, based on that volatility.
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Volatility Orders

Please note the following requirements for transmitting a VOL combination order:
l

l

l

l

Combo VOL orders must be Smart-routed.
All legs must be on the same underlying, and each leg must independently be eligible to
use the VOL order type. For example, a BuyWrite order could not be sent as a VOL order
since its stock leg would not allow this order type.
All VOL orders must be DAY orders.

You can elect to price a Smart-routed Index Option order using reverse futures premium calculations by selecting a futures contract from the Reference Contract field.
Note: If you have changed the reference contract in the Model Navigator, VolatilityTrader will used the new contract as the default
reference contract.

5. To have the workstation calculate a limit price for the option or combination order based on
your volatility input, enter a value in the Order Volatility field. The value shown in the Imp
Vol field is calculated via the Model Navigator.
6. To transmit the order, click the "T" in the Transmit field, or the Transmit icon on the trading
toolbar.
Field

Description

Volatility

If desired, enter a volatility to use in calculating a limit price for the option. If
blank, the calculation will use the volatility derived via Option Analytics.

Volatility
Type

Select from Daily or Annual volatility.

Hedge
Order
Type

Select an order type. The application will send an order against the executed
option trade to maintain a delta neutral position. Use the Hedge Aux. Price field to
set a price for orders that require one. Note that for index options, you will need to
select a futures contract for use in a hedge delta trade.
Alternately, you can use the right-click menu to attach a Delta Hedge order and
set the hedging attributes from the new order line.
Please note that if you select Continuous Update, the system will use the delta
associated with the parent order, which is calculated from the user-defined Implied
Volatility specified at the time of the most recent order modification or price
update, instead of using the current delta of the option based on market data at the
time of trade.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the
time the parent order fills, and the best available price is used as the limit price
(best ask for a buy and best bid for a sell).

Hedge Aux.
Price
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Used in conjunction with the Hedge Order Type field. If you have selected an
order type that requires you to define a price, for example a relative order, use this
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field to set the price.
Continuous
Update

Check this selection to continuously update the price of the order if the price of the
underlying instrument changes significantly. Note that you can only check
Continuous Update for three active orders at a time.
You will be subject to cancellation fees for order modifications that are made by
the system when you have the Continuous Update mode enabled.

Reference
Price Type

Elect to use the NBB (bid) when buying a call or selling a put; the NBO (ask)
when selling a call or buying a put; or the average of the best Bid and Ask. This
price is also used to compute the limit price sent to an exchange (whether or not
Continuous Update is selected), and for stock range price monitoring.

Stock Price
Monitoring

Undrl. Range (Low) - enter a low end acceptable stock price relative to the selected option order. If the price of the underlying instrument falls BELOW the lower
stock range price, the option order will be cancelled. Merely touching the price
does not cancel the order.
Undrl. Range (High) - enter a high end acceptable stock price relative to the
selected option order. If the price of the underlying instrument rises ABOVE the
upper stock range price, the option order will be cancelled. Merely touching the
watermark does not cancel the order.

Reference
Contract

TWS Users' Guide

Used for smart-routed Index Option volatility orders. This field allows you to
select the futures contract to use for calculating the implied volatility. To activate
this feature, use the Volatility and Analytics page in Global Configuration and
selectPrice index options relative to futures contract.
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Attach a Delta Hedge Order
Attach a delta hedge order to an options order, and as an alternative to setting a hedge order attribute in the original Volatility order line.

To attach a Delta Hedge order
1. From the right-click menu, select Attach and then select Delta Hedge.
A new linked delta hedge order line displays. The link between the parent and child orders
is illustrated in the Key field.
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2. Select an order type for the hedging order (Limit, Market or Relative).

Please note that when you attach a delta hedge order to a Volatility order with Continuous Update or to a Relative/Pegged-to-Stock order, the system will use the delta associated with the parent order instead of using the
current delta of the option based on market data at the time of trade. For Volatility orders, this delta is calculated
from the user-defined Implied Volatility specified at the time of the most recent order modification or price
update. For Relative/Pegged-to-Stock orders, this is the delta specified by the user.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the time the parent order fills, and
the best available price is used as the limit price (best ask for a buy and best bid for a sell).
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Volatility Trading
The Volatility order type lets you create option orders where the limit price is calculated as a function of an option volatility that you can modify. If you did not create the order from the VolatilityTrader, you can activate the Volatility tab by selecting VOL as the order type on the Basic tab. If
you have attached a delta hedge order from the trading window, you can view the order parameters
on the Hedging tab.

To remove tabs and view all fields on a single large page, select the
Comprehensive view.
Field

Volatility
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the Imp Vol field is calculated via the Model Navigator.
Continuously
Update Limit
Price

When checked, the option price is automatically updated as the underlying stock price
moves.

Precautionary
Settings

Set these price cap “double-checks” as a precaution to ensure your order price remains
within an acceptable distance from the market.

Volatility
Type

Elect to view daily or annual volatility.

Hedge Delta

Select a Hedge Order Type. An order will be submitted against the executed option
trade to maintain a delta neutral position.
For index options, you can define the Hedging, or reference, contract. If you have modified the reference contract in the Model Navigator, the modified contract will be used
as the new default reference contract for the order.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the time
the parent order fills, and the best available price is used as the limit price (best ask
for a buy and best bid for a sell).
Use the Hedge Auxiliary Price field to set an auxiliary price for orders that require
one, such as the offset for a Relative order.

Reference
Price Type

Bid or Ask - If selected, use the NBB (bid) when buying a call or selling a put and the
NBO (ask) when selling a call or buying a put.
Average - uses average of the best Bid and Ask. This price is also used to compute the
limit price sent to an exchange (whether or not Continuous Update is selected), and for
underlying range price monitoring

Reference
Contract

Select a futures contract to use in calculating the index value. The order price is then
derived from this index value.

Underlying
Price Monitoring

Underlying Range (Low) - enter a low end acceptable stock price relative to the selected option order. If the price of the underlying instrument falls BELOW the lower
stock range price, the option order will be cancelled. Merely touching the price does
not cancel the order.
Underlying Range (High) - enter a high end acceptable stock price relative to the selected option order. If the price of the underlying instrument rises ABOVE the upper
stock range price, the option order will be cancelled. Merely touching the watermark
does not cancel the order.
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Algos
AlgoS helps to balance market impact with risk to get the best price for large volume orders. Our
growing family of algos includes the following:
l

Accumulate Distribute

l

Option Portfolio

l

ScaleTrader

l

IBAlgos

l

CSFB Algos

l

Jefferies Algos
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Accumulate Distribute
Use the Accumulate/Distribute algo to buy or sell large quantities in smaller, random sized increments over time, minimizing market impact. This algo supports multiple asset classes including
stocks, options, futures, forex, and combination orders.
Customize the basic algo with conditions to meet your specific views on the market. Multi-account
users will see the Account selection list at the top of the algo page.
Note: Orders submitted via Accumulate/Distribute currently are active only while
you are logged into TWS and stop when you log out. When you log back into
TWS, answer “Yes” when asked if you want to reactivate the algo. If you
answer “No” your Accumulate/Distribute algo orders are deleted.

Get Started
Define the Algorithm
Basic Algorithm Example
Using Templates
Define Algo Conditions
Create Multiple Algo Orders
Transmit and Modify the Algo
Monitor the Order Progress
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Accumulate Distribute

Get Started
The Accumulate/Distribute algo works to get the best price for your large volume orders while
attempting to minimize market impact. It achieves this by slicing large orders into smaller components, and accumulating or distributing over time based on your pre-defined order parameters.
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The algo window is divided into four major sections:
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l

l

Accumulate Distribute

The Algorithm area, where you define the basic parameters of the order.
The Conditions area, where you specify conditions about price, position and market behavior
that must remain true for your order to be valid.

l

The order Summary, which displays continuous real-time order progress.

l

The Control buttons, which you use to start and stop the algo and apply changes.

It also includes the Orders, Trades and Log panels, and the Quote panel to define the contract.
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To open the Accumulate/Distribute window
l

From the New Window dropdown scroll to the More Advanced Tools menu and then scroll up
to Accumulate/Distribute.
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Define the Algorithm
The Algorithm area is where you set up basic parameters of the algo. Fields shaded pink are
required.

Numbered descriptions below correspond to the numbered fields in the image above.
1. Select the action, BUY or SELL.
2. Enter the total order quantity, for example 1,000,000.
3. Define the size component for each increment. For example, you may want to trade the
1,000,000 share order in 500-share increments.
4. Specify the timing of order submission for the components, in seconds, minutes, or hours. For
example, you may want to accumulate 1,000,000 shares in 500 share increments every 30
seconds.
5. Select the order type. The fields to set the price depend on the order type you select. For stock orders,

choose from:
l

l

l

Market - the order will attempt to fill at the current market price.
Limit - set a limit price with an optional offset amount which must be met or bettered for
the order to fill.
Relative - Set an optional offset amount, and specify a cap. The quote adjusts automatically based on your criteria as the market moves.
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l

RPI (Retail Price Improvement) - For stocks only. This order type is similar to a Relative
order but requires an offset of higher than zero.

6. Select time in force.
7. Set order price to ...(for RELATIVE orders) For BUY orders, use the bid plus any amount. For
SELL, use the ask minus any amount. To use only the bid/ask with no offset you must enter “0.”
This field is only visible for REL orders only and works with the following field:
8. ...but not higher than - For RELATIVE orders, this is the price cap, which works in conjunction with the

price calculation set in the previous field.
- For LMT orders, the field is “Set limit price to:...”
- For MKT this field does not display.
Choose from the following calculations to ensure the limit price will not be set higher than (for a buy) or
lower than (for a sell):
l

None - for REL orders only. There is no cap on the price.

l

Value - opens a field to set an absolute limit price.

l

l

l

l

l

l

l

l

l

l

Mark Price - this is a static value shown in parentheses plus or minus an offset. This price
will not move with the order.
Bid - bid plus/minus an optional offset amount. Enter a negative value to effect a minus
offset.
Ask - ask plus/minus an optional offset amount. Enter a negative value to effect a minus
offset.
Last - the last traded price plus/minus an optional offset amount. Enter a negative value
to effect a minus offset.
VWAP - the VWAP plus/minus an optional offset amount. Enter a negative value to effect
a minus offset.
Mov VWAP - the moving VWAP (of the current contract) over the past [specified time
period] plus/minus an optional offset amount. Enter a negative value to effect a minus offset.
Mov Avg - the moving average (of the current contract) over the past [specified time
period] plus/minus an optional offset amount. Enter a negative value to effect a minus offset.
Exp Mov Avg - the exponential moving average (of the current contract) over the past
[specified time period] plus/minus an optional offset amount. Enter a negative value to
effect a minus offset.
My Last Trade - the price of the last trade in the algo, shown as the Last Trade Price in the
order Summary block. Note that this value cannot be used for the limit price alone since
it would have no price for the first trade.
Relative to size traded - calculates the price cap as: user-defined base price minus userdefined offset value per number of shares relative to the total size traded in the algo,
which is reflected in the Shares bought field of the algo Summary block. For example, if

TWS Users' Guide

362

Algos

Accumulate Distribute

the values are: $5.50 - .02 per 100 shares, the cap price for the first 100-share order
where Size Traded = 0 would be $5.50. Assuming the trade continues to execute in 100share increments, the price cap would changes as follows: Size Traded = 100 cap =
$5.48; Size Traded = 200 cap = $5.46; Size Traded = 300 cap = $5.44.
l

Relative to position - calculates the price cap the same as Relative to size traded except
that the calculation is relative to the position as specified in the Account window and the
Position column, while the size traded is relative to what happens only in the Accumulate/Distribute algo.

9. Enter the value that corresponds to the selection above.
10. For Relative and Limit orders, click and to add more price conditions to the “but not higher
than/not lower than” price capping calculation. When you add multiple price-bounding conditions, a new “Greatest of/Least of” selection appears for you to ensure the order price will not
be higher(lower) than the greatest of/least of Condition A and Condition B and Condition C etc.
11. Start time - by default, the start time is set to the current time, or to the next open if the markets are currently closed. Click in the field to set a new start time, but note that the algo will not
start until you hit the Start button.
12. End time - by default, the end time is set to closing time of the current day, or to the next close
is the algo is started outside of regular trading hours. Click in the field to set a new end time.
13. Modify the time zone if desired.
14. Wait for current order to fill before submitting next order - if checked, the next component will
be held until the current quantity fills. The countdown until the Time of next order stops while
the algo waits for the current order to fill. Once it fills, the next order is submitted if the specified time interval has elapsed.
15. Catch up in time - if checked and the algo falls behind, the next order will be placed immediately after the current order fills, disregarding the time interval. This process will repeat until
the algorithm has caught up. Missed orders are tracked in the algo Summary block.
Note: After one order fills, there is always a delay of two seconds before the
next order is submitted.
16. Randomize time period by +/- 20% - if checked, the time interval you specified will be
increased or decreased randomly by up to 20% in either direction, to help keep the order from
being noticed in the market. For example, if your defined time interval is 40 seconds, randomizing allows the algo to submit orders at intervals of 32, 33, 34, 35, 36, 37, 38, 39, 40, 41,
42, 43, 44, 45, 46, 47 or 48 seconds.
17. Randomize size by +/- 55% - if checked, the increment size you specified will increase or
decrease randomly by up to 55% (rounded to the nearest 100) in either direction, to help keep
the order from being noticed in the market. For example, if your defined increment is 500
shares, randomizing allows the algo to submit orders in random increments of 200, 300, 400,
500, 600, 700 or 800 shares.
18. Allow this order to be filled outside of regular trading hours - if checked order may fill
outside regular trading hours.
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19. If the bid/ask is ____ or higher - for a buy order, if the current offer size is greater than or
equal to the size entered here AND the price is the same or better than the entered price, the
algo will take the entire size, or as much as will not exceed the total order quantity. This order
is submitted as IOC (Immediate-or-cancel).

TWS Users' Guide

364

Algos

Accumulate Distribute

Basic Algorithm Example
The populated fields in the image below translate to the following:
Buy 500,000 shares in size increments of 200 every 25 seconds. Set the price to the current best bid,
but don’t pay any more than the ask price. Let the algo run until it fills or is canceled.Wait for the current size component to fill before submitting the next increment, and if the algo falls behind schedule
catch up in time by submitting increments immediately after a fill instead of honoring the time interval. Mix up the time intervals by adding and subtracting 20%, and make the order size less uniform
by adding/removing 55% on each order, rounding to ensure no odd lots. If a large size order hits the
market with a size of 200,000 or more and a price of 421.00 or better, take the entire offer without
exceeding the original total order quantity or 500,000.
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Using Templates
You can save the basic algorithm settings in a named template to help you save time defining multiple
Accumulate/Distribute algo orders. Please note that the template only saves the basic algo settings,
not the conditions, since conditions are contract-specific and would not translate across different algo
orders.

Save Settings as a Template

After you have defined the basic algo settings described in the Define the Algorithm section, you may
elect to save these parameters for use with another Accumulate/Distribute algo order.
To save a template
1. From the Template command in the title bar, Save Template As.
2. Enter a descriptive name for the template (for example Buy 20000 or Sell 1,000,000) and click
OK.
To use an Accumulate/Distribute template
l

From the Template command in the title bar, select Load Template.

If you make changes to an existing template after you load it, you have the choice to either Save Template which saves your changes to the existing template, or Save Template As to create a new template.

TWS Users' Guide

366

Algos

Accumulate Distribute

Define Algo Conditions
Note that the more conditions to be met, the more difficult it may be for your order to completely fill
or to fill according to schedule.

All of the conditions are optional, but if you elect to set a condition, any unfilled fields in the definition
become mandatory and are shaded pink.
To clear the values from a condition, click the “x” at the end of the line. The “x” only appears when
you have entered data in a field.
Numbered descriptions below correspond to the numbered fields in the image above.
1. Specify whether you want untrue conditions (when set) to permanently stop the algo, or to stop
it temporarily and resume if/when conditions become true.
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2. Define a range within which the contract price must stay for the order to continue working.
3. Ensure that the price movement will not be affected by news stories by entering a value in
minutes. Until there has been no news for your defined time period as the algo will not work.
News is monitored by the news suppliers you have set up in TWS, including Google News,
Yahoo! Headlines and the Reuters subscription service.
4. Specify that your position, as reflected in the Account window and Position column, must be
greater than or less than a specified value. This acts as a floor or ceiling for the position. Not
only will TWSnot place the order if the Position condition is violated, but it will not fill any order
that would leave it violated.
5. Moving averages for this contract - Define moving average criteria for the current contract. Specify that the current contract’s: moving VWAP, moving average, exponential
moving average or last over the past [specified time period] is at least a [specified percent]
greater than or less than another moving average (for the current contract) over [specified
time period]. To clear the values, click the ‘x’ at the end of the line.
6. Moving averages for - Compare two moving averages, which could be for the same contract
or for different contracts, for the same time period or for different time periods. Specify the
underlying, and then set values as in #4 above. To clear the values, click the ‘x’ at the end of
the line.
7. These three fields work together to compare the change in price of two stocks over a specified
time period, based on the difference between the stock’s price and its moving average. The
algo completes the calculation based on your inputs. To clear the values, click the ‘x’ at the end
of the line. Enter a percent value difference that must be met between the two stock calculations.
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Accumulate Distribute

Create Multiple Algo Orders
The Accumulate/Distribute algo was designed to allow a single trader to do the work of multiple
traders, and it's easy to create and monitor multiple orders from the same page.

To add another Algo
1. Click the "+" sign from the Accumulate/Distribute algo page to add a new tab.
2. On the new page, enter a symbol in the Contract field on the Quote panel and select a contract.
3. Define the algo.

To monitor all algo orders from a single page, open the Accum/Dist Summary tab.
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Transmit and Modify the Algo
Use the buttons along the bottom of the Conditions area to control the algo.

You cannot activate the algo until all required fields are filled. Missing fields are shaded pink.
Once all fields are complete you can activate the algo. Buttons works as described below:

Preview - Click to update the order line, and to display the Order Preview box.
Transmit - Transmit the order. Additionally, if you modify the order, click to apply changes to the algo. For
example, if you change the share increment from 500 to 300, the change will not be recognized until you click the
Transmit button.
Save - Saves the order for transmission at a later date.
Restore- click to restore unapplied changes to the original value. For example, you can undo your change by
clicking Restore. Once you Apply the change the Restore button is no longer available.
Cancel Order - Cancels the order.
Start - activates the algo. If you stop the algo manually, click Start to resume from where it left off.
Stop - stops the algo. This button will become active once the algo is started.
Reset - if the algo is stopped, either because it has finished or because you have manually stopped it, the Reset
button will start the algo from the beginning. If you prefer to resume the algo from where it left off, use the Start
button.
Status text: this note tells you what is happening on the current algo screen.
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Accumulate Distribute

Monitor the Order Progress
The order Summary provides real-time data to let you monitor the progress of the Accumulate/Distribute order. This data applies only to the algo on this page. Use the aggregate
Summary tab to see order management lines for all of your Accumulate/Distribute algos.

Data in the Summary block monitors the order in real time and shows the following:
1. Share submitted - Shows the number of shares that have currently been submitted.
2. Shares bought - The total number of shares bought (or sold) to date in the algo. The sliding
shading illustrates the percent of the order complete.
3. Shares remaining - The outstanding quantity.
4. Last Trade Price - The price at which the last trade in the algo filled.
5. Average price - The average price to date for the completed portion of the order.
6. Time of last size increase - The time the last component size filled.
7. Time until next size increase - The counter counts down the time until the next component
size will be submitted.
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Option Portfolio
Introduction

Use the Option Portfolio to select, analyze and trade combinations of options on any US stock or index
to achieve the user-specified values of the Greeks, including delta, gamma, vega and theta, or to compare cost/P&L for a contract or combo you would like to acquire with a simulated portfolio.
Save the Option Portfolio query to Risk Navigator to have orders generated when risk-based alarms
are triggered.
l

Get Started

l

Define and Submit the Query

l

Constrain the Query Results

l

Evaluate the Solution

l

View What-if Risk in the IB Risk NavigatorSM
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Get Started
The Option Portfolio window runs off a sophisticated back-end algorithm that mathematically optimizes an options portfolio using the defining criteria and constraints that you enter via TWSalong with
relevant economic criteria.
To open the Option Portfolio window
1. Select an underlying US stock or index on a trading page.
2. From the Trading Tools menu select Option Portfolio.
Note: If you don’t see Option Portfolio in the tools list, expand the hidden items
using the arrow at the bottom of the menu.

The Option Portfolio window opens and you’re ready to define the query. To add a tab with another
underlying to the Option Portfolio window, click the New Tab "+" icon.
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The Option Portfolio algorithm works within the user-defined query constraints, and evaluates the
comprehensive options market data (including bid and ask price and size) to minimize the sum of the
following, and find the lowest cost solution:
l

Cost to execute, as represented by the bid/ask spread for each option in the Query Results
list, specifically:
(ask - bid) x (contract multiplier) x quantity
summed over all orders in the Query Results list;

l

l

Commission charged to fully execute all orders in the Query Results list;
Cost to hold the Query Results list for a given period of time. This term is only relevant
when the Hold until date is set to a value other then the current date. In this event, the holding
cost is calculated as:

[(option value on “hold until” date) - (solution order
price for the option)] x (contract multiplier) x (signed
quantity)
summed over all orders in the Query Results list.
The algorithm continues to work and reevaluates the solution in the Query Results list every 30
seconds until the user submits the order group for execution, freezes the updates to evaluate the solution in more detail, or changes the query criteria.
Next: Define and Submit the Query
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Define and Submit the Query
Define the query by entering the quantity of the risk dimension you wish to acquire, and setting
optional specifications such as time slicing and randomization, an expiry and strike range, and an
underlying reference price range and Hold until date. You can also elect to create a Reference Portfolio and have the Option Portfolio query an optional portfolio with the same or better P&L.

To define a query
1. Select the desired objective
2. For the greeks, enter the position quantity you’d like to acquire.
The position quantity is equal to:

greek value x position x multiplier
For example, 20 long call options with a delta of .4989 would show a position Delta of
approximately 1000. The position Delta calculation is:

.4989 x 20 x 100 = 997.8 OR
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3. For a Reference Portfolio, use the Composer to define the legs of a portfolio.
4. Define any optional query parameters.
Parameter

Time-sliced
orders
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Select this option to acquire the total objective in smaller increments, with orders being submitted at user-defined time intervals of seconds, hours or minutes.
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Randomize
time period
by +/- 20%

When you check the Randomize time checkbox, the Option
Portfolio randomly changes the user-defined time interval by
any value up to as much as 20% in either direction.
For example, an order with a time interval of 30 seconds might
randomly be submitted at varying intervals of 24, 25, 26, 27,
28, 29, 30, 31, 32, 33, 34 35, 36 seconds.

Randomize
size by +/55%

When you check the Randomize size checkbox, the Option
Portfolio randomly changes the user-defined size increment by
any value up to as much as 55% in either direction.
For example, an order using increments of 500 might randomly
return orders with an objective anywhere from 275 up to 775.

Expiry Range
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Strike Range

Select the range of strikes you are willing to trade.

Reference
Price

By default, the midpoint of the bid/ask of the underlying price
is used to calculate the objective.
Enter a reference price if you prefer to use a value other than
the midpoint of the underlying price. Note that an alternate ref-
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erence price cannot be used if the Price between constraint is
used.

The Reference Portfolio used the underlying price range as a
high/low boundary when calculating P&L.

Hold until

Enter a date if you want to hold the solution in the Query Results list until a specific date.

Long/Short
options only

Checked by default. Constrains the solution to only include
long or short option trades, as appropriate. For example, when
buying or selling Delta, long options would be more appropriate to avoid the risk of being short options. The text will
change based on the objective and signed quantity. When
requesting short gamma, short vega or long theta, the text will
read “short options only.”

Allow underlying leg

Check to allow a stock leg in the proposed solution list.

5. Add other constraints if needed (see Constrain the Query Results).
6. Submit the query by clicking the Submit Query button.
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Next: Constrain the Query Results
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Constrain the Query Results
Option Portfolio allows you to constrain the query results in the risk dimensions other than the objective dimension. So, if your goal is to achieve a specific Gamma position, you will be able to constrain
the resulting Delta, Vega and Theta. The algorithm imposes the following default constraints:
C
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For example, the default Delta constraint ensures that the Gamma and Vega of the Query Results solution are positive.
To override the system defaults, enter a value in one or multiple input fields and click Submit Query.
Next: Evaluate the Solution
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Evaluate the Solution

Freeze updates to the query to evaluate the solution, and use the IB Risk NavigatorSM to see how
implementing the option portfolio will affect your current risk profile.

For the Reference Portfolio, click the P&L Charts tab to compare P&L on the query results with that of
the reference portfolio.
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To stop the algorithm from updating results
1. Click Freeze Updates to keep the algorithm from reevaluating and displaying new solutions.
Note that the data will continue to tick but the Query List will remain unchanged.
Next Step: View What-if Risk in the IB Risk NavigatorSM
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View What-if Risk in the IB Risk NavigatorSM
You can view the risk summary for the proposed Option Portfolio solution list in the IB Risk Navigator,
and add your existing portfolio to the What-if to see how acquired Greek risk dimension will affect
your existing risk profile.

The above image is querying for a basket of trades to acquire 6,000 delta. We have elected to Freeze
updates to the solution list and open the proposed list in the IB Risk Navigator. We click the Risk Navigator button, and within seconds the solution list opens in its own What-if Portfolio window, shown
below:
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To view the solution list in Risk Navigator
1. Click the Risk Navigator button to open a What-if scenario that contains the Query Results
list.
The What-if is indicated by a red border around the portfolio, and is named “Option Portfolio.”
2. Select any Report or Measure to see the isolated risk profile for the list.
You can also view the proposed solution list integrated with your current portfolio risk profile. Simply
add your portfolio to the What-if scenario from the Option Portfolio.

To add your portfolio to the What-if scenario
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1. From the Edit menu of the IB Risk Navigator, select Add From.
2. Your actual portfolio, named My Portfolio, is the default selection. Click OK.If you have created
other portfolios, you may select another from the list.
3. The positions in your portfolio are added to the What-if scenario from the Option Portfolio solution list.
Below you can see the What-if portfolio outlined in red, and below, your actual portfolio. The highlighted positions are common to both, but distinct at this point.

After you elect to Add your portfolio, the two sets of positions are summed in the new, integrated
What-if Portfolio, shown below.
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ScaleTrader
Introduction

The ScaleTrader can help prevent increasingly deteriorating prices on large sized orders. Choose to
create a simple scale order, a pair trade, or a multi-leg combo.
l

About ScaleTrader

l

Basic Scale Orders

l

Basic Scale with Profit Orders

l

Scale Profit Orders with Initial Component

l

Scale Profit with Restore Size

l

Use the ScaleChart

l

View Scale Progress

l

ScaleTrader for Pairs

l

Combo Orders

l

Scale Order Examples

l

ScaleTrader Summary
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About ScaleTrader
ScaleTrader is a flexible trading tool that implements a sophisticated trading algorithm, allowing you
to scale into a large position without being subject to increasingly deteriorating prices, or to trade continually over a specified price range to capture a user-defined profit offset amount. ScaleTrader supports all products traded at IB except Mutual Funds.
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ScaleTrader Summary and Status

Below the Scale chart, the Summary and Status sections give you more information on the current
scale order.
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The Summary shows the number of price levels in your scale, the average price of the total order,
the amount, and the range of the scale between the top and bottom prices.
The Status displays the displays the size of your filled position, and shows the latest Buy price and
Sell price working for the active scale order.
Use the Start and Stop buttons to start and stop the algo. Use Dismiss to close the ScaleTrader.
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Basic Scale Orders
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. A basic scale order might involve simply scaling into or out of a position, with or without a
profit trade.
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To create a basic scale order
1. Select the action, Buy or Sell.
2. Maximum Position - Enter the total order size. Note that this value refers only to the position
for this algo order. It does not take into account or affect any current position in the underlying
that you may hold.
3. Initial Component Size - The initial component size refers to the number of units that will be
submitted at the starting price, and is used in determining the number of components and price
levels needed to achieve the Maximum Position. The component size must be entered in round
lots.
Note: If you do not enter a value in the Subsequent Comp. Size field, this value will
be used for both initial and subsequent components
4. Subsequent Comp. Size - The number of units that will be submitted at subsequent price
levels. Must be entered in round lots.
5. Starting Price - The price at which the initial component will be submitted. The starting price
defaults to the ask, but can be changed directly in the field or by dragging the blue line in the
scale chart.
6. Price Increment - Used to define the price levels for each scale component. The increment will
be subtracted from the last price level for a buy order, and added to the last price level for a sell
order.
Note: The number of components along with the Starting Price and Price Increment
are used to calculate the Bottom Price, which is the lowest price at which any
of the order components will be submitted. If you change the Bottom Price,
the Price Increment is recalculated.
For an example of how a basic scale order like this one will behave, see Example 1: Basic Scale
Order.
To view the progress of your scale order, use the View Scale Progress feature.
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Basic Scale with Profit Orders
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. A basic scale order might involve simply scaling into or out of a position, with or without a
profit trade. The Profit taking orders are submitted against a filled order component at a specific price
level, where the price is calculated using the component price level +/- the defined profit offset.
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To create a basic scale with profit orders
1. Select the action, Buy or Sell.
2. Maximum Position - Enter the total order size. Note that this value refers only to the position
for this algo order. It does not take into account or affect any current position in the underlying
that you may hold.
3. Initial Component Size - The initial component size refers to the number of units that will be
submitted at the starting price, and is used in determining the number of components and price
levels needed to achieve the Maximum Position. The component size must be entered in round
lots.
Note: If you do not enter a value in the Subsequent Comp. Size field, this value will
be used for both initial and subsequent components
4. Subsequent Comp. Size - The number of units that will be submitted at subsequent price
levels. Must be entered in round lots.
5. Randomize Size - Check to help ensure the components are not easily detected in the market.
Resulting component sizes will be plus or minus 55 percent rounded up or down to the nearest
round lot. For a 400 component size, submitted sizes could be 200, 300, 400, 500 or 600.
Note: The Randomize feature cannot be used with profit taker orders.
6. Starting Price - The price at which the initial component will be submitted. The starting price
defaults to the ask, but can be changed directly in the field or by dragging the blue line in the
scale chart.
7. Price Increment - Used to define the price levels for each scale component. The increment will
be subtracted from the last price level for a buy order, and added to the last price level for a sell
order.
Note: The number of components along with the Starting Price and Price Increment
are used to calculate the Bottom Price, which is the lowest price at which any
of the order components will be submitted. If you change the Bottom Price,
the Price Increment is recalculated.
8. Check Create profit taking order and enter a profit offset amount.
For an example of how a basic scale order like this one will behave, see Example 2: Scale order with
Profit-Taking Orders.
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Scale Profit Orders with Initial Component
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. A basic scale order might involve simply scaling into or out of a position, with or without a
profit trade. The Profit taking orders are submitted against a filled order component at a specific price
level, where the price is calculated using the component price level +/- the defined profit offset. If
you use a higher Initial Component size, the profit orders are submitted against a component size AS
IF the components were submitted at the Starting Price + Price Increment.
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To create a scale profit order with Initial Component
1. Select the action, Buy or Sell.
2. Maximum Position - Enter the total order size. Note that this value refers only to the position
for this algo order. It does not take into account or affect any current position in the underlying
that you may hold.
3. Initial Component Size - The initial component size refers to the number of units that will be
submitted at the starting price, and is used in determining the number of components and price
levels needed to achieve the Maximum Position. The component size must be entered in round
lots.
Note: If you do not enter a value in the Subsequent Comp. Size field, this value will
be used for both initial and subsequent components
4. Subsequent Comp. Size - The number of units that will be submitted at subsequent price
levels. Must be entered in round lots.
5. Randomize Size - Check to help ensure the components are not easily detected in the market.
Resulting component sizes will be plus or minus 55 percent rounded up or down to the nearest
round lot. For a 400 component size, submitted sizes could be 200, 300, 400, 500 or 600.
6. Starting Price - The price at which the initial component will be submitted. The starting price
defaults to the ask, but can be changed directly in the field or by dragging the blue line in the
scale chart.
7. Price Increment - Used to define the price levels for each scale component. The increment will
be subtracted from the last price level for a buy order, and added to the last price level for a sell
order.
Note: The number of components along with the Starting Price and Price Increment
are used to calculate the Bottom Price, which is the lowest price at which any
of the order components will be submitted. If you change the Bottom Price,
the Price Increment is recalculated.
8. Check Create profit taking order, and enter the profit offset.
Once the price increment has been entered, the Top Price is calculated, and will be higher than the
starting price by the price increment times the number of component sizes higher the initial price is
compared to the subsequent component size. in the above example, the initial size is one component
size larger than the subsequent size, so the calculation is 1 x .02 = .02. The top price will be .02 (or
one price increment) higher than the starting price.
For an example of how a scale profit order with a larger initial component will behave, see Example
3: Scale with Profit and Initial Component size.
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Scale Profit with Restore Size
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. If you elect to Restore size after taking profit, the algo will restore the size component at
the last filled price level once the associated profit order has filled.
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To create a scale profit order with Restore Size
1. Select the action, Buy or Sell.
2. Maximum Position - Enter the total order size. Note that this value refers only to the position
for this algo order. It does not take into account or affect any current position in the underlying
that you may hold.
3. Initial Component Size - The initial component size refers to the number of units that will be
submitted at the starting price, and is used in determining the number of components and price
levels needed to achieve the Maximum Position. The component size must be entered in round
lots.
Note: If you do not enter a value in the Subsequent Comp. Size field, this value will
be used for both initial and subsequent components
4. Subsequent Comp. Size - The number of units that will be submitted at subsequent price
levels. Must be entered in round lots.
5. Randomize Size - Check to help ensure the components are not easily detected in the market.
Resulting component sizes will be plus or minus 55 percent rounded up or down to the nearest
round lot. For a 400 component size, submitted sizes could be 200, 300, 400, 500 or 600.
6. Starting Price - The price at which the initial component will be submitted. The starting price
defaults to the ask, but can be changed directly in the field or by dragging the blue line in the
scale chart.
7. Price Increment - Used to define the price levels for each scale component. The increment will
be subtracted from the last price level for a buy order, and added to the last price level for a sell
order.
Note: The number of components along with the Starting Price and Price Increment
are used to calculate the Bottom Price, which is the lowest price at which any
of the order components will be submitted. If you change the Bottom Price,
the Price Increment is recalculated.
8. Check Create profit taking order and enter a profit offset amount.
9. Check Restore size after taking profit.
For an example of how the Restore size scale feature will behave, see Example 4: Scale order with
Restore Size.
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ScaleTrader for Pairs
A pair trade involves trading two stocks simultaneously, buying one and selling the other at predefined price differences. Usually, the two stocks selected have displayed a close price relationship in
the past, or the relationship is dictated by fundamentals. When this relationship approaches a certain,
extreme level, a position is established in which the relatively overvalued stock is sold short and the
other one is bought for approximately equal dollar values. It is expected that eventually the relationship will return to a normal level, at which time the position is unwound at a profit.
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Stock-stock pair combinations can only be traded as non-guaranteed. To help increase the chances
that both legs will fill, stock-stock scale pairs can only be sent as:
l

l

LMT + MKT, where one or both legs are submitted as marketable limit orders when the combo
becomes marketable. If only one leg fills, the second leg is resubmitted as a market order.
REL + MKT, where one or both of the legs are submitted as simulated relative orders (at the bid
for a buy and at the ask for a sell). If only one leg fills, the second leg is resubmitted as a market order.

To create a scale stock pair trade based on price difference
1. Open the ScaleTrader.
l

l

From within Mosaic, use the New Window dropdown and select More Advanced
Tools and then ScaleTrader.
From within the Advanced Order Management quote monitor, use the Trading
Tools menu.

2. Select the Pair tab and click the Edit Pair button.
3. Create tickers for each of the stock-stock pair:
l

Enter the higher priced of the pair in the Buy line.

l

Enter the lower priced (but relatively overvalued) of the pair in the Sell line.

4. Choose price difference and click Create.
Note: At this point you will be required to acknowledge that the combo is non-guaranteed.
The scale chart shows the price difference between the two contracts over time. The starting price
illustrates the beginning level of price difference between the two contracts at which you want to submit an order.
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Use the ScaleChart
The ScaleChart provides a visual method of modify the scale prices. Use the lines and handles in the
chart to set the Starting Price and bottom price and have TWS calculate the price increment.

l

To move the prices, grab a line in the chart.

l

When you move the blue Starting Price line, the other lines move in the same increment.
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l

l

When you move the Bottom Price line, the Price Increment is recalculated since the distance
between the starting and bottom prices have changed. If the Initial Component is higher than
the Subsequent Component size, the Top Price is also recalculated.
If you move the top price, the Initial Component Size, Price Increment and Bottom Size are all
recalculated.
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View Scale Progress
You can monitor the progress of your scale orders using the Scale Progress box.

To View Scale Progress
l

Right-click the scale order line and select View Scale Progress.

The Scale Progress Box
The Scale Progress box displays the complete scale price ladder, the Open/Filled component list for
the parent scale order, and the Open/Filled component list for the child profit orders.
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Scale Order Examples
The data assumptions in the table below are repeated for all examples, with other variables described
as needed. These examples do not encompass all of the potential algorithmic results that would occur
on partially filled component levels.
Example 1: Basic Scale Order
Example 2: Scale order with Profit-Taking Orders
Example 3: Scale with Profit and Initial Component size
Example 4: Scale order with Restore Size
Example 5: Restart ScaleTrader
Example 6: Restart ScaleTrader with Filled Initial Component Size
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Example 1: Basic Scale Order
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Data Assumptions:
Label

Value

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial/Subsequent Component Size

400

Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

This is an order to buy 10000 shares scaled into 25 components of 400 shares each.
The first 400 share component is submitted as a buy limit order at the Starting Price of $26.28.
When the complete order fills, the next component of 400 shares is submitted at $26.26 (starting
price - price increment).
If price movement results in this order becoming unmarketable, the remainder of the order is held.
Once the price level fills, the next component for 400 shares is submitted at $26.26 (last filled price
level - price increment).
This pattern continues until all components have filled, or you cancel the order.
Basic Scale Orders topic.
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Example 2: Scale order with Profit-Taking Orders
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Data Assumptions:
Label

Value

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial/Subsequent Component Size

400

Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

Create profit taking
order

Check to enable

Profit Offset

0.20

Like example 1, this is an order to buy 10000 shares scaled into 25 components of 400 shares each.
In addition, we have instructed TWS to submit profit-taking sell orders against each order component, with a .20 profit offset. This means the profit orders will be submitted at the last filled price
level plus the .20 cent offset.
The first 400 share component is submitted as a buy limit order at the Starting Price of $26.28. When
the component order fills two things happen. The next component of 400 shares is submitted at
$26.26 (component price - price increment), and a sell order is submitted for 400 shares at $26.48
(component price + profit offset).
When the $26.26 price level fills, a sell order for 400 shares at $26.46 (component price + profit offset) is submitted. This pattern continues until all components have filled, or you cancel the order.
Note: The order will be held if any parent component becomes unmarketable, but
the profit orders can continue to work without holding up the order.
Basic Scale with Profit Orders topic.
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Example 3: Scale with Profit and Initial Component size
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Data Assumptions:
Label

Value

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial Component Size

800

Subsequent Component Size

400

Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of the
order ticket)

Create profit taking
order

Check to enable

Profit Offset

0.20

The difference between this order and the order in Example 2 is that the Initial Component Size is larger than the subsequent component size by one full size. This feature works in conjunction with the
profit taking orders, which we have enabled at an offset of $.20.
To understand the larger initial component, let’s first look at the mechanics of using the same component size of 400 with the $.02 profit offset. In this case, a BUY order would be submitted at the
starting price of $26.28 and after it fills, the profit SELL order would be submitted at the component
price + profit offset, or $26.48. When this fills, you have bought at $26.28 and sold at $26.48 for a
profit of $.20 per share.
Now let’s look at the example above with the Initial Component of 800. TWS submits the first component as a BUY order for 800 at the Starting Price, or $26.28. But when this fills, the profit sell
orders are submitted in Subsequent Component-sized lots AS IF the 800 shares were sent in as two
BUY orders at $26.28 and $26.26, right up to the non-editable Top Price. So two sell orders for 400
shares each are submitted for $26.48 and $26.46. Once these fill, the subsequent 400-share components kick in for the remainder of the 10000-share order.
Scale Profit Orders with Initial Component topic.
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Example 4: Scale order with Restore Size
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Data Assumptions:
Label

Value

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial/Subsequent Component Size

400

Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

Create profit taking
order

Check to enable

Profit Offset

0.20

Restore size after taking profit

Check to enable

The Restore Size feature restores the component size at a specific price level after the opposite side
order for the price level fills.
In this example, the order is scaled into 25 components of 400 shares each.
The first 400-share component is submitted at $26.28. After this level fills, the next limit order for
400 is submitted at $26.26, and at the same time an opposite-side profit order is submitted for 400 at
$26.48 (component price + profit offset).
Once the sell order fills at $26.48 taking the profit, the filled quantity of 400 is put back in to the original order at its same price level of $26.28, and the $26.26 price level component is canceled.
Note: When using the Restore size feature, you may want to consider making the
profit offset closer to the price increment to help ensure the orders fill.
Scale Profit with Restore Size topic.
Example 5: Restart ScaleTrader
Data Assumptions:
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Label

Value

NBBO

$10.12 - $10.15

Action

Buy

Total Order Size

1000

Initial Component Size

100

Subsequent Component
Size

100

Starting Price

$10.10

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of the
order ticket)

Create profit taking
order

Enabled

Profit Offset

.03

Restore size after taking profit

Enabled

Restart ScaleTrader

Enabled

Initial Position

200

The Restart feature helps you resume a busted ScaleTrader order from the point of the bust. A bust
results in a lost connection between the scale and profit order processes, leaving two independent
scaled orders. You can cancel these orders and create a new ScaleTrader Restart order.
The Existing Position value of 200 tells ScaleTrader that two of the components have filled, at $10.10
and $10.08, respectively. It "restarts" the scale order beginning with the 3rd component. The first buy
order is for 100, and is submitted at $10.06. The profit-taker orders are set up for all three components, 100 at $10.13, 100 at $10.11, and 100 at $10.09, which are submitted. When the sell order
for 10.13 fills, the size is restored at the 10.10 price level.
Note: The Existing Position feature is only available if the profit-taking order and
Restore Size instructions are used.
Example 6: Restart ScaleTrader with Filled Initial Component Size
A busted scale order results in a lost connection between the scale and profit order processes, leaving
only two independent scaled orders. The Restart instruction is designed to help you resume a cancelled or busted ScaleTrader order, starting from the point at which the scaled sequence left off.
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First, cancel the two separated scale orders. Next, create a new ScaleTrader Restart order by identifying your current position and telling ScaleTrader how much of the initial component size filled in the
busted order. ScaleTrader will restart the order at the appropriate component and price level.

Note: The Filled Initial Component Size field only becomes active if the Existing Position value is less than the
Initial Component Size.
Profit Offset: $0.02
Restore Size after taking profit: box checked on Order Ticket Scale tab
Restart ScaleTrader: box checked on Order Ticket Scale tab
Existing Position value: 500
Filled Initial Component Size: 1200 (this value must be greater than or equal to the Existing Position value, up to a maximum of the Initial Component Size).
The Filled Initial Component Size of 1200 tells ScaleTrader that there is an unfilled quantity of 800 (of
the 2000 Initial Component Size). The first buy order for 800 is submitted at $10.15, and profit-taker
orders of 1000 and 200 are set at $10.17 and $10.18, respectively.
Activate the Restart ScaleTrader instruction using the checkbox on the Scale tab of the Order
Ticket. This feature is only available if the profit-taking order and Restore Size instruction is used,
and if the value in the Existing Position field is less than the Initial component size.
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When using ScaleTrader for creating generic combination orders, note the following:
l

l

When you create a STK STK generic combo, the ratios are automatically simplified when you
save the combo. This means that the combo you define in the Combo Selection box to Buy 300
XYZ and sell 700 ABC ends up on the ticker line as Buy 3 XYZ and Sell 7 ABC.
Scale parameters such as Total Order Size and Initial and Subsequent Component sizes are
expressed in terms of the total combo. For example, if you buy a generic STK STK combo
defined as Buy 10 DELL, Sell 1 IBM, and set the Initial Component Size to 5, the first component
order would be: Buy (5 x 10) DELL, Sell (5 x 1) IBM.

Guaranteed combination pairs including US stock-option and option-option pairs, and which can be
traded from the Combo tab, can use the following order types:
l

l

LMT + LMT, where one or both legs are submitted as marketable limit orders when the combo
becomes marketable. If one fills, the other is resubmitted as a limit order.
REL + LMT, where one or both of the legs are submitted as a simulated relative order (at the bid
for a buy and at the ask for a sell). If only one leg fills, the second leg is resubmitted as a limit
order.
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l

ScaleTrader

LMT + MKT, where one or both legs are submitted as marketable limit orders when the combo
becomes marketable. If only one leg fills, the second leg is resubmitted as a market order.
REL + MKT,where one or both of the legs are submitted as a simulated relative order (at the bid
for a buy and at the ask for a sell). If only one leg fills, the second leg is resubmitted as a market order.

Use ScaleTrader for combination orders
1. Click the Combo tab in ScaleTrader.
2. If you opened ScaleTrader with an underlying selected, click the Edit Combo button; otherwise,
enter an underlying and select from the combo type, including EFP, Futures Spread or Option
Combo.
3. Use the ComboTrader box to define a strategy, and click Create.
You can monitor the progress of your scale orders by right-clicking on the order line and selecting
View Scale Progress.
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Use the Scale Summary page to view real-time status of your scale orders, including filled and total
quantity, filled, remaining, and total value, and the percent filled for each scale. The Scale Summary
is a system-generated page with its own layout.

To create a Scale Summary
1. Use the right-click menu fromAdd Tab indicator and select ScaleTrader.
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IBAlgos
Introduction

Use IBAlgos to implement optimal trading strategies which help balance market impact with risk to
achieve the best execution for larger orders.
l

Create IBAlgo Orders

l

Arrival Price

l

Dark Ice

l

Percentage of Volume Strategy

l

VWAP

l

TWAP

l

Minimize Impact

l

Balance Impact and Risk
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Create IBAlgo Orders
Use IBAlgos to automatically balance market impact with risk on your large volume orders. You can
create algo orders from the trading window or using the Order Ticket.

To set up an IBAlgo order
1. On the trading page, create an order by clicking the Ask price for a Buy order or Bid price for a
Sell order.
2. Click in the Destination field in the order line, scroll downs to the Algorithms section and select
IBALGO.Note: You must use the order Destination field, not the market data
Exchange field.
3. In the Algo fields, define the algorithm. Only those strategies valid for the instrument type will
appear in the strategy selection list. Based on the strategy you select, the necessary parameters will display.
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Arrival Price
This strategy is designed to achieve or outperform the bid/ask midpoint price at the time the order is
submitted, taking into account the user-assigned level of market risk which defines the pace of the
execution, and the user-defined target percent of volume.

l

l

l

l

l

Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
Urgency/Risk Aversion - select from the most aggressive Get Done to the least aggressive
Passive. This value determines the pace at which the order will be executed. High urgency may
result in greater market impact.
Start time/End time - change the default times at which the submitted order will start to work
and be canceled using the Start/End Time fields. The End Time supersedes the time in force.
Note that the algo will stop at the designated end time regardless of whether the entire quantity
has filled unless you check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified end
time, but will continue to work past the end time to execute any unfilled portion. This feature
only applies when an End Time has been specified.
Attempt completion by EOD - if checked your order will be execute by the end of day if possible.
Please note that a portion of your order may be left un-executed if the risk of the price changing
overnight is less than the extra cost of executing the whole order today regardless of whether
the EOD box is checked.

For more information on IBAlgos, see the IB Order Types and Algospage.
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Dark Ice
The Dark Ice algo is similar to an iceberg or reserve order, as it allows the user to specify a display
size different from the order size, which is shown in the market. Additionally, the algo randomized
the display size +/- 50%, and based on the calculated probability of the price moving favorably, it
decides whether to place the order at the limit price or one tick better.

l

l

l

Display Size - enter a size that you want displayed to the market. Note that the algo will randomize the size by 50% on either side.
Start time/End time - change the default times at which the submitted order will start to work
and be cancelled using the Start/End Time fields. The End Time supersedes the time in force.
Note that the algo will stop at the designated end time regardless of whether the entire quantity
has filled unless you check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified end
time, but will continue to work past the end time to execute any unfilled portion. This feature
only applies when an End Time has been specified.

For more information on IBAlgos, see the IB Order Types and Algospage.
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Percentage of Volume Strategy
Allows you to participate via volume at a user-defined rate. Order quantity and volume distribution
over the day is determined using the target percent of volume you entered along with continuously
updated volume forecasts calculated from TWS market data.

l

l

l

Target Percentage - enter the target percentage of participation in average daily volume.
Start time/End time - change the default times at which the submitted order will begin to work
and be cancelled using the Start/End Time fields. Note that the algo will stop at the designated end time regardless of whether the entire quantity has filled.
Attempt to never take liquidity - check to ensure the algo order will not hit the bid or lift the
offer if possible. This may help to avoid liquidity-taker fees, and could result in liquidity-adding
rebates. However, it may also result in greater deviations from the benchmark.
Note: IB will use best efforts not to take liquidity, however, there will be times that
it can not be avoided.

For more information on IBAlgos, see the IB Order Types and Algospage.
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VWAP
Designed to achieve or outperform the VWAP price, calculated from the time you submit the order to
the close of the market.

l

l

l

Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
Start time/End time - change the default times at which the submitted order will start to work
and be cancelled using the Start/End Time fields. The End Time supersedes the time in force.
Note that the algo will stop at the designated end time regardless of whether the entire quantity
has filled unless you check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified end
time, but will continue to work past the end time to execute any unfilled portion. This feature
only applies when an End Time has been specified.
Note: If you specify and Start and End time, TWS confirms that acceptability of the
time period using yesterday’s trading volume. If the time period you define is
too short, you will receive a message with recommended time adjustments.

l

Attempt to never take liquidity - check to ensure the algo order will not hit the bid or lift the
offer if possible. This may help to avoid liquidity-taker fees, and could result in liquidity-adding
rebates. However, it may also result in greater deviations from the benchmark.
Note: IB will use best efforts not to take liquidity, however, there will be times that
it can not be avoided.

For more information on IBAlgos, see the IB Order Types and Algospage.
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TWAP
Designed to achieve the time-weighted average price calculated from the time the order is submitted
to the close of the market.

Trade when - select from:
l

l

l

l

l

l

Marketable - the default value indicates that the order will be submitted when it is marketable,
based on your limit price.
Matching Midpoint - the order will be submitted when the limit price = midpoint of the bid/ask.
Matching Same Side - the order will be submitted when the limit price = the price on the same
side as your order (either the bid or the ask).
Matching Last - the order will be submitted when the limit price = last price.
Start time/End time - change the default times at which the submitted order will start to work
and be cancelled using the Start/End Time fields. The End Time supersedes the time in force.
Note that the algo will stop at the designated end time regardless of whether the entire quantity
has filled unless you check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified end
time, but will continue to work past the end time to execute any unfilled portion. This feature
only applies when an End Time has been specified.

For more information on IBAlgos, see the IB Order Types and Algospage.
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Minimize Impact
Designed to minimize market impact by slicing the order over time as defined by the Max Percentage
value. This algo applies to Options only.

l

Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.

For more information on IBAlgos, see the IB Order Types and Algospage.
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Balance Impact and Risk
Balances the market impact of trading the option with the risk of price change over the time horizon
of the order by taking into account the user-assigned level of market risk which defines the pace of
the execution, and the user-defined target percent of volume. This algo is for options only.

l

l

Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
Urgency/Risk Aversion - select from the most aggressive Get Done to the least aggressive
Passive. This value determines the pace at which the order will be executed. High urgency may
result in greater market impact.
This feature is designed to affect large orders that affect a significant percentage of the average daily volume.

l

Attempt completion by EOD - if checked your order will be executed by the end of day if possible. If not checked, a portion of your order may be left unexecuted if the risk of the price changing overnight is less than the extra cost of executing the whole order today.

For more information on IBAlgos, see the IB Order Types and Algospage.
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CSFB Algos

CSFB Algos
Introduction

To use CSFB algos, select CSFBALGO as the routing destination.
l

Crossfinder

l

Float

l

Guerrilla

l

Pathfinder

l

Reserve

l

Strike

l

Tex

l

TWAP

l

VWAP

l

Work It

l

Work It IW

l

10B 18
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Crossfinder
This strategy locates liquidity amongst a broad list of dark pools, with continuous crossing capabilities. Using dynamic smart routing logic, CrossFinder will spread your order over multiple destinations. This algo will fill at the midpoint or better, and may not execute.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Float
This tactic displays only the size you want shown and floats on the bid, midpoint, or offer until completion. Enter a display size and choose a patient, normal, or aggressive execution.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Guerrilla
The GUERRILLA algo works differently depending on the Execution Style you select.
l

l

Normal and Passive modes: This tactic works orders without displaying bids or offers. When
liquidity materializes, it seeks to aggressively participate in the flow. If liquidity is poor, the
order may not complete.
Aggressive mode: This will hit bids/take offers in an intelligent way based on a fair price model.
It never posts bids or offers.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Pathfinder
This tactic gives you direct market access via Credit Suisse’s smart order routing infrastructure.
Orders routed through PathFinder are routed immediately to various destinations with the best price
and liquidity. Credit Suisse will simultaneously sweep all available liquidity and post the remainder at
your limit price. PathFinder will intelligently and dynamically post across multiple destinations.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Reserve
Displays the size you want shown at your price instruction (market or limit). Upon getting filled, it
sends out the next piece until completion.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Strike
This is a very aggressive tactic that will hit bids/take offers that are better than your limit price, but
will never post bids or offers. It achieves high participation rates. Note it is not a pure sweep and can
sniff out hidden liquidity. As a result, it is often a better choice than placing a limit order directly into
the market.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Tex
Designed to minimize implementation shortfall. The tactic takes into account movements in the total
market and in correlated stocks when making pace and price decisions. Timing is based on price and
liquidity.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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TWAP
The system trades based on the clock, i.e., on a 2 hour order the system is 25% done after 30
minutes, 50% done after an hour, etc. Unlike VWAP, TWAP (time weighted average price) does not
speed up/slow down based on projected volume or price moves. However, it does use smart limit
order placement strategies throughout the order.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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VWAP
System attempts to match the VWAP (volume weighted average price) from the start time to the end
time. A unique and powerful feature is the ability to accept a maximum percent volume limit (“don’t
be more than 20% of the volume.”) The system trades over your time period, subject to your price
and volume constraints.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Work It
The objective is to get the trade done at or better than the arrival price, which is the price at the time
the order was entered. Participation rates will vary based on price and other factors. You can control
the participation rate using minimum and maximum % volume constraints. The order may finish
before your end time if there is sufficient liquidity.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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Work It IW
This tactic is aggressive at or better than the arrival price, but if the stock moves away it works the
order less aggressively. However, if the stock moves in your favor, it will act like Strike and quickly
get you done. This tactic does not accept maximum or minimum % volume. Use regular Work It if
you need to control participation rate.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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10B 18
This Corporate Buy Back tactic will assist the trader in managing the execution of a corporate buy
back order by conforming to the price test rules as set forth by SEC Rule 10b-18. The trading benchmark for the Corporate Buy Back tactic is the volume weighted average eligible price from the start
of the trade to the end. The Corporate Buy Back tactic does not guarantee it will finish the entire order
because of the price tests.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.

TWS Users' Guide

451

Algos

Jefferies Algos
Introduction

To use Jefferies algos, select JEFFALGO as the routing destination.
l

Buyback

l

Post

l

Seek

l

Strike

l

TWAP

l

Volume Participation

l

VWAP
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Buyback
This strategy provides volume-participation trading to issuers seeking safe harbor (SEC Rule 10b-18)
in stock repurchases.

To use Jefferies algos, select JEFFALGO as the routing destination from the Basic tab on the Order
Ticket. Set up algo parameters from the JEFFALGO tab.
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Post
This strategy can limit the impact of large orders by using the Display Size to show only a small slice
of the order to the markets.

To use Jefferies algos, select JEFFALGO as the routing destination from the Basic tab on the Order
Ticket. Set up algo parameters from the JEFFALGO tab.
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Jefferies Algos

Seek
This strategy pursues best execution for illiquid securities by seeking out hidden liquidity from multiple sources, including hidden and displayed market centers.

To use Jefferies algos, select JEFFALGO as the routing destination from the Basic tab on the Order
Ticket. Set up algo parameters from the JEFFALGO tab.
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Strike
This strategy seeks best execution in the user-designated time period, while minimizing market
impact and volatility cost and tracking the arrival price.

To use Jefferies algos, select JEFFALGO as the routing destination from the Basic tab on the Order
Ticket. Set up algo parameters from the JEFFALGO tab.
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TWAP
This strategy spreads transactions evenly over the designated time period by slicing the total order
quantity into smaller orders.

To use Jefferies algos, select JEFFALGO as the routing destination from the Basic tab on the Order
Ticket. Set up algo parameters from the JEFFALGO tab.
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Volume Participation
This strategy allows the user to designate the percentage of stock to be executed during a specified
period of time to keep in line with the printed volume. The impact of the trade is directly linked to the
volume target you specify.

To use Jefferies algos, select JEFFALGO as the routing destination from the Basic tab on the Order
Ticket. Set up algo parameters from the JEFFALGO tab.
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Jefferies Algos

VWAP
This strategy automatically manages transactions to achieve the all-day or intra-day VWAP through a
proprietary algorithm.

To use Jefferies algos, select JEFFALGO as the routing destination from the Basic tab on the Order
Ticket. Set up algo parameters from the JEFFALGO tab.
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Order Types
TWS offers over 50 different order types, comprising basic and advanced orders, algos, attributes
and times in force.
l

Basic Order Types

l

Advanced Order Types

l

Attached Orders

l

Volatility Orders

l

Times in Force

TWS Users' Guide

460

Order Types

Basic Order Types

Basic Order Types
l

Limit

l

Market

l

Stop

l

Stop Limit

l

Limit if Touched

l

Market if Touched

l

Limit-On-Close

l

Market-On-Close

l

Market-to-Limit

l

VWAP
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Limit
A limit order is an order to buy or sell a contract ONLY at the specified price or better.
To create a Limit order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select LMT as the order type.
3. In the Lmt Price field, enter the price at which you want the order to execute.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of limit orders and the products and exchanges on which they're supported, visit the Order Typesinformation page.
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Basic Order Types

Market
A market order is an order to buy or sell an asset at the bid or offer price currently available in the
marketplace. When you submit a market order, you have no guarantee that the order will execute at
any specific price.
To create a Market order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MKT as the order type.
3. To transmit the order, click the "T" in the Status field.

For a more detailed description of market orders, visit the Order Typesinformation page.
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Stop
A Stop order becomes a market order to buy or sell securities or commodities once the specified stop
price is attained or penetrated. A Stop order is not guaranteed a specific execution price.
To create a Stop order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select STP as the order type.
3. Enter the Stop Election price in the Aux. Price field.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of stop orders, visit the Order Typesinformation page.
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Basic Order Types

Stop Limit
A Stop Limit order is similar to a stop order in that a stop price will activate the order. However,
unlike the stop order, which is submitted as a market order when elected, the stop limit order is submitted as a limit order. Use the Lmt Price and Aux. Price fields on the trading screen to enter
orders requiring multiple prices or values.
To enter a Stop Limit order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL
order.
2. Click in the Type field and select STP LMT as the order type.
3. Enter the Limit price in the Lmt Price field.
4. Enter the Stop Election price in the Aux. Price field.

You can enable the system to automatically adjust the limit price if you change the stop price. To activate this
feature, on the Edit menu select Global Configuration and then select Order in the left pane. Check Auto-adjust
limit price for STP LMT and LIT orders. The limit price will move based on the offset implied when you set the
original limit and stop election prices.
For a more detailed description of stop limit orders, visit the Order Typesinformation page.
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Limit if Touched
A limit if touched order is designed to buy (or sell) a contract below (or above) the market, at the
limit price or better. The Aux. Price value is the trigger to submit the limit order at the specified limit
price.
To create a Limit if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select LIT as the order type.
3. In the Lmt Price field, enter the price at which you want the order to execute.
4. In the Aux. Price field, enter the "touched" price to trigger the order.
5. To transmit the order, click the "T" in the Status field.

For a more detailed description of Limit if Touched orders and the products and exchanges on which
they're supported, visit the Order Typesinformation page.
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Market if Touched
A market if touched order is designed to buy (or sell) a contract when the market goes below (or
above) the current price. The Aux. Price value is the trigger to submit the market order.
To create a Market if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MIT as the order type.
3. In the Aux. Price field, enter the "touched" price to trigger the order.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of Market if Touched orders visit the Order Typesinformation page.
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Limit-On-Close
An LOC (limit-on-close) order will fill at the closing price if that price is at or better than the submitted
limit price. Otherwise, the order will be canceled.
To create an LOC order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select LOC as the order type.
3. To transmit the order, click the "T" in the Status field.

For a more detailed description of LOC orders, visit the Order Typesinformation page.
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Market-On-Close
An MOC (market-on-close) order will execute as a market order as close to the closing price as possible.
To create an MOC order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select MOC as the order type.
3. To transmit the order, click the "T" in the Status field.

For a more detailed description of MOC orders, visit the Order Typesinformation page.
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Market-to-Limit
A market-to-limit order is sent in as a market order to execute at the current best price. If the entire
order does not immediately execute at the market price, the remainder of the order is re-submitted
as a limit order with the limit price set to the price at which the market order portion of the order
executed.
To create a market-to-limit order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MTL as the order type.
3. To transmit the order, click the "T" in the Status field.

For a more detailed description of market-to-limit orders, visit the Order Typesinformation page.
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VWAP
VWAP (Volume-Weighted Average Price) orders are supported for large cap securities only. You can
also use the non-guaranteed VWAP Algo.
To create a VWAP order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select VWAP as the order type.
3. If desired, change the VWAP cut-off time using the TIF field.

By default, the VWAP is computed from the soonest cut-off time to the market close. To change, click the Time
Entry calendar icon to select a new VWAP cut-off, or start, time. If none is selected, the soonest cut-off is used.
In addition, you can modify the end time of the calculation using the Expiry Time field.
4. To transmit the order, click the "T" in the Status field.

A transmitted VWAP order is accepted immediately and CANNOT BE CANCELLED.
VWAP orders are automatically routed.
For a more detailed description of VWAP orders, visit the Order Typesinformation page.
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l

Stop Order with Protection

l

Trailing Stop

l

Trailing Stop Limit

l

Trailing Market if Touched

l

Trailing Limit if Touched

l

Trailing Limit + Market

l

Trailing Relative + Market
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All or None (AON)
Mark an order as "all or none" to specify that the order not execute unless the entire order quantity is
available and it can be filled in its entirety. This attribute can be applied to all order types.
To mark an order as All or None
1. Display the All or None field on your trading window:
a. Hold your cursor over a field in the order row fields until the green “+” sign appears.
Click the “+” sign to show the list of order fields.
b. In the Order Attributes category, select All or None. The field is added to the left of the
selected field.
c. Highlight All or None and click the Add button.
2. Create an order (click the Ask Price to create a BUY order, or the Bid Price to create a Sell
order).
3. Check the All or None checkbox to tag the order.

You can also apply order attributes from the Miscellaneous tab on the Order Ticket.
For an example of using an All or Noneorder, visit the Order Typesinformation page.
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Auto Trailing Stop
You can attach a trailing stop order to a limit order. The attached trailing stop order is automatically
activated when the limit order is filled.

To attach an auto trailing stop
1. Right-click on a limit order and select Attach, then select Auto Trailing Stop.
l

To modify the trailing amount, change the value in the Aux. Price field.

To change the default trailing amount used to calculate the stop election price, use the Order > Order
Defaults page of Global Configuration.
2. When the limit order executes, the trailing stop order is submitted. The stop election price will
be calculated using the (parent order limit price + trailing amount) for Buy orders, and the (parent order limit price - trailing amount) for Sell orders.
The relationship between the parent and attached order can be seen in the Trailing Key field. Related
orders are assigned the same trailing key.
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Block
A block order is a high volume order that consists of a minimum of 50 contracts at a specific limit
price.
To submit a block order
1. Click the bid or ask price field on the option for which you want to submit a block order.
2. Check the Block Order attribute. To display the attribute:
l
Hold you mouse over the Type field label until the green “+” sign appears.
l

Click the “+” sign to display the field pick list, and from the Order Attributes section
select Block Order.

3. In the Exchange field, select ISE.
4. In the Price field enter a limit price.
5. Click Transmit to send the order.
For a more detailed description of block orders and the products and exchanges on which they're supported, visit the Order Typesnformation page.
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Bracket
Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two
opposite-side orders. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop
(or stop-limit) order. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low
side buy limit order.
The order quantity for the bracketing orders is the same as that of the original order. By default, the
amount off the current price to which a bracket order is set is 1.0. This offset amount can be manually
changed on the order management line for a specific order, or you can modify the default offset
amount using the Order Preset in Global Configuration.
In addition, if you display the OCA Group field on your order line, you will see that the two child
bracket orders are automatically put into an OCA group. This means that when one of the orders
executes, the other will automatically be cancelled.
When including bracket orders in a basket, display the Key field in the BasketTrader to see the parent/child relationship between orders.

If you attach a bracket to a working order, you will need to transmit the child orders manually. However, the system does recognize that the parent and child orders are designed to work as a bundled group, which you can see
by the matching values in the Trailing Key field if you display this field on your order line. If you attach a
bracket to a working order and modify the parent, when you re-transmit the parent order the children are then
transmitted automatically.
To create a Bracket order
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1. Click the "Ask" or "Bid" price of an asset to create an Order Management line.
l
Click the Ask Price to create a Buy order.
l

Click the Bid Price to create a Sell order.

2. On the right-click menu, select Attach and then select Bracket Orders.
3. Verify that the order parameters are correct.
4. Transmit the order.
For more information on Bracket orders, visit the Order Types information page.
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Box Top
A BOX TOP order is sent in as a market order to execute at the current best price. If the entire order
does not immediately execute at the market price, the remainder of the order is re-submitted as a
limit order with the limit price set to the price at which the market order portion of the order
executed.
To create a BOX TOP order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select BOX TOP as the order type.
3. To transmit the order, click the "T" in the Status field.

Available for options routed to BOX.
For details on Box Top orders, visit the Order Typesinformation page.
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Conditional
A conditional order is an order that will automatically be submitted or cancelled ONLY IF specified criteria for one or more defined contracts are met. You can use stocks, options, futures or security
indexes to trigger a conditional order.

To create a conditional order
1. Select an order line.
2. From the right-click menu, select Modify and then select Condition.

TWS Users' Guide

480

Order Types

Advanced Order Types

3. From the Conditional tab on the order ticket click Add Condition.
4. Enter contract information for the contingent asset in the Conditional Order box.
5. Enter the trigger information for the contingent asset:
l

l

l

Select the trigger method.
Select whether the price of the contingent asset should be less than or equal to
(<=) or greater than or equal to (>=) the trigger price.
Enter the trigger price.
Note: If you select the double bid/ask trigger method, the greater than
or equal to operator (>=) will use the BID price and the less than
or equal to operator (<=) will use the ASK price.

6. Click OK. The condition appears in the Current Conditions list.
To set multiple conditions, use the Add Condition button and click AND or OR in the Current Conditions area.
Field/Button

Description

Add Condition

Invokes the Conditional Order entry box.

Delete

Deletes the selected condition.

Modify

Opens the Conditional Order entry box for the selected condition to allow you to make changes.

Allow condition to
be satisfied...

Lets the selected condition activate the order if it is satisfied
outside of regular trading hours.

Action to take...

If selected conditional order is satisfied, you can elect to have
the primary order submitted OR cancelled.
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Discretionary
A Discretionary Order attribute can be applied to a smart-routed limit order. You define a discretionary amount, which is added to or subtracted from the limit price, that increases the price
range over which the order is eligible to execute. Only the original limit price is displayed to the market.
To create a Discretionary order
1. Display the Discretionary field on an order management line:
l

l

Hold your cursor over a field in the order row fields until the green “+” sign
appears. Click the “+” sign to show the list of order fields.
In the Prices category, select Discretionary Amt. The field is added to the left of
the selected field.

2. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
3. In the Type field, select LMT as the order type.
4. Enter a discretionary amount in the Discretionary Amt field of the order line.
5. To transmit the order, click the "T" in the Status field.

For more information on discretionary orders, visit theOrder Typesinformation page.
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Funari Orders
A Funari order is submitted as limit order, with any remaining unfilled quantity resubmitted as a Market-OnClose order at the end of trading.

To create a Funari order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL
order.
2. In the Dest. field ensure that the destination is TSEJ.
3. Click in the Type field and select FUNARI as the order type.
4. Specify the limit price.
This order type is only available for stock orders direct-routed to the Tokyo Stock Exchange.
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Hidden
A Hidden order (generally a large volume order) shows no evidence of its existence in either the market data or the deep book.
To create a Hidden order
1. Display the Hidden field on an order management line:
l

l

Hold your cursor over a field in the order row fields until the green “+” sign
appears. Click the “+” sign to show the list of order fields.
In the Order Attributes category, select Hidden. The field is added to the left of the
selected field.

2. On the trading screen, create an order (click in the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).
3. Check the Hidden field.

4. To transmit the order, click the "T" in the Status field.
For a more detailed description of hidden orders, visit the Order Typesinformation page.
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IBDARK Orders
Non-marketable U.S. stock orders routed to IBDARK are tagged "post only” and are held in IB's order book
where incoming SmartRouted orders from other IB customers are eligible to trade against them.

To route an order to IBDARK
1. From the market data line of a US Stock, click the Bid to create a SELL order or the Ask to create
a BUY order.
2. In the Destination field, select IBDARK.
3. Transmit the order.
For more information on how the IBDARK order works, see the IBDARK Order Type page.
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Iceberg/Reserve
An Iceberg/Reserve order allows you to submit an order (generally a large volume order) while publicly disclosing only a portion of the submitted order at a time.
To create an Iceberg/Reserve order
1. Show the Display Size field on an order management line:
l

Hold your mouse over any order row field until the "+" sign appears to the left of
the field title.

l

Click the "+" sign to invoke the order fields dropdown list.

l

In the Order Attributes list select Display Size.

2. On the trading screen, create an order (click the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).
3. In the Display Size field, enter the quantity that you want publicly disclosed.

For a more detailed description of iceberg/reserve orders visit the Order Typesinformation page.
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ISE Stock Exchange Midpoint Match
The ISE Stock Exchange executes stock trades at the midpoint price, between the NBB (National Best
Bid) and the NBO (National Best Offer). They offer two types of midpoint match (MPM) order types:
Standard and Solicitation of Interest (SOI). The Standard MPM order can be of any size, and can be
set as either a limit or market order. You can also add the IOC (Immediate or Cancel) time in force to
this order type. The Standard order is kept completely hidden from the market.
To create a standard MPM order
1. Create a market data line for an ISE stock.
2. Create an order. Click the Bid field (for a sell order) or the Ask field (for a buy order).
3. In the Type field, choose from Market or Limit. If you select Limit, verify or modify the limit
price.
4. In the Destination field, ensure that ISE is selected.
5. Transmit the order.
For a more detailed description of ISE MPM orders, visit the Order Typesinformation page.
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Limit + Market
The LMT + MKT order type is available for certain multi-leg combinations, and when used with a nonguaranteed combination order it could help to increase the chances of all legs in the order being filled.
Initially one or more legs are submitted as limit orders, but if the first leg fills or partially fills, the
remaining legs are resubmitted as market orders.

To create a combination Limit + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
3. From the Type dropdown, select LMT + MKT.

When you select LMT + MKT, the limit price field becomes inactive and the Trigger Price field requires the
combo price input.
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Market with Protection
A Market with Protection order is sent in as a market order to execute at the current best price. If the
entire order does not immediately execute at the market price, the remainder of the order is re-submitted as a limit order, with the limit price set by the exchange to a price slightly higher/lower than
the current best price.
To create a market with protection order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MKT PRT as the order type.
3. To transmit the order, click the red "T" in the Transmit field.

For a more detailed description of market with protection orders, visit the Order Typesinformation
page.
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Minimum Quantity
Use the Minimum Quantity order attribute to ensure that the minimum specified number of units is
filled for your order.
To create a Minimum Quantity order
1. Show the Min Quantity field: Hold your mouse over any field title until the "+" and "x" Insert
and Remove icons appear. Click the "+ " to display the list of available fields. Note that if you
hover your mouse over an order field, all available order fields are displayed. If you hover over
a market data field, all available market date fields are displayed.
2. On the trading screen, create an order (click the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).
3. In the Min. Quantity field enter the minimum number of contracts that must be available for any
part of the order to execute.

Available for bonds and Smart-routed options orders.
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NYSE Closing Auction D-Quote
The D-Quote order provides greater flexibility, execution speed and enhanced representation during
the NYSE closing auction.
To create a D-Quote order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Destination field, select NYSEFLOOR.
3. In the Type field, select LMT or MKT as the order type.
l

l

Market orders will receive the closing print price.
Limit orders will receive the closing print price if the order is priced at or better than the closing
auction price.

4. To transmit the order, click the "T" in the Status field.

For a more detailed description of D-Quote orders, visit the Order Typesinformation page.
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One-Cancels-All (OCA)
For Mosaic orders, see the Advanced Orders Panel topics, One Cancels Other.
A One-Cancels-All (OCA) order is a combination of separate orders that are worked in conjunction
with one another in the marketplace. A customer enters orders as part of an OCA group, and when an
order is executed, the remaining orders in the group are canceled. If an order is partially executed,
the remaining orders in the group are reduced proportionately to the amount that was executed. If an
order is canceled before execution, the remaining orders in the group are canceled.
To create an OCA order
1. Display the OCA Group order field: Hold your mouse over any field title until the "+" and "x"
Insert and Remove icons appear. Click the "+ " to display the list of available fields. Note that if
you hover your mouse over an order field, all available order fields are displayed. If you hover
over a market data field, all available market date fields are displayed.
2. On the trading screen, create an order (click in the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).
3. Identify the order as part of an OCA group by entering a group name in the OCA Group field
(you can use any descriptive name that you want).

4. Continue to create orders, and identify each as part of the group by entering the same name in
the OCA Group field for each order you create.
5. After you have created all orders for a group, transmit the OCA order by clicking Transmit All
Orders on Page on the Trade> Transmit menu.

Because the OCA procedure is an automated process, there is no guarantee that requested cancellations and
modifications will reach the specific exchange before an order has been executed.
For a more detailed description of OCA orders visit the Order Typesinformation page.
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Passive Relative
The Passive Relative order submits a limit order at a less aggressive price than the National Best Bid
and Offer (NBBO). Your price is automatically adjusted when the market moves. For a buy order,
your bid is pegged to the NBB by a less aggressive offset amount*, and if the NBB moves up, your bid
will also move up. For sales, your offer is pegged to the NBO by a less aggressive offset, and if the
NBO moves down, your offer will also move down. In addition to the offset, you can define an absolute cap, which works like a limit price, and will prevent your order from being executed above or
below a specified level.
For passive relative orders with a "0" offset, the order is submitted as a limit order at the best
bid/ask, and will move up and down with the market to continue to match the inside quote.

If you have tooltips enabled, you can hold your mouse over the Limit price of the relative order and see the current exchange price for that order.
*The offset is the amount that will be subtraced from the best bid (for a buy order) and added to the
best ask (for a sell order) to create the limit price at which the order will be submitted.

To enter a Passive Relative order
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1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL
order.
2. Click in the Type field and select PASSV REL as the order type.
3. Enter the offset amount in the Offset Price field, or set a percent using the Pct. Offset field.
If both fields have values the higher of the two will be used as the offset. To display the Pct. Offset field, hold your mouse over the Offset Price field until the “+” and “x” icons appear, and
click the “+” icon. From the Prices category select Pct Offset.

For a more detailed description of Passive Relative orders, visit the Order Typesinformation page.
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Pegged-to-Market
Submit an aggressive order that is pegged to buy on the best offer and sell on the best bid.
To create a Pegged-to-Market order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Dest. field ensure that the destination is Island.
3. In the Type drop-down select PEG MKT.
4. If desired, modify the offset amount in the Aux. Price field.
5. To transmit, click the "T" in the Status field.

Available for stock orders direct routed to Island.
For a more detailed description of pegged-to-market orders, visit the Order Typesinformation page.
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Pegged to Midpoint
Pegged to Midpoint orders seek to execute at the midpoint of the National Best Bid and Offer (NBBO),
with the option of making the order less aggressive by using an offset amount. The offset amount is
subtracted from the NBBO midpoint for a buy order, and added to the NBBO midpoint for a sell order.
The offset for a pegged to midpoint order makes the order price less aggressive. The order price
adjusts automatically to peg the midpoint if the market moves. The price only adjusts to be more
aggressive. If the market moves in the opposite direction, the order will execute.
In addition to the offset, the limit price acts as a price cap that will prevent your order from being
executed above or below a specified level.

To create a pegged to midpoint order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL
order.
2. In the Dest. field ensure that the destination is Island.
3. Click in the Type field and select PEG MID as the order type.
4. If desired, enter an offset amount in the Aux. Price field.
This order type is only available for US Equity orders direct-routed to Island.
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For a more detailed description of pegged to midpoint orders, visit the Order Typesinformation page.
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Pegged to Stock
Sometimes referred to as Relative to Stock, a pegged to stock order specifies that the option price
will adjust automatically relative to the stock price, using a calculated value based on data you enter.

A Pegged to Stock order direct-routed to BOX puts you in BOX's Price Improvement auction.

To create a Pegged to Stock order
1. Click the Ask price to create a BUY options order, or the Bid price to create a SELL options
order.
2. Select PEG STK in the Type field. Ensure that the supporting Pegged order fields are visible.If
you don't see PEG STK in the Type list, check to be sure that your option is routed to SMART (or
an exchange that supports this order type). This order type is only valid for US Equity options.
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3. In the Delta field, enter an absolute value which will be used as a percent, eg. "5" equals 5%.
This percent value is signed positive for calls and negative for puts. This value is multiplied by
the change in the underlying stock price, and the product is added to the starting price to
determine the option price.
4. The Stock Reference Price used is the midpoint of the NBBO at the time of the order. You can
change this value if desired.
5. Define an optional high/low stock range if desired. If the stock price moves outside of the
range, your order will be canceled. Use the Underlying Range (High) and Underlying Range
(Low) fields.
6. The Starting Price for the option order is the midpoint of the option NBBO at the time of the
order. You can change this value if desired.
When you create a pegged to stock order using the Order Ticket, use the Basic tab to select the order
type and set the Starting price. Use the Pegged tab to set the Stock Ref. price, the high and low underlying range limits, and the Delta value.
For more details and an example of a pegged-to-stock order, visit the Order Typesinformation page.
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Pegged to Benchmark
Similar to a Pegged to Stock (sometimes known as Relative to Stock) order, a Pegged to Benchmark order specifies that the order price will adjust automatically relative to changes in the price of a user-specified reference
asset. To determine whether the reference asset price has changed, the system monitors changes to the Last
price for indexes, and changes to the Bid (for buy orders) and to the Ask (for sell orders).

To create a Pegged to Benchmark order
1. From the Quote Monitor, click the Bid for SELL order, click the Ask for a BUY order.
2. From the Type field in an order line select PEG BENCH.
3. Within the inline algo parameters you can define the following fields:
l

l

l

l

l

l

With a starting price of: Enter the price for the current order. By default the starting price
for a Buy order = bid (at the time the order is created), for a Sell order = ask (at the time the
order is created).
Decrease price by/Increase price by: Specify an offset by which the price will increase/decrease in response to the same-direction movement in the price of the reference contract.
For every price decrease (or increase) of: Enter the reference contract price-change
increment that will drive the increase/decrease of the order price.
in reference contract: Enter the underlying symbol for the reference contract.
Starting reference price is: You must enter a starting price for the reference contract. The
reference price is the current bid (for a buy order) and the current ask (for a sell order).
Order will be active only while reference price is between: If desired, set a defining
"valid" price range for the reference contract. If the price moves outside the defined range, the
order will be canceled.

4. Click Transmit to send the order.
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Price Improvement Auction
For options routed through BOX, you may elect to participate in the Price Improvement Auction to better your price.
To submit a Price Improvement Auction order
1. Create an options order routed to BOX.
2. In the Type field, select either LMT, REL, or PEG STK.
l
For Limit orders, enter the limit price in the Lmt. Price field in penny increments.
l

l

For Relative orders, set a relative offset amount (in penny increments) in the Aux. Price
field.
For PEG STK orders, you enter the starting price in the Aux. Price field, the delta in the
Delta field, the optional stock reference price in the Stock Ref. Price field, the low side of
the optional stock range in the Underlying Range (Low) field, the high side of the optional
stock range in the Underlying Range (High) field. Use the Order Ticket, or display these
fields from the Order Columns tab in page layout.

3. Transmit the order by clicking the "T" in the Status field.
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For a more detailed description of box auction orders, visit the Order Typesinformation page.
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Relative/Pegged-to-Primary
The relative order provides a means for traders to seek a more aggressive price than the National
Best Bid and Offer (NBBO). By becoming liquidity providers, and placing bids or offers into the book
that are more aggressive than what is currently quoted, traders increase their odds of execution.
Quotes are automatically adjusted when other market participants become more aggressive. For a
buy order, your bid is pegged to the NBB by a more aggressive offset amount*, and if the NBB moves
up, your bid will also move up. For sales, your offer is pegged to the NBO by a more aggressive offset, and if the NBO moves down, your offer will also move down. In addition to the offset, you can
define an absolute cap, which works like a limit price, and will prevent your order from being
executed above or below a specified level.
For relative orders with a "0" offset, the order is submitted as a limit order at the best bid/ask, and
will move up and down with the market to continue to match the inside quote.

If you have tooltips enabled, you can hold your mouse over the Limit price of the relative order and see the current exchange price for that order.

To enter a Relative order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL
order.
2. Click in the Type field and select REL as the order type.
3. Enter the offset amount in the Aux. Price field, or set a percent using the Pct. Offset field. If
both fields have values the higher of the two will be used as the offset. To display the Pct. Offset field:
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l

l

Hold your cursor over a field in the order row fields until the green “+” sign
appears. Click the “+” sign to show the list of order fields.
In the Price category, select Pct Offset. The field is added to the left of the selected
field.

If you submit a relative order with a percentage offset, you are instructing us to calculate an order price that is
consistent with the offset, but that also complies with applicable tick increments. Therefore we will calculate the
order price rounded to the appropriate tick increment (e.g., pennies for a U.S. stock trading at a price over
$1.00). Buy orders will be rounded down to the nearest acceptable tick increment and sell orders will be rounded
up.
You can modify the offset amount for several relative orders on the same trading page at one time.
To do this, select multiple relative orders by holding the Ctrl key and clicking on each order. After
you have selected all relative orders, right-click on one of the selected orders and select Modify. In
the Relative Order Modification box, define an offset or percent offset amount and click OK. All
selected orders will be changed.
Please note that you can change the name of the Relative order to Pegged-to-Primary using the Settings page of the Display group in Global Configuration. For a more detailed description of relative
orders visit the Order Typesinformation page.
*The offset is the amount that will be added to the best bid (for a buy order) and subtracted from the
best ask (for a sell order) to create the limit price at which the relative order will be submitted.

TWS Users' Guide

504

Order Types

Advanced Order Types

Relative + Market
The REL + MKT order type is available for certain multi-leg combinations, and when used with a nonguaranteed combination order it could help to increase the chances of all legs in the order being filled.
Although the order type uses the term "Relative," this refers to the behaviour of the limit order initially submitted, which is pegged to the bid for a buy and to the ask for a sell similiar to a Relative
order, in an attempt to add rather than remove liquidity. Initially one or more legs are submitted as
limit orders, but if the first leg fills or partially fills, the remaining legs are resubmitted as market
orders.

To create a combination Relative + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
3. From the Type dropdown, select REL + MKT.
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When you select REL + MKT, the limit price field becomes inactive and the Trigger Price field requires the
combo price input.
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Retail Price Improvement Orders (RPI)
This order is similar to a Relative order, but requires an offset greater than zero (which may be submitted in subpennies). RPI orders are routed to a separate book at the NYSE to trade against qualified orders.

To submit an RPI order
1. Click the Ask price to create a Buy order or the Bid price to create a Sell order.
2. From the Type field, select RPI.
Note: If you don't see RPI in the order type list, ensure that your Destination is set
to SMART and that the stock is listed on either the NYSE or NASDAQ.
3. Specify an offset greater than zero.
4. Transmit the order.

For more information, see the Order Types page on the website.
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Snap to Market
The Snap to Market (SNAP MKT) order is similar to a pegged order, as the original order price is determined by
the current bid/ask plus or minus an offset. But unlike the pegged order price, the "snap to" order price doesn't
continue to peg as the price moves.
A Snap to Market BUY order snaps to the ask minus the offset, to set the order price. For a SELL order, it snaps
to the bid plus the offset.

To create a Snap to Market order
1. Create a buy or sell order.
2. From the Type field select SNAP MKT.
3. Specify an offset amount that will be subtracted from the bid (for a buy order) to determine the
limit price.
4. Transmit.
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Snap to Midpoint
The Snap to Midpoint (SNAP MID) order is similar to a pegged order, as the original order price is determined
by the current bid/ask plus or minus an offset. But unlike the pegged order price, the "snap to" order price doesn't
continue to peg as the price moves.
A Snap to Midpoint BUY order snaps to the midpoint of the bid/ask minus the offset to set the order price. For a
SELL order, it snaps to the midpoint of the bid/ask plus the offset.

To create a Snap to Midpoint Order
1. Create a buy or sell order.
2. From the Type field select SNAP MID.
3. Specify an offset amount that will be subtracted from the midpoint of the bid/ask to determine
the limit price.
4. Transmit.
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Snap to Primary
The Snap to Primary (SNAP PRIM) order is similar to a pegged order, as the original order price is determined
by the current bid/ask plus or minus an offset. But unlike the pegged order price, the "snap to" order price doesn't
continue to peg as the price moves.
A Snap to Primary BUY order snaps to the bid plus the offset to set the order price. A SELL order snaps to the
ask minus the offset.

To create a Snap to Primary Order
1. Create a buy or sell order.
2. From the Type field select SNAP PRIM.
3. Specify an offset amount that will be added to the bid (for a buy order) to determine the limit
price.
4. Transmit.
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Sweep-to-Fill
A sweep-to-fill order identifies the best price and the exact quantity offered/available at the price,
and transmits the corresponding portion of your order for immediate execution. It simultaneously
identifies the next best price and quantity offered/available and submits the matching quantity of
your order for immediate execution.
To create a sweep-to-fill order
1. Display the Sweeps to Fill field for an order management line: Hold your mouse over any
field title until the "+" and "x" Insert and Remove icons appear. Click the "+ " to display the list
of available fields. Note that if you hover your mouse over an order field, all available order
fields are displayed. If you hover over a market data field, all available market date fields are
displayed.
2. On the trading screen, click the Ask Price to create a BUY order, or the Bid Price to create a
Sell order.
3. Check the Sweep to Fill field.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of sweep-to-fill orders, visit the Order Typesinformation page.
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Stop Order with Protection
A Stop with Protection order is similar to a stop limit order. The order is submitted with a Stop Price.
When the contract trades at the stop price the order triggers, and is submitted as a limit order at the
exchange-defined "protection" limit price.
To create a stop with protection order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select STP PRT as the order type.
3. Define the Stop Price.
4. Transmit by clicking the "Transmit" button.
For a more detailed description of stop orders with protection, visit the Order Typesinformation page.
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Trailing Stop
A trailing stop sell order sets the initial stop price at a fixed amount below the market price. As the
market price rises, the stop price rises by the trailing amount, but if the stock price falls, the stop
price remains the same. When the stop price is hit, a market order is submitted. Reverse this for a
buy trailing stop order. This strategy may allow an investor to limit the maximum possible loss
without limiting possible gain.

To create a trailing stop order
1. Click in the Ask Price to initiate a BUY order, or the Bid Price to initiate a SELL order.
2. Click in the Type field and select TRAIL from the dropdown list of order types.
3. Enter a value in the Trailing Amt field. This amount is used to calculate the initial Stop Price,
by which you want the limit price to trail the stop price. To change the absolute value to a percent of the best bid/ask, click in the field to initiate a dropdown arrow, and then choose Amt or
%.
l

l

Stop Price - This field is optional. By default, the initial Stop Price is calculated
as: market price - trailing amount. You can modify the stop price, but if it is lower
than the calculated value, it will be discarded when the order is submitted. Note
that the value you enter may display in the Stop Price field even if it is not used.
Limit Price - this value defaults to the current best bid/ask. The limit price will
move with the trailing stop price based on the delta between the two prices (initial
stop price - initial limit price = limit delta). If the limit price and stop price are equivalent, they will move together with a zero delta.

4. To transmit the order, click the "T" in the Status field.
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For a more detailed description of Trailing Stop orders visit the Order Typesinformation page.
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Trailing Stop Limit
A trailing stop limit order lets you create a trailing stop order that works in conjunction with a dynamically-updating limit order. When the stop order triggers, a limit order is submitted at the last calculated price (instead of a market order which would be submitted with a regular trailing stop order).
The Trailing Stop Limit order uses four components: Stop price, Trail amount, Limit price, and Limit
Offset.

To enter a trailing stop limit SELL order
1. Click in the Bid Price to initiate a SELL order.
2. Click in the Type field and select TRAIL LIMIT.
3. Display the Stop Price and Lmt Offset fields (Hold your mouse over any field title until the
"+" and "x" Insert and Remove icons appear. Click the "+ " to display the list of available fields.
Note that if you hover your mouse over an order field, all available order fields are displayed.
If you hover over a market data field, all available market date fields are displayed. ).
4. Enter values in the following fields:
a. Aux Price (Trailing Amt) - This value is subtracted from the bid price to continually
recalculate the stop price, if the market price rises. Use the dropdown to choose
Amt or %. The trailing percent is calculated off the current best bid/ask. Note that
you can define a default Trailing Amount in the Order Defaults Default Order Offset
Amounts area.
b. Stop Price - You must enter an initial stop price. Unlike a trailing stop order, the
initial stop price is not automatically calculated by TWS when you transmit the
order, since the stop price is needed to calculate the limit price or limit offset. The
stop price is continually recalculated when the market price rises. If the initial stop
price is higher than the (market price - trail amount) it will not be modified.
c. Limit Price OR Limit Offset - The limit order piece of the trailing stop limit is submitted once the stop price is penetrated. While the market price and stop price continue to fall, the limit price is also recalculated using the limit offset, and moves
with the stop price.
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l

If you enter a limit offset, the limit price is calculated using (stop price - limit
offset).
If you enter a limit price, the limit offset is calculated using (stop price - limit
price) when the order is submitted.
If the limit price and stop price are equivalent, they will move together with
no offset.

5. To transmit the order, click "T" Status field.
For a more detailed description and example of Trailing Stop Limit orders, visit the Order
Typesinformation page.
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Trailing Market if Touched
A trailing market if touched is similar to a trailing stop order, except that the sell order sets the initial
stop price at a fixed amount above the market price instead of below. As the market price falls, the
stop trigger price falls by the user-defined trailing amount, but if the price rises, the stop price
remains the same. When the stop trigger is touched, a market order is submitted. Reverse this for a
buy trailing market if touched order.
To create a Trailing Market if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select TRAIL MIT as the order type.
3. In the Aux. Price field, enter the trailing amount.
4. In the Stop Price field, enter the trigger price.
5. To transmit the order, click the "T" in the Status field.
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Trailing Limit if Touched
A trailing limit if touched is similar to a trailing stop limit order, except that the sell order sets the initial stop price at a fixed amount above the market price instead of below. As the market price falls,
the stop trigger price falls by the user-defined trailing amount, but if the price rises, the stop price
remains the same. When the stop trigger is touched, a limit order is submitted. Reverse this for a buy
trailing limit if touched order.
To create a Trailing Limit if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. If not already visible, display the Stop Price and Lmt Offset fields (right-click in the column
headers and select Customize Layout, then use the Order Columns tab to add fields).
3. Enter values in the following fields:
a. Aux Price (Trailing Amt) - This value is added to the bid price to continually recalculate the stop price, if the market price drops. Use the dropdown to choose Amt or
%. The trailing percent is calculated off the current best bid/ask. Note that you can
define a default Trailing Amount in the Order Defaults Default Order Offset Amounts
area.
b. Stop Price - You must enter an initial stop price. Unlike a trailing market if
touched order, the initial stop price is not automatically calculated by TWS when
you transmit the order, since the stop price is needed to calculate the limit price or
limit offset. The stop price is continually recalculated when the market price falls.
If the initial stop price is higher than the (market price - trail amount) it will not be
modified.
c. Limit Price OR Limit Offset - The limit order piece of the trailing stop limit is submitted once the stop price is penetrated. While the market price and stop price continue to fall, the limit price is also recalculated using the limit offset, and moves
with the stop price.
l
If you enter a limit offset, the limit price is calculated using (stop price - limit
offset).
l

l

If you enter a limit price, the limit offset is calculated using (stop price - limit
price) when the order is submitted.
If the limit price and stop price are equivalent, they will move together with
no offset.

4. To transmit the order, click "T" Status field.
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Trailing Limit + Market
The TRAIL LMT + MKT order type is available for certain multi-leg combinations. You define the trailing amount, and when the order triggers it behaves the same as the Limit + Market order.

To create a combination Trailing Limit + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
3. From the Type dropdown, select TRAIL LMT + MKT.
4. Set or confirm the Trailing Amount and Trigger Price.

When you select TRAIL LMT + MKT, the limit price field becomes inactive and the Trigger Price field requires
the combo price input.

TWS Users' Guide

520

Order Types

TWS Users' Guide

Advanced Order Types

521

Order Types

Trailing Relative + Market
The TRAIL REL + MKT order type is available for certain multi-leg combinations. You define the trailing amount, and when the order triggers it behaves the same as the Relative + Market order.

To create a combination Trailing Relative + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
3. From the Type dropdown, select TRAIL REL + MKT.
4. Set or confirm the Trailing Amount and Trigger Price.

When you select TRAIL REL + MKT, the limit price field becomes inactive and the Trigger Price field requires
the combo price input.
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Volatility Orders
Introduction for Users
l

Volatility Trading

l

Attach a Delta Hedge Order

l

Volatility Trading via the Order Ticket
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Attached Orders
Use attached orders to hedge a parent order. TWS lets you:
Attach a Beta Hedge Order - offset market risk by entering into a position with another contract based
on the system or user-defined beta.
Attach an FX Order - allows you to offset risk with currency different from your account’s base currency.
Attach a Pair Trade - trade a mis-valued pair of contracts and provide the ratio between the parent
and child hedge order.
Attach a Delta Hedge Order - send an order against the executed option trade to maintain a delta neutral position.
The attached hedge orders are considered child orders of the parent order, and are submitted one
time when the parent order is submitted. These orders are not continuously updated.
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Attach a Beta Hedge Order
Attach a Beta Hedge order to hedge a stock order with an ETF.

To attach a beta hedge order
1. Create a buy or sell stock order.
2. Right-click in the order line, and select Attach, then select Beta Hedge.
3. Click the Attributes box in the Status field to show the hedge attributes on the inline editor.

4. Enter a hedging contract, generally an ETF. The system beta of the stock relative to the selected ETF is calculated and displayed next to the hedging contract.
5. Hold your mouse over the Beta icon to see the calculated estimated quantity of the hedging contract.
6. If desired, adjust the beta by entering a new value in the User Beta field. The quantity of the
child hedge order is recalculated.
7. Click T to transmit the original order. The attached beta hedge is automatically transmitted.
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Attach a Delta Hedge Order
Attach a delta hedge order to an options order, and as an alternative to setting a hedge order attribute in the original Volatility order line.

To attach a Delta Hedge order
1. From the right-click menu, select Attach and then select Delta Hedge.
A new linked delta hedge order line displays. The link between the parent and child orders
is illustrated in the Key field.
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2. Select an order type for the hedging order (Limit, Market or Relative).

Please note that when you attach a delta hedge order to a Volatility order with Continuous Update or to a Relative/Pegged-to-Stock order, the system will use the delta associated with the parent order instead of using the
current delta of the option based on market data at the time of trade. For Volatility orders, this delta is calculated
from the user-defined Implied Volatility specified at the time of the most recent order modification or price
update. For Relative/Pegged-to-Stock orders, this is the delta specified by the user.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the time the parent order fills, and
the best available price is used as the limit price (best ask for a buy and best bid for a sell).
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Attach an FX Order
You can elect to attach an FX Order in cases where you are buying a contract in a currency other than
your base, and want to convert base currency to the currency of the contract to cover the cost of the
trade.
To attach an FX Order
1. Create a buy order on a contract.
2. Right-click in the order line, and select Attach, then select FX Order.

3. Click the Attributes box in the Status field to show the hedge attributes on the inline editor. The
appropriate currency pair is displayed.

Hold your mouse over the FX icon to see the calculated estimated quantity of the hedging contract.
4. Transmit the parent order. The attached fx order will sell your base currency and buy a quantity
of the needed currency to cover the parent trade.
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Attach a Pair Trade
The attached Pair Trade can be used to hedge one contract against another, generally in the same
industry. Offset a price discrepancy between the two contracts with a ratio.

To attach a Pair Trade
1. Create a buy or sell stock order.
2. Right-click in the order line, and select Attach, then select Pair Trade.
3. Click the Attributes box in the Status field to show the hedge attributes on the inline editor.
4. Enter a contract to hedge the parent contract.

5. In the Hedging Ratio field, enter a value as a whole number or a decimal. This value is the first
term in the ratio.

Hold your mouse over the Pair icon to see the calculated estimated quantity of the hedging contract based on the
entered ratio. For example, if the parent order quantity is 500 and you enter a Hedge Ratio of 2, the estimated
quantity of the hedge order will 1000, i.e. a 2:1 ratio.
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Times in Force
Introduction
l

Time in Force for Orders

l

Good After Time

l

See Regular Trading Hours for more information.

l

Fill or Kill

l

Auction

l

Market-on-Open

l

Limit-On-Open
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Times in Force for Orders
The time in force for an order defines the length of time over which an order will continue working
before it is canceled. We support many times in force which are described below.

The selections available for any order are valid based on the combined order type, exchange and product. Not all
TIFs are available for all orders.

l

l

l

l

l

DAY - A Day order is canceled if it does not execute by the close of the trading day. Unless otherwise specified, every order is a Day order.
GTC - A Good-Til-Canceled order will continue to work within the system and in the marketplace until it executes or is canceled. GTC orders will be automatically be cancelled under
the following conditions:
If a corporate action on a security results in a stock split (forward or reverse), exchange for
shares, or distribution of shares.
If you do not log into your IB account for 90 days.
At the end of the calendar quarter following the current quarter. For example, an order placed
during the third quarter of 2011 will be canceled at the end of the first quarter of 2012. If the
last day is a non-trading day, the cancellation will occur at the close of the final trading day of
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that quarter. For example, if the last day of the quarter is Sunday, the orders will be cancelled
on the preceding Friday.
l

Orders that are modified will be assigned a new “Auto Expire” date consistent with the end of
the calendar quarter following the current quarter.
Orders submitted to IB that remain in force for more than one day will not be reduced for
dividends. To allow adjustment to your order price on ex-dividend date, consider using a GoodTil-Date/Time (GTD) or Good-after-Time/Date (GAT) order type, or a combination of the two.

For market centers that do not accept "native" GTC orders, the order type is simulated by resubmitting the relevant order each business day upon opening of the market center.
l

l

l

l

l

OPG - Use OPG to send a market-on-open (MOO) or limit-on-open (LOO) order.
IOC - Any portion of an Immediate-or-Cancel order that is not filled as soon as it becomes available in the market is canceled.
GTD - A Good-Til-Date order will remain working within the system and in the marketplace until
it executes or until the close of the market on the date specified. When you select GTD as the time
in force, both an Exp. Date and Exp. Time field is displayed on the order management line. Enter
the date up until which you want the order to continue to work in the format YYYYMMDD. To set a
time, enter the time in the format HH:MM(:SS). If desired, enter a time zone using an accepted
three-letter acronym. Note that if you do not enter a specific time zone, the time zone to which
your computer is set will be used.
FOK - If the entire Fill-or-Kill order does not execute as soon as it becomes available, the entire
order is canceled.
DTC - A Day 'Til Cancelled order is similar to a day order, but instead of being cancelled and
removed from the trading screen at the end of the day, the order is deactivated. This means that
the order is cancelled AT THE EXCHANGE but remains on your trading screen to be re-transmitted
whenever you click the Transmit button.

Fill/trigger outside RTH - When displayed, checking this option allows orders the flexibility to fill
(and/or trigger in the case of stop and other trigger orders) both during regular hours and outside of
regular trading hours.

This option may not be available for particular products that are not listed on an exchange. IBcustomers are
solely responsible for ensuring that this parameter is available for the product involved.
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Regular Trading Hours
You can trade many exchange-listed products outside of regular trading hours. To allow trading outside regular hours for all eligible products, ensure that the setting is enabled in all order presets.
To enable outside trading hours in Order Presets
1. Display the Presets column if it is not displayed: Hold your mouse over any field title until the
"+" and "x" Insert and Remove icons appear. Click the "+ " to display the list of available fields.
Note that if you hover your mouse over an order field, all available order fields are displayed.
If you hover over a market data field, all available market date fields are displayed.
2. Click in the Presets field on a ticker line and select Configure at the bottom of the dropdown list.
The Preset for the current contract is displayed.
3. In the Settings area at the top of the Presets page, check Allow order to be activated,
triggered or filled outside of regular trading hours.
When the Preset is active for the contract, the order will be eligible to trade outside of regular trading
hours IF it is exchange-traded and eligible on the exchange.
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Good After Time
A "good after time" order is held in the system and sent to the exchange on the date and time you
enter.

To create a "good after time" order
1. Display the Start Time field on an order management line:
l

l

Hold your cursor over a field in the order row fields until the green “+” sign
appears. Click the “+” sign to show the list of order fields.
In the Time in Force category, select Start Time. The field is added to the left of the
selected field.

2. On the trading screen, create an order (click in the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).

3. In the Good After Time field, click the Calendar icon to open the date/time setter.
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4. Choose a month, year and day from the Date area, and a time and time zone from the Time
area. Click OK.
Note that the time uses a 24-hour clock instead of "AM" and "PM."
5. Transmit the order. The order is held in the IB system until the time and date you set.
For a more detailed description of GAT orders and the products and exchanges supported, visit the
Order Typesinformation page.
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Fill or Kill
A time in force for options orders, specifying that the order must execute immediately and in its
entirety, or be canceled.

To apply the FOK time in force to order
1. Create an options order (click the Ask Price to create a BUY order, or the Bid Price to create
a Sell order).
2. In the TIF field, select FOK.
Note: If FOK is not displayed in the dropdown list, it is not applicable to the order
your are creating.
3. Transmit the order by clicking the "T" in the status field.
For more information about Fill or Kill orders, visit the Order Typesinformation page.
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Auction
An auction order is submitted at the Calculated Opening Price (COP). If the order doesn't execute, it is
resubmitted as a limit order at the COP or best bid/ask.
To create an auction order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order. This action
will open the Order Ticket window.
2. Select an order type in the Type field.
3. In the Time in Force field, select AUC (auction).
4. Transmit the order by clicking "T" in the Status field.

Available for limited products and exchanges, including futures on HKFE and stock on LSE, IBIS, and
VSE.
For a more detailed description of auction and other order types, visit theOrder Types information
page.
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Market-on-Open
MOO (market-on-open) is a market order executed at the market's open at the market price.
To create a MOO order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select MKT as the order type.
3. In the TIF field, select OPG as the time in force.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of MOO orders visit the Order Typesinformation page.
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Limit-On-Open
A LOO (limit-on-open) order is a limit order executed at the market's open if the opening price is
equal to or better than the limit price.
To create a LOO order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select LMT as the order type.
3. In the TIF field, select OPG as the time in force.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of LOO orders, visit the Order Typesinformation page.
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The Quote Monitor
l

Add a Quote Monitor

l

Edit a Quote Monitor

l

Add and Remove Fields

l

Restore and Save Page Settings

l

Organize Data on a Page

l

Create a Group Header

l

View Margin Requirements for a Position

l

Use the Feature Search

l

Use the Order Wizard

l

Use Quick Data

l

Import Tickers from a File

l

Create TWS Window Groups

l

Enable Quick Stock Entry

l

Edit Dividends Schedule

l

Price and Size Wheels

l

The Price and Size Wands

l

Check Risk Pre-Order

l

View Futures Prices Term Structure

l

Receive Delayed Market Data

l

Market Data Fields

l

Order Management Fields

l

Trade Bonds

l

Trade Mutual Funds

l

Trade FX from the Trading Window

TWS Users' Guide

540

The Quote Monitor

Add a Quote Monitor

Add a Quote Monitor
There is no limit to the number of Quote Monitors you can create in TWS. You can enter as many lines
of market data as you want, but at any one time you will only be able to see 100 active market data
lines at a time. For details, see Notes about Market Data use. Use the Quote Monitors to sort your
assets by instrument type, exchange, or your own trading system categories. You can navigate
through the tabbed pages without the mouse by using the Ctrl key along with the Page Up and Page
Down keys.
l

To detach a page, simply click the tab and drag the page away from the tabset.

l

To create a new page, click the “+” sign and select Quote Monitor

l

To delete a page, click the X.

l

To rename a page, right-click the page title and select Rename Page.

You can also use a page-level feature called Quick Stock Entry, which will automatically complete a
market data line for a stock using the set of order destinations you set up.
To add a Portfolio Page
You can create a system-maintained Quote Monitor that includes a data line for each position in your
portfolio. Use the right-click menu from the “+” sign and select Portfolio Window. The portfolio page
can only be created once.
This creates a page with the same positions that are displayed in the Portfolio section of the Account
window. Each time you take a position, the Portfolio page is automatically updated to include market
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data for the new position. When you zero out a position, the market data line remains on your Portfolio page. You can remove zero position tickers from this and other pages using the right-click menu
on a page and selecting Clear Zero Position Rows.
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Edit a Quote Monitor

Edit a Quote Monitor
Modify the page name and other settings, add or remove market data and order fields, and insert a
market data line or a blank line in your Quote Monitor using the right-click menu or the Request
Ticker dialog box.
See how to:
l

Edit a page name and other settings

l

Copy tickers to a new page

l

Edit a page layout

l

Insert a Market Data line between two existing lines

l

Move, drag, and drop a Market Data line up or down on a page

l

Delete a row

l

Delete multiple rows

l

Select contiguous rows

l

Select non-contiguous rows

l

Clear data from a row and leave an empty line

l

Add a blank row (above the selected row)
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To edit a page name and other settings
1. Right-click the page tab and select Rename Page.
2. Modify the page name or assigned layout and click OK.

The Pending page is a system page that displays all of your working orders. You cannot delete or rename the
Pending page, but you can edit order parameters.
To copy tickers to a new page
1. On a populated Quote Monitor, click the first ticker row you want to copy.
2. Press and hold the shift key and click the last row you want to copy. This will select all rows
including the first and last highlighted ticker rows.
3. Use the right-click menu to select Copy.
4. In the tabset of pages, click the “+” tab to create a new page.
5. Enter a page name and click OK.
6. Right-click in the top blank row of the new page and select Paste.
To edit a page layout
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Edit a Quote Monitor

1. Right-click the page tab and select Layout.
2. Modify the desired characteristics and click OK.

Before you modify the page layout be aware that you are not simply changing the look of the active page, you are
modifying an applied layout which may also be associated with other pages.
To insert a Market Data line between two existing lines

When you add a line, it is inserted ABOVE the selected line.
1. Click in a market data line. The new line will be inserted ABOVE this line.
2. Right click and select Insert Row.
To move, drag, and drop a Market Data line up or down on a page
1. Select the market data line you want to move by clicking in the line.
2. Click and hold the mouse in the selected line.
3. Drag the selected line up or down on the page.
4. Release the mouse to drop the line in its new position.
To Delete Lines on a Quote Monitor
You can delete lines from your Quote Monitor using the right-click menu.

The delete command does not distinguish between deleting blank lines and deleting market data lines, and does
not give you a warning before it deletes your data. Be certain you have only selected the lines you want to delete.
Selected lines appear highlighted in dark grey across the Trading screen.
To delete a row
l

Right click in the line you want to delete and select Delete Row.

To delete multiple rows
1. Select the line(s) you want to delete by clicking the lines.
2. Right click and select Delete Rows.
To select contiguous rows
l

Click in the first line you want to delete, hold down the Shift key, and click in the last line to
select a group of contiguous rows.

To select non-contiguous rows
l

Hold the Ctrl key and click each row.

To clear data from a row and leave an empty line
l

Right click in the line you want to delete and select Clear Row.

To add a blank row (above the selected row)
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l

Right click in a line and select Insert Row.
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Close All Positions

Close All Positions
Accessed from the Trade menu, use the Close Selected Positions and Close All Positions commands to close a
selected group of positions in your portfolio with a single action.

To close selected positions
1. Select the positions to close by holding down the Ctrl key and clicking the positions with your
mouse .
2. From the Trade menu select Close Selected Positions.
3. Select a percentage to close.
a) Choose 50% or 100%,
b) Or elect to define a custom percent.
4. Specify and submit the order.
a) If you choose 50% or 100%, use the Close Position box to modify order parameters before
submitting the order.
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b) If you choose Close Customer Percent, enter the percentage in the field and click OK, then
use the Close Position box to modify order parameters before submitting the order.
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Add and Remove Fields

Add and Remove Fields
You can quickly add and remove fields from the Quote Monitor by holding your mouse over the field
name to invoke the plus/delete editing icons.

To add or remove columns from the window
1. Hold your mouse over a field to invoke the quick add/remove icons.
2. Click the “+” icon to pick a field from the dropdown picklist which will be insert to the left of the
selected field.
3. Click the “x” icon to remove the field from the page. You can re-add the field at any time.
You can choose not to see these icons by deselecting the feature Show icons on column headers to
add or remove columns on the General page of Global Configuration.
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Restore and Save Page Settings
To restore trading pages and tickers you had set up on a previous day, you can elect to restore the
entire settings file, which includes all trading pages and their tickers.

Restoring a page file completely replaces all of your current trading pages with those from a previous day.
To restore settings
1. On the File menu, select Open Settings File.
2. In the Open dialog box, click on the day's file you want to use to replace the current set of
pages and tickers.
Note: To view the actual dates the files were saved, click the Details icon on the top
right of the box.
1. Click Open. Your current trading pages and tickers are replaced with those in the file you selected.

Save Settings to the IB Server
When you are logging in you can check Store settings on server. This setting serves two purposes: it
GETS the saved settings from the IBserver when you log in, and it SAVES any session changes to the
IBserver when you log out.
If this feature is not checked, you will not have global access to your account settings from any internet machine.
To save your settings on the IB server
1. After you've logged in, from the Edit menu select Global Configuration.
2. On the Lock and Exit page, check Use/store settings on server.
To use global settings that have been saved on the IB server
In the Login box, check the Store settings on server box. This instructs TWS to go to the global server
and use any settings you saved previously.
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Organize Data on a Page

Organize Data on a Page
You can sort a page of market data lines alphabetically by underlying ticker symbol. Once you have
sorted the lines, you cannot return to your original market data line order. Use drag-and-drop to
rearrange the order of your trading pages within the tabset.
To alphabetically sort page tabs
1. Open the page you want to sort by ticker.
2. Right-click in the heading area of the page tab and select Sort Tickers.
To move a Quote Monitor within the pages tabset
1. Click on a page tab to select the page.
2. Click and hold the mouse, and drag the page left or right within the tabset.
3. Release the mouse to drop the page in its new location.

You cannot move the Pending page tab.
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Create a Group Header
The Group Header row can be used to separate tickers into groups on a single Quote Monitor. The
header keeps the group together if you choose to auto-sort on the page by column header. Additionally, if you drag the header to a Watchlist or another trading page, all tickers under the header
will be dragged with it.
Additionally, several of the P&L columns, including the Market Value, P & L, Realized P & L and Unrealized P & L columns will be totaled for all positions within a group and the values displayed on the
Group Header row.

A group includes all tickers under the Group Header until the next Group Header, regardless of blank lines.

To create a group header
1. Right-click in an empty market data line and select Create Group Header.
2. Enter a descriptive line of text or a title to appear in the row, and click OK.

If you want to insert a header between a list of existing tickers, right-click on the ticker ABOVE WHICH you
want to create the header row and select Insert Row. Then use the blank row to insert the header row.
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Field Sorting

Field Sorting
You can sort all fields by ascending and descending value (-15, -12, 10, 22) by clicking the field one or multiple.
Additionally you can also sort many of the TWS fields by ascending or descending absolute value (10, -12, -15,
22 etc). You can change the sort type by clicking the field title multiple times to cycle through sort types in order
(no sort, descending order, ascending order, descending by absolute value, ascending by absolute value) or by
using the right-click menu. Each sort type is identified by an icon; ascending and descending use upward and
downward pointing arrows respectively, and ascending and descending absolute value use upward and downward
pointing arrows with border lines, respectively.
Fields that currently support the new sort types include the following: (new fields may be added)
l

%Change (used in Top % Gainers scan)

l

%Change Since Open (used in Top % Gainers Since Open scan)

l

%Gap (used in Top Close-To-Open % Gainers scan)

l

ImpVol %Change (used in Top Option Imp Vol % Gainers scan)

l

ImpVol vs Hist (used in High Option Imp Vol Over Historical scan)

l

Growth (used in High Growth Rate scan)

l

ROE (used in High Return On Equity scan)
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Create the Portfolio Window
The Portfolio window is an automated trading page you can elect to create. It is based on the current
content of your portfolio.

To create a Portfolio window

From Classic TWS - Click the "+" icon along the end of the tabset and select Portfolio Window.
From Mosaic - In the Monitor section, click the "+" icon and select Portfolio.
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Create the Portfolio Window

Click the Filter icon to filter by symbol. The content will be filtered out as you type.
Group By

Positions in the Portfolio page can be grouped by Security Type or Expiry using the right-click menu in the Contract field. You can also click the Contract field multiple times to change the grouping mode. The cycle allows
you to group by:
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l

Alphabetically (by contract name), ascending.

l

by Security Type, ascending

l

by Expiry, ascending

l

by Expiry, descending

l

by Expiry and Option Right, ascending

l

by Expiry and Option Right, descending

Additionally, when the portfolio is sorted and you hold your mouse over the Position or Market Value fields, the
summary data totals for the sorted section displays the total position, total market value, and total cost basis.
For information on configuring this page, see the See Portfolio Window for more information. configuration topic.
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View Margin Requirements for a Position

View Margin Requirements for a Position
You can view the margin requirements on a specific position from the right-click Contract Info menu

To view margin requirement on a position
l

From a ticker line, use the right-click menu to select Contract Info and then Show Margin
Requirements.
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Use the Feature Search
The comprehensive Search returns a categorized list of application-related results with links that will
open a window, add a column or display a feature. Use the Search to add contracts to your trading
page based on search criteria.

To use the Search field
1. In the top right corner of a main Quote Monitor, enter a word or phrase in the Search field and
hit Enter.
2. On the Search Results page, check Application to view all TWS-related occurrences of the
search topic, and check Contracts to see all contracts with the search topic in the title.
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Use the Feature Search

Using the Search results
l

For application-related results, clicking a link will perform the search related action based on
the results category. For example, if you clicked OptionTrader from the Open
Window category, TWSwould open the OptionTrader window, or bring you to that window if it's
already open.
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l

For Add Contract results, clicking a link will open a ticker line on the last active trading page
with the search item as the contract in focus. From this point you can either add the contract, or
click the Find button to broaden your search by company name.
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Use the Order Wizard

Use the Order Wizard
The Order Wizard is a live order-creation panel at the bottom of the Advanced Order Management
quote monitor that sorts order types by category, and helps you to create an order by presenting
valid attributes for each order type you select.

To use the Order Wizard
1. Click the Order Wizard icon on the trading toolbar to display or hide the Order Wizard panel.
The Order Wizard opens below your trading window.

You can instruct the wizard to open each time you create an order using the General page on Global Configuration.
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2. Click a category in the left pane, and use the associated attributes in the right pane to customize your order.
The Summary section along the top of the Order Wizard panel always displays the current
order description, and immediately reflects any changes to the active order. The changes
are also reflected on the order line in your trading window.
3. Use the Preview button to review your complete order description. Use the Transmit button
to send the order, and use the Cancel button to cancel the order.
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Use Quick Data

Use Quick Data
You can use market data shorthand to quickly request data for stock, options, futures and forex contracts.

Use Quick Data for Stocks
l

In the Contract field use the format symbol pipe exchange, as in:
IBM|SMART or DELL|ISLAND.

For NASDAQ listed contracts, use ISLAND as the destination.
Use Quick Data for Options and Futures
l

Enter shorthand in the Contract field using the format exchange symbol pound sign exchange
as in:
MSQJC#SMART (option) or
MSFT1CU8#ONE (future)

Use Quick Data for Forex
l

Enter an fx pair using the syntax xxx.yyy, for example EUR.USD.
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Import Tickers from a File
You can populate a trading page with market data that you import from a comma-delimited .csv file
or .txt file. Create the list using any word processing program and save the file with a .txt file extension, or in MS Excel and save as a .csv file.
To create file of ticker symbols to import
1. Create a file with the extension .txt, for example twsTickers.txt, or create a .csv file in Excel.
2. In the text file, create one comma-delimited line for each line of market data you want using
the syntax described below. In Excel, create one row, using one cell for each field. Note that
the first field designation is the line type: DES, SYM, and CON.
DES, UNDERLYING, SECTYPE, EXCHANGE, EXPIRATION, STRIKE, PUT/CALL, MULTIPLIER
SYM, SYMBOL, EXCHANGE
CON, CONID, EXCHANGE
The DES line type requires information or placeholders for information, with the strike, Put/Call and
multiplier fields being optional. Format for the expiry is YYYYMM, or YYYYMMDD. All entries must be
in caps. An example for an options contract XYZ would be:
DES, XYZ, OPT, ISE, 200607, 75, CALL,
A stock contract for symbol XYZ in this line type would look like this:
DES, XYZ, STK, SMART,,,,
where the commas are placeholders for fields you don't define for stocks.
Using the SYM line type for a stock would look like this:
SYM, XYZ, SMART
Use the CON type to quickly enter contracts with a conid, for example
CON, 12348765, SMART
To import a file
1. From the File menu, use the Disabled Items arrow to display the Import/Export features.
2. Select Import/Export, and then Import Contracts.
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Import Tickers from a File

When you import a file, the contract lines will be entered on the bottom of the active trading
page unless you elect to enter them on a new page.
3. Use the Browse button to find the file to import.
4. Specify where you want imported tickers to go, either onto an existing page or onto a new
page.
5. Click OK.

TWS Users' Guide

565

The Quote Monitor

Create TWS Window Groups
Assign windows to a "group" to link order and ticker actions. You assign a window to a group using the
colored blocks on the top right of the title bar. All windows with the same color are part of the same
group. When you change focus on one of the group's "Source" windows, all destination windows in the
group reflect the change.

Any window that can be part of a group will display the blocks. A window can be part of one group at a
time. When you close the window, its group affiliation is erased.
The window's designation is displayed in a mouse-over tooltip when you hover over the Group icon. A
window can be a:
Source - this is a controlling window and can only SEND instructions.
Destination - this is a receiving window, and can only RECEIVE instructions from a window
with Source privileges.
Source/Destination - this is a multi-tasking window which can both SEND instructions to and
RECEIVE instructions from other windows in the group.
Create a windows group
1. Select a Group number from the dropdown list of group boxes.
2. Open other desired windows and select the same group number/color from the Group list.

Example
1. Create a group which includes the main Quote Monitor, real-time Charts with ChartTrader displayed, and the Order Ticket.
2. In the main Quote Monitor, select a ticker line, for example Dell.
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Create TWS Window Groups

Note: Note that in the two other windows, the contract description changes to Dell.
3. Now in the main Quote Monitor, click the Ask price to create a Buy order on a different ticker,
for example IBM.
n

Note that in the chart, the data will change to IBM, however no order will be created in ChartTrader. This is because real-time charts are designated as Destination/Source for tickers only.

n

On the Order Ticket, which is a Destination window for both tickers and orders, the
IBM order is reflected.
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Transfer Login Authentication
Traders using TWS can pass off their login authentication to their mobileTWS device to allow them to trade on
mobileTWS without going through the login process.
mobileTWS for iPhone, iPad and Android supports Read-Only Access, which allows mobileTWS users to view
their IB account without logging in. Before trading access is granted the user will be required to complete the full
account login on their mobile device.
If you are working at your desktop TWS and need to leave the office, you can transfer your account authentication over to mobileTWS, which saves you the effort of opening and logging into mobileTWS.
To transfer login authentication from TWS to mobileTWS
1. While logged into TWS, tap the mobileTWS icon on your mobile device.
2. In mobileTWS, at the message stating that another session exists, tap "OK."
3. In TWS, click Transfer Authentication to Mobile Device in the Mobile Login Handoff dialog.
Note: To keep your TWS desktop session logged in, click Disconnect Mobile Device.
You can now trade via mobileTWS.
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Enable Quick Stock Entry

Enable Quick Stock Entry
Quick Stock Entry is a page-level feature which automatically completes a market data line for a
stock based on the underlying symbol you enter. When enabled, you simply enter the stock symbol,
and TWS completes the ticker line.
If you enable multiple exchanges, you will get a ticker line for all exchanges on which the symbol
trades. For example, I activate NYSE, SMART/NYSE, ISLAND, and TSE. When I enter the ticker "MMM"
I get four ticker lines, where MMM represents 3M on all but TSE, where it represents Minco Gold
Corp.

Before you can use the Quick Stock Entry feature, you must:
l

Enable a trading page for Quick Stock Entry

l

Create a list of quick stock order destinations

To enable Quick Stock Entry
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When you enable Quick Stock Entry for a page, the system assumes that you want to enter ONLY
stock tickers on this page, and automatically completes a market data line with the appropriate order
destination.
1. Open the page you want to enable for Quick Stock Entry.
Note: We recommend that you identify the page as being enabled for Quick Stock
Entry by naming it appropriately.
2. Right- click in the area of the page tab and select Settings.
3. In the Page Settings dialog box, select Quick Stock/Bond Entry.
4. Click the Quick Stock Entry Exchanges button to add recognized exchanges for quick stock entry
support.
To add Quick Stock Entry Exchanges
1. On the Edit menu, select Global Configuration.
2. In the left pane, select Quick Stock/Bond Entry Exchanges.
3. Click Add.
4. Enter a destination, for example ISLAND, and click OK.
5. Add as many order destinations as you would like to have available. You can add more destinations at any time.

To add SMART, you must also define the primary exchange, for example NYSE, or ISLAND (for NASDAQ
stocks).
You can also use the syntax symbol|exchange to enter a stock ticker.
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Edit Dividend Schedule

Edit Dividend Schedule
Use the Dividend Editor to manually create your own dividend schedule. IB provides an automatic
"best guess" dividend payment schedule based on historical data for that asset.

To open the dividend editor
1. Right-click the ticker whose dividend schedule you want to edit.
2. Select Dividend Schedule.

To manually create a dividend schedule
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1. Use the Upcoming tab.
2. Check the Manual Edit checkbox. The existing information remains as a starting point, but you
can modify any fields, and add or remove dividends.
3. To insert or delete a line, click the Insert Dividend or Delete Dividend command.
4. Modify data on any line by clicking in a field and changing the value.
Note: The Dividend Amount is a cash value.
5. Click Save to apply your modified dividend schedule to the selected asset.
To paste dividends from a Word or Excel table
1. Create a two-column table in MS Word or MS Excel.
2. Enter data in the format of the existing table, with the Ex-Dividend Date in the first column and
Dividend Amount in the second column of your table.
3. Select and copy the table.
4. From the Upcoming tab of the dividend editor, click the Paste button. The data from your
external dividends table will replace the current dividends data.
5. Click Save to save your changes.
6. Click OK to save your data and exit the Dividends Editor.
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Price and Size Wheels

Price and Size Wheels
You can quickly modify the price or size in an order row using the scroll-wheel on your mouse.

To modify price or size using the scroll wheel
1. Click in the Quantity or Price field in an order row.
l

Scroll the wheel upward to increase the value.

l

Scroll the wheel downward to decrease the value.
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The Price and Size Wands
The Price Wand and Size Wand help you to modify the order price and order quantity using just your
mouse. Wands become active when you click and hold the mouse in the Lmt Price or Quantity field
on an order line.
To use the price wand
1. Create a Limit order. The Lmt Price field populates with the best bid or ask price.
2. Click and hold your mouse in the Lmt Price field to invoke the price wand.
3. Select a new limit price and release the mouse.

The top of the wand ladder includes MARKET; the bottom is VWAP. These selections change your order type to
a MARKET or VWAP order to use the market or vwap price.
The prices in the wand ladder are created using the market price plus/minus the price increment.
To modify increments in a wand
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The Price and Size Wands

1. On the Edit menu, select Global Configuration.
2. Expand the Order category in the left pane, and select General.
3. In the right panel, check Big scale prices or Big scale sizes to increase the price/size increment
used in the wand.
To allow penny increments for US Options in Price wand

1. On the Edit menu, select Global Configuration.
2. In the Configuration category in the left pane, select Display.
3. Check the option to Use penny increments in price wand for US options.
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Switch Exchange
When you add a market data line to a Quote Monitor, you have the choice of directed exchange or SMART for
the ticker's market data. For positions that display on the system-drive Portfolio page, this choice is made by
TWS, and it may be the case that TWSuses an exchange to which you have no subscription. In this case there
may be no data showing for certain positions on the Portfolio page.
The Switch Exchange button allows you to choose a subscribed exchange, enabling ticking data for the position
from the Portfolio window.
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Check Risk Pre-Order

Check Risk Pre-Order
Before you transmit an order, use the Check Risk feature to get a quick idea of how transmitting the
order might affect your portfolio-relative P&L.

To check risk on an order
l

From an order line, right-click and select Check Risk.

The Risk NavigatorSM Portfolio Relative P&L chart displays both the current and potential P&L for your
portfolio. You can also create and check risk on multiple orders.
To check risk on multiple orders
1. Hold down the Ctrl key and click on each non-submitted order you want to include in the Check
Risk P&L.
2. From the Trade menu, select Check Risk.
The Risk Navigator’s Portfolio Relative P&L displays two lines: the red solid line shows your current
portfolio relative P&L for all positions, and the blue dashed line shows the ‘what-if’ Portfolio Relative
P&L including the order(s) you are considering.
You can also elect to use the Date Scenario, which shows the current portfolio P&L and the ‘what-if’
portfolio P&L at the selected expiration date.
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If you check the risk on a potential order for a contract in which you hold no current position, the number of ‘what-if’ positions will increase. If you check the risk on an order for a contract in which you
currently hold a position, the ‘what-if’ position will not change, but the risk will increase or decrease
the current position and still be reflected in the blue dashed line.

To view a complete What-If scenario in Risk Navigator comprised of all current positions plus
whatever trades you are considering, click the View Details button in the top left corner.
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View Futures Prices Term Structure

View Futures Prices Term Structure
Chart the term structure of futures prices over a period of two years.
To view futures term structure
1. On the Quote Monitor, select a futures contract.
2. From the right-click menu, select Charts, then Term Structure.
3. In the second set of price terms, select a year, month and day whose closing price you want to
compare to the default previous day’s close.

Use the calendar chooser to avoid inadvertently choosing a weekend day or holiday.
The chart adjusts to display the price comparison. Add multiple terms to the same chart. The settlement price difference is charted below the term structure.
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Receive Delayed Market Data
Customers have the option to receive delayed market data for contracts to which they do not currently hold market data subscriptions. You can elect to receive delayed data by clicking the Free
Delayed Data button from a non-subscribed ticker row.

You can choose to trade with no data and not see the subscription and delay data buttons by turning
off the prompts in Global Configuration.
To hide market data buttons
1. From the Edit menu, select Global Configuration.
2. In the left pane of Global Config, select Display and then select Ticker Row.
3. Check Do not prompt for market data subscriptions. Note that you must restart TWS for this
change to take effect.
To re-enable market data buttons
1. From the Edit menu, select Global Configuration.
2. In the left pane of Global Config, select Display and then select Ticker Row.
3. Uncheck the “Do not prompt” box.
If you have subscribed to delayed data, but wish to remove it, click the Reset Subscription button.
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Add Market Data using Class or Symbol

Add Market Data using Class or Symbol
Add market data by entering the contract symbol or class as defined by the exchange on which it
trades.
To add an options security definition directly to the trading screen
1. Click in an empty row in the Contract column.
2. Enter the security definition by contract class or contract symbol, and press ENTER. Use the
formats in the table below.
Symbol Entry Formats
contract class

@

exchange acronym

contract symbol

#

exchange acronym

To add a security definition using Request Ticker form
1. In symbol mode, click the Add Ticker icon on the Trading toolbar.
2. In the Instrument Type field select Option.
3. Select the Symbol Type.
If you
select

Do this

Class

Enter the contract class symbol, exchange, expiration date and strike price,
and select the right.

Contract

Enter the exchange local symbol and the exchange.

If you add a market data line for a derivative instrument, TWS will ask if you want the underlying symbol added
to the page. If you answer yes, it will be included at the bottom of the page (unless the underlying is already on
the page).
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Introduction
To add or remove fields from your Quote Monitor or any tool, hold your mouse over a field until the
"Insert" and "Remove" commands appear. If you hover over a Market Data field, the list will display
the market data categories; if you hover over and order field, the list of order fields is displayed.

To add a field
1. Hold your mouse over a field to display the Insert and Remove selections.
2. Click the "+" sign to add a column.
3. Choose from the displayed list or categories and field columns to add a field to the right of the
current field.
By default, the fields are sorted by category using the Group radio button. Sort alphabetically by
selecting the Sort radio button.
l

Contract Description

l

News

l

Position and P & L

l

Price-based

l

High/Low/Volume

l

Options

l

Bond Columns

l

Auction

l

Fundamentals
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l

Graphic Prices

l

Order Presets

l

Stock Borrow/Loan

l

WSH Corporate Event Calendar (subscription)

l

Short Interest
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Contract Description
Column
Name

Description

Category

A category within an industry in which the underlying can be categorized.

Company
Name

Shows the company name for the underlying.

Data
Source

Identifies the source of the top market data.

Description

Identifies the instrument type and other descriptive contract information.

Contract

Provides the contract description including the underlying, primary exchange,
and if not Smart, the directed exchange.

Industry

The type of industry under which the underlying is categorized.

Exchange

The market data exchange. If no other exchange is specified for order routing,
this exchange is also where the contract will be routed. Select SMART order
routing to route directly to the best available market.

Notes

An editable, unlimited text field where you can enter notes about the underlying, etc. When you mouse over the Notes text, it displays in a pop up box so
you can read the entire note.
Note: The Notes field is not editable on system-generated pages, since these
pages (including the Pending page and Portfolio page) function differently from
user-maintained pages. They are dynamically created and populated at the start
of a TWS session and do not have the capability to save user-entered text.

Shortable

Uses colors to identify whether or not there is stock available for the customer
to short it. Colors relay the following information:
Red - No shares are available
Dark Green - The system is trying to locate shares.
Light Green - At least 1000 shares are available.

Sector

The most detailed description of the industry under which the underlying company can be categorized.

Symbol

Shows the exchange symbol for the contract.

Trading

The trading currency of the asset.
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Currency
Underlying
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The underlying symbol for the contract. To toggle between underlying and symbol mode, on the View menu select the desired mode.
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News
Column
Name

Description

News
Time

Displays the time and date of the latest contract-related news story. Rows use a
color gradient to help differentiate latest from oldest stories at a glance. To view
this field, you must activate the RSS News feed feature via the Feature Selector>Fundamental Analysis category.

News
Title

Displays the title of the news story. To view this field, you must activate the
RSS News feed feature via the Feature Selector>Fundamental Analysis category. For a deeper look at a story, double-click the title.
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Position and P & L
Column
Name

Description

Avg Price

The average cost of the current position.

Cost Basis

The cost basis is calculated using the formula:
average price x position x multiplier

Market
Value

Equal to (position * market price).

Position

Your current position in the selected contract.

P&L

Displays gains or losses. To modify the P&L calculation used, right-click the
field and select or deselect Include today's opening position in P&L calculation.
NOTE: When the closing price is not available, the average price is
used for the P&L calculation. This occurrence is noted by an exclamation point (!) in the P&L field.

Unrealized
P&L

Calculates unrealized P&L for stocks, stock options and futures options. Unrealized P&L is calculated using the formula:
(current market price - average cost/share) x total number of shares
The average cost per share is updated in realtime. This field is automatically
added to the Trading window when the customer takes a position. Once
removed it is not automatically added again.

Realized
P&L

Calculates the realized profit and loss per position.

Unrealized
P&L Spinner

A graphic real-time representation of unrealized profit and loss, where the
arrow color indicates whether your current unrealized P&L is positive (blue) or
negative (red), the direction indicates whether the last price change was negative (pointing left) or positive (pointing right), and the length of the arrow represents the distance between the purchase/sale price and the last bid/ask.

TWS Users' Guide

587

The Quote Monitor

Prices
Column
Name

Description

Ask

The best ask price for a contract. This is the best price at which you could currently BUY.

Ask Size

The approximate depth of the current offer.

Bid

The best bid price for a contract. This is the best price at which you could currently SELL.

Bid Size

The approximate depth of the current bid.

Change

How much the current price has risen or declined from the previous day's closing price. If the price has declined, the background is red. If the price has risen,
the background is blue. To toggle between dollar change and percent change,
click the column title.

Change
(%)

The percentage that the current price has risen or declined from the previous
day's closing price. If the price has declined, the background is red. If the price
has risen, the background is blue. To toggle between percent change and dollar
change, click the column title.

Change
Since
Open

The change in price (by dollar value or percent) since the day's opening price.
If the price has declined, the background is red. If the price has risen, the background is blue. To toggle between percent change and dollar change, click the
column title.

Close

Displays the last available closing price for the asset. For US equities, we use
corporate action processing to get the closing price. This means the close price
is adjusted to reflect forward and reverse splits, and cash and stock dividends.

Dividends

Dividend information displayed on a “best efforts” basis.

EXT

Requires a subscription to eSignal market data. The exchange where the contract has traded.

Gap

Displays the difference between the previous night's closing price and the day's
opening price. You can toggle this display between showing the gap in currency
units or percentage points (100% x Gap / Today's Open). To toggle the display,
right-click the column title and select Toggle Display.

Last

The last price at which the contract traded. A "C" in front of the last price
indicates that this is the previous day's closing price.
For forex, commodities and IB index CFDs, the "midpoint" value is displayed
instead of the last.
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Last Size

The size of the last contract traded. If the last contract traded is larger than the
previous one, the font is green. If it's smaller, the font is red.

Mark
Price

The mark price is equal to the LAST price unless:
Ask < Last - the mark price is equal to the ASK price.
Bid > Last - the mark price is equal to the BID price.

Mid

The midpoint between the current bid and ask.

Open

The opening price for the day.

RSI Colorful

Requires a subscription to eSignal market data. The Relative Strength Index
compares the magnitude of recent losses to recent gains and relays that comparison in the form of a number that ranges from 0 to 100 where 0 indicates
weaker performance. For quick reference, the background color is red if the
RSI is less than 20, and green if the RSI is higher than 80.

RSI
Numeric

Requires a subscription to eSignal market data. The Relative Strength Index
compares the magnitude of recent losses to recent gains and relays that comparison in the form of a number that ranges from 0 to 100 where 0 indicates
weaker performance.

Spread

The difference between the current ask and bid.

Trade
Time

Time of the last trade. The background color indicates the relative activity of a
security compared with all other active contracts on your trading pages. The
lighter background indicates more activity for the contract. Darker indicates
that other securities are trading more actively.

Underlying
Price

Displays the price of the underlying.

VWAP

The volume-weighted average price.

Y Close

Requires a subscription to eSignal market data. The previous trading day’s last
trade price.
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High/Low/Volume
Column
Name

Description

13 week
low

The lowest price for the past 13 weeks.

13 week
high

The highest price for the past 13 weeks.

26 week
low

The lowest price for the past 26 weeks.

26 week
high

The highest price for the past 26 weeks.

52 week
low

The lowest price for the past 52 weeks.

52 week
high

The highest price for the past 52 weeks.

Average
Volume

The average daily trading volume over 90 days (multiply this value times 100).

Low

Low price for the day for the selected contract.

High

High price for the day for the selected contract.

Relative
Volume

Requires a subscription to eSignal market data. Compares today’s volume with
volume from the previous trading day. Indicator grows toward the right as
today’s volume increases.

Relative
Volume
3D

Requires a subscription to eSignal market data. Compares today’s volume with
volume from the previous trading day. Indicator grows toward the right as
today’s volume increases.

Volume

Trading volume for the day for the selected contract.

Volume
Spinner

A graphic representation of volume activity, where a blue bar representing
10,000 shares moves across the field from left to right. The faster the bar moves
the higher the trading volume. A temporary color change indicates that the last
sale was greater than 10,000 shares.

Y High

Requires a subscription to eSignal market data. The highest price from the previous trading day.

Y Low

Requires a subscription to eSignal market data. The lowest price from the previous trading day.

TWS Users' Guide

590

The Quote Monitor

Y
Volume

TWS Users' Guide

Market Data Fields

Requires a subscription to eSignal market data. The trading volume from the previous trading day.

591

The Quote Monitor

Options
Column
Name

Description

Ask Exch

Identifies the options exchange(s) posting the best ask price on the options contract.

Bid-Exch

Identifies the options exchange(s) posting the best bid price on the options contract.

Call/Put
Interest

Call option open interest/put option open interest.

Call/Put
Volume

Call option volume/put option volume for the trading day.

Closing
Implied
Vol.

The implied volatility of the option on yesterday’s closing price.

Historical
Vol.

Displays the 30-day historical volatility for an option. Right-click the field header
to toggle between Daily or Annual.

Imp Vol
(%)

The implied volatility is based on the average of the best bid and offer for an
option. This calculation is non-linear, and may not converge for low vega
options. In such cases, no implied volatility estimate will be displayed.

Model

The option model price is calculated using the underlying price, interest rate,
dividends and other data that you enter using the Option Model Editor.

Model IV

The option model implied volatility.

Open
Interest

Charts the total number of options that were not closed.

Opt. Imp.
Vol.
Change

The absolute change in implied volatility between the current value and the value
calculated using yesterday’s closing price.

Opt.
Implied
Vol

A prediction of how volatile an underlying will be in the future. The IB 30-day
volatility is the at-market volatility estimated for a maturity thirty calendar days
forward of the current trading day, and is based on option prices from two consecutive expiration months.

Opt.
Volume

The total number of contracts traded over a specified time period.

Opt
Volume

Change in volume from the previous day's close.
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Change
Put/Call
Interest

Put option open interest/call option open interest, for the trading day.

Put/Call
Volume

Put option volume/call option volume for the trading day.

Time
Value

Shows the premium in excess of the option’s intrinsic value.
Time Value = Option Bid - Intrinsic Value
IV for Calls = max(stock price - strike, 0)
IV for Puts = max(strike - stock price, 0)
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Bond Columns
The bond-related fields below can be added to your trading windows in TWS.
Column
Name

Description

Bid Yield

The yield-to-worst. This is the lower of yield to maturity and yields to all calls.
The yield is only shown if it is offered on the exchange.

Ask Yield

The yield-to-worst. This is the lower of yield to maturity and yields to all calls.
The yield is only shown if it is offered on the exchange.

Last Yield

The yield-to-worst. This is the lower of yield to maturity and yields to all calls.
The yield is only shown if it is offered on the exchange.

Bond Attributes

Bond attributes of last sale price which may include:
Non-standard settlement date (normal settlement for bonds is T + 3), including

C - cash trade
ND - next day trade
S# - seller's option
Other Attributes

W - weighted average trade
A - afterhours trade
10 yr
Hedge

The equivalent number of 10-year US Treasury bonds that would hedge one of
the given bonds. It is the DVO1 of the given bond divided by the DV01 of the
10-year US Treasury bond.

Convexity

Duration is a reasonably good estimate of bond price movements upon small
interest rate moves. However, it assumes that bond price moves linearly with
interest rates, which is not true especially for larger rate moves. Convexity corrects duration for this non-linearity as follows:
= ½ x Convexity x (Rate Move in decimals ^ 2) * 100
In Example 1, if the convexity is 8, the correction to duration would be:
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= ½ x 8 x (0.0050 ^ 2) * 100 = 0.01%
Hence, the bond price would be expected to increase by:
= 2.5% + 0.01% = 2.51%
or:
= 2.51% x 105 = 2.6355
Duration
(%)

Duration is a measure of bond price sensitivity to interest rate movements. It is
defined as the percentage decrease (or increase) in the bond price in response
to a 100 basis point upward (or downward) move in interest rates.
Example 1: When the interest rates in the market fall by 50 basis points, a
bond trading at 105 with a duration of 5 would be expected to appreciate by
roughly: 5 x 50 / 100 = 2.5%. Note that for ordinary bonds,the price moves
opposite to the interest rate. If the rates had increased by 50 basis points, the
bond price would have declined by 2.5%.

Value of
BPs

The dollar value decrease in the price of a bond due to a 1 basis point, upward
parallel shift in the yield curve. Commonly referred to as DV01. It is the duration times the bond price divided by 100.

Amount
Outstanding

The amount of the bond outstanding as of the corporations’s latest available
balance sheet.

Bond Short
Name

Shows the actual text name of the bond for easier identification.

CUSIP

The cusip identifier.

Coupon

The interest rate used to calculate the amount you will receive annually, payable based on the Payment Frequency.

Current
Ask Yield

The yield of the bond if it is purchased at the current offer.

Current Bid
Yield

The yield of the bond if it is purchased at the current bid.

Exchange
Listed

Indicates whether or not the bond is listed.

Payment
Frequency

The bond payment frequency.

Ratings

The rating issued for the bond.
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Auction
For Arca options orders.
Column
Name

Description

Auc.
Price

The price at which the auction would occur if no new orders were received and
the auction were held now. The indicative price for the auction.

Auc.
Volume

The number of shares that would trade if no new orders were received and the
auction were held now.

Imbalance

The number of unmatched shares for the next auction; shows how many more
shares are on one side of the auction than the other.
Blue indicates an imbalance on the buy side (more buy orders), red indicates an
imbalance on the sell side (more sell orders).

TWS Users' Guide

596

The Quote Monitor

Market Data Fields

Fundamentals Other
To add Popular Fundamentals columns to the Quote Monitor or other window, hold your mouse over the Market
Data column next to where you want to include the column, and click the green "+" sign to display the list of
available columns.
Column
Name

Description

Book Value
(tangible) per
share

This is the interim Tangible Book Value divided by the Shares Outstanding at the end of the most recent interim period. Tangible Book
Value is the Book Value minus Goodwill and Intangible Assets for the
same period.

Cash Flow per
share

This value is the trailing twelve month Cash Flow divided by the trailing
twelve month Average Shares Outstanding. Cash Flow is defined as the
sum of Income After Taxes minus Preferred Dividends and General Partner Distributions plus Depreciation, Depletion and Amortization.

Cash per share

This is the Total Cash plus Short Term Investments divided by the Shares
Outstanding at the end of the most recent interim period.
NOTE: This does NOT include cash equivalents that may be reported
under long term assets.

Current ratio

This is the ratio of Total Current Assets for the most recent interim period
divided by Total Current Liabilities for the same period. NOTE: This item
is Not Available (NA) for Banks, Insurance companies and other companies that do not distinguish between current and long term assets and
liabilities.

Dividend rate

This value is the total of the expected dividend payments over the next
twelve months. It is generally the most recent cash dividend paid or
declared multiplied by the dividend payment frequency, plus any recurring
extra dividends.

EDITD

Earnings Before Interest, Taxes, Depreciation and Amortization (EBITDA) is EBIT for the trailing twelve months plus the same period's
Depreciation and Amortization expenses (from the Statement of Cash
Flows). NOTE: This item is only available for Industrial and Utility companies.

EPS Change
TTM %

This is the percent change in the trailing twelve month EPS as compared
to the same trailing twelve month period one year ago. It is calculated as
the trailing twelve month EPS minus the trailing twelve month EPS one
year ago divided by the trailing twelve month EPS one year ago, multiplied by 100. NOTE: If either value has a negative value, the resulting
value will be Not Meaningful (NM).
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EPS Change
Y/Y %

This value is calculated as the most recent interim period EPS minus the
EPS for the same interim period one year ago divided by the EPS for the
same interim period one year ago, multiplied by 100. NOTE: EPS must be
positive for both periods. If either EPS value is negative, the result in Not
Meaningful (NM).

EPS Normalized

This is the Normalized Income Available to Common Stockholders
for the most recent annual period divided by the same period's
Diluted Weighted Average Shares Outstanding.

Earnings
before taxes

Also known as Pretax Income and Earnings Before Taxes, this is
Total Revenue for the most recent TTM period minus Total
Expenses plus Non-operating Income (Expenses) for the same
period.

Earnings
before taxes
Normalized

This is the Income Before Tax number excluding the impact of all
unusual/one-time/special charges items for the most recent
annual period.

Gross margin

This value measures the percent of revenue left after paying all
direct production expenses. It is calculated as the trailing 12
months Total Revenue minus the trailing 12 months Cost of Goods
Sold divided by the trailing 12 months Total Revenue and multiplied by 100. NOTE: This item is only available for Industrial and
Utility companies.

Growth rate %
- dividend

The Dividend Growth Rate is the compound annual growth rate in
dividends per share. It is calculated for three years whenever four
years of dividends are available.

LT debt/equity

This ratio is the Total Long Term Debt for the most recent interim
period divided by Total Shareholder Equity for the same period.

Net Income
Available to
Common,
Normalized

This is the annual dollar amount accruing to common shareholders
for dividends and retained earnings excluding the impact of all
unusual/one-time/special charges items.

Net income
available to common

This is the trailing twelve month dollar amount accruing to common shareholders for dividends and retained earnings. Income
Available to Common Shareholders is calculated as trailing twelve
month Income After Taxes plus Minority Interest and Equity in
Affiliates plus Preferred Dividends, General Partner Distributions
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and US GAAP Adjustments. NOTE: Any adjustment that is negative
(i.e.. Preferred Stock Dividends) would be subtracted from
Income After Taxes.

Net Profit Margin %

Also known as Return on Sales, this value is the Income After
Taxes for the trailing twelve months divided by Total Revenue for
the same period and is expressed as a percentage. NOTE: Most
Banks and Finance companies do not report revenues when they
announce their preliminary quarterly financial results in the press.
When this happens, the trailing twelve month value will not be
available (NA).

Operating margin

This value measures the percent of revenues remaining after paying all operating expenses. It is calculated as the trailing 12
months Operating Income divided by the trailing 12 months Total
Revenue, multiplied by 100. Operating Income is defined as Total
Revenue minus Total Operating Expenses.

P/E Normalized

This is the Current Price divided by the latest annual Normalized
Earnings Per Share value.

Payout ratio

This ratio is the percentage of the Primary/Basic Earnings Per
Share Excluding Extraordinary Items paid to common stockholders
in the form of cash dividends during the trailing twelve months.

Pretax margin

This value represents Income Before Taxes for the most recent
fiscal year expressed as a percent of Total Revenue for the most
recent fiscal year.

Price to Cash
Flow per share

This is the current Price divided by Cash Flow Per Share for the
trailing twelve months. Cash Flow is defined as Income After
Taxes minus Preferred Dividends and General Partner Distributions plus Depreciation, Depletion and Amortization.

Price to sales

This is the current Price divided by the Sales Per Share for the trailing twelve months. If there is a preliminary earnings announcement for an interim period that has recently ended, the revenue
(sales) values from this announcement will be used in calculating
the trailing twelve month revenue per share. NOTE: Most Banks
and Finance companies do not report revenues when they
announce their preliminary interim financial results in the press.
When this happens, the trailing twelve month values will not be
available (NA) until the complete interim filing is released.
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Return on average assets

This value is the Income After Taxes for the trailing twelve months
divided by the Average Total Assets,expressed as a percentage.
Average Total Assets is calculated by adding the Total Assets for
the five most recent quarters and dividing by five.

Return on
investment

This value is the trailing twelve month Income After Taxes divided
by the average Total Long Term Debt, Other Long Term Liabilities
and Shareholders Equity, expressed as a percentage.

Revenue

This is the sum of all revenue (sales) reported for all operating
divisions for the most recent TTM period. NOTE: Most banks and
Insurance companies do not report revenues when they announce
their preliminary quarterly financial results in the press. When this
happens, the quarterly value will not be available (NA).

Revenue
Change TTM %

This is the percent change in the trailing twelve month Sales as
compared to the same trailing twelve month period one year ago.
It is calculated as the trailing twelve month Sales minus the trailing twelve month Sales one year ago divided by the trailing twelve
month Sales one year ago, multiplied by 100.

Revenue
Change Y/Y %

This value is calculated as the most recent interim period Sales
minus the Sales for the same interim period 1 year ago divided by
the Sales for the same interim period one year ago, multiplied by
100.

Revenue
growth rate

The Five Year Revenue Growth Rate is the annual compounded
growth rate of Revenues over the last five years.

Revenue/share

This value is the trailing twelve month Total Revenue divided by
the Average Diluted Shares Outstanding for the trailing twelve
months. NOTE: Most Banks and Insurance companies do not report
revenues when they announce their preliminary quarterly financial
results in the press. When this happens, the trailing twelve month
values will not be available (NA).

Total
debt/total
equity

This ratio is Total Debt for the most recent interim period divided
by Total Shareholder Equity for the same period. NOTE: This is not
meaningful (NM) for banks.

Volume

This is the daily average of the cumulative trading volume for the
last ten days.
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Fundamentals Popular
To add Popular Fundamentals columns to the Quote Monitor or other window, hold your mouse over the Market
Data column next to where you want to include the column, and click the green "+" sign to display the list of
available columns.

To add multiple columns, right-click the column header and select Customize Layout.
Column
Name

Description

Analyst Forecast of EPS N12

Provides the analyst forecast estimate of EPS for the next twelve
months.

Book Value
(Common
Equity) per
share

Defined as the Common Shareholder's Equity divided by the Shares
Outstanding at the end of the most recent interim period. Book Value
is the Total Shareholder's Equity minus Preferred Stock and Redeemable Preferred Stock.

Dividend Yield
%

Dividends per share/current price, expressed as a percentage.

Dividends
(TTM)

This is the sum of the Cash Dividends per share paid to common stockholders during the last trailing twelve month period.

EPS Growth

This growth rate is the compound annual growth rate of Earnings Per
Share over the last 5 years, excluding Extraordinary Items and Discontinued
Operations.
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NOTE: If the value for either the most recent year or the year furthest out is
zero or negative, the growth rate cannot be calculated and 'NA' (Not Available) will display.

EPS excluding
extraordinary
items

This is the Adjusted Income Available to Common Stockholders for
the trailing twelve months divided by the trailing twelve month
Diluted Weighted Average Shares Outstanding.

Market Cap

The market cap value is calculated as follows:
Current Price x Current Number of Shares Outstanding

P/E

This ratio is calculated by dividing the current Price by the sum of the
Diluted Earnings Per Share from continuing operations BEFORE Extraordinary Items and Accounting Changes, over the last four interim periods.

Price/Book

This is the Current Price divided by the latest interim period Book Value Per
Share.

Price/Tang.
Book Ratio

The current price divided by the latest interim period Tangible Book
Value per Share. Tangible Book Value per Share is the book value
minus Goodwill and intangible Assets, divided by the Shares Outstanding at the end of the interim period.

Quick Ratio

Also known as the Acid Test Ratio, this value is defined as Cash plus Short
Term Investments plus Accounts Receivable for the most recent interim
period divided by the Total Current Liabilities for the same period.
NOTE: This item is Not Available (NA) for banks, insurance companies
and other companies that do not distinguish between current and long term
assets and liabilities.

Return on
Equity
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This value is the Income Available to Common Stockholders for the trailing
twelve months divided by the Average Common Equity, and is expressed as
a percentage. Average Common Equity is calculated by adding the Common
Equity for the 5 most recent quarters and dividing by 5.
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Graphic Prices
Column
Name

Description

Ask Spinner

A red bar whose placement in the field represents the cents in the current best
Ask price, relative to a dollar. A bar in the center of the field indicates that the
cents value in the Ask price is close to $.50. A bar toward the left indicates
that the cents value is closer to zero, and to the right indicates that it's
approaching one dollar.

Bid Spinner

A green bar whose placement in the field represents the cents in the current
best Bid price, relative to a dollar. A bar in the center of the field indicates
that the cents value in the Bid price is close to $.50. A bar toward the left
indicates that the cents value is closer to zero, and to the right indicates it's
approaching one dollar.

Candlestick

A graphic representation of the direction and magnitude of price change. The
wide end of the arrow represents the opening price, and the narrow end represents the last price. An arrow pointing to the right indicates that the price is
higher than the previous close, and an arrow pointing to the left indicates that
the price has dropped from the previous close. A brighter shade indicates a
greater magnitude of price change.

Graphic
Change

A graphic representation of the difference between the last price and the previous day's closing price. The arrow is centered in the field, and colored green
if the last price is higher than the close, and colored red if it's lower. The
longer the arrow the wider the difference between the two prices. The field
accommodates graphing changes up to $2.00 below and $2.00 above the close.

Last Spinner

A magenta bar whose placement in the field represents the cents in the current
Last price relative to a dollar. A bar in the center of the field indicates that the
cents value in the Last price is close to $.50. A bar toward the left indicates
that the cents value is closer to zero, and to the right indicates that it's
approaching one dollar.

RSI

Requires a subscription to eSignal market data. The Relative Strength Index
compares the magnitude of recent losses to recent gains and relays that comparison in the form of a number that ranges from 0 to 100 where 0 indicates
weaker performance. For quick reference, the indicator shows a red bar if the
RSI is less than 50, and a green bar otherwise. Bar size and color hue change
based on the RSI value.

RSI Scaled

Requires a subscription to eSignal market data. The Relative Strength Index
compares the magnitude of recent losses to recent gains and relays that comparison in the form of a number that ranges from 0 to 100 where 0 indicates
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weaker performance. The scaled version uses values from 20 to 80. For quick
reference, the indicator shows a red bar if the RSI is less than 50, and a green
bar otherwise. Bar size and color hue change based on the RSI value.

Range

A graphic comparison of the last price to the day's high and low. The indicator
starts in the center of the field and moves toward the left (in red) as the last
price approaches the day's low, and to the right (in green) as the last price
approaches the day's high. If the last price equals the low or high, the bar
changes color. You can elect to view the Range in three visual different
modes, basic Range, Range 3D, and Range 3D Alert. Only the last shows a
color change when the price equals the high or low.

Smart Spinner

A graphic representation of the cents in the current price relative to a dollar. If
you hold a short position, the bar is red and represents the cents in the Ask
price. If you hold a long position, the bar is green and represents the cents in
the Bid price. For contracts in which you hold no position, the bar is gray, and
represents the cents in the Last price. A bar in the center of the field indicates
that the cents value in the price is close to $.50. A bar toward the left indicates
that the cents value is closer to zero, and to the right indicates that it's
approaching one dollar.
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Market Data Fields

Order Presets
Column
Name

Preset

TWS Users' Guide

Description

Displays the current default strategy for the contract, and contains a drop-down
selection list of all order strategies available for the contract. If a custom
strategy is in place for the contract and the Presets field is not displayed, the Preset Strategy icon will be shown in the contract description field.
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Stock Borrow/Loan
Column

Description

Underlying

The underlying symbol.

Position

Your current position in the asset. In the Stock Borrow/Loan window, this represents your current borrow position.

Loanable
Quantity

Shows the quantity available for lending in the underlying, based on your current position.

Avg Rate

The average borrow rate of your current Borrow/Loan positions.

Auction
Borrow
Size

The volume of shares being bid for at the Auction Borrow rate.

Auction
Borrow

This value represents the best rate quoted to lend the underlying, and is the percentage of the total collateral you will receive (without interest) for lending the
contract, in addition to the collateral you receive based on the price of the
underlying. Hold your mouse over the value to see the Total Rate (interest - borrow fee).

Click the Auction Borrow field to create a Lend order.
Auction
Lend

This value represents the best rate quoted to borrow the underlying, and is the
percentage of the total collateral you must put up for borrowing the contract.
The borrow fee is in addition to the collateral you pay based on the price of the
underlying. Hold your mouse over the fee to see the Total Rate (interest - borrow fee).
Click the Auction Lend field to create a Borrow order.

Auction
Lend Size

The volume of shares available to borrow at the Auction Lend rate.

Auction
rate

The indicative rate for the next scheduled auction. Auctions occur every 15
minutes while the Borrow/Loan market is open.

Borrow
Size

The volume of shares being bid for at the last auction rate during continuous
trading.

Borrow

The last auction rate that was established during continuous trading.
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Lend

The last auction rate that was established during continuous trading.

Lend Size

The volume of shares available to borrow at the last auction rate during continuous trading.

Auction
Volume

The total number of shares available for the next auction.

Previous
Auction
Volume

The total number of shares that were available for the previous auction.

Last

The equilibrium rate established at the last auction.
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Short Selling
Add short selling Market Data fields to any tool or window. To insert a field:
Hold your mouse over any field title until the "+" and "x" Insert and Remove icons appear. Click the
"+ " to display the list of available fields. Note that if you hover your mouse over an order field, all
available order fields are displayed. If you hover over a market data field, all available market date
fields are displayed.

Column
Name

Description

Days to cover

Calculated as the aggregate short interest for the month divided by the
average daily share volume traded between short interest settlement
dates. Also known as "Short Interest Ratio."

Shares short

The total number of shares of a security that have been sold short by
customers and securities firms that have not been repurchased to settle
outstanding short positions in the market; the net short positions outstanding in the stock as of the settlement date.

Short % of Float

Percentage of short interest shares to Float shares outstanding, or:
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Percentage of Float = Short interest/float shares *100.

Fee rate

Interest rate charted on borrowed shares.

Rebate rate

Fed funds rate minus the interest rate charged on borrowed shares.

Shortable
shares

The number of shares available for shorting.
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Order Management Fields
Customized Layout

To add or remove fields from your Quote Monitor, right-click on any field label and select Customize
Layout. In the list of Order Management columns, move the desired field from the Available to the
Shown list to display, or from the Shown list to the Available list to hide. You can modify the layout of
fields per page, or globally using a page layout that is applied to multiple Quote Monitors.

Changes to a page layout are automatically applied to any pages that already use the layout.
l

Mandatory Columns

l

Contract Descriptions
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l

Time in Force Columns

l

Quantity Columns

l

Price-based Columns

l

Actions Columns

l

Adjustable Stop Columns

l

Volatility Columns

l

EFP Columns

l

Pegged to Stock Columns

l

Order Attributes Columns

l

Status Columns

l

Scale Order Columns
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Mandatory Columns
The columns below are always displayed on an order line in the trading window.
Column
Name

Description

Shown Columns (mandatory columns that cannot be removed)

Action

The order action. BUY or SELL.

Type

The order type.

Quantity

The number of units in your order.

Lmt.
Price

The limit price for order types to which this price applies, including Limit, Stop
Limit, and Relative orders.

Aux.
Price

This field reflects the Election price for Stop and Stop Limit orders, and the Offset Amount for Relative and Trailing Stop orders. You can set these auxiliary
amounts in the Default Order Settings box.

Basis
Points

Used with futures EFPs. The basis point value is equal to the implied interest
rate x 100.

Status

The order status. See Guide to System Colors for details.
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Contract Descriptions
Column
Name

Description

Contract Description

Description

Identifies the instrument type and other descriptive contract information.

Exchange

The market data exchange. If no other exchange is specified in the Destination
field, this is also the destination to which the contract will be routed. Select
SMART order routing to route directly to the best available market.

Symbol

The exchange symbol for the contract.

Underlying

Shows the underlying symbol. Note that if you want a single Underlying field
on the trading window with no order field below it, check the Underlying field
for both market data and order management.
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Time in Force Columns
Column
Name

Description

Time in Force

Exp. Date

For GTD orders. Keeps the order active until the close of market on the date you
enter. Date format is YYYY/MM/DD.

Exp.
Time

For GTD orders. Keeps the order active until the time on the date you enter in
the Exp. Date field.

Good
After
Time

Activates the order after the specified time has elapsed.

Time in
Force

The time span over which your order remains active. By default, the time in
force is day, which means any part of your order that has not executed by the
time the market closes will be cancelled by the system.
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Order Management Fields

Quantity Columns
Column
Name

Description

Quantity

Display
Size

Enter a display size to create an iceberg order.

Min Quantity

Enter the minimum acceptable quantity that must be available for the order to
execute.

Quantity
Type

Used in conjunction with Quantity Value field to automatically calculate order
quantity based on your instructions.

Quantity
Value

Used in conjunction with Quantity Type field to automatically calculate order
quantity based on your instructions.

Total Qty

The total quantity of the original order.
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Price-based Columns
Column
Name

Description

Prices

Current Price

The current working price of an order at the exchange.

Discretionary
Amt

Enter a discretionary amount with a limit order to create a discretionary order.

Lmt Offset.

Used for trailing stop limit orders to determine the limit price for the contract.

Pct. Offset

Creates an offset price based on a percentage off the best bid or ask. Use a
decimal value between 0 - 1.

Stop Price

The Election price for Stop and Stop Limit orders, and the initial stop price for
trailing stop and trailing stop limit orders.
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Order Management Fields

Actions Columns
Column Name

Description

Actions
Cancel

Click to cancel the order.

Transmit

Click to send the order to the order destination.
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Adjustable Stop Columns
Column
Name

Description

Adjustable Stop

Adj Order
Type

The order price submitted when the trigger price is hit on a stop, stop limit,
trailing stop or trailing stop limit order.

Adj Stop
Lmt Price

The initial limit price for the adjusted stop limit or trailing stop limit order.

Adj Stop
Price

The new stop price for the adjusted order.

Adj Trailing
Amnt

The new trailing amount for a trailing stop or trailing stop limit order.

Trigger
Price

The price that triggers the one-time adjustment of a stop, stop limit, trailing
stop or trailing stop limit order.
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Order Management Fields

Volatility Columns
Column
Name

Description

Continuous
Update

If checked, the option limit price is automatically updated based on significant
movement in the price of the underlying. Also used for EFPs.

Hedge Aux
Price

If needed, enter the auxiliary price for a delta neutral order type that requires
another price field.

Hedge
Order Type

Define an order type for a delta neutral trade. This will be submitted in conjunction with dynamic management of your volatility orders.

Reference
Price Type

For dynamic volatility orders. Choose the average of the NBBO, or the bid or
ask price to be used as the reference price.

Undrl.
Range
(High)

The optional low-end value of a stock range for Volatility orders. If the price
of the underlying falls below this value, the order is cancelled.

Undrl.
Range
(Low)

The optional high-end value of a stock range for Volatility orders. If the price
of the underlying rises above this value, the order is cancelled.

Volatility

Displays volatility for the option at a specific strike price.

Volatility
Type

Select either Annual or Daily implied volatility calculation for VOL orders.
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EFP Columns
Column
Name

Description

EFP

Continuous
Update

For EFPs. If checked, the limit price is automatically recalculated based on
movement in the basis points.

Int. Rate

For EFPs.
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Pegged to Stock Columns
Column
Name

Description

Pegged-to-Stock

Delta

Used for pegged to stock orders. This value is used as a percent, and is multiplied by the change in the underlying price. this value is added to the starting
price to determine the price for a call option.

Stock Ref
Price

An optional value used for Pegged to Stock option orders. If left blank, the
NBBO midpoint is used. This value is subtracted from the current NBBO midpoint to determine a change in the stock price.

Undrl
Range
(High)

The optional high-end value of a stock range for Pegged to Stock orders. If the
price of the underlying rises above this value, the order is cancelled.

Undrl
Range
(Low)

The optional low-end value of a stock range for Pegged to Stock orders. If the
price of the underlying falls below this value, the order is cancelled.
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Order Attributes Columns
Column
Name

Description

Order Attributes

All or None

Marks the order as AON, to ensure the order will not execute unless/until the
entire quantity is available.

Block

Mark your high-volume limit order as a block order.
You may want to consider using ScaleTrader for large volume orders.

Consider
Cost

If checked, Smart router will consider trade costs, including commissions,
when deciding where to route your order.

Hidden

Check to create a hidden order.

Hide Pennies

For US Options orders in pennies, hides the pennies from the market.

ISE Order
Type

For Midpoint Match orders on the ISE Stock Exchange, select from two order
types. A Standard order is entered as a market or limit order but is not displayed to the trading community. Standard orders support the Immediate or
Cancel (IOC) order attribute.
An SOI (Solicitation of Interest) order broadcasts the symbol to ISE MPM
users. These orders have a minimum order quantity of 2000.

Non-Guaranteed

Check to indicate that you will take all the risk for partially executed smartrouted spread orders.

OCA
Group

Allows you to create a one-cancels-all advanced order group without opening
the Order Ticket window.

Open/Close

Specifies whether the order is to open (or increase) a position, or close (or
decrease) a position.

Add Liquidity

If checked, this feature attempts to improve the price on the combo by
providing liquidity on at least one leg of a two-legged combo by submitting one leg of a marketable combo one tick below the market for
that leg. Leaving this feature enabled may result in the combo order
not executing.

Origin

The customer type from which the order originated. Mainly used for institutional accounts.

Preserve
Time Pri-

Check to keep your order in the queue regardless of incurred exchange fees.
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ority

Shareholder

A tag used by large shareholders who trade Canadian products.

Sweep to
Fill

Check to create a sweep-to-fill order.

Soft Dollars

Use the dropdown list to select the soft dollar tier for the order. This field is
only visible for accounts that have soft dollar functionality enabled.

Trigger
Method

Displays a dropdown field with a list of all available Trigger Methods. This
allows you to select a new method on a per-order basis.
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Status Columns
Column
Name

Description

Status

Destination

The routing destination.

Key

System-created key to identify bundled limit, bracket and trailing stop
orders.

Trade Price

The price at which the order or portion of the order executed.
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Order Management Fields

Scale Order Columns
Column
Name

Description

Scale Orders

Scale
Incr.

This amount is used to calculate the per-unit price of each component in the
scale ladder. Note that the price increment cannot be negative.

Scale Init

Set the initial component size for the scaled order.

Scale
Profit Offset

A value in this field instructs TWS to submit profit-taking orders, and defines
the minimum amount of profitability you will accept to exit a position.
ScaleTrader will submit an opposite-side profit order against the original order,
using the limit price of the parent component plus/minus the profit offset. For
example, if you submit a 10,000 share BUY limit order at $65.00 with a component size of 1000, and enter $15.00 as the Scale Profit Offset, as soon as
the first component executes, TWSwill submit a 1000 share SELL limit order
at $80.00.

Scale Sub

Set the subsequent component size for the scaled order. If you leave this field
blank, ScaleTrader uses the initial component size.
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Trade Bonds
Introduction

TWS lets you trade Smart-routed US Corporate bonds, US Treasury bonds, notes and bills, and US
Municipal bonds.
l

Subscribe to Bond Data

l

Trade Treasuries

l

Trade US Corporate Bonds

l

Trade US Municipal Bonds
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Trade Bonds

Trade US Corporate Bonds
Use the US Corporate Bonds scanner to find contracts to add to your trading page.

Add corporate bonds market data to your trading page
1. Enter an underlying symbol and hit enter, then select the Bond instrument from the selection
list.
2. In the Contract Selection box, use the Maturity date, Issue Date and Coupon filter lists to narrow your display choices.
3. Select the contract(s) from the right pane and click OK.
If you want to add multiple contracts with different maturities, click Add instead of OK. This will
add the selected contracts to your trading screen and then allow you to select a different maturity date and add more contracts. Click OK to close the box.
Market data for the bond is displayed on the trading page. The following information is noted in the
Description field of the market data line:
l

l

Instrument type - For treasuries. Labeled as bond, note, or bill.
Coupon - the interest rate used to calculate the amount you will receive as interest payments
over the course of a year.

l

Maturity date - the date on which the issuer must repay the face value of the bond.

l

CUSIP number - a nine-character ID for a specific security.

l

Bond rating - Identifies the credit rating of the issuer. A higher credit rating generally indicates
a less risky investment. The bond ratings are from Moody's and S&P, respectively.

To see contract details, double-click on a market data line.
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Trade corporate bonds
1. Click the Ask to create a BUY order; click the Bid to create a SELL order.
2. Click “T” to transmit the order.

Place a non-marketable limit order that meets or exceeds the best quote and your order will be included in the
market data shown to other IB customers.
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Trade Treasuries
Once you have subscribed to bond market data via Account Management, you can enter data and
trade t-bonds, t-bills and t-notes.
To trade treasuries
1. Add market data for treasuries
1. Click the Treasuries icon on the Trading toolbar, or use the Edit menu and select Treasury
Bond Selector.
2. In the Contract Selection box, use the Type list in the left pane to choose Bills, Bonds or
Notes.
3. Filter your contracts using the Maturity date, Issue Date and Coupon filter lists.
4. Select the contract(s) from the right pane and click OK.
If you want to add multiple types of treasuries to your screen, click Add instead of OK. This
will add the selected contracts to your trading screen and then allow you to select a different
type and add more contracts. Click OK to close the box. to your trading page.
2. Click the Ask to create a BUY order, click the Bid to create a SELL order.
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Trade US Municipal Bonds
US residents can trade municipal bonds in TWS

Add muni bond market data to your trading page
1. In the Underlying field, enter the municipality name, for example Boston.
2. From the list of results, uncheck all asset types except munis.
3. Select the muni bond(s) from the remaining results and click OK.
4. The muni data is added to your trading window.

Add the Company Name field to your page layout to see the municipality name. The Underlying field only displays the CUSIP.
Trade muni bonds
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Trade Bonds

1. Click the Ask to create a BUY order; click the Bid to create a SELL order.
2. Click “T” to transmit the order.
3. In the Comparable Bonds screen, submit an RFQ, compare your bond to others that are comparable, and transmit your order.
Notes on Comparable Bonds

MSRB Rule G-18 requires each broker, dealer and municipal securities dealer, when executing a transaction in municipal securities for or on behalf of a customer, to make a reasonable effort to obtain a
price for the customer that is fair and reasonable in relation to prevailing market conditions. Since IB
customers enter orders to buy and sell municipal bonds into an automated system, the system is
designed to provide the relevant information regarding each security that a customer is considering
trading.
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IB's Best Execution policy is designed to attempt to get two or more quotes for each customer transaction. Because the municipal securities market may be extremely illiquid, two quotes may not be
available for a specific security and the currently available quotes may not reflect the best possible
price. Therefore, in addition to providing the customer with quotes and comparable prices for the specific bond chosen by the customer, IB provides quotes and prices for comparable bonds as a comparison and also provides a facility to place a request for a quote (RFQ) on a specific bond that the
customer selects. After reviewing and evaluating the prices for comparable securities, in addition to
the specific security that they have requested, customers can transmit an order for the municipal
bond of their choice.
To qualify as “comparable” to your target bond for price comparison, a bond must meet all of the following criteria:
l

l

l

l

It must have the same organization type, bond type, debt class and rating as the target bond.
It must have identical watchlist status as the target bond (either “none”, or “marked for
upgrade” or “marked for downgrade”).
The difference between the target bond's coupon rate and the associated bond's rate must be
50 basis points or less.
The difference in maturity date between the target bond and the associated bond must be one
year or less.
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Trade Mutual Funds

Trade Mutual Funds
Choose a fund and trade from the trading window or the Order Ticket.
Before you can trade funds, you must upgrade your trading permissions. To access Account Management, on the Account menu select Account Management Home. Under Trading Access select
Trading Configuration. In the Trading Permissions section of the page, check Mutual Funds.

To trade a fund
1. Add fund contracts to your trading window.
2. Click the Mutual Funds icon from the trading toolbar, or from the Edit menu select Mutual
Fund Selector.
3. In the Contract Selection box, select a fund family in the left pane, and then choose the contract(s) you want to trade in the right pane. Click OK.

Data for funds only appears in the Last or Close price fields. Mutual funds are accumulated throughout the
day and transmitted to the funds at 15:59 for pricing.
4. From the trading window, click the Bid field for a sell order and the Ask field for a buy order.
l

For a Sell order, define the number of shares you want to sell by entering a dollar
value in the Lmt Price field, or the number of shares in the Quantity field.
If you enter a dollar value, the number of shares is calculated using the prior
day's closing price.

l

For a Buy order, enter a dollar value in the price field. The number of shares purchased is calculated after the funds are priced.

5. Click “T” to transmit your order.

Mutual funds can only be sent as Market orders.
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For more details on mutual funds and to access electronic prospectuses, see the Funds product page.
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Trade FX from the Trading Window

Trade FX from the Trading Window
If you have a multi-currency margin account, you can trade domestic and foreign securities and currencies from the same account.
To use FXTrader for trading FX, see the FXTrader topic.
To trade FX from the trading window
1. Add a market data line using the traded currency pair.

To add a primary pair, simply enter the symbol using the syntax xxx.yyy, for example EUR.USD.
2. Select the instrument type Forex, and choose the trading currency.

Example 1
If you want to buy/sell a specific amount of GBP, set up the market data line by entering the symbol
GBP (as the transaction currency) and selecting Forex as the instrument type. In the Contract Selection box, choose USD as the Currency (settlement currency) from the list in the right pane. Or simply
enter GBP.USD. You will then receive the quote GBP.USD, with the Bid: 1.5598 Ask: 1.5600. This
means that GBP 1 = USD 1.56XX
To buy GBP 10,000, click on the ask and enter 10,000 as the quantity of GBP that you wish to buy. You
will pay $1.5600 for each GBP.
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To sell GBP 10,000, click on the bid and enter 10,000 as the quantity of GBP that you wish to sell. You
will receive $1.5598 for each GBP.
Example 2
If you want to buy/sell a specific amount of USD, set up the market data line by entering the symbol
USD (as the transaction currency) and selecting Forex as the instrument type. In the Contract Selection box, choose GBP as the Currency (settlement currency) from the list in the right pane. You will
then receive the quote USD.GBP, with the Bid: 0.5950 Ask: 0.6230. This means that USD 1 = GBP
0.62XX
To buy USD 10,000, click on the ask and enter 10,000 as the quantity of USD that you wish to buy.
You will pay GBP 0.6230 for each USD. Thus, you will pay GBP 6,230.
To sell USD 10,000, click on the bid and enter 10,000 as the quantity of USD that you wish to sell. You
will receive GBP 0.5950 for each USD. Thus, you will receive GBP 5,950.
For more details, see the Forex Products pages on the IB website.
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Trade FX from the Trading Window

Real-Time Activity Monitoring
l

The Account Window

l

The Trade Log

l

Other Tools

l

Understanding System Colors

l

Alerts and Notifications
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The Account Window
The Account window lets you monitor every aspect of your account activity. We present "key" account
values as the default when you first open the Account window (this default view is shown in the illustration below). The account window conveys in real-time values the funds you have available for additional trades and current margin projections.
The Account screen is divided into the following sections:
l

l

l

l

l

l

Balances, which shows your account balances for securities, commodities and in total. These
balances don't include margin requirements.
Margin Requirements, which shows your current initial and maintenance margin requirements
based on your current positions. Customers under the Reg T margin model can compare their
current margin to current projected requirements under the Portfolio Margin model by clicking
the Try PM icon.
Available for Trading, which tells you what you have for additional trades and cushion before
liquidation, based on your balance information and margin requirements.
Market Value - Real FX Position, which shows the total value of all positions, sorted by currency.
FX Portfolio - Virtual FX Position, which shows activity for currency pair trades only. The value
in the Position field only reflects trades executed in the FX market. Please note that these may
not reflect real-time FX positions, since non-base currency conversions may also be included.
Portfolio, which lists all current positions sorted by underlying, and displays the total current
market value for each position.

To open the Account window
l

On the main trading Toolbar, click the Account icon, or from the Account menu select
Account Window.
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The Account Window

Advisors and other multi-client account holders will see a drop-down selection on the Account and
Summary tabs to select either an individual account or an account group.

On the Account page, elect to display account information for All accounts, any individual account
including the Master, or a user-defined Account Group, which includes a subset of accounts (in the
image above, Group 1 is a user-defined account groups).

On the Summary page, choose to view the account summary for All accounts, or for any Account
Group.
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Advisors can also print the summary page by selecting Print Summary from the File menu.
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The Account Window

Balances
The Balances section shows your account balances for securities, commodities and in total. These balances don't include margin requirements.
To view all Balances values, expand the section using the green plus (+) sign. To customize this view
to show only the values you want to see, put a check next to these parameters and click the green
minus (-) sign to contract the section.

The following table defines the fields available in the Balances section.
Parameter

Securities

Commodities

Net Liquidation
Value

Total cash value + stock value + securities
options value + bond value + fund value.

Total cash value (which
includes futures P&L) + commodities options value.

Equity with Loan
Value

Cash Account: Settled Cash.

Cash Account: Total cash
value + commodities option
value - futures maintenance margin requirement + minimum (0,
futures P&L).

Margin Account: Total cash value + stock
value + bond value + fund value + European
& Asian options value.

Margin Account: Total cash
value + commodities option
value - futures maintenance margin requirement.
Previous Day Equity
with Loan Value

Marginable Equity with Loan Value as of
16:00 ET the previous day.

Not applicable.

Reg T Equity with

Cash Account: Settled Cash.

Cash Account: Total cash
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Loan Value

Margin Account: Total cash value + stock
value + bond value + fund value + non-U.S.
& Canadian securities options value +
accrued interest + accrued dividend.

value + commodities option
value - futures maintenance margin requirement + minimum (0,
futures P&L).
Margin Account: Total cash
value - futures maintenance margin requirement.

Special Memorandum Account

If this values falls
below zero at the
end of the trading
day, positions will
be liquidated.

A special account associated with a Reg T
Margin account that is maintained for the purpose of applying Federal Regulation T initial
margin requirements at the end of the trading
day.

Not applicable.

Max ((EWL - US initial margin requirements)*, (Prior Day SMA +/- change in day's
cash +/- US initial margin requirements** for
trades made during the day.))
*calculated end of day under US Stock rules,
regardless of country of trading.
**at the time of the trade

Securities Gross
Position Value
(GPV)

Long Stock Value + Short Stock Value +
Long Option Value + Short Option Value +
Fund Value

Cash

Settled cash + sales at the time of trade +
futures P&L

Settled cash + sales at the time
of trade + futures P&L

Settled Cash

Cash recognized at the time of settlement purchases at the time of trade - commissions
- taxes - fees.

Same as for Securities.
Futures Settlement: Trade date +
1 day

Stock Settlement: Trade date + 3 days
Options Settlement: Trade date + 1 day
Accrued Interest

Interest that has accumulated but has not
been paid or charged.

Dividend Payables

Dividends in Lieu that must be paid by the
holder of a short position.
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Margin Requirements
Use real-time margin monitoring to see your current margin requirements at a glance, and to understand the margin implications of any transaction before you transmit an order.
To view real-time margin requirements
1. From the Account menu, select Account Window.
2. The Account Information window shows your account details, including the current market
value and portfolio.
3. Use the Margin Requirements section to monitor your margin.

To check projected margin requirements under the Portfolio Margin model, click the Try PM icon. Portfolio Margin uses a risk-based model that may result in lower margin for balanced portfolios with
hedging positions. Existing customers can upgrade to a Portfolio Margin account via Account Management.
You can also see the margin impact for a single order using the right-click Check Margin command
from an order line on the trading window.
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To preview margin impact
1. Use the right-click menu from an order line to select Check Margin.
2. View the order details before you transmit, including commissions, margin impact and the
order description.
3. Click Transmit to send the order from the Preview window, or Close to modify before sending.

Monitor Margin Requirements
Margin is calculated at three periods during the day: the market's open, the market's close, and
overnight. The Margin Requirements section shows your current margin, projected margin for the
next period of margin calculation (Look Ahead) and the Overnight calculation (valid for futures only).
l

l

l

The Current margin is your real-time requirement right now. If you happen to be viewing this
screen at 1:00 AM, your current and overnight margin values for your futures positions will be
identical. If you're viewing this screen during trading hours, your current margin requirements
for futures will be less than or equal to the overnight requirement.
The Look Ahead projects what your margin requirements will be at the next margin calculation,
based on what you have in your portfolio now and based on current margin policies (which are
subject to change at any time without notice). If you're viewing this screen at 2:00 PM, the
next calculation will be at the close. If you're viewing this screen at 1:00 AM, the next calculation will be at the open.
Overnight is the requirement after regular market hours.
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To view all Margin Requirements values, expand the section using the green plus (+) sign. To customize this view to show only the values you want to see, put a check next to these parameters and
click the green minus (-) sign to contract the section.
Margin Warning

To help you stay on top of your margin requirements, we now provide pop-up messages and colorcoded account information to notify you that you are approaching a serious margin deficiency. TWS
will highlight the row whose value is in the distress state. The colors on your account screen tell you
the following:
Yellow - You have only a 5% cushion above the margin requirement.
Note: If your account equity moves rapidly from a greater than 5% cushion to a
margin violation, your positions may be liquidated without you receiving a yellow warning.
Orange - Your margin cushion is depleted and you have a short time to enter into margin-reducing
trades before your positions are liquidated. At this point you will not be able to enter into any trades
that might decrease your margin.
Red - Your positions will shortly start to be liquidated as necessary to bring your account back within
the margin limits.
The following table defines the fields available in the Margin Requirements section.

Parameter

Securities Account

Commodities Account

Reg T Margin

Initial margin requirements calculated
under US Regulation T rules.

Initial margin requirements calculated
under US Regulation T rules.

Current Initial
Margin

Initial margin requirement in the base currency of the account. The initial margin
requirement is what is required to open a
new position.

Initial margin requirement in the base currency of the account. The initial margin
requirement is what is required to open a
new position.

Post-Expiry
Margin @
Open (predicted)

Provides a projected "at expiration"
margin value based on the soon-toexpire contracts in your portfolio.
Value displays at expiration and are
highlighted in red. All other times the
value is "0". The projected value in
this field includes the anticipated
account value including the expiring
contract. To see just the projected
margin and excess liquidity value for
the expiring contract, double click the
entry.

Provides a projected "at expiration"
margin value based on the soon-toexpire contracts in your portfolio.
Value displays at expiration and are
highlighted in red. All other times the
value is "0". The projected value in
this field includes the anticipated
account value including the expiring
contract. To see just the projected
margin and excess liquidity value for
the expiring contract, double click the
entry.
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Current Maintenance Margin

Maintenance margin requirement in the
base currency of the account. This is the
value required to maintain your current
positions.

Maintenance margin requirement in the
base currency of the account. This is the
value required to maintain your current
positions.

Projected
Look Ahead
Initial Margin

Projected initial margin requirement as of
next period's margin change in the base
currency of the account.

Projected initial margin requirement as of
next period's margin change in the base
currency of the account based on current
margin requirements, which are subject to
change. This value depends on when you
are viewing your margin requirements. If
it is 3:00 pm ET, the next calculation
you're looking ahead to is after the close,
or the Overnight Initial Margin. If it's 3:00
am ET, the next calculation will be at the
market's open.

Projected
Look Ahead
Maintenance
Margin

Projected maintenance margin requirement as of next period's margin change, in
the base currency of the account.

Maintenance margin requirement as of
next period's margin change in the base
currency of the account based on current
margin requirements, which are subject to
change. This value depends on when you
are viewing your margin requirements. If
it is 3:00 pm ET, the next calculation
you're looking ahead to is after the close,
or the Overnight Initial Margin. If it's 3:00
am ET, the next calculation will be at the
market's open.

Projected
Overnight Initial Margin

Projected overnight initial margin requirement in the base currency of the account.

Overnight initial margin requirement in
the base currency of the account based on
current margin requirements, which are
subject to change.

Projected
Overnight
Maintenance
Margin

Projected overnight maintenance margin
requirement in the base currency of the
account.

Overnight maintenance margin requirement in the base currency of the account
based on current margin requirements,
which are subject to change.

Please see the Margin Overview page on the IB website for details on margin calculations and softedge margining.
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Available for Trading
The Available for Trading values show you the state of your account at a glance. Your Available Funds
tells you if you can put on a trade. Your Excess Liquidity tells you whether you have sufficient cushion
to maintain your current positions, your Buying Power tells you how much you have at your disposal
including your equity and IB's margin.
To view all Available for Trading values, expand the section using the green plus (+) sign. To customize this view to show only the values you want to see, put a check next to these parameters and
click the green minus (-) sign to contract the section.

The following table defines the fields available in the Available for Trading section.
Parameter

Current Available Funds

Securities Account

This value tells what you have available
for trading.

Commodities Account

Same.

Equity with Loan Value - Initial margin.
Current Excess
Liquidity

This value shows your margin cushion,
before liquidation.

Net Liquidation value - Maintenance margin.

Equity with Loan Value - Maintenance
margin.
Post-Expiry
Excess (pre-
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dicted)

excess liquidity value based on the
soon-to-expire contracts in your portfolio. Value displays at expiration
and are highlighted in red. All other
times the value is "0". The projected
value in this field includes the anticipated account value including the
expiring contract. To see just the projected margin and excess liquidity
value for the expiring contract,
double click the entry.

excess liquidity value based on the
soon-to-expire contracts in your portfolio. Value displays at expiration
and are highlighted in red. All other
times the value is "0". The projected
value in this field includes the anticipated account value including the
expiring contract. To see just the projected margin and excess liquidity
value for the expiring contract,
double click the entry.

Special
Memorandum
Account

Line of credit created when the market
value of securities in a Reg. T account
increase in value.

N/A

See the Knowledge Base for details.
Look Ahead
Available
Funds

This value reflects your available funds
at the next margin change. The next
change is displayed in the Look Ahead
Next Change field.

Net Liquidation value - Look ahead Initial margin.

Equity with loan value - look ahead initial margin.
Look Ahead
Excess Liquidity

Equity with loan value - look ahead maintenance margin.

Net Liquidation value - look ahead maintenance margin.

Overnight
Available
Funds

Same as during regular trading hours.

Net Liquidation value - Overnight Maintenance margin

Overnight
Excess Liquidity

Same as during regular trading hours.

Net Liquidation value - Overnight Maintenance margin.

Buying Power

Cash Account: Minimum (Equity with
Loan Value, Previous Day Equity with
Loan Value)-Initial Margin

Not applicable for futures.

Standard Margin Account: Minimum
(Equity with Loan Value, Previous Day
Equity with Loan Value) - Initial Margin
*4
Leverage
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Look Ahead
Next Change

Shows you when the next margin period
will begin.

Same.

Day Trades
Left

Number of day trades still available for
4-day pattern day trader period.

Not applicable for futures.
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Market Value - Real FX Position
The Market Value section shows you total value for all assets sorted by currency. Accounts with the
ability to transfer between brokers will also have an In Transit tab to monitor DVPs and other position
transfers.

The following table defines the fields in the Market Value section. Note that not all available fields are
displayed in the above image.
Parameter

Description

Currency

Open positions are grouped by currency.

Total Cash

Cash recognized at the time of trade + futures P&L.
This value reflects real-time current FX positions, including:
• Trades executed directly through the FX market
• Trades executed as a result of automatic IB conversions, which occur when you
trade a product in a non-base currency,
• Trades deliberately executed to close non-base currency positions using the
FXCONV destination.

Settled Cash

Total cash that has settled + futures P&L.

Accrued
Interest

Reflects the current month's accrued debit and credit interest to date, updated daily.

Stock

Real-time mark-to-market value of stock.

Options

Real-time mark-to-market value of securities options.
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Futures

Real-time change in futures value since last settlement.

FOPs

Real-time mark-to-market value of futures options.

Funds

Current funds balance.

Exchange
Rate

The currency exchange rate to the base currency.

Net Liquidation Value

Total cash value + stock value + options value + bond value.

Unrealized
P&L

The difference between the current market value of your open positions and the average cost, or Value - Average Cost.

Realized P&L

Shows your profit on closed positions, which is the difference between your entry
execution cost and exit execution cost, or
(execution price + commissions to open the position) - (execution price + commissions to close the position).
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FX Portfolio - Virtual FX Position
This section shows activity only for currency pair trades. The "Position" value may reflect the sum of
trades executed in the FX market plus conversions to convert non-base funds into your base currency. Consequently these “virtual” postions do not necessarily reflect your real-time FX positions.
For the actual currency balance, check the Total Cash field of the Market Value section.
To avoid having currency conversions reflected in this panel, use the FXCONV destination on the order
line.
When the FX Portfolio panel is displayed, currency positions will also be displayed in the trading window. To remove currency positions from display, condense the FX Portfolio panel by clicking the
arrow to the left of the panel title.

The following table defines the fields available for display in the FX Portfolio section.
Parameter

Description

Contract
description

Symbol and description.

Exchange

An exchange on which the pair trades. This may not be the executing exchange for the
trade.

Position

The sum of trades executed in the FX market for the selected currency pair.

Unsettled Position

Unsettled currency trades.

Currency

Currency used to buy/sell the FX pair.

Market Value

(Position) x (market price).
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Market Price

Real-time price of the position.

Average
Price

Average price per contract.

Unrealized
P&L

The difference between the trade price and the market price times position, including
commission.
Example: BUY 20,000 EUR.USD @ 1.54390
Trade Price = 1.54390
Market Price (current price) = 1.54385
1.54390 – 1.54385 = .00005
.00005 X 20,000 = 1
+ 2.5 commission = -3.50 Unrealized P&L

Realized
P&L

Realized profit & loss for the pair.

Liquidate
Last

Last liquidation "Yes" or "No" tag. If set to "Yes" this position will be put at the end of
the queue to liquidate last in the case of margin requirements. To set, use the right-click
menu on the desired position.
Note: While IB provides customers the opportunity to pre-request the order of liquidation in the event of a margin deficiency in their account, such requests are not binding
on IB. In the event of a margin deficiency in customer’s IB account, IB retains the
right, in its sole discretion, to determine the assets to be liquidated, the amount of assets
liquidated, as well as the order and manner of liquidation. Customers are encouraged to
consult the IB Customer Agreement and the IB Disclosure of Risks of Margin Trading
for further information.

TWS FX Dual Presentation
In TWS, IB presents currency/FX position data in two different areas of the account window. We separate out your actual currency values, which may result from FX trades, conversions, or trading
products in another currency, from your direct FX pair trading activity.
Market Value - Real FX Balances
Your account’s actual currency balances are shown in the Market Value – Real FX Balances section of
the account window.
FX Portfolio - Virtual FX Position
The FX Portfolio section displays your FX trading activity in currency pairs, and may also reflect “indirect” FX currency conversions designed to close out a non-base currency balance. This view is helpful
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for FX Traders and allows tracking of a running P&L and average cost, but DOES NOT reflect your
actual cash balance in any currency. To manage actual currency positions, refer to the Market Value Real FX Balances section of the account window.
Automated FX Transaction Decision
When you submit an FX order, TWS will attempt to identify whether you want an FX pair trade or a
currency conversion, based on your positions and balances, and will ask you how you want the currency trade to be considered. If you elect “Currency Conversion,” TWS will create the order to reflect
this objective. You submit the order manually, and when the order fills your virtual position in the FX
Portfolio section will not be affected. Previously, conversions would affect the virtual position and
your only option was to manually adjust the position and cost to negate the completed conversion.
If you prefer to let TWSmake this determination without displaying the confirmation box, check Let
TWSmake this determination automatically in the future at the bottom of the confirmation box. When
you activate this feature, FX trades will display FXCONV as the Destination. You can change the destination on a per-order basis by selecting IDEALPRO. To enable the message again, activate it from
the Messages section of Global Configuration. Note that the order is not transmitted automatically.
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Portfolio
The Portfolio section shows the current value of each position and allows you to mark any position to
be liquidated last in the event of a margin call. Accounts with the ability to make transfers between
brokers will also have an In Transit tab to monitor DVPs and other position transfers.
Please note that TWS displays all FA customer positions in the Account window on a net/aggregate
basis.

The following table defines the fields in the Portfolio section.

Parameter

Description

Show Zero Position Rows - displays a line for all traded contracts even if the position was
closed out.
Contract
description

Symbol and description.

Position

Quantity of long/short shares or contracts.

Currency

Currency of the contract.

Market Value

(Position) x (market price).

Market Price

Real-time price of the position.

Average
Price

Average cost of stock and securities options opening positions, including commissions.
Note: Right click and select Show all values in base currency to have TWS
convert all non-base currency position values for display in your base currency. Converted values are displayed in italics for easy identification.

Unrealized
P&L

(Market value of positions) - (average cost).

Realized

(Market value of positions since close of period*) - (average cost for these

TWS Users' Guide

657

Real-Time Activity Monitoring

P&L

positions).
*Cut-off times for determining realized P&L for transactions are as follows:
• 20:30 ET for securities
• Two periods for futures: 17:30 ET and 7:10 ET

Liquidate
Last

Last liquidation "Yes" or "No" tag. If set to "Yes" this position will be put at
the end of the queue to liquidate last in the case of margin requirements. To
set, use the right-click menu on the desired position.
Note: While IB provides customers the opportunity to pre-request the order
of liquidation in the event of a margin deficiency in their account, such
requests are not binding on IB. In the event of a margin deficiency in customer’s IB account, IB retains the right, in its sole discretion, to determine
the assets to be liquidated, the amount of assets liquidated, as well as the
order and manner of liquidation. Customers are encouraged to consult the IB
Customer Agreement and the IB Disclosure of Risks of Margin Trading for
further information.

The Right-click Portfolio Menu
If you select an asset in the Portfolio section and click your right mouse button, you will have access
to the following menu items.

Parameter

Description

Sort by Security Type

Sort positions alphabetically by security type.

Sort by Current Page
Order

Sort positions based on their location on a trading page.
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The Account Window

• Buy - Creates a buy order on the trading page for the selected contract.
• Sell - Creates a sell order on the trading page for the selected contract.
• Close Position - Transmits an appropriately sized opposite-side
order to close our the position.
• Close All Positions - Transmits multiple opposite-side orders to
close out all positions in your portfolio.
• Close Portion of Positions - In the text entry box that pops up, enter
the percentage which will be used to calculate the size of each position's opposite-side order transmitted.

Transfer

For transfer-capable accounts - initiates a DVP/RVP, CMTA or other
transfer.

Create Ticker

Creates a market data line for the contract on the main trading screen.

Adjust Position or Average Price

Only active for Forex positions. Use this feature to enter a hypothetical "new" position and "new" average cost. This feature does not
modify your forex positions but lets you create a "what-if" to see total
P&L including positions you may hold elsewhere.

Adjust Average Price

Displayed for all products except cash. Select a position and choose
Adjust Average Price. Use the dialog box to enter a new position or
change the average price to include transfers and corporate actions.

Set Liquidate
Last

Last liquidation "Yes" or "No" tag. If set to "Yes" this position will
be put at the end of the queue to liquidate last in the case of margin
requirements. To set, use the right-click menu on the desired position.
Note: While IB provides customers the opportunity to pre-request
the order of liquidation in the event of a margin deficiency in their
account, such requests are not binding on IB. In the event of a margin
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deficiency in customer’s IB account, IB retains the right, in its sole
discretion, to determine the assets to be liquidated, the amount of
assets liquidated, as well as the order and manner of liquidation. Customers are encouraged to consult the IB Customer Agreement and the
IB Disclosure of Risks of Margin Trading for further information.

Unset Liquidate Last

Removes the “Liquidate Last” designation for a position.

Create Portfolio Page

Creates a trading page called Portfolio that includes market data lines
for all tickers in your Portfolio.

TWS Users' Guide

660

Real-Time Activity Monitoring

The Trade Log

The Trade Log
Introduction

The Trade Log displays reports for daily executions including those completed during after-hours trading.

To see trades
l

Click the Trade Log icon on the trading toolbar, or from the Account menu select Trade Log.

Trades Tab
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The Trades window has two tabs: Trades and Summary. Advisors and other multi-client account holders have the option to see trade activity for All accounts, an individual account (including the Master)
or any user-defined Account Group. The account group “Global Fund” is selected in the image above.
To add or remove columns from the Trades tab
1. Right-click in any column heading and select Layout.
2. Check the columns you want to include; uncheck columns you want to hide.
Column
Name

Description

Action

The action, either Bought (Bot) or Sold (SLD)

Quantity

The number of units in the trade.

Underlying

The underlying symbol.

Comb

If checked, identifies the trade as a combo trade. Use the “+” sign
to expand the combo and view individual legs.

Description

The contract description.

Price

The current market price per unit.

Currency

The currency in which the position is held.

Exchange

The exchange that executed the order.

Date

The execution date.

Time

The execution time.

Order ID

The order ID.

Order Ref

The order reference number as defined by the user on the Order
Ticket. For basket orders, this field contains the name of the basket to which the order belongs.

Commissions

Commission charged on the trade.

VWAP Time

For VWAP orders, the time at which the order executed.

Comment

Displays comments relative to the order.

Account

Identifies the beneficial account number.

Confirm

Valid only for Linkage customers.

Submitter

Identifies the order submitter.

Yield

The yield-to-worst. This is the lower of yield to maturity and
yields to all calls. The yield is only shown if it is offered on the
exchange.
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The text along the bottom of the window describes the sort order of fields on the
Trades tab.
Email Trade Reports
You can select a group of trades and email them from your default email client. Customize the mail
settings to include specific fields and use different delimiters (these separate the data in the list and
may need to be changed based on how the recipient intends to use the list).
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To email trades
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1. From the Trades tab, select the trades you would like to email.
l
To select a group of contiguous trades, click on the first trade, hold down the Shift key
and click on the last trade in the group.
l

To select a group of non-contiguous trades, press and hold the Ctrl key while you click on
the desired trade lines.

2. Right-click the trades or group of trades and select Email trades.
3. In the configuration box, choose the column layout and other settings for the email.
l
Default Columns shows the columns that are on your trades window.
l

Extended Form includes all available columns.

l

Custom Columns allows you to select the columns to include in the email.

4. Enter the email address(es) of the recipient(s) and send your trade reports.

Export Trade Reports
You can export today's and previous days' execution reports to a file which you can then view using
MS Excel or another outside application.
To export trade reports
1. Click the Trade Log icon on the Trading toolbar to open the Trades window.
2. On the File menu, select Export Today's (or Previous Day's) Reports.
3. If applicable, select the day's report and click OK.
In the Filename field, enter the location and filename you want to assign to the report. Note
that the report will be saved as a text (.txt) file.

l

Check Extended Form to include the type, expiry, strike, right and premium currency
fields on the exported report.

l

Check ID to include the ID field on the report

l

Check Add Volatility Link to include the volatility calculation (for Volatility orders).
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4. In the Symbol dropdown choose Underlying, Local Symbol or both.
5. Click OK to save the report to an outside directory.
You can open your exported report in a spreadsheet such as MS Excel, by performing a few simple
steps.
To open your trade report in Excel
1. Open MS Excel and click File > Open.
2. In the Files of type dropdown, select All Files (*.*).
3. Find the location of the .txt executions file you want to open.
4. In the Text Import Wizard, use Delimited as the file type and click Next.
5. Select Semicolon as the delimiter and click Next.
6. Leave the column data format as General and click Finish.
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Trades Summary
The Summary tab displays execution information by contract. To view executions, click the
Trades icon on the trading toolbar.

To add/remove columns
1. Right-click on any column heading and select Customize Layout.
2. In the Available Columns list, select a column and click Add to move it into the Shown
Columns list.
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Other Tools
Introduction
l

Profit and Loss

l

Pending Orders Page

l

Trader Dashboard

l

Bulletins and System Status

l

Audit Trails

l

Best Price for Options using SmartRoutingSM
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Profit and Loss
You can see P&L on the trading screens and in the Account window. Quickly add and remove fields to
and from your Quote Monitor.

l

Position - shows your position in the instrument.

l

Market Value - equal to the position * market price.

l

l

Avg Price - the average price is calculated by dividing your cost (execution price + commission) by the quantity of your position. This value is then used to determine your unrealized
P&L. Right-click the field name and select Configure Precision to specify additional decimal
places that will display as superscript.
P&L - Shows your profit and loss for the current day. You can elect to show New Position P&L
displayed as P&L (N) which is only for transactions executed today, or Daily P&L which
includes all open positions plus the New Position P&L.

To set the P&L calculation between New and Daily, right-click the field name and check or uncheck
Include today's opening position in P&L calculations.
To display New Position P&L
1. Right click the P&L field.
2. Uncheck Include today's opening position in P&L calculation. The field heading will display P&L
(N) to indicate it's for new positions only.
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New Position P&L calculation:
(current price - purchase price) x (number of outstanding shares purchased today).
To display Daily P&L
1. Right click the P&L field.
2. Check Include today's opening position in P&L calculation. The field label will read P&L.
Daily P&L calculation:
(current price - prior day's closing price) x (total number of outstanding shares) + (New Position calculation for all new positions) + (Closed Position calculation for all closed positions).

Closed Position calculation:
(trade price - prior day's closing price) x (total number of closed shares).
l

Unrealized P&L - the difference between the current market value and the average price of
your position.
Note: Select "Display Both" from the right-click menu to show the unrealized P&L as
both a value and a percentage off the initial investment.

l

l

Realized P&L - show your profit or loss on closed positions, which is the difference between
your entry execution cost (execution price + commissions to open the position) and exit execution cost (execution price + commissions to close the position).
Cost Basis - (the current position x average price).
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Pending Orders Page
You can view working orders on the Pending page, as well as on any trading page that displays the
instrument. Once an order has been executed, it is removed from the Pending page and the execution
report is displayed in the Trade log. If you have orders pending when you log in, the Pending page is
automatically displayed for your review.
You can view positions on the Pending page by displaying the Positions column using the Page Layout.

To view pending orders
l

On the Trading screen, click the Pending tab. When orders are working, the Pending tab title,
along with the title of the page on which the asset is displayed, is red.

You can also elect to display GTC orders on a separate Pending page from other orders.
To separate Pending order pages for GTCs
1. On the Edit menu select Global Configuration.
2. In the left pane, select Order, then select General.
3. In the right panel, check Display pending day and GTC orders on separate pages.
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You can manage working orders from the Pending page, but you cannot create an order or add a new market data
line. You can also modify conditions for a conditional order from the Pending page.
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Trader Dashboard
The real-time Trader Dashboard is an optional tool that can be displayed at the top of the pages tabset. This customizable panel allows you to monitor data fields from your Account Information window, keep abreast of the most recent activity for specific contracts, and view current real-time news
headlines for products in your portfolio and for any tickers you are watching.

To configure the Trader Dashboard
1. On the Edit menu, select Global Configuration.
2. In the left pane, click Trader Dashboard.
3. Use checkboxes in the right pane to set the following:
l
Check Show news to display news headlines for any products in your portfolio and to alert
you to recent news on any tickers you elect to display.
l

To see only portfolio-relevant news, check Display News for products in portfolio only.
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l

l

l

To only see indicators of recent news next to individual tickers that you are watching,
check Display recent news indicator only.
Check Show price change in percentage to view the last price and price change values as
percentages in ticker lines.
Check Show price change in value to view the last price change as an absolute value.

4. Click the Add Account Data button, and scroll down the list. Double-click each Account field
that you want to add to the dashboard. Each field you double-click is added to the Display
Item list on the configuration pane. Click OK to close the Add box.
The descriptions for Account Information fields are in the Account Information topic.
5. To add a last price/price change field for a contract, enter the underlying in the Symbol field
and click Add Ticker, then define the contract parameters just as you do when you add market
data to the trading page. The last price/price change displays in red to indicate downward movement and blue to indicate upward movement.
6. Click OK. The Trader Dashboard is displayed at the top of your trading window, just above
the pages tabset.
You can change the display name for selected dashboard fields using the Change Label feature.
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Bulletins and System Status
Notices concerning exchange issues, system problems and other trading information are announced
through bulletins and system status reports. Bulletins are announced by a flashing red "Bulletin" notification along the top of the Menu bar.

To read the current bulletin
l

Click the flashing red "Bulletin" notification.

To review bulletins
l

Click the Bulletin icon on the toolbar, or

l

From the View menu, select Bulletins.

You can move and resize the Bulletins window (which opens when you perform any of the above actions) so
that it doesn't block out the critical information on your trading screen. The system saves your settings and will
always open the window to the size and location you specify.
To see the system status from the website
l

From the View menu, select IB Systems.
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Audit Trails
This feature creates a file of daily trading activity that you can view from your browser. An audit file
is created each day, and is named using the day of the week. Each week, the existing daily files are
overwritten by the new files using the same name. You can rename these daily files if you want to
save them.

To view an Audit Trail
1. From the Account menu, selectAudit Trail.
2. Select a day up to 5 days back.
3. Choose Condensed or Expanded form, and click OK.
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Best Price for Options using SmartRoutingSM
Option traders who use SmartRouting can see which exchange(s) are offering the best bid and ask
price. This information is displayed in the Bid Exch and Ask Exch fields on the Market Data line. Each
exchange is represented by a single alpha character as defined in the table below. If multiple
exchanges show an identical "Best" price offering, then multiple alpha characters are displayed. For
example, if "ACP" is displayed in the Bid Exch column of a market data line, it means that AMEX,
CBOE, and PSE are all offering the identical highest bid price (shown in the Bid Price column) for the
option. Valid exchange abbreviations are:
Acronym

Exchange

A

AMEX

B

BOX

C

CBOE

I

ISE

P

PSE

X

PHLX

BT

BATS

W

CBOE2

Exchange abbreviations are always displayed in yellow. The Bid Price and Ask Price, Bid Size and
Ask Size colors convey the following information:
Color

Description

YELLOW indicates no change in price or size.

GREEN indicates an upward movement in price or size.

ORANGE (or red) indicates a downward movement in price or
size.
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PURPLE indicates that the best price is not executing automatically
at any of the exchanges displayed.

SmartRouting does not guarantee that your order will execute at the best displayed price. We display
prices in purple to illustrate that some exchanges are not automatically executing at the best price,
and that your order might execute at a different price. However, the availability of automatic execution updates with every tick.

ISE always executes automatically, but may not always be offering the best price and may slow down their execution times in a fast market.
For more details on order routing and Smart Order routing, see the Customer Agreement on the IB
website.

TWS Users' Guide

678

Real-Time Activity Monitoring

Understanding System Colors

Understanding System Colors
Introduction

The application uses colored text and backgrounds to convey information about market movement,
order destination, and order status. Colors are used on all screens that send and receive data, including the Trading screen, the Market Depth window and the Arbitrage Meter. The meaning of the text colors is consistent throughout the screens. Information on system colors is sorted into the following
sections:
l

Text Colors

l

Background colors on a Market Data line

l

Background colors on an Order Management line

l

Order Status colors
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Text Colors
Colored text on the screen's black background is used to represent up and down movement of price
and quantity, and order destination information.
Color

Description

YELLOW indicates no change in size or price.

GREEN indicates an upward movement in size or price.

ORANGE (or red) indicates a downward movement in
size or price.

For options, the price displayed in PURPLE indicates that
the best price is not executing automatically at one or more
of the exchanges displayed.
MAGENTA - For inter-market spread orders, indicates
the implied price of the order.

LIGHT BLUE indicates that this was the last price at
which the contract traded.

MEDIUM BLUE indicates that the quote is not currently
tradable.

The page tab text changes color from black to RED to indicate that the page displays an asset for
which an order has been transmitted.
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Background colors on a Market Data Line
Color

Description

DARK GRAY across the entire Market Data line indicates
that the line is selected.

The Change field line uses a background color to represent up and down market movement.
Color

Description

The Change column identifies the degree and direction of
change in the asset's current price from the prior day's closing price.
A RED background in the Change field indicates that the
change for the day is negative.
A GREEN background in the Change field indicates that the
change for the day is positive.

This PALE RED indicates that trading has been halted on
the underlying.

Change for the day figures are based on 4 P.M. Eastern Time (ET) prior day closing prices.
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Background colors on an Order Management Line
Color

Description

A BLUE background in the Action field indicates a BUY
action.

A RED background in the Action field indicates a SELL
action.

LIGHT BROWN across the entire Order Management line
indicates that you have modified a working order but have
not yet re-transmitted the order.
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Order Status Colors
The color in the Status field of an order management line indicates the status of your order.
Color

Description

LIGHT GRAY indicates that you are in the process of
creating an order and you have not yet transmitted it.

LIGHT BLUE indicates that you have transmitted your
order, but have not yet received confirmation that it has
been accepted by the order destination.

PALE PURPLE indicates that an order has been accepted by the system (simulated orders) or an exchange (native orders) but that currently the order is not working,
due to system, exchange or other issues. When the order
becomes active, the order status color will change appropriately.
PURPLE indicates that the order has been suspended
and is awaiting customer action. Component size is larger than the account can support. Please modify the component size or add funds to your account.
DARK BLUE indicates that an order has been accepted
by the system (simulated orders) or an exchange (native
orders) and that this order has yet to be elected. The
order status remains DARK BLUE until the election criteria are met. At that time the order is triggered, and the
order status color will change appropriately.
Prior to TWS 919, dark blue was also displayed for native stops that were at the exchange but hadn't been
triggered. Beginning with TWS919, native stops at the
exchange, both triggered and untriggered, display green.
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GREEN indicates that your order has been accepted and
is working at the destination.
When you display the Shortable market data column,
this color indicates that at least 1000 shares are available to sell short.
DARK GREEN is used in the Shortable column and
indicates that this contract can be sold short but that at
the moment there are no shares available for short sale,
and that the system is searching for shares.
LIGHT GREEN is used by the Blotter to indicate that a
ticket has been accepted by the trader.

PINK indicates that you have sent a request to cancel
the order but have not yet received cancel confirmation
from the order destination. At this point, your order is
not confirmed canceled. You may still receive an execution while your cancellation request is pending.
ORANGE indicates that a cancellation request has been
accepted by the system but that currently the request is
not being recognized, due to system, exchange or other
issues. At this point, your order is not confirmed canceled. You may still receive an execution while your
cancellation request is pending.
RED indicates that the balance of your order has been
confirmed canceled by the system. This could occur
unexpectedly when the destination has rejected your
order.

In the Shortable column, RED indicates that no shares are available for short
sale.
Once the order is confirmed canceled, the Order Management line will disappear from your trading screen after 30 seconds. Please see the Customer
Agreement for further information on order confirmation and order cancellation.
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MAROON indicates that an attached simulated order
type has been accepted by the system and has yet to be
elected. The order is held in the IBsystem (and the
status remains MAROON) until the election criteria are
met. At that time the order is transmitted to the order
destination specified and the order status color will
change appropriately.
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Alerts and Notifications
Introduction
l

Set Time Alerts

l

Set Price Alerts

l

Set Margin Alerts

l

Set Volume Alerts

l

Set Execution-based Alerts

l

Assign Actions to Alerts

l

Set Price Movement Alarms

l

Set Volume Change-activated Alarm

l

Change Notification Sound for Events
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Alerts and Notifications

Set Time Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define
the conditions which must be met to activate the alert. The second is the Actions area, where you
define the action that will occur when the conditions are met. Create alerts based on price movement,
time and date, trading volume or the state of your margin cushion. Alert actions include sending a
notification such as a pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a buy or sell order.

To set a time alert
1. On the Analytical Tools menu select Alerts.
l
If you're already in the Alerts box, click the Alerts tab to gain access to the New button.
Continue with Step 2 below.
2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes
the name you enter.
3. Define an asset in the Conditions area by clicking the Add button.
4. Begin to set the alert conditions by selecting Time in the Choose Condition section of the
Create Condition box, then click Next.
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5. On the Configure Time Condition page use the Operator field to choose from "greater than or
equal to" or "less than or equal to."
6. In the Time field, set the time and date. Use the calendar date/time chooser for easy selection
and to ensure the format is correct.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another
contract on the next line following the above steps 3 - 6 above.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message
and audio alerts, and elect to have an order triggered.

Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition to be satisfied..." box.
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Set Price Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define
the conditions which must be met to activate the alert. The second is the Actions area, where you
define the action that will occur when the conditions are met. Create alerts based on price movement,
time and date, trading volume or the state of your margin cushion. Alert actions include sending a
notification such as a pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a buy or sell order.

To set a price alert
1. On the Analytical Tools menu select Alerts.
l
If you're already in the Alerts box, click the Alerts tab to gain access to the New button.
Continue with Step 2 below.
2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes
the name you enter.
3. Define an asset in the Conditions area by dragging and dropping one from your trading screen,
or click the Add button.
4. Begin to set the alert conditions by selecting Price in the Choose Condition section of the
Create Condition box, then click Next.
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5. On the Configure Price Condition page, enter an underlying if you have a blank field and select
the rest of the instrument description parameters including instrument type and exchange.
6. Select a trigger method from the Method dropdown list.
7. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
8. In the Price field, enter the price that will be acted on by the operator defined above, and click
the Finish button.
9. To define multiple conditions, select And or Or from the Logic drop-down list, and add another
contract on the next line following the above steps 3 - 8.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message
and audio alerts, and elect to have an order triggered.

Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition to be satisfied outside of regular trading hours" box.
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Set Margin Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define
the conditions which must be met to activate the alert. The second is the Actions area, where you
define the action that will occur when the conditions are met. Create alerts based on price movement,
time and date, trading volume or the state of your margin cushion. Alert actions include sending a
notification such as a pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a buy or sell order.

Margin Alerts
Margin alerts are based on the status of an IB-calculated "margin cushion" derived using current values from your account. You can find these values on the Account screen. The margin cushion is calculated as follows:
(Equity with Loan Value - Maintenance Margin)/Net Liquidation Value

To create a margin cushion alert
1. On the Analytical Tools menu select Alerts.
l
If you're already in the Alerts box, click the Alerts tab to gain access to the New button.
Continue with Step 2 below.
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2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes
the name you enter.
3. Define an asset in the Conditions area by dragging and dropping one from your trading screen,
or click the Add button.
4. Begin to set the alert conditions by selecting Cushion in the Choose Condition section of the
Create Condition box, then click Next.
5. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
6. In the Cushion(%) field, enter a percent value that will be acted on by the operator defined
above, and click the Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another
contract on the next line following the above steps 3 - 6.
You can now assign an action to an alert in the form of a message, order action, or audio notification.

Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition to be satisfied..." box.
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Set Volume Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define
the conditions which must be met to activate the alert. The second is the Actions area, where you
define the action that will occur when the conditions are met. Create alerts based on price movement,
time and date, trading volume or the state of your margin cushion. Alert actions include sending a
notification such as a pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a buy or sell order.

To set a volume alert
1. On the Analytical Tools menu select Alerts.
l
If you're already in the Alerts box, click the Alerts tab to gain access to the New button.
Continue with Step 2 below.
2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes
the name you enter.
3. Define an asset in the Conditions area by dragging and dropping one from your trading screen,
or click the Add button.
4. Begin to set the alert conditions by selecting Volume in the Choose Condition section of the
Create Condition box, then click Next.
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5. On the Configure Volume Condition page, enter an underlying if you have a blank field and
select the rest of the instrument description parameters including instrument type and
exchange.
6. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
7. In the Volume field, enter the volume value that will be acted on by the operator defined
above, and click the Finish button.
8. To define multiple conditions, select And or Or from the Logic drop-down list, and add another
contract on the next line following the above steps 3 - 7.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger.

Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition to be satisfied..." box.
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Set Execution-based Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define
the conditions which must be met to activate the alert. The second is the Actions area, where you
define the action that will occur when the conditions are met. The Execution-based alert will trigger a
user-defined action when an execution for the defined contract occurs. Alert actions include sending a
notification such as a pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a buy or sell order.

To set an execution-based alert
1. On the Analytical Tools menu select Alerts.
l
If you're already in the Alerts box, click the Alerts tab to gain access to the New button.
Continue with Step 2 below.
2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes
the name you enter.
3. Start defining the alert by clicking the Add button.
4. Begin to set the alert conditions by selecting Trade in the Choose Condition section of the
Create Condition box, then click Next.
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5. On the Configure Trade Condition page, enter an underlying IF you only want the alert to trigger
at the execution of a specific underlying. Otherwise leave ANY.
6. In the Exchange field, select an exchange from the dropdown list IF you only want the alert to
trigger for an execution at a specific destination. Otherwise, leave ANY.
7. In the Type field, choose an instrument type IF you only want the alert to trigger at the execution of a specific instrument type. Otherwise leave ANY. Click the Finish button.
8. To define multiple conditions, select And or Or from the Logic drop-down list, and add another
contract on the next line following the above steps 3 - 7.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger.

Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition to be satisfied..." box.
To keep the alert active for multiple executions on the same underlying, check the Repeatable box.
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Assign Actions to Alerts
l

Assign Message Action to Alerts

l

Assign Order Action to Alerts

l

Assign Audio Action to Alerts

l

Assign Sounds to Events
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Set Price Movement Alarms
For any asset, you can set a price-triggered alarm that goes off when the selected price hits the trigger value. You can use values in the Bid, Ask and/or Last price fields as the triggers. The price field
and page title turn red and start to blink when your price has been reached. You can also set an audio
alarm that notifies you by beeping.

Each line of market data with an attached price-activated alarm will always take up one live market data line
whether the page is open (active) or closed. You can only receive market data for a limited number of live market data lines (usually 40).

When you log off, any alarms you have set will be shut off unless you choose to preserve them
between sessions. To do this, select Preserve the alarm between sessions when you set the alarm.
To set a price movement alarm
1. Select the asset for which you want to set an alarm.
2. Right click and select Analytical Tools, then select Set Alarm.
3. In the Alarm Settings window, enter a "less than" and/or "greater than" price in any or all of
the bid, ask and last price entry fields.
4. To set a volume activated alarm, enter a trigger amount in the Alarm if volume is greater
than field.
5. To add a beeping sound to the visual alarm, select Play warning sound.
Example: If you enter a price of $40.15 in the second field on the top row, Alarm if bid is greater
than, your alarm will trigger when the bid price for the selected asset is greater than or equal to
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$40.15. Put a price of $40.00 in the first field (Alarm is bid is less than) and the alarm will trigger is
the bid is equal to or falls below that price.
The default background color for all fields that have an alarm set is murky green. You can modify the
background color by using the Layout editor.
To shut off an activated price movement alarm
l

Click in the market data line of the asset that has the alarm.
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Set Volume Change-activated Alarm
For any asset, you can set a volume change-triggered alarm that goes off when the volume for the
selected asset rises by the amount you define. The Volume field and page title turn red and start to
blink when the volume has increased by your set amount. You can also set an audio alarm that notifies you by beeping.

Each line of market data with an attached alarm will always take up one live market data line whether the page
is open (active) or closed. You can only receive market data for a limited number of live market data lines (usually 40).

When you log off,. any alarms you have set will be shut off unless you choose to preserve them
between sessions. To do this, select Preserve the alarm between sessions when you set the alarm.
To set a volume change alarm
1. Select the asset for which you want to set an alarm.
2. Right-click and select Analytical Tools, then select Set Alarm.
3. In the Alarm Settings window, enter a trigger amount in the Alarm if volume is greater
than field.
4. To add a beeping sound to the visual alarm, check Play warning sound.
If you have the Volume field displayed on your trading screen, you will see the default background
color on market data lines that have alarms set is murky green. You can modify the background color
by using the Layout editor.
To shut off an activated volume increase alarm
l

Click in the market data line of the asset that has the alarm.
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To hear sounds other than a beep on your computer, you must have a sound card installed.
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Price/Risk Analytics
l

Intro to IB Risk NavigatorSM

l

Option Analytics Window

l

Intro to Model Navigator

l

Index Arbitrage Meter
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IB Risk NavigatorSM

IB Risk NavigatorSM
Introduction
l

Open the IB Risk Navigator

l

Use the Report Viewer

l

Use the Report Selector

l

Portfolio Relative P&L Graph

l

Risk Dashboard

l

Create a What-If Portfolio

l

Create Custom Scenarios

l

Custom Scenario Examples

l

VaR on Demand

l

Create a Basket Hedge Order

l

Risk Navigator Reports

l

Risk Navigator Alarms

l

Check Risk Pre-Order

l

Use the Industry Editor

l

Measure by Underlying and Maturity

l

Measure by Price Change and Volatility Change

l

P&L Pie Chart

l

Upload a Portfolio
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Open the IB Risk Navigator
The IB Risk NavigatorSM shows your portfolio risk for multiple asset classes, and allows you to:
l

View and assess specific risk slices of your portfolio, such as risk by position, risk by underlying, and risk by industry

l

View the greek contract and position risk dimensions for each report

l

See Value at Risk and Portfolio Statistics

l

Measure your portfolio P&L (from close-to-close) by Price Change/Volatility Change, and measure exposure and the greek position dimensions by Underlying/Maturity.

IB Risk Navigator report data refreshes automatically every 10 seconds, and immediately whenever
an order executes, for all reports except the Measure by Price Change and Volatility Change report.
This report uses prices from the close of the previous business day and calculates market outcome
risk by advancing the time parameter to the close of the next business day.
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IB Risk NavigatorSM

To open IB Risk Navigator
1. On the Analytical Tools menu, select Risk NavigatorSM.
2. Select an asset type to get started. Note that the available reports and content will change
based on the asset class selected.
You can also access the IB Risk Navigator from the OptionTrader.
For details on using specific sections of the IB Risk Navigator, click a link below:
n

Use the Report Viewer

n

Use the Report Selector

n

Portfolio Relative P&L Graph

n

Custom Scenarios

n

Create a What-If Portfolio

n

Upload a Portfolio
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Use the Report Viewer
The Report Viewer displays the report you defined in the Report Selector. The Report Viewer:
l

Lets you view portfolio risk metrics for multiple asset classes, including P&L, Exposure, VAR
and the Greeks.

l

Has drill-down access to let you control the depth of detail you see for each underlying.

l

Allows you to customize the view by adding, removing and configuring columns.

l

Lets you sort by column in ascending or descending order by clicking the column header. The
primary sort column displays a red arrow, downward pointing for descending, upward pointing
for ascending.
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IB Risk NavigatorSM

You can add or remove metrics columns in a report using the Metrics menu selections.
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Use the Report Selector
The Report Selector is your starting point for navigating your risk summary. Selections change
based on the product tab you have selected. Construct custom reports that slice and display various
angles of your exposure and other risk metrics.

The IB Risk Navigator includes your current position data when it opens, which it then uses in both the P&L
graph and report calculations. Any positions that cannot be resolved (for any reason) are shown in the Position(s)
not included list in the Report Selector area. If the position is highlighted in yellow, its data is not included in the
calculations for the P&L graph; if the position is highlighted in peach, its data is not included in the report calculations; if it's pink, its data is excluded from both the graph and the report calculations. This box will not
appear if ALL positions can be included unless you elect to display it manually, using the checkbox on the View
menu.
To define your report

1. From the Report field, use the dropdown list to choose a perspective from which to assess your risk. Each

report is briefly described in the table below.
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2. In the Plot list, choose to show:
l
Equity Portfolio Value Change, which illustrates how the total value of your portfolio or
subportfolio will change based on a percent change in the price of the underlying(s).
l

l

Equity Portfolio Value, which plots your portfolio/subportfolio P&L, but also includes the
market value for those positions in your portfolio for which the price/risk cannot be calculated (opaque positions).
Equity Delta Position which shows the delta of your portfolio/subportfolio versus the
underlying price. This plot is always based on the most recent data.
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3. In the Underlying list, choose whether to display report data for all underlyings or only for a
specific underlying and its derivatives.

4. In the Currency dropdown, select All to include all currencies in your report, or select a single
currency.
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5. In the Position field, IF you have specified a single underlying in the Underlying field above, you
can select one or All positions on the underlying to include in the report.

6. In the Expiry list:

Choose TOTAL to display the Total row in the matrix, and show the P&L plot using the total of all
positions.
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Choose ALL to expand the matrix to show each row, and to show individual P&L lines for each
expiry in the P&L plot. The color key on the right side of the chart identifies the line for each
month.
Choose Spot to filter out the options. Select a single expiry to chart the P&L for all options with the
expiration date.
Choose multiple expiry selection to create multiple P&L charts with one expiry plotted in each
chart.

7. Use the Date scenario to plot line for multiple dates. Note that the colored legend along the bottom of the P&L graph corresponds to the lines in the graph AND to the date(s) selected in the
Date scenario.

Click a report name to view the report topic.
Reports

Portfolio Report - This report presents
risk and exposure for your entire portfolio
across multiple asset classes. The Portfolio view does not display any totals,
unlike the Risk by Underlying report.

Measure by Underlying and Maturity - This
report displays risk measures across all asset
classes for all underlyings, grouped by expiry.

Risk by Position Report - This report displays risk metrics across all asset classes,

Risk by Underlying Report - The default report.
This report displays portfolio metrics across all
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for each position.

asset classes and provides drill-down depth control for each underlying.

Risk by Industry Report - This report displays your portfolio risk and exposure
across multiple asset classes, sorted by
industry sector. Drill-down detail lets you
go two levels deep into the industry subcategories, and into the underlying and its
derivatives for each industry category and
subcategory.

Measure by Price Change and Volatility
Change - This report measures the market outcome for the contract price, delta, gamma,
vega, and theta - using underlying and derivative prices on the close of any business day at multiple positive, negative, and zero percent
change scenarios in the underlying price, volatility and interest rate.

Value at Risk Report - This report shows
the greatest loss that a portfolio will sustain over a one-day period, with 99.5%
confidence. VAR is calculated using
three different methods, each with different assumptions about correlations of
the underlying assets in the portfolio.

Portfolio Statistics Report - The Portfolio Statistics report shows summary tables for stock,
futures, options and warrants, and cash.

P&L Pie Chart - The P&L Pie Chart
shows the position Delta and P&L for all
positions in your portfolio relative to the
total portfolio.
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Portfolio Relative P&L Graph
The Portfolio Relative P&L graph illustrates how the total value of your portfolio for a specific
asset class (or a subset of your portfolio) will change, based on a percent change in the price(s) of the
underlying(s). Available settings may change based on the asset class displayed.

Figure A
Figure A shows the portfolio-relative P&L for your equity portfolio, based on the value All Underlyings selected from the Underlying list in the Report Selector. The Most Recent price scenario was
selected from the right-click graph menu and is illustrated in the top right corner of the graph.
For Bonds, the P&L plot is based on the interest rate change.
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Figure B
Figure B displays both the portfolio-relevant P&L and the projected Vol up, which raises the implied
volatility by 15% in relative change* and the T down, which reduces the time to expiry by one calendar day. While you can elect to display the base P&L using both the previous day’s closing price and
the most recent dynamic price, the volatility and time variables are always based on the previous
close.
The Confidence Interval, shown within the yellow vertical lines, illustrates the worst-case loss over
a one-day period with a default 99.5% confidence level. Use the Confidence subcommand on the Settings menu to toggle between 95%, 99% and 99.5% confidence levels.
Use the Vol-up, Vol-down and T-down checkboxes below the graph to view the plot under different
scenarios to help you visualize the volatility and time risk in your option positions. Vol-up raises the
implied volatility by 15% in relative change*; Vol-down reduces the implied volatility by 15% in relative change*, and T-down reduces the time to expiry by one calendar day.
*Relative percent change is calculated by multiplying the current implied volatility by 15%, and
adding/subtracting this value to/from the current implied volatility. For example, if the current
implied volatility of an option is 10%, a 15% relative increase would result in an implied volatility of
11.5%, calculated as follows: 10 + (10 * 0.15) = 11.5% . If the current implied volatility of an option
is 42.45%, a 15% relative decrease would result in an implied volatility of 36.082%, calculated as follows: 42.45 - (42.45 * 0.15) = 36.082%.
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Figure C

Figure C displays your portfolio-relevant P&L for ALL Expirys. The color key to the right identifies
each line in the plot.
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Risk Dashboard
The Risk Dashboard is pinned along the top of the product tabsets, and is available for what-if as well as active
portfolios. The dashboard provides at-a-glance account information including:

Dashboard Field

Description

Net Liquidation

The total Net Liquidation value for the account.
This value is taken from the Total Net Liquidation Value field in the Account
Information window.

P&L

The total daily P&L for the entire portfolio.
This value is taken from the "All Contracts" level of the Risk Navigator
P&L tab in the P&L for the Day field.

Maintenance Margin

Total current maintenance margin. Use this to see margin for a hypothetical
what-if portfolio as well as for your current portfolio.
This value is taken from the Margin Requirements section in the Account
Information window.

Initial Margin

Total initial margin requirements. Use this to see margin for a hypothetical
what-if portfolio as well as for your current portfolio.
This value is taken from the Margin Requirements section in the Account
Information window.

VAR

Shows the Value at Risk for the entire portfolio. VAR is a measure of
the largest anticipated loss over a specified time period and confidence level, where the confidence level provides the probability that
the VAR measure will not be exceeded.

Expected Shortfall (ES)

The expected return of the portfolio in the worst case. This is the average VaR.

To hide or display the dashboard
l

From the View menu, select Risk Dashboard.
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Stock Yield On Demand
The Stock Yield Enhancement Program allows you to earn extra income on the fully-paid shares of stock held in
your account. You can find out what your potential extra earned income would be at any time using the Stock
Yield report.
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Create a Basket Hedge Order
Display the Hedge metric on the Risk by Underlying and Risk by Industry reports to create a basket of
delta hedge orders.

To create a basket hedge
1. Display the Hedge column from the Metrics menu in the Risk by Underlying or Risk by Industry
report.

2. Enable the checkbox in the Hedge column of an underlying for all subportfolios whose deltas
you want to hedge.

To select all subportfolios, use the checkbox in the All Underlyings top row.
3. When all contracts are selected, click the Hedge button in top right corner of the report.
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4. Define the hedge order attributes and click OK:
l
Pick the order type (Limit, Market or Relative).
l

If you selected the Relative order type, define the relative offset amount

5. The BasketTrader opens, and the legs of the order reflect the subportfolios you selected in the
Risk Navigator.

The Total Quantity for each leg is identical to the delta for the subportfolio, with the Action set to the
opposite side; if the delta is positive, the leg becomes a SELL order. If the delta is negative, the leg
becomes a BUY order.

You can save the basket for later use by clicking the Save button at the top right of the basket.
For more information on using basket orders, see the BasketTrader topic.
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Upload a Portfolio
You can upload your portfolio into the IB Risk Navigator using a .csv Excel spreadsheet. Positions are
imported into a hypothetical What-if You can import positions to a hypothetical What-If portfolio, and
you can create orders from the What-If to essentially add the positions to your actual portfolio.
You can also create a what-if and quickly populate it with your existing portfolio all from within the
Risk Navigator.

To create a .cvs file to import
1. Create an Excel spreadsheet.
2. Create a header row that contains the field headings. Field headings can be in any order. Valid
header row field titles include (but are not limited to):
l

Action

l

Quantity

l

Symbol

l

SecType

l

Exchange

l

Currency

l

Expiry

l

DivPrt (dividend protected - for futures)

l

CUSIP

l

ISIN
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3. For each order/position you want to import, create a single row of order parameters. Ensure that
field values match the field label in the header row. For example, don't put the symbol "IBKR" in
a field under the SecType field or the import will be rejected.
Note: If the order does not require a specific field value, that cell should be left
blank.
4. Save the spreadsheet with a .csv extension, making note of where you save it.
To import a .csv portfolio file into Risk Navigator
1. Open the IB Risk Navigator from the TWS Analytical Tools menu.
2. From the Portfolio menu select Import.
3. Navigate to the .csv file or enter the file name in the File Name field and click Open.
The imported orders are opened in a new What-If portfolio. Note that both Maintenance and Initial
margin values are displayed for the portfolio in the Risk Dashboard. If you have multiple asset types,
use the tabset to display risk for each type.
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What If and Custom Scenarios
l

Create a What-If Portfolio

l

Create Orders from a What If Portfolio

l

Custom Scenarios

l

Custom Scenario Examples

Create a What-If Portfolio
The What-if portfolio feature lets you create an editable, hypothetical portfolio based on your actual
portfolio. This allows you to see how your risk profile would change based on changes you make to
your portfolio, such as adding, closing, reducing or increasing positions, and lets you check your margin requirements on the portfolio. You can import your current portfolio to a What-If, or build a new
hypothetical portfolio, position-by-position, to see how the risk profile changes as positions are added
and modified. The What-if feature lets you drag new symbols into the portfolio from your trading window to "take" a new position, and edit the position quantity for existing positions. You can also elect
to open positions for some or all of the "what-if" contracts in your hypothetical portfolio. What-if portfolios are outlined in red for easy identification, and display the What-if title at the top of the window.
Use the margin entries on the Risk Dashboard to calculate margin for your entire what-if portfolio.
You can also create an order from within a What-if portfolio that will fill on an exchange. For details,
See for more information.
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To create a "what-if" scenario based on your current portfolio
1. Open the IB Risk Navigator window and on the Portfolio menu, select New. A new, blank whatif window opens.
2. On the Edit menu, select Add From. Your current portfolio is the default list value, named My
Portfolio.
3. Click OK to add your current portfolio to the What-if window.

This creates a copy of your portfolio. You can now drag in new contracts from your trading screen, and see the
results of modifying your positions without actually making any changes.
To save a "what-if" portfolio
1. On the Portfolio menu select Save As.
2. Enter a file name and click Save.
To reload the last saved version
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Use this command to reset all values in the active portfolio to the last saved version. This command
only works on an unsaved file. An unsaved portfolio will display an asterisk "*" at the end of the title.
1. On the Edit menu select Reload from file.
2. Confirm that you want to reload the file and lose all of your unsaved changes by clicking Yes.
To add/subtract positions from other portfolio files
1. From the active portfolio, on the Edit menu select Add From or Subtract From.
2. Select a portfolio to add/subtract. The add/subtract selection list only displays names of portfolios that are currently open.
3. Click OK to add or subtract positions from the active portfolio.
l

l

The add/subtract feature nets out positions common to both portfolios, and creates
a contract line for each new contract (even if the position is "0").
You can add/subtract the same portfolio multiple times. Current positions are netted out each time.

To add one new contract
1. Click NEW and enter the underlying symbol.
2. Define the asset.
3. Specify the position.
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Create Orders from a What If Portfolio

The What-If portfolio allows you to create and fine-tune hypothetical "positions" in a risk-free environment. You
can create a similar position in your actual portfolio using the Trade feature in the what-if.
When you initiate an order from a what-if position, Risk Navigator will create an order in TWS such that its execution will result in a position that mimics the what-if position. This means that if you create an order on an
underlying in which you already hold a position, the quantity for the order will be calculated to accommodate the
current position. For example, if you currently hold a long position of 100 in IBKR and you create a trade from
the IBKR what-if position of 700, the order quantity in TWSwill be for 600 shares.

To create an order from a what-if position
1. Ensure that the position on which you want to base the order is checked using the Include/Exclude box.
2. Check the Trade box for the position you want to create.
3. Click Trade to create the order(s).

The order is created in TWS. You will need to review and transmit the order to complete the trade.
Custom Scenarios
You can elect to modify the variables that affect your risk profile using the Custom scenario command
on the View menu.
The Custom Scenario section is populated with the same data as the realtime market scenario until
you modify the variables.
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Note: VAR in the market scenario is calculated based on the previous day's closing
price, whereas VAR in the Custom Scenario is calculated based on the current
Last price when the scenario is created. Total VAR can be found in the "Value
at Risk" report.

To create a Custom Scenario
1. In the Scenario Editor, filter the underlyings you want to include in the custom view.
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l

Select All Underlyings to affect the entire portfolio from a single editing line.

l

Select Any Underlyings to edit individual underlyings line by line.

l

Choose a single underlying to show the subportfolio (the underlying and its derivatives). Additionally, use Ctrl + click to select multiple underlyings.

2. Modify the Date to view your risk profile at a future date. By default the date is set to today.
3. In the Underlying Price section, define the value of the price change and the type.
l

l

l

ExpV - the Custom Scenario price will be changed to exactly reflect the explicit
value in the Price field, either positive or negative depending on the sign. For
example, if the price for ABC is currently $60.25 and you enter 55.00 ExpV, the Custom Scenario price for ABC will be $55.00.
Chg - Adds or subtracts the value in the Price field, depending on the sign. For
example, if the price for ABC is currently $60.25 and you enter -4.25 Chg, the Custom Scenario price for ABC will be $56.00.
Chg% - Adds or subtracts the percent of the value in the price field, depending on
the sign. For example, if the price for ABC is currently $60.25 and you enter 10
%Chg, the Custom Scenario price for ABC will be $54.23.

The values in the Custom Scenario are always compared to values in the realtime Market
Scenario. For example, if you modify the Price parameter to show a 10% change in the underlying price and get a Custom Scenario price of $54.23, then you modify this price again to
see a -10% change, the new calculation will be based on -10% of the market price of $60.25,
not the existing custom scenario price of $54.23.
4. Use the Volatility section to modify volatility using the same types (ExpV, Chg and %Chg as described

above in the Price section.
5. Hit Apply at the top left of the Scenario Editor to see the impact of your changes in the Custom Scenario

section.
Custom Scenario Examples
You can create complex custom scenarios by editing the price, date and volatility variables. The
examples below are only a few of the possible custom views available, and are meant to help you
become familiar with the tool.
Custom Scenario Example 1: You want to view the impact on your portfolio of a 10% change in the
underlying price of AMZN.
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The effects of this change can be seen in the Custom Scenario, and can be compared with the realtime market data that appears in the adjoining Market Scenario. The underlying price change
shows in the underlying stock line, and the trickle-down affect of this change can be seen in the Price,
Value, Delta and Theta fields.
Custom Scenario Example 2: You want to see the impact of expired options at different exercise
prices.
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The effects of this change can be seen in the Custom Scenario, and can be compared with the realtime market data that appears in the adjoining Market Scenario. Your custom scenario is answering
the question: If the options have expired and the current stock price is $124.00, how would this affect
my AMZN subportfolio?” The trickle-down affect of this change can be seen in the Position field, since
a portion of the expired options would have been in the money and exercised, affecting your position,
as well as the Value and Delta of the underlying. You will not see any data in the options fields on the
Custom Scenario side, since the options have expired.

Modified data in the editor appears in red, indicating that you have not yet applied the changes. When you click
Apply, the red color is removed.
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Risk Navigator Products and Tabs
l

P&L Summary

l

On Demand VaR

l

Margin Sensitivity

P&L Summary
The P&L Summary report displays profit and loss values for all contracts in your portfolio. The display
is sorted by asset type, and includes the total P&L for your portfolio, totals by asset class, and the current P&L for each asset.
To view the P&L, click the P&L tab.
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On Demand VaR

The On Demand Value at Risk report calculates VaR for the entire portfolio. The report calculates VaR at the
subportfolio level and aggregates it at the currency and portfolio levels. On Demand VaR is also available for
What-If portfolios. Hold your mouse over the column names inside the report for more information.
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To use the On Demand VaR report
1. From the Risk Navigator main window, select the VaR tab.
2. Select the VaR Scenario:
l

Historical - Uses past data to estimate price.

l

Monte Carlo - Implements a model for price estimation.

3. Specify the confidence level.
Note: 100% is only available in the Historical scenario.
4. Specify the time horizon in days.

Margin Sensitivity

The Margin Sensitivity report, accessed from the report tabset next to the VAR report, shows you the margin
impact to your portfolio of a specific increase and decrease in your positions or a group of positions.
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Once the position change is specified, the report shows the initial and maintenance margin sensitivity for both
position increase and position decrease. Along the top of the report is the Control Panel which is used to specify
how to modify the positions in your portfolio. The method is set to "Order defaults" by default.
l

l

Overall - Uses the value you set in the entry field. If this radio button is selected, enter the
change amount for all positions in your portfolio in the enterable field.
Order defaults - uses the Order Quantity default specified in the order presets, based on asset
type. If the stock default quantity is 500 and the option default order quantity is 5, all stock positions will display margin impact on + and - 500, and all option positions will show impact for +
and - 5 contracts.
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l

l

By asset type - Use the Edit box to enter the change value for each asset type.
Position Size - Changes the current position by the current position size. A stock position of
7200 will show margin impact for a position of 14,400, and 0 (+7200 and -7200).

In the bottom right corner you can change the display from "All Underlyings" to a specific underlying, and you
can change the way the report is displayed by selecting "Margin Sensitivity by Underlying."
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Risk Navigator Alarms
You can set Alarms in Risk Navigator that alert you with sound, send a pop-up message and create an order
when a specified measure achieves a user-defined value. Available measures against which you can set alarms
include Delta, Futures Delta, Gamma, Delta Dollars, Gamma Dollars, Vega and Theta. Note that these are "position" values (indicated by capitalization of the first letter). You can set alarms at the position level or at the "All
Underlying" level. Additionally if you access the Bond tab you can set alarms based on the bond measures including Dv01, Duration and Convexity.
l

Set a basic alarm

l

Set an alarm to create an Option Portfolio order

l

Set an alarm to create a single order

To set a basic alarm in Risk Navigator
1. Right-click the contract and select Set Alarm.
2. Define the measure, select the operator, specify the value.
3. Indicate the alert method(s) and other Settings and select Set.

To remove an alarm, right-click the contract and select Remove Alarm.
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Click Add Single Order to open the Order Ticket and define the order you want to be created when the alarm is
triggered. Once the alarms triggers, the Order Ticket opens again with your defined order criteria. You can edit
and/or transmit the order. Please note that market conditions may have changed by the time your alarm triggers;
you may want to consider using a Relative order, and we recommend that you review the order parameters when
the alarm triggers before you submit the order.
Set an alarm to create a single order
1. Right-click the contract and select Set Alarm.
2. Define the measure, select the operator, and specify the value.
3. Click Add Single Order to open the Order Ticket.
4. Specify the order criteria including the order type and any necessary offset values.
Note: We recommend that you use a Relative order as the market conditions may
have changed by the time the alarm triggers.
5. Click Create Order. The order will be created when the alarm triggers and you must manually
transmit the order.
6. Click Set to set the alarm. Click Edit or Remove to modify or delete the order.
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Option Portfolio Alarms in Risk Navigator

You can set Alarms in Risk Navigator that trigger the creation a pre-defined Option Portfolio order. You must
submit the order manually.
Available measures against which you can set alarms include Delta, Futures Delta, Gamma, Delta Dollars,
Gamma Dollars, Vega and Theta. Note that these are "position" values (indicated by capitalization of the first letter). You can set alarms at the position level or at the "All Underlying" level.
To set up an alarm, right-click the contract and select Set Alarm.

To trigger an Option Portfolio order from a Risk Navigator alarm
1. Right-click a contract and select Set Alarm.
2. Define the measure, select the operator, specify the value.
3. Click Add Option Portfolio Order to open the Option Portfolio tool.
4. Specify the criteria and run the Option Portfolio query.
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5. Click Save Query to Alarm in Risk Navigator to have the order created when the alarm triggers.
6. Click Set to set the alarm.
When the alarm triggers, the Option Portfolio order will be displayed and you can transmit the order.
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IB Risk Navigator Reports
Introduction
l

Portfolio Report

l

Risk by State Report

l

Risk by Country Bonds Report

l

Risk by Position Report

l

Plot Data by Underlying

l

Risk by Underlying Report

l

Risk by Industry Report

l

Measure by Underlying and Maturity

l

Measure by Price Change and Volatility Change

l

Portfolio Statistics Report

l

Value at Risk Report

l

P&L Pie Chart

l

Market Scenario Drill Through

Portfolio Report
Use the Portfolio report to view risk and exposure for all positions in your portfolio. You can view
totals for specific risk measures (where applicable) in the Risk by Underlying report.
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To view the Portfolio report
1. On the Analytical Tools menu, select IB Risk Navigator.
2. In the Report Viewer, select Portfolio in the Report dropdown.
3. Use the Underlying and Measure dropdown lists to define your report criteria.

Use the Metrics menu to display available risk metrics.
Risk by State Report

For Municipal Bonds Only. The Risk by State report sorts muni bond positions by state.
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To run the Risk by State report
1. From the Risk Navigator main window, select the Bond tab.
2. In the Report field, select Risk by State.
Risk by Country Bonds Report

For Bonds Only. The Risk by Country report sorts bond positions by country-related attributes that you specify
from the Settings menu.
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To run the Risk by Country report
1. From the Risk Navigator main window, select the Bond tab.
2. In the Report field, select Risk by Country.
3. From the Settings menu, specify the Country sort criteria:
l

Registration - This is the country where the bond was issued.

l

Issuer Domicile - The domicile of the bond issuer.

l

Parent Domicile - The domicile of the parent company of the bond issuer.

l

Ultimate Parent Domicile - The domicile of the ultimate parent company of the bond issuer.

Risk by Position Report
The Risk by Position report displays risk measures calculated for each position, by underlying.
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To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as shown above.
Use the Metrics menu to display available risk metrics.
Plot Data by Underlying

Select this report to view values for the symmetric data slicers in the P&L Plot. By default the slicers are spaced
at +/- 3%, 6%, 9%, 12% and 15%.
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If you have the crosshair activated in the P&L plot using the right-click menu, when you hold your mouse over a
line in the plot its value is displayed.
To open the Plot Data by Underlying report
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1. Open the Risk Navigator
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator
from the Portfolio category.
2. From the Report drop down list, select Plot Data by Underlying.

To change the interval between plot slicers
1. From within the plot, drag any of the blue slicer lines in an out to change the interval. Note that
the corresponding negative/positive line will also adjust.
2. Using the menu, from the Metrics menu select Plot data columns and then select Settings.
Risk by Underlying Report
The Risk by Underlying report is designed to open by default when you open the IB Risk
NavigatorSM. This report displays portfolio metrics across all asset classes and provides drill-down
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depth control for each underlying.

To view the Risk by Underlying report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Underlying in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.

Use the Metrics menu to display available risk metrics.
Risk by Industry Report
The Risk by Industry report sorts your portfolio by industry. This report displays values on all
levels of detail, from individual positions to totals per industry sector.
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To view the Risk by Industry report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Industry in the Report dropdown.
You can drill down several levels within an Industry category, and then drill down in the
Underlying field for that category to see all underlyings in the industry, and then all derivatives of the
underlying. To drill down to a deeper level of detail, click the plus "+" sign. A minus "-" sign indicates
that you have drilled down to the deepest level of detail. Click the "-" sign to go up a level.
Use the Metrics menu to display available risk metrics.
Use the Industry Editor
You can modify the default industry groups shown in the Risk by Industry report using the Industry
Editor. The editor allows you to assign an underlying to a different group, assign the underlying to multiple industry groups, and create new industry sectors, groups and sub-groups.
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To use the Industry Editor
l

In the Risk by Industry report, from the Risk Navigator Edit menu select Edit industry groups.
The Sector, Group and Subgroup fields become editable when you click in them.

An asterisk appears next to any underlying whose sector, group or subgroup have been edited.
To assign an underlying to a different sector, group or subgroup
l

Click the appropriate field in the underlying row and select a different entry.

To add the underlying to multiple groups
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1. Use the Industry Editor Edit menu to select New Entry for Underlying. A second line is created
for the underlying.
2. Click the appropriate field to display the dropdown list and select a different entry. You now
have two lines for the underlying with two different industry selections.
To add a new industry
1. Select an underlying, and use the Industry Editor Edit menu to select New Entry for Underlying.
2. Enter the name of the new industry in the blank field. You now have two different lines for the
underlying with two different industry selections.
3. To remove the original, right-click the row and select Remove Row.

You must also enter anew Group and Subgroup for the new industry. This new entry will now be available in
the selection list for all underlyings.
Measure by Underlying and Maturity
The Measure by Underlying and Maturity matrix displays risk by measure for all underlyings, sorted by expiry. The measure, which you selected in the Measure dropdown of the Report Selector, is
displayed along the top of the matrix. The expiry fields display the sum of all positions (measures) for
the given underlying/expiry.
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To view the Measure by Underlying and Maturity report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Measure by Underlying and Maturity in the Report dropdown.
Use the Metrics menu to display available risk metrics.
Measure by Price Change and Volatility Change
This report uses the Risk FactorySM system to calculate the theoretical price and a set of risk measures for each position in your portfolio in each of the market outcome scenarios noted in the bulleted
list below, and measures the market outcome for the relative portfolio Delta, Gamma, Vega, and
Theta.
Note: You must "Download global risk" from the Settings menu to populate this
report.
All other reports in the Risk Navigator use real-time data in their calculations, but values in this
report are calculated using the underlying and derivative prices on the close of the previous business
day, at multiple positive, negative, and zero percent change scenarios in the underlying price, volatility and interest rate.
Scenarios for each value are:
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l

Underlying price scenarios: -30%, -20%, -10%, unchanged, +10%, +20%, +30%

l

Volatility scenarios: -30%, -15%, unchanged, +15%, +30%

l

Interest rate scenarios: -100 bp, -50 bp, unchanged, +50 bp, +100 bp

The scenarios advance the time parameter to the close of the next business day, and the values in the
table reflect the scenarios applied to the measure you picked in the Report Selector. Although 175
market outcome scenarios (7x5x5) are calculated for each contract, you can only view a flat slice of
these values at one time, due to the limitations imposed by our 2-dimensional display capabilities.

To view the Measure by Price Change and Volatility Change report
1. From the Risk Navigator Report Viewer, select Measure by Price Change and Volatility
Change in the Report dropdown.
2. From the Settings menu, select Download global risk.
3. Use the Dimensions>Scenario Risk Matrix menu to change the row and column values to view
different scenarios.
You can apply market scenarios to other IB Risk Navigator reports using the drill through feature.
Market Scenario Drill Through
You can apply a market outcome scenario (calculated in the Measure by Price Change and Volatility
Change report) to any of the other risk reports using the drill through command on the right-click
menu.

TWS Users' Guide

755

Price/Risk Analytics

To apply market outcome scenarios to other reports
1. Select a market outcome scenario by clicking in a cell at the intersection of the x-axis and yaxis scenarios.
2. Use the right-click menu to select Drill Through, and then select a report.
3. The chosen report is displayed with the applied market outcome scenario you selected
described at the top of the report.
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When you are viewing the market outcome scenarios via the drill-through feature, all of the values on the report
reflect this hypothetical scenario, and therefore do not reflect actual, real-time risk. To reset the report to realtime, click the Reset Scenario button on the top right.
Portfolio Statistics Report
The Portfolio Statistics report shows two summary tables: one for all Stock and Futures positions,
and one for all Options positions.
The Stock and Future summaries shows all long positions, all short positions, the net and gross
units, and their corresponding total value.
The Option/Warrant summary shows all long calls, long puts, the sum of both calls and puts, and
the total value; all short calls, short puts, the sum of both calls and puts, and the total value; the net
units for calls, puts, the sum of both and the total net value; and gross units for calls, puts the sum of
both, and the corresponding net value.
The Cash balance summary shows you total in base, and all cash totals for currencies in your portfolio.
The Opaque Positions list displays positions for which risk cannot be calculated. While these positions
are not included in any risk reports, the market value is included in the Portfolio Value version of the
P&L graph.
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To view the Portfolio Statistics report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Portfolio Statistics in the Report dropdown.
Value at Risk Report
The Value at Risk report shows the greatest loss that a portfolio will sustain over a one-day period,
with either 95%, 99.5% or 99.5% confidence. VAR is calculated using three different methods, each
with different assumptions about correlations of the underlying assets in the portfolio. This report is
only available in the Equity tab and is calculated in real-time using the P&L plot data. To see VAR for
you entire portfolio, use the VAR tab.

l

Worst Case -Calculates the worst case price movement between the selected confidence interval for each underlying independently. Note that the VAR column in the Risk by Underlying
report contains the same values.
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Perfect Correlation - Assumes each underlying in your portfolio moves perfectly correlated
with the S&P 500, and calculates the worst case price movement between the confidence interval of SPX.
Index Correlated Price Estimate - Assigns a correlation (Beta) to each underlying in your
portfolio to the S&P 500 (used as a reference index), and then looks for the worst loss within its
adjusted confidence level.

To view the VAR report
1. Open the Risk Navigator.
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator
from the Portfolio category.
2. From the Report field, select Value at Risk.

P&L Pie Chart
The P&L Pie Chart shows the position Delta and P&L for all positions in your portfolio relative to the
total portfolio. Use default color coding to see losing positions in red, profiting positions in green and
neutral positions in blue, or change the coloring to display each position using a different color.
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To view the P&L Pie Chart
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Selector, select P&L Pie Chart from the Report dropdown.
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Risk Navigator Menus
l

Metrics

l

Settings

l

Aggregated Greeks in Reports

Report Metrics
The Metrics menu at the top of the IB Risk Navigator is context-sensitive, and allows you to select
applicable metrics for each report. Available metrics include:

Metrics

Description

Size columns...
Position size

Select Position size to display your (signed) position in the contract. A short
position is depicted by a "-" minus sign.
Choose "None" to remove the Position field from your report.

Value columns...
All

Selects all available value columns to include in the report.

None

De-selects all columns.

Unrealized P&L

(Market value of positions) - (average cost).

Realized P&L

(Market value of positions since close of period*) - (average cost for these
positions).
*Cut-off times for determining realized P&L for transactions are as follows:
• 20:30 ET for securities
• Two periods for futures: 17:30 ET and 7:10 ET

Total P&L
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for each position.

P&L for Day

(current price - prior day's closing price) x (total number of outstanding
shares) + (New Position calculation for all new positions)

Price

The current market price of one unit of the contract.

Price Change

The difference between the last price, and the closing price on the
previous trading day.

Price Change
%

The percentage difference between the last price, and the closing
price on the previous trading day.

Underlying
Price

The price of the underlying (in cases where position is a derivative).

Average Cost

The average price you paid (cost) per unit.

Value

The (price) x (position).

Conversion Rate

Displays the rate used to convert non-base positions into the base currency.

Currency

The currency of the position.

VAR

Value at Risk (VAR) is a measure of market exposure. It shows the
greatest expected loss over a one-day period, with 99.5% confidence.
Note: In cases where the VAR cannot be calculated, the notation "N/A" is
displayed on a violet background.

Position Risk columns...
All

Selects all available value columns to include in the report.

None

De-selects all columns.

Delta

This position delta captures both the direction and the magnitude of the portfolio's sensitivity to an underlying by representing the degree and direction
of change in the option price, based on a change in the price of the underlying.
We use a capital "D" to differentiate the IB Risk Navigator position Delta
from the contract delta. Position Delta is calculated as (delta * position).

Delta Dollars

Delta Dollars is calculated using the formula:
delta x underlying price.
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Futures Delta

This column is derived from raw position delta. For each futures position or
futures option position with this future as direct underlying, futures delta =
(delta / exp(r*T)) / futureMultiplier, where futureMultiplier is the contract
multiplier of future, exp(r*T) is the scaling factor that we currently apply to
raw delta; dividing by it yields the original raw delta.

Gamma

Gamma helps you assess directional risk by defining the speed at which the
option's directional changes will occur, i.e. the rate of change of delta.
We use a capital "G" to differentiate the IB Risk Navigator "position
Gamma" calculated as (gamma * position) from the contract gamma calculation.

Gamma Dollars

Gamma Dollars is calculated using the formula:

Vega

Vega represents the portfolio's sensitivity to changes in implied volatility of
the underlyings, and shows the change in the price of an option relative to a
change in the implied volatility of the underlying. Generally long option positions benefit from rising (and suffer from declining) implied volatilities,
while short option positions experience the opposite - they benefit from
declining (and suffer from rising) implied volatilities.

0.5 x Gamma x (Underlying Price x 1%)2

We use a capital "V" to differentiate the IB Risk Navigator "position Vega"
calculated as (vega * position) from the contract vega calculation.
Theta

Theta represents the portfolio's sensitivity to the passage of time by indicating the rate at which the market value of your portfolio will change with
time. This metric calculation is based on the assumption that all other variables remain unchanged, including the underlying price, implied volatility
and interest rate.
We use a capital "T" to differentiate the IB Risk Navigator "position Theta"
calculated as (theta * position) from the contract theta calculation.

Contract Risk columns...
All

The "unrealized" Average Cost P&L is shown in total, per underlying, and
for each position.

None

The current market price of one unit of the contract.

Delta

Delta captures both the direction and the magnitude of the portfolio's sensitivity to an underlying by representing the degree and
direction of change in the option price, based on a change in the
price of the underlying.

Gamma

Gamma helps you assess directional risk by defining the speed at
which the option's directional changes will occur, i.e. the rate of
change of delta.
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Vega

Vega represents the portfolio's sensitivity to changes in implied
volatility of the underlyings, and shows the change in the price of an
option relative to a change in the implied volatility of the underlying.
Generally long option positions benefit from rising (and suffer from
declining) implied volatilities, while short option positions experience the opposite - they benefit from declining (and suffer from
rising) implied volatilities.

Theta

Theta represents the portfolio's sensitivity to the passage of time by
indicating the rate at which the market value of your portfolio will
change with time. This metric calculation is based on the assumption
that all other variables remain unchanged, including the underlying
price, implied volatility and interest rate.

Implied Volatility

The implied volatility on an option.

Implied Volatility Change

The absolute change in implied volatility between the current value
and the value calculated using yesterday's closing price.

Implied Volatility Change
(%)

The change in implied volatility between the current value and the
value calculated using yesterday's closing price, as a percentage.

Historical Volatility

The last available historical volatility.

Historical Volatility Change

The difference between the historical volatility as of yesterday's
close and the current historical volatility.

Historical Volatility Change
(%)

The difference between the historical volatility as of yesterday's
close and the current historical volatility, as a percentage.

Hedge

Adds a new column with checkbox, which allows you to select multiple subportfolios by underlying (a subportfolio includes all of your positions in an
underlying and its derivatives) and create a basket of hedge orders to offset
the deltas of each subportfolio.

Plot data columns..
All

Adds all data slicers below to the P&L Plot.

None

Removes all data slicers from the P&L Plot.

3%

Add or remove just this pair of data lines (+3%/-3%)

6%

Add or remove just this pair of data lines (+6%/-6%)

9%

Add or remove just this pair of data lines (+9%/-9%)

12%

Add or remove just this pair of data lines (+12%/-12%)
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15%

Add or remove just this pair of data lines (+15%/-15%)

Settings

Click to adjust slicer line values. You can also grab and drag slicer
lines within the P&L plot.

Risk Navigator Settings Menu

Use the Settings menu to specify global directives for the Risk Navigator.

Confidence

Set the confidence level which is used in both the P&L plot and in the
VaR calculations. Possible values are 95%, 99% and 99.5%.

Reference Currency

Defines the base currency for the portfolio. This is used in the portfoliolevel aggregations and in forex decomposition on the forex tab.

Country

For bonds Risk by Country report. Sort bonds by:
Registration - This is the country where the bond was issued.
Issuer Domicile - The domicile of the bond issuer.
Parent Domicile - The domicile of the parent company of the bond
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issuer.
Ultimate Parent Domicile - The domicile of the ultimate parent company
of the bond issuer.
Scaling

Define scaling settings for the presented measures.

Percentages

Percentage settings for the Measure by Price Change and Volatility
Change report.

Drilling

Specifies the drilling depth, i.e. the number of levels that should be
expanded when you drill down.

Greek Aggregations

Select cross-underlying aggregation methods for the Greek columns.

Date Scenario

Specific to the P&L plot. Specify whether changing the Date Scenario
for Custom Scenarios is restricted to the selected underlying.

Pin First Row

When selected, the first row of aggregated report data will
remain visible below the header row when you scroll through a
table. This setting is enabled by default.

Exclude
undefined values in aggregations

When checked, the Greek aggregation will exclude any undefined
position. Positions may be undefined for many reason including
missing market data, invalid prices, missing conversion rates
etc.

Download
Global Risk

This feature is mandatory when presenting the risk matrix via the
Measure by Price Change and Volatility Change report. This features requires greater CPU and memory usage and should be disabled until needed.

Aggregated Greeks in Reports
The aggregate calculations for the Delta, Gamma and Vega position Greeks can be changed from the
Settings menu by choosing Greek aggregations.
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Change Greek aggregation calculations
1. From the Settings menu, select Greek aggregations.
2. Use the radio button to choose a calculation.
Calculations use the following variables:
S_i = underlying price.
sigma_i = historical volatility of the underlying.
Delta_i = total delta denominated to the base currency.
Gamma_i = total gamma denominated to the base currency.
Vega_i = total vega denominated to the base currency.
Straight add:
Aggregated Delta = sum over i (Delta_i)
Aggregated Gamma = sum over i (Gamma_i)
Aggregated Vega = sum over i (Vega_i)
Perfect Correlation:
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Aggregated Delta = sum over i (Delta_i * S_i * sigma_i)
Aggregated Gamma = 0.5 * sum over i (Gamma_i * (S_i * sigma_i)^2)
Same Percentage Move:
Aggregated Delta = sum over i (Delta_i * S_i * 0.01)
Aggregated Gamma = 0.5 * sum over i (Gamma_i * (S_i * 0.01)^2)
Aggregated Vega = sum over i (Vega_i * S_i * 0.01)
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Option Analytics

Option Analytics
Introduction
l

Option Analytics Window
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Option Analytics Window
The Option Analytics window displays values that reflect the rate of change of an option's price with
respect to a unit change in each of a number of risk dimensions.
The contract price plots display the static set of contract prices determined during the price scan.
Each point associates an underlying price on the horizontal axis with the corresponding contract price
on the vertical axis. Note that the contract price is expressed as the price per underlying unit (just as
it is represented on an order line or in the execution window). The top plot displays calls, the bottom
plot displays puts, for whichever option your have highlighted in the list.
Use the Vol-up, Vol-down and T-down checkboxes to view the plot under different scenarios to help
you visualize the volatility and time risk in your option positions. Vol-up raises the implied volatility
by 15% in relative change*; Vol-down reduces the implied volatility by 15% in relative change*, and
T-down reduces the time to expiry by one calendar day.
To view the Option Analytics window
l

l

From the OptionTrader, select a contract and on the OptionTrader toolbar click Analytics, and
then select Option Analytics.
From the trading window, select an options contract, and use the Analytical Tools
menu command to select Option Analytics.

Option Analytics Fields

Contract
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price.
delta

The rate of change in the value of a call option with respect to a change in the price of the
underlying asset. Since call values increase with an increase in the price of the underlying
asset, delta-call is always a positive number. A call option with a delta of 1.0 will move at
100% of the rate of change of the underlying, an option with a delta of 0.50 will move at
50% of the rate of change of the underlying, etc.

gamma

The rate at which the delta of an option changes with respect to a change in the price of
the underlying asset.

vega

The rate of change in the value of an option with respect to a change in the volatility.

theta

The amount that an option value will change with the passage of one day. This is not the
derivative, but rather it is a difference. Theta is also known as the time value decay, or
premium decay.

These values are updated with the underlying last price, and when you apply changes to an option class. These
risk dimension values can also be displayed on the Option Trader screen.
*For an example of a relative percent change, if the current implied volatility of an option is 10%, a
15% relative change would result in an implied volatility of 11.5%, calculated as follows:
10% * (1 + 0.15) = 11.5%.
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Use the Model Navigator

Use the Model Navigator to modify option pricing assumptions, including the volatility, interest
rates and dividends, and have the Model Navigator use these values in its option model price calculations.
l

Using the Model Navigator

l

Contract Description Pane

l

Volatility Model Pane

l

Edit the Volatility Profile

l

Edit Interest Rates

l

Edit Dividends

l

Edit the Lending Yield

l

Model Price Color Key

l

Modify Chart Display Settings
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Using the Model Navigator
Price/Risk Analytics uses current market data along with interest and dividend values to calculate
implied volatilities and option model prices. Use the Model Navigator to modify pricing assumptions
and recalculate the model price.
Note: Option model computation requires market data for both the option and its
underlying. In the case of index options, the market data for the futures reference contract is also required.

To open the Model Navigator
1. From the Analytical Tools menu, select Model Navigator.
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l

l

If you open the Model Navigator from the OptionTrader, it is automatically populated with all
loaded option chains.
If you open the Model Navigator from a Quote Monitor, it will show options on all pages that
have the Model or Imp Vol fields displayed, which require the model price calculation.
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To display Model or Imp Vol fields on a Quote Monitor
1. Hold your mouse over a Market Data column to display the “+” icon, and click on it to show the
column picklist.
2. Expand the Options category and select the Imp. Vol and/or Model fields.
The Imp Vol and Model fields display on the page, and all options contracts on the page now require
a model calculation and will appear in the Model Navigator Contract Description pane. The implied
volatility calculation is non-linear and may not converge for low vega options. In such cases, the
Model Navigator will not provide an implied volatility estimate.
The Model Navigator window comprises three main sections: the Contract Description Pane which
shows all available options in an expandable tree, the Volatility Model Pane which displays the volatility curve plots, and the Volatility Curve Table table which lists associated strike prices and implied
volatilities.
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Contract Description Pane
The left pane shows all available options grouped by ultimate underlying, which can be sorted alphabetically or based on option count order using the Sorting command on the Settings menu. Select the
checkbox next to an expiration date to create a volatility model. All volatility models on an underlying
appear in the same sub-pane. Each underlying has a unique pane of volatility model(s).

Use the Settings menu to elect not to merge the FUT subtree with the option, and see the whole FOP
structure.
To include contracts in the Model Navigator, you must either:
l

Use the OptionTrader and download a set of option chains

l

Open the IB Risk NavigatorSM, or

l

Add the contracts to your trading page with the Imp Vol. and/or Model fields displayed.
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Volatility Model Pane
Volatility Models are displayed for all checked contracts in the center pane of the Model Navigator.
The Volatility Model pane includes:
l

l

Price Offset - optional. Offset the price of the underlying for selected options, by an absolute
value or a percent of the current price.
Volatility Curve Plot - Shows the volatility profile as a function of the strike price. You can manually edit a plot by right-clicking and choosing Edit.

l

The horizontal axis is the strike price, the vertical axis is the volatility.

l

Risk Navigator calculates the implied volatility for each option in a class.
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l

l

l

l

l

The blue and red dots show implied volatility derived from the market data for calls and puts,
respectively. Dark blue/dark red indicates a half quote call/put (either just the bid or just the
ask).
Volatility knots calculated from the option bid/ask include a representational “error bar” to indicate the error range of the calculation. This range is specified numerically in the mouse-over
help, for example “+/- 0.008.” If the volatility is not calculated using bid/ask (for example, a
half quote call/put) the error range is not displayed.
If there is no bid/no ask, the volatility is calculated from the previous closing price indicated by
an open circle.
The average or close implied volatilities are fitted to a parabola, vs. the strike price. The fit is
weighted by the vega of each option, which means that the curve is constrained to be closest to
the implied volatilities for the options that have the most vega, i.e. whose option price changes
the most per unit change in the option's volatility.
To see details for a given implied volatility point, hold your mouse cursor over the point. The
system will display the option right, strike price implied volatility and error range.
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Volatility Curve Table
The volatility curve table reflects the data in the plot. To add IV (Manual) entries, use the Edit menu
to select the profile to edit, or right-click in a plot and select Edit. Both the volatility plot and table
become editable. In the Manual column, double-click the implied volatility at a strike price and enter
a new value.

By default, the Model Navigator’s sophisticated option model calculation engine uses the values in the
plot along with the calculated interest rate, dividends, underlying price and other parameters, to calculate the Model price. If you prefer to calculate the model price using the pricing assumptions reflected in an edited plot, you must apply the changes to your plot and leave it in
Edit mode. Any expiry that has a volatility curve plot in Edit mode will use this profile in the calculation of the Model price and Implied Volatility.
You can also modify the Interest Rates and Dividend Schedule, and specify that these modified pricing
assumptions be used in the Model Price calculations.
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Edit Interest Rates
You can modify the interest rate by entering values in the Manual column of the Interest Rate Navigator.
To open the Interest Rate Navigator
1. From the top-level Edit menu, select Interest Rate.

There are two interest rate columns, Forward Rate (Auto) and Forward Rate (Manual). The Auto
column displays the U.S. default rate. The Manual column initially displays the U.S. rate (rather
than an empty field), but the value is editable.
To edit interest rates
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1. Select the Manual radio button to make the column of manual rates editable.
2. Double-click a rate in the Manual column and enter a new rate.
3. Click Apply to save your changes.
To have the model calculations use your manual value, ensure that the Manual radio button is selected.
l

l

l

l

l

l

To change the number of dates/rates displayed, right-click in the table and select Add new to
create a blank editable row at the top of the table, or Remove Selected to delete the selected
row.
To globally apply an offset value or percent to all manual entries, enter an offset amount in the
Interest Rate Offset field, and select the Percent or Absolute value radio button.
The option model is calculated using the interest rate you define by selecting the Auto or
Manual radio buttons.
The annual percentage rate is a simple time deposit rate using the bank year calendar (360
days/year).
The system converts the interest rate table to a set of exponential interest rates that apply on a
spot-to-date basis for each expiry in a class. This is displayed as the IR value in the Contract
Description Pane when you expand an expiry.
The interest rate table applies across all option classes. When you change the interest rate in
one option class, the change is applied to all option classes.
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Edit Dividends
In addition to letting you manually set the dividend schedule, the Dividend Schedule Navigator also
provides an automatic "best guess" dividend payment schedule based on historical data for that
asset.
To open the Dividend Schedule Navigator
1. From the top-level Edit menu, select Dividend Schedule.

There are two dividend, Dividend (Auto) and Dividend (Manual). The Auto column displays the
"best guess" dividend payment schedule based on historical data. The Manual column shows the
same values (rather than an empty column), but the value is editable.
To edit dividends
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1. Select the Manual radio button to make the manual column editable.
2. Double-click a dividend in the Manual column and enter a new value.
3. Click Apply to save your changes.
l

l

l

To change the number of dividends displayed, right-click in the table and select Add new to create a blank editable row at the top of the table, or Remove Selected to delete the selected row.
To globally apply an offset value or percent to all manual entries, enter an offset amount in the
Dividend Offset field, and select the Percent or Absolute value radio button.
The option model is calculated using the dividend schedule you specify by selecting the Auto or
Manual radio buttons.
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Edit the Lending Yield
Adjust the underlying yield so that the stock lending rate is reflected in the model calculation using
the Lending Yield table. You will be able to edit the yield for any underlyings for which you have an
option displayed on the Quote Monitor. You must also have the Model and/or Imp Vol field displayed
on the Quote Monitor to see entries in the Model Navigator.
To open the Dividend Schedule Navigator
1. From the Analytical Tools menu, select Model Navigator.
2. Within the navigator, select the Dividend tab.

The white fields are editable, and changes to the yield are reflected in the left page Yield field.
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Model Navigator

To edit the Lending Yield
1. Set the time in days when the rate will begin to decrease linearly with time.
2. Set the rate in basis points.
3. Set the time in days when the rate will decrease to zero.
4. Click Apply to incorporate the edited lending yield in the model calculation.
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Model Price Color Key
Model prices are displayed in color on the trading screen to help you see at a glance where they fall in
relation to the bid and ask prices. The color bar below shows the range within which model prices my
fall. Model price colors update with the underlying last price.
You must have the Model field displayed on your trading page to see the model price.

To show a field in TWS
Hold your mouse over any field until the "+" and "x" icons appear. Click the "+ " to display the list of available
fields. Note that if you hover your mouse over an order field, all available order fields are displayed. If you hover
over a market data field, all available market date fields are displayed.

Implied volatilities (in the Imp. Vol column) are always displayed in either pink or white. If either the Model or
Imp Vol(%) values are displayed in white, it means the model hasn't calculated any prices or implied volatilities.
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Index Arbitrage Meter

Index Arbitrage Meter
Introduction

The Index Arbitrage Meter illustrates the extent of the premium (or discount) of the lead month
futures price above (or below) its fair future value with respect to the index price. A green bar indicates that the lead month futures price is at a premium to (i.e. greater than) its fair future value. A red
bar indicates that the lead month futures price is at a discount to its fair future value. This tool is available for Index instrument types.

To show or hide the Arbitrage Meter on Login
When you log in, the Arbitrage Meter is displayed by default for all index instruments. To hide the
arbitrage meter on login:
1. On the Edit menu, select Global Configure, then select Display in the left pane.
2. Check or uncheck Show Arbitrage Meter.
To display the Arbitrage Meter for an index
1. Click on the desired market data line to select the index.
2. Right click and select Tools and then select Arbitrage Meter.
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Fundamental Analytics
l

Company Fundamentals

l

Quote Details
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Company Fundamentals

Company Fundamentals
Subscriber-based Company Fundamentals provides comprehensive, high quality financial information
on thousands of companies worldwide.
Customers who subscribe to Reuters Worldwide Fundamentals receive additional global data, and customers who subscribe to Wall Street Horizon have access to comprehensive high-quality financial
information on thousands of companies, in the form or company and portfolio Events Calendars.
Note: To subscribe to Reuters Fundamentals and Wall Street Horizon, log into
Account Management, and use theMarket Data Subscriptions page. You can
access Account Management directly from within TWS by selecting Account
Management Home from the TWS Account menu.
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To access Company Fundamentals
1. Select an underlying symbol.
2. Use the right-click menu to select Analytical Tools, and then select Company Fundamentals.
3. Use the drop-down list in the title bar to change windows. Availability is based on your subscriptions. Choose from the company Summary, Financial Summary, WSH Corporate Event Calendar, Dividend Calendar, Analyst Recommendations, Financial Ratios, Financial Statements,
Analyst Forecasts, Similar Products, SEC Filings, and Insider Trading.
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Wall Street Horizon Data
Subscribe to Wall Street Horizon to see ticker-specific events calendars and industry-related events
for thousands of companies worldwide. The Events Calendars display dates for earnings announcements, shareholder meetings, investor conferences and other events, and provides links to Seeking
Alpha transcripts whenever available.

To access the WSH Events Calendar
1. From the Quote Monitor, window, select a ticker.
2. Use the right-click menu and select Analytical Tools and then Company Fundamentals.
3. Click Event Calendar from the pick list.
The Related Events table shows recent events for companies in the same sector as the ticker on your
page.
l

l

Select a future event in either table and click Set Alert to create a message or order action
alert.
Click the blue hypertext to access a transcript.
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You can also view the Events Calendar for multiple tickers.
To view Events for multiple tickers
1. From the trading window, select multiple tickers by holding the Ctrl key and clicking the market
data lines.
2. Use the right-click menu to select Events Calendar.

Portfolio Events Calendar
You can also view recent events for your portfolio, which comprises all of your current positions.
To view a Portfolio Events Calendar
1. From the Analytical Tools menu, select Event Calendar and then My Portfolio.

If you have a large portfolio, it may take several minutes for all of the data to load. You may want to consider
viewing events for a subset of tickers using the procedure above.

Recent events are listed in the Events table, sorted by date.
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l

l

l

Company Fundamentals

Click the Underlying field heading to re-sort the table by underlying. Click any other field to resort by that field.
Hold your mouse over the Earnings Call Information icon to see dates for upcoming Earnings
calls.
Select a line and click the Company Fundamentals button to open that tool for a single underlying.
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Reuters Data in Company Fundamentals
Once you have subscribed to Reuters Worldwide Fundamentals via Account Management, you can
view Reuters data through a set of contract-specific reports.

The Reports
Select a report title to open the report. If the report includes sub-reports, these are accessible from
the pick list in the top left corner.
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Adding Reuters Fields to the Trading Window
To display/remove market data columns on a page
1. Right click any column heading on a trading page, and select Customize Layout.
2. Click the Market Data Columns tab to view columns.The columns already displayed on your trading window appear in the Shown Columns list on the left side of the page. The remaining
columns are grouped by category in the Available Columns list to the right.
3. Expand the Fundamentals category in the right pane and Add or Remove fields from the trading
window.

Column
Name

Description

Fundamentals

Dividends
(TTM)

This is the sum of the Cash Dividends per share paid to common stockholders
during the last trailing twelve month period.

EPS
Growth

This growth rate is the compound annual growth rate of Earnings Per
Share over the last 5 years, excluding Extraordinary Items and Discontinued
Operations.
NOTE: If the value for either the most recent year or the year furthest out is
zero or negative, the growth rate cannot be calculated and 'NA' (Not Available) will display.

Market
Cap

The market cap value is calculated as follows:
Current Price x Current Number of Shares Outstanding

P/E

This ratio is calculated by dividing the current Price by the sum of the Diluted
Earnings Per Share from continuing operations BEFORE Extraordinary Items
and Accounting Changes, over the last four interim periods.

Price/Book

This is the Current Price divided by the latest interim period Book Value Per
Share.

Quick
Ratio

Also known as the Acid Test Ratio, this value is defined as Cash plus Short
Term Investments plus Accounts Receivable for the most recent interim period
divided by the Total Current Liabilities for the same period.
NOTE: This item is Not Available (NA) for banks, insurance companies and
other companies that do not distinguish between current and long term assets
and liabilities.

Return on
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This value is the Income Available to Common Stockholders for the trailing
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Equity
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twelve months divided by the Average Common Equity, and is expressed as a
percentage. Average Common Equity is calculated by adding the Common
Equity for the 5 most recent quarters and dividing by 5.

796

Fundamental Analytics

News and Research

News and Research
Real-time News

You can now elect to view real-time news stories from sources like CNET News, Google News, MSNBC
and Reuters using the News features.
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To display News fields
1. Hold your mouse over any field title until the "+" and "x" Insert and Remove icons appear. Click
the "+ " to display the list of available fields. Note that if you hover your mouse over an order
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News and Research

field, all available order fields are displayed. If you hover over a market data field, all available
market date fields are displayed.
2. From the News category and News Time and then News Title. Note that you can drag and drop
them to another position if desired.
In addition, the rows are displayed in colors. Stories with the lightest color are the most recent.
3. Click a news title to display all associated news headlines in the bottom news panel.
4. To view a full story, click the headline.
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Quote Details
Introduction

The Quote Details windows provide quick-glance data on a specific underlying.
To open a Quote Details window
1. Select an underlying.
2. From the Analytical Tools menu, select Quote Details.

This small floating window is packed with critical data including:
l

The last traded price and it's change from the previous day's close both as an absolute value
and as a percentage;

l

The NBBO and Bid/Ask sizes;

l

The current high/low and a daily candlestick that illustrate the high/low/open/last;

l

The 52-week high/low and a 52- week candlestick that illustrate the high/low/open/last;

l

A volume indicator that shows the Average Daily Volume (ADV) against both the current
Volume (V) and the Average Daily Volume right now (ADVn).

You can open multiple Quote Detail windows and move them anywhere on your screen. For windows
grouping, the Quote Details acts as both a source and target, which means that changing the ticker in
the Quote Details will change it in other grouped windows (source) and changing the ticker in other
grouped windows will be reflected in the Quote Details (target).
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Technical Analytics
l

Mutual Fund Replicator

l

MultiCharts Advanced Charting

l

Bond Search

l

Charts

l

Chart Types & Tools

l

Chart Indicators

l

Market Scanners

l

Virtual Securities
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Mutual Fund Replicator

Mutual Fund Replicator
The Mutual Fund Replicator finds an ETF(s) whose performance parallels that of a user-specified mutual fund.
Once you enter the mutual fund name or ticker symbol, the replicator scans the market and returns the top single
and compound ETFs (in the recommended quantity) whose performance most closely follows that of your submitted mutual fund. The Performance Analysis and Return Comparison panels display performance correlation
characteristics including the correlation, tracking error and a comparison of management fees.
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Mutual Fund Replicator

Use the Mutual Fund Replicator
1. Open the Mutual Fund Replicator.
l

l

In Mosaic, use the New Window dropdown and select the tool from the Technical Analytics section of the menu.
In TWS, use the Analytical Tools menu.

2. Enter the fund symbol, or click the looking-glass icon to search using the Mutual Fund Selector.
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Time and Sales Data
You can elect to view the Time & Sales for any underlying.

To open Time & Sales in the Mosaic
1. From the New Window dropdown select Time & Sales.
2. To change the underlying, select a new ticker in a grouped window, or enter the ticker symbol
in the entry field.
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To search for a date and time from a chart, use the "Select from chart" from the Search button.
Select from chart
1. From the Time & Sales Search menu, choose Select from chart. The chart for the active underlying opens with the cursor in "Time and Sales" mode.
2. Click on the time/date you want reflected in the Time & Sales window.
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MultiCharts Advanced Charting
MultiCharts advanced charting is now accessible from within TWS as a complement/upgrade to our existing interactive charts.
Multicharts.net
The MultiCharts.net tool is available in free of charge to IB customers (does not include the ability to trade) and
includes:
l

Advanced charting

l

Drawing tools and a large library of more than 300 indicators

l

User-programmable technical indicators

l

Strategy backtesting

l

User-programmable trading strategy signals

User-programmable features can be programmed using C# or Visual Basic. To trade from within
MultiCharts.net, upgrade for $39.00 per month (following a one-month free trial).
MultiCharts PowerLanguage
Customers who want to trade from within MultiCharts AND who need to program complex custom technical
indicators but are not programmers can subscribe to MultiCharts PowerLanguage. This version offers all of the
charting features of MultiCharts.net plus the ability to trade, and the addition of PowerLanguage, a more userfriendly computer programming language with a small learning curve that was designed to be used by non-programmers. The PowerLanguage version is available for $39.00 per month (following a one-month free trial).
Please note that MultiCharts is currently not supported for accounts holding a large number of positions and these
accounts may experience stability issues if they use the tool. Also note that these two products are independent,
and charting details set up in MultiCharts.net will not be transferred over to MultiCharts PowerLanguage.
Using MultiCharts
1. Download the desired version of MultiCharts.
l

From within Mosaic, use the New Window drop-down and select MultiCharts.

l

From within Classic TWS, use the Analytical Tools menu and select MultiCharts.

2. From the MultiCharts launch page, choose the version to download.
Note: The two versions are not compatible. If you elect to change versions at any
time you will lose all existing MultiCharts data and settings.

Please note that the initial download may take some time.
Resources:

MultiCharts Users' Guide
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MultiCharts Advanced Charting

MultiCharts.net Programming Guide
MultiCharts PowerLanguage Keywords
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Virtual Securities
The Virtual Security feature provides the ability to view current pricing and chart historical pricing for a synthetic security that you create by entering one or multiple underlyings in an equation using our flexible Virtual
Security Equation Builder. Once you have defined a Virtual Security and designated a ticker symbol for it, it can
be used throughout TWS in the quote and analytical tools. It cannot be used in any of the trading tools.

To create a virtual security
1. In the Quote Monitor, right-click in a blank line select Virtual Security.
2. Using the equation builder, define the custom security. Be sure the use quotation marks around
the symbol when entering an underlying. See example.
3. Enter a name for the virtual security and click OK.
The security is listed as a new contract in the Quote Monitor and displays the Last, Bid and Ask prices.
You can view the calculated market data and chart historical pricing for the synthetic ticker, but you
can't use it in any of the trading tools.
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Price History
The Price History shows the Open, High, Low, Close and Volume by date, with the first line ticking real-time
market data and corresponding to today's date.

Use the scroll bars on the right side to scroll up and down by date, and use the "Options" button at the bottom of
the scroll bar to go to a specific date/time, export the current table to Excel, and show splits/dividends by opening
the Adjustments field.

To open the Price History window
l

From the New Window dropdown (or from the Mosaic Toolbox) click Price History.
Note: If you open the Price History from the Mosaic Toolbox, the window will open
linked to the same windows group as the toolbox, and populated with that
group's current underlying.
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Market Scanners
Intro
l

Create a Market Scanner

l

Use the US Corporate Bond Scanner

l

Non-Subscribed Scanner Locations

l

After Hours Scanner Snapshot

l

Market Scanner Types
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Create a Market Scanner
The Market Scanners quickly scan of relevant markets and return the top contracts based on the
instrument, parameter and filtering criteria you define. In addition, you can transmit orders directly
from a scanner page, and save a scan as a template for later use.

To create a Market Scanner page
l

On the Analytical Tools menu select Market Scanner.
A new Market Scanner page is created

To define scan criteria
1. Select an instrument type from the Instrument list. Note that the scan title changes with each
selection to reflect the criterion you select.

Instruments are defined by region. “Global” scanners can scan an instrument across global markets.
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2. Choose the location/exchange whose data will be included in the market scan. The valid locations change in response to the instrument you selected in Step 1.
3. Use the Filter fields to narrow the contracts that will be returned in your query by characteristic. For example, you may only want to see the Top% US Stock Gainers within a certain
P/E range, or with a capitalization above 2,000,000.
4. Choose a Scanner parameter, such as Top% Gainers, Hot Contracts by Price or Top Option
Implied Volatility in the Parameter field.
5. Click Search to return the top contracts that meet your search criteria. Data is updated every
60 seconds.

Most scans return the top 50 contracts by default. You can specify the maximum number of returns using the
Max results field.
To save a scanner template
1. After you have defined the scan criteria, click the "Save" disk icon to the right of the Max Results field.
2. Select Save Template.
3. Enter a descriptive file name and click Save.
To use a saved scanner template
1. From within a Market Scanner page, click the "Save" disk icon to the right of the Max Results
field.
2. Select Load Template.
3. Select the scanner file you want to use and click Open.
IB's daily Options Brief uses the TWS Market Scanner data as the basis for its commentary.
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Market Scanner Types
Available market scans change based on the Instrument/Location criteria you select.

Market Scanner Parameters

Parameter

Description

Top% Gainers

Contracts whose last trade price shows the highest percent increase from the previous night's closing price.

Top%
Losers

Contracts whose last trade price shows the lowest percent increase from the previous
night's closing price.

Most Active

Contracts with the highest trading volume today, in terms of shares.

Not Open

Contracts that have not traded today.
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Most Active($)

Contracts with the highest trading volume in terms of dollar amount.

Most Active (Avg$)

Contracts with the highest average trading volume in terms of dollar amount. The
volume is averaged over the past 90 days.

Halted

Contracts for which trading has been halted.

Hot Contracts by
Price

Contracts where:
(lastTradePrice-prevClose)/avgDailyChange is highest in absolute value (positive or
negative).
The avgDailyChange is defined as an exponential moving average of the contract's
(dailyClose-dailyOpen)

Hot Contracts by
Volume

Contracts where:
today'sVolume/avgDailyVolume is highest.
avgDailyVolume is a 30-day exponential moving average of the contract's daily
volume.

Top Trade
Count

The top trade count during the day.

High
Dividend
Yield

Returns the top 750 US stocks with the highest dividend per share yield.

Top Trade
Rate

Contracts with the highest number of trades in the past 60 seconds (regardless of the
sizes of those trades). Displays the trades/minute field.

Top Price
Range

The largest difference between today's high and low, or yesterday's close if outside
of today's range.

Hot by
Price
Range

The largest price range (from Top Price Range calculation) over the volatility.

Top
Volume
Rate

The top volume rate per minute.

Top %
Gainers
Since
Open

Shows contracts with the highest percent price INCREASE between the last trade
and opening prices.

Top %
Losers
Since

Shows contracts with the highest percent price DECREASE between the last trade
and opening prices.
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Open
Top Closeto-Open %
Gainers

Shows contracts with the highest percent price INCREASE between the previous
close and today's opening prices.

Top Closeto-Open %
Losers

Shows contracts with the highest percent price DECREASE between the previous
close and today's opening prices.

Highest
Option Imp
Vol*

Shows the top underlying contracts (stocks or indices) with the highest vega-weighted
implied volatility of near-the-money options with an expiration date in the next two
months.

Lowest
Option Imp
Vol*

Shows the top underlying contracts (stocks or indices) with the lowest vega-weighted
implied volatility of near-the-money options with an expiration date in the next two
months.

Top Option
Imp Vol %
Gainers*

Shows the top underlying contracts (stocks or indices) with the largest percent gain
between current implied volatility and yesterday's closing value of the 15 minute average of implied volatility.

Top Option
Imp Vol %
Losers*

Shows the top underlying contracts (stocks or indices) with the largest percent loss
between current implied volatility and yesterday's closing value of the 15 minute average of implied volatility.

High
Option Imp
Vol Over
Historical*

Shows the top underlying contracts (stocks or indices) with the largest divergence
between implied and historical volatilities.

Low
Option Imp
Vol Over
Historical*

Shows the top underlying contracts (stocks or indices) with the smallest divergence
between implied and historical volatilities.

Most Active by Opt
Volume

Displays the most active contracts sorted descending by options volume.

Most Active by Opt
Open
Interest

Returns the top 50 underlying contracts with the (highest number of outstanding call
contracts) + (highest number of outstanding put contracts)

High Opt
Volume
P/C Ratio

Put option volumes are divided by call option volumes and the top underlying symbols
with the highest ratios are displayed.

Low Opt
Volume

Put option volumes are divided by call option volumes and the top underlying symbols
with the lowest ratios are displayed.
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P/C Ratio
High
Option
Open
Interest
P/C Ratio

Returns the top 50 contracts with the highest put/call ratio of outstanding option contracts.

Low
Option
Open
Interest
P/C Ratio

Returns the top 50 contracts with the lowest put/call ratio of outstanding option contracts.

Hot by
Option
Volume

Shows the top underlying contracts for highest options volume over a 10-day average.

13-Week
High

The highest price for the past 13 weeks.

13-Week
Low

The lowest price for the past 13 weeks.

26-Week
High

The highest price for the past 26 weeks.

26-Week
Low

The lowest price for the past 26 weeks.

52-Week
High

The highest price for the past 52 weeks.

52-Week
Low

The lowest price for the past 52 weeks.

High
Growth
Rate (Reuters)

Returns the top 50 contracts with the highest Earnings Per Share growth rate. Note
that a new field, Growth Rate, is inserted after the Description field to display the
EPS per contract.

Low
Growth
Rate (Reuters)

Returns the top 50 contracts with the lowest Earnings Per Share growth rate. Note
that a new field, Growth Rate, is inserted after the Description field to display the
EPS per contract.

High P/E
Ratio (Reuters)

Returns the top 50 contracts with the highest Price to Earnings ratio. Note that a new
field, P/E Ratio, is inserted after the Description field to display the P/E ratio per
contract.
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Low P/E
Ratio (Reuters)

Returns the top 50 contracts with the lowest Price to Earnings ratio. Note that a new
field, P/E Ratio, is inserted after the Description field to display the P/E ratio per
contract.

High
Quick
Ratio (Reuters)

Returns the top 50 contracts with the highest "Quick" ratio. Note that a new field,
Quick Ratio, is inserted after the Description field to display the Quick Ratio per
contract.

Low Quick
Ratio (Reuters)

Returns the top 50 contracts with the lowest "Quick" ratio. Note that a new field,
Quick Ratio, is inserted after the Description field to display the Quick Ratio per
contract.

High
Dividend
Yield (Reuters)

Returns the top 50 contracts with the highest dividend per share yield. Note that a
new field, Div Per Share, is inserted after the Description field to display the per
share dividend yield per contract.

Low
Dividend
Yield (Reuters)

Returns the top 50 contracts with the lowest dividend per share yield. Note that a new
field, Div Per Share, is inserted after the Description field to display the per share
dividend yield per contract.

High
Return on
Equity
(Reuters)

Returns the top 50 contracts with the highest return on equity. Note that a new field,
Return on Equity, is inserted after the Description field to display the return on
equity per contract.

Low
Return on
Equity
(Reuters)

Returns the top 50 contracts with the lowest return on equity. Note that a new field,
Return on Equity, is inserted after the Description field to display the return on
equity per contract.

High
Price/Book
Ratio (Reuters)

Returns the top 50 contracts with the highest price to book value per share ratio. Note
that a new field, Price/Book Ratio, is inserted after the Description field to display
the return on equity per contract.
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Low
Price/Book
Ratio

Returns the top 50 contracts with the lowest price to book value per share ratio. Note
that a new field, Price/Book Ratio, is inserted after the Description field to display
the return on equity per contract.

(Reuters)

Market
Statistics

Let's you see exchange-specific statistics for:
• Advancing, declining and unchanged issues
• Up, down, unchanged and total volumes
• TRIN and TICK indicators
To use, select Market Statistics from the Instruments list, then select an exchange
from the Location dropdown.

High Synth
Bid Rev
Yield

Highlights the highest synthetic EFP interest rates available. These rates are computed by taking the price differential between the SSF and the underlying stock and
netting dividends to calculate an annualized synthetic implied interest rate over the
period of the SSF. The High rates may present an investment opportunity.

Low Synth
Bid Rev
Yield

Highlights the lowest synthetic EFP interest rates available. These rates are computed by taking the price differential between the SSF and the underlying stock and
netting dividends to calculate an annualized synthetic implied interest rate over the
period of the SSF. The Low rates may present a borrowing opportunity.

Relevant
EFPs

This tool scans the US market and returns all Exchange for Physicals relevant to your
portfolio, based on the stock and SSF positions you currently hold. For more information on using EFPs to reduce your trading cost, see the Relevant EFPs user guide
topic.

The following scanners are available, based on the selected instrument:

*30-day (V30) Implied Volatilities:
Implied volatility is calculated using a 100-step binary tree for American style options, and a BlackScholes model for European style options. Interest rates are calculated using the settlement prices
from the day’s Eurodollar futures contracts, and dividends are based on historical payouts.
The 30-day volatility is the at-market volatility estimated for a maturity thirty calendar days forward
of the current trading day. It is based on option prices from two consecutive expiration months. The
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first expiration month is that which has at least eight calendar days to run. The implied volatility is
estimated for the eight options on the four closest to market strikes in each expiry. The implied volatilities are fit to a parabola as a function of the strike price for each expiry. The at-the-market implied
volatility for an expiry is then taken to be the value of the fit parabola at the expected future price for
the expiry. A linear interpolation (or extrapolation, as required) of the 30-day variance based on the
squares of the at-market volatilities is performed. V30 is then the square root of the estimated variance. If there is no first expiration month with less than sixty calendar days to run, we do not calculate a V30.
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Use the US Corporate Bond Scanner
The US Corporate Bond scanner includes filters and parameters specific to the needs of bonds
traders.

To scan for US Corporate Bonds
1. From the Analytical Tools menu, select Market Scanner.
2. Select US Corporate Bonds as the instrument type.
3. Define optional filters to control the search results:
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4. Set the sort criteria for results display, and click Search.
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Non-Subscribed Scanner Locations
Market scanners support limited returns when you select a non-subscribed location, which displays in
italics with a lock icon indicating a restricted search. If you choose to include a non-subscribed location, the results may include contracts from the location but no market data.
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In the above scan, Hong Kong (HKFE) is a non-subscribed location. When it is checked to include in
the scan, the scan parameters also display in italics to indicate that the results include non-subscribed
data.
When you click Search to run the scan, you will receive a notification that you have included assets
from non-subscribed exchanges, and you have the option to add a market data subscription directly
from this box.

From the scan results, you can also elect to subscribe to the location, or to receive free delayed (nonsubscribed) market data. If you elect to receive delayed data, the data line will be highlighted in yellow as an indication. In the above scan, the markets are closed and you are viewing an After Hours
Scanner Snapshot, indicated by the grey background.
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After Hours Scanner Snapshot
When all trading has stopped including extended hours trading, you can still use most TWS Market
Scanners (with the exception of penny option and EFP scanners).
After-hour scanners use data from the previous close to provide a static snapshot as of the market's
close. A scan displaying snapshot data is identified by a gray background color in the Scanner display.
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TICK & TRIN Market Indicators
Use market indicators to help spot trends. The Tick Index indicator shows the number of stocks trading on an uptick minus the number of stocks trading on a downtick. The TRIN (Trader's Index) indicator is a technical analysis indicator calculated by dividing the advances-to-declines spread by the
volume of advances to declines.

To see tick and trin indicators
1. use the Search feature to enter “tick” or “trin” and select the index you want to view.
The date lines appear on your trading window, and the Index Arb meter opens with the Index Price.
Note that you can not trade these indexes.
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Create a Real-time Chart

l

Chart Parameters

l

Thumbnail Charts

l

Time Period Charts

l

Automatic Charts

l

Chart a Combo
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l

Chart Multiple Assets

l
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l

Add New Chart to Existing Chart Window

l
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l

Vertical Scrollbars
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Charting Expired Contracts
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Editing Charts
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Chart Display

l

Move the Right Margin
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Create a Real-time Chart
You can define parameters to display a real-time line or bar chart for all supported contracts.
Note: Charts are not supported for mutual funds.

Some of the features of a real-time chart are captured in the above image.
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1. Chart Dashboard/Menu allows you to quickly change the underlying, time period and chart display type

and Save Templates (File menu) access Chart Parameters, Studies, and Global Configuration (Edit menu)
and easily control hide/display attributes of the chart's components (View menu)
2. Chart Toolbar - Provides quick-click access to add commentary, edit the chart, zoom in and out, change

the cursor to a crosshair, increase or decrease the bar width for a bar chart, and open Global Configuration.
3. The customizable Quote Zone makes relevant data immediately visible on the chart. To add/remove fields

from the Quote Zone, right-click and select Configure Quote Zone.
4. Action Buttons - Click a button to arm the cursor with the selected function. Click in the chart at the

desired price level to create a price alert, sell order or buy order at the selected price. The order displays
on the chart and in the ChartTrader panel if you have that opened (via Chart Parameters).
5. Hot Buttons - Check the "Armed" checkbox to activate Instantaneous Transmission. Click a
button to arm the cursor with the selected function. Click in the chart at the desired price level
to immediately transmit a price alert, sell order or buy order at the selected price. Enable
via the Hot Buttons checkbox in the Additional Data and Features section of the Chart Parameters window.
6. Vertical Scrollbar allows you to quickly increase or decrease the visible price range. Once you use the

scrollbar, the price update is locked and you must unlock using the price icon for real-time updates. The
blue arrow icon allows you to add a degree of vertical buffer to the chart with each click.
7. The Bar Details Zone provides detailed information for a specific bar in the chart. We have displayed it

for information only, since the image depicts a line chart.
8. If enabled, the ChartTrader displays once you have created an order using the Buy or Sell hot buttons.

Enable via the ChartTrader checkbox in the Additional Data and Features section of the Chart Parameters window.
To create a chart
1. Select the contract for which you want to create a chart.
2. From the right-click menu, select Charts and then select New Chart.
3. Define settings as described in the Chart Parameters topic.
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Chart Parameters
You can set chart parameters when you open a chart, and modify parameters from within a chart
from the Edit menu.

Field

Time Period

Description

Choose a time period and interval along with the denomination of bar or line for the chart.
If you select an Automatic chart, you are selection only the
interval and denomination. You will be able to modify the
time period using the drag bar within the chart.
Click the Customize Menu link to define custom time periods/intervals.
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What to show:

Choose the primary display: Trades, Midpoint, Bid/Ask,
Option Volume, Historical Volatility, Option Implied Volatility, Option Open Interest.

Bar Type

Choose the type of bar if applicable, either High Low
Bar or Candlestick. Note that this selection will be greyed
out if it is not applicable.

Volume Plot Height

This applies to the plot height of additional plots such as
Volume.

Show # bars

Enter the number of bars to display on the chart, and check
to enforce this attribute. When checked, the number of bars
remains consistent regardless of changes to the Time period
or other variables.

Manual Vertical Scale

Define a price range to scale the vertical axis for the chart.
If checked, click the yellow lock icon that will appear in
the chart to re-enable auto-scaling.

Additional Data and Features

Additional data shown in your chart parameters box is dependent on the selections you set as the
primary parameters. The table below lists all potential options. Because they are context-sensitive,
you won’t see all of them at the same time.

Field & Description

Field & Description

Field & Description

Bid/Ask or Midpoint or Trades
Shows a secondary plot along with your primary
plot. Display will change based on your primary
plot, i.e. if you show Trades as the primary, your
options will include Bid/Ask and Midpoint.

Volume Histogram
Shows the daily trading volumes at each price
point in a separate area of the chart.

Daily P&L
Displays daily profit
and loss for the con-

Option volume
Charts call and put volume in the Option
Volume sub-chart.
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tract.

such as open interest
and volume, check to
display the total value
for calls and puts.

Historical volatility
Displays actual historical volatility.

Option implied volatility
Charts implied volatility in a Volatility
sub-chart.

Option open interest
Chart put and call open interest on the Open
Interest sub-chart.

Put-call ratio
Shows the put-call
ratio in a sub-chart.
Note that you must display Option Volume or
Option Open Interest
to enable the put-call
ratio.

Crosshair
Displays the cursor
as a crosshair on the
chart.

Legend
Hide or display the chart legend.

Prior close
Displays the prior
day’s closing price for
the contract.

Quote zone
Display market data
for the contract directly in the chart.

Quote panel
Display the traditional Quote Panel above the
chart.

Hot buttons
Display the Buy, Sell
and Alert hot buttons in
the chart.

Buttons panel
Display the configurable Buttons
panel along the bottom
of the chart. The button arms the cursor to
complete the selected
action.

ChartTrader
Displays the Orders, Log, Trades and Portfolio
tabs along the top of the chart. These panels
will also open automatically when you create
an order.

Completed trades

Volume
Plots trade volume in
a sub-chart. Set the
Volume Plot Height
above if desired.

Logarithmic Scale
Change the increments on the price axis to represent price change by "percentage change"rather than "dollar-value" change. Using Log
Scale, a $5.00 change from 10 to 15 represents
a 50% price change, while a $5.00 change from
20 to 25 is a 25% change.

Displays the Show
Trades checkboxes
along the top of the
chart.

Highlight on Chart

Define the extras you want to have highlighted on your chart.
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Field

Description

Splits and dividends

Shows splits and dividends on the underlying.

Order description

Includes order information directly in the chart.

My trades

Highlights the trades you made on the underlying.

Highlight on Y axis

Specify that any of the following items be highlighted along the Y-axis in the chart.

Field

Description

Bid/ask

Highlights the bid and ask prices.

Last

Highlights the last traded price.

High/Low

Highlights the current high and low of the underlying.

Cursor price

Highlights the current price level of your mouse cursor.

Vertical Buffer

A vertical buffer makes the price range on a chart larger than necessary to give extra space at the top and bottom
of the actual chart. When you add a vertical buffer, the chart automatically scales to accommodate a wider price
range. You can elect to:
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Field

Description

Scale to Fit
Studies

Y-axis (price) scaling will accommodate any studies to
ensure that they are visible in the new scaled layout.

Ignore Studies

Y-axis (price) scaling ignores any studies and applies
scaling only based on price.

Display Vertical Scrollbar

Checked by default. Uncheck to removed the vertical
scrollbar from the scaled chart.

Chart Time Options

Set time options for this chart.

Field

Description

Keep chart upto-date

Check to have chart update in real-time.

Show data outside of regular
trading hours

If checked, displays charts for exchanges that trade extended hours,
like Globex.

Show data in
user time zone

If checked, uses the time zone from your computer. Otherwise, uses
the time zone from the contract’s listed market.
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Set ignored
daily time interval

Define a time interval that will be ignored when charting the underlying.

Bypass this dialog when opening a new chart

If checked, these settings are applied to the next chart you open
without displaying this dialog box. You can modify settings by selecting Chart Parameters from the Chart menu.
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Thumbnail Charts
Thumbnails are small floating charts that provide at-a-glance tracking.

To create a thumbnail chart
1. Select an underlying on a Quote Monitor.
2. Use the right-click menu to select Analytical Tools>Technical>Thumbnail Chart.
The small chart can be moved to any area of your desktop, and can be reduced or enlarged by
grabbing and dragging one of sides.
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Time Period Charts
You can quickly change or create new Time Period charts from the chart dashboard.

To change a time period
1. From the dropdown list in the dashboard, you can:
l

l

l

Click a new time period/denomination pair (the current set shows a checkmark).
Use the denomination dropdown on any time period and choose a new one. For
example, change the 2 days/5 min bars to 2 days/15 min bars.
Use the Other dropdown to create a new time period/denomination pair.
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Automatic Charts
Quickly create an automatic chart that lets you quickly pick the bar denomination (5 minute bars,
daily bars etc) independent of the time period, using the chart dashboard.

To create an automatic char
1. From the dropdown list in the dashboard, select an automatic chart.
You cannot create custom displays for automatic charts, but must choose from the pre-defined displayed or Other charts.

TWS Users' Guide

840

Technical Analytics

Charts

Chart Combos
TWS will chart a combination comprised of multiple legs, but you must first specify that you want to have the
combo charted. Due to the capacity for pacing market data requests, charting a combo may result in very slow
load times for your charts.

To chart a combo
1. Select the market data line for the combination from the Quote Monitor.
2. Use the right-click menu to select Charts then New Chart.
3. Define the parameters for the chart and click OK.
4. Decide how you want to handle charting of combo orders:
a. Chart this combo now provides a one-time charting action for the current combo.
b. Always chart this combo will bypass this selection box the next time you choose to chart
the specific combo.
c. Always chart all combos will bypass this selection box for all combo charts.
The combination is charted.
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Reposition Charts
Grab and move the chart within its frame to view different time and price areas of the chart. Repositioning the chart results in a snapshot view of the chart with locked data. The chart must be unlocked
to reestablish realtime price updates.

To reposition a chart
1. Within a chart, use the View menu to select Reposition. The cursor changes to a pointing hand.
2. Move this cursor to an area in the chart you want to move, and click the mouse. The cursor
changes to the “move” icon.
3. Keeping the mouse key depressed, slide the chart around to reposition. The vertical sliders and
price axis adjust according.
4. Release the mouse key to disable Reposition mode.
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To resume price updates
l

Click the yellow lock on the price axis that signifies snapshot mode.
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Chart Multiple Assets
You can chart two or more assets on the same chart for comparison.

To chart multiple assets
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1. From the Edit menu, select Secondary Series.
2. In the Contract section, enter the underlying symbol and select the contract.

3. Select the source for the plot:
n

Trades shows the prices at which orders executed.

n

Midpoint plots the midpoint of the current best bid/ask price.

n

Bid/Ask shows the best bid and best ask.

4. Choose the Axis Selection and Scale Type:
n

Primary with Auto Scale automatically scales and plots the secondary contract
relative to the price for the primary contract.

n

Primary with None does not scale the secondary contract and modifies the price
axis to include the price range for both contracts.

n

Secondary with Auto Scale automatically scales and plots the secondary contract
and shows the scaled, secondary price axis along the right side of the plot.

n

Secondary with None shows the secondary price axis along the right side of the
chart and plots the secondary series with no scaling along that secondary price
axis.

5. If you select Auto Scale:
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In the Lines meet at: field you can enter a date different from the starting date of the time period
at which the two points in the chart will meet. By default, lines meet at the starting date of the time
period and are auto-scaled accordingly.
6. Click OK. All contracts are charted in different colors, defined by a key along the bottom of the
chart.

TWS Users' Guide

846

Technical Analytics

Charts

Charts - Estimated Price Range
The Estimated Price Range presents a graphical representation of the estimated price range of an asset to one,
two or three standard deviations. The estimated range is calculated based on the current price, the implied volatility of the symbol's option, and the distance in time from "now." The graphical representation uses a blue shaded
area to chart the estimated range over time.
Note: This feature is only available for contracts that have options.

To display the Estimated Price Range
1. Ensure that the feature is activated in the Chart Parameters box.
2. Grab the right margin arrow to the left to expose the blue Estimated Price Range graphic.
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When the margin line is selected, the estimated price range with top and bottom prices are highlighted. Slide the margin line to the left or right to see the estimated price range for specific days.

To enable Estimated Price Range
1. Open the Chart Parameters box (from Mosaic use the File menu; from TWS use the Edit menu).
2. Check Estimated Price Range and specify the number of standard deviations.
3. Click OK.
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Add New Chart to Existing Chart Window
You can elect to include multiple charts within a single window, use auto display features to arrange
the charts, and share trendlines among charts with the same underlying.

To add a new chart to an existing chart window
1. From the File menu, select Add Chart to Window.
2. If you want the chart to use the same security that the existing chart uses, check Sub-chart
uses current security. Checking this feature pre-populates the contract description in the Chart
Parameters box. If you're adding a chart for a different security, uncheck this selection.
Note: If you have charted multiple contracts in the same chart, the Current Security
refers to the symbol used to create the original chart.
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3. Define the new chart in the Chart Parameters box and click OK. Both charts appear in the
charts frame.
To arrange multiple charts within a window
l

On the chart's View menu, select Chart Tiling. Choose from Gird, Horizontal, Vertical, or Custom. All charts in the window conform to the selected tiling design.

To share trendlines for the same contract among charts
If you have charts for the same underlying, you can choose to apply a trendline action to all of the
charts by activating the Share Trendlines feature.
1. Click the Configure wrench from the chart window.
2. In the Settings page, check Share trendline among charts.
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Save a Chart Layout as a Template
You can reuse the layout of a favorite chart by saving the chart as a template and then reapplying the
template to other contracts.

To create a chart template
1.

Create a real-time chart or group of charts with all parameters defined.

2. On the chart's File menu, select Save Chart Template.
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3. Give the template a descriptive name by replacing "untitled" in the Template File field with a
chart name.

In cases where you are saving a template with more than one chart, click the Advanced button to specify which
chart is Replaceable when you open the template. You must have at least one chart labeled “Replaceable.”
4. Click OK to save the template.
To use a template to create a new chart
1. On the chart's File menu, select Open Chart Template.
2. Select the chart template you want to open from the Template File list, or use the Browse button to find the template you want to use.
3. Enter new contracts by entering the underlying symbol in the Underlying field
4. Click OK to see the new chart based on your saved template.

TWS Users' Guide

852

Technical Analytics

Charts

Charting Expired Contracts
You can chart data for expired futures contracts on the real-time charts. In addition, if you want to
chart an expired contract that is not currently on your trading screen, you can add the contract.

To add an expired futures contract to the trading window
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1. Enter the underlying symbol and hit enter, then choose Futures from the instrument type list.
2. At the bottom of the expiry list, select Expired, and then choose the expired contract you want
to chart by selecting the expiry month and year.
3. If you would like market data for the underlying as well, click Yes at the message asking if you
want to add the underlying.
To chart an expired contract
1. Select the expired contract and from the right-click menu select Charts, then select New Chart.
2. Set your chart criteria for the contract.
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Charts Toolbar
Use the icons on the toolbar to initiate an action. For instructions on how to add or remove buttons
from the toolbar, use the charts Configuration topic.
Icon

Action

Description

Chart Parameters

Opens the Chart Parameters dialog box where you set or modify criteria for the chart display.

Show/Hide
ChartTrader

Opens (or hides) the ChartTrader tool, which lets you submit trades
directly from a chart.

Show/Hide
Time Parameters panel

Allows you to change the time period and interval for the active
chart.

Open Chart
Template

Allows you to open a saved template created from one or multiple
charts.

Print

Prints the selected chart.

Shift Time
Period...

Set a new date and time for the chart data.

Shift Time
Period to
Present

Resets the time period to the current data/time.

Add Contract

Define chart parameters for a new asset which is added to the current chart.
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Add Study

Click the dropdown arrow next to the icon to select a chart study.

Add New
Chart

This button allows you to quickly add another chart to the open chart
window. To start with the same contract information, check Subchart uses current security in the pop-up box.

Add Commentary

Opens the Add Commentary dialog box. Enter text that will be displayed on the chart in a commentary box.

Remove All
Commentaries

Deletes all commentary boxes from the chart.

Compare to
Index

Charts the selected index on the active chart.

Tile Charts

Automatically resizes and arranges multiple charts into the pattern
you specify using the dropdown arrow. Choose from grid, horizontal, vertical, or custom.

Modify or
Remove

Click the dropdown arrow next to the icon to modify or remove the
selected asset or study from a chart. This feature works for single
charts with multiple assets or studies. It will not include multiple
charts within a single chart frame.

Show bars

For a candlestick chart, click to change to bars.

Show candlesticks

For a bar chart, click to change to candlestick display.
The icon that reflects the current chart type is greyed out.

Show/Hide
Volume

TWS Users' Guide

Displays or hides the Volume panel on the bottom of the chart.

856

Technical Analytics

Charts

Time & Sales

Click to change the cursor to the Time & Sales line. Click on a
time, and the Time & Sales data page opens for that time. To
change the cursor back, click the Switch to Crosshair icon.

Toggle
Crosshair

Changes the cursor to a crosshair. Note that if you don't have the
Show horizontal crosshair line enabled in Global Configuration, you
will only see a vertical line when you are in this mode.

Edit Chart

A selected trendline will now display a white square at either end.
When you click and pull an end, you can rotate the trendline 360
degrees and shorten or lengthen the line. Clicking in the line area
still allows you to move the trendline while maintaining the same
length and angle to the chart. Right-clicking the trendline allows you
to change the color of the line, the thickness of the line, or remove
the line.

Undo

Click to undo the last action.

Redo

Click to reapply the last undone action.

Add Horizontal Trendline

Turns the cursor to a horizontal trendline. Click in the chart to set
the trendline. To change the cursor back, click the Switch to
Crosshair icon.

Add Vertical
Trendline

Turns the cursor to a vertical trendline. Click in the chart to set the
trendline. To change the cursor back, click the Switch to Crosshair
icon.

Add Fibonacci Line

Inserts a Fibonacci trendline to the chart.

Remove Selec- Removes the selected trendline. To change the cursor back, click
ted Trendline
the Switch to Crosshair icon.
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Remove all
Trendlines

Removes all trendlines from the active chart.

Zoom in

Zooms in to an area on the chart. You can scroll to a new area in
the zoom in box.

Zoom out

Zooms out to give you a bigger view of the chart area.

Switch to
smaller bars

This icon becomes active after you have zoomed in. Click to display
smaller bars.

Enter visible
range

Opens the Visible Range dialog where you enter the price range
that will be visible in the chart.

Clear range
entered

Clears the previously set Visible (price) Range.

Add Horizontal Space
to Chart

Creates a "zoom out" effect by condensing the current view and
adding more time intervals to the right side of the chart.

Remove Horizontal Space
from Chart

Removes time intervals to create a "zoom in" effect.

Add Vertical
Space to
Chart

Creates a vertical "zoom out" effect by condensing the current view
and adding more price intervals to the top of the price axis.

Remove Vertical Space
from Chart

Removes price intervals from the top of the chart to create a "zoom
in" effect.
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Increase Bar
Width

Increase the width of bars in the bar chart by 1 pixel per click of the
icon.

Decrease Bar
Width

Decreases the width of bars in the bar chart by 1 pixel per click of
the icon.

Configure
Chart Colors

Opens the Global Configuration window with Chart Colors selected.
Change the colors displayed on different chart parameters.

Refresh

Refreshes chart data.

Configure

Opens the Global Configuration window for Chart configuration.
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Editing Charts
The right-click Edit menu for trendlines, indicators, bars and other chart display items lets you hide,
remove, and change the data, color, and thickness of items to customize your chart and make it
easier to read.

To use the charts editing feature
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1. Select a display feature for editing by holding your mouse over the chart item. An item is "selected" when it changes color.
2. Right-click and apply the desired edit to your display.
The right-click menu is context-sensitive to display only applicable editing choices based on the
item you selected. For example, if you select a bar in a bar chart, the right-click menu choices
include Remove Bar, Replace Bar Data and Change Bar Color. If you select a plotted line from
an indicator, the right-click menu choices include Hide Indicator, Change Indicator
Thickness and Change Indicator Color.
To undo an edit
l

Use the Undo or Redo icons on the chart toolbar to remove or reapply the last editing function
you performed.

To hide and show indicator lines
1. Select an indicator line by holding your mouse over the line. It changes color to indicate that it
has been selected.
2. Right-click and check "Hide Indicator name." The line disappears, and the color key block turns
grey.
3. To show a hidden line, slowly move your mouse up the chart until the hidden line displays in
grey.
4. Right-click and check "Show Indicator name." The line reappears, and the color key block
returns to its original color to match the line.
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TWS displays upcoming splits and dividends directly on your chart. When this feature is enabled,
events will be visible on the chart when you open it, with splits in magenta and dividends in yellow.
When you hold your mouse over the event, a pop-up box displays details.

To enable viewing of splits and dividends
1. In the Global Configuration panel, select Charts and then Settings in the left pane.
2. In the Highlight on chart area of the Settings page, check Splits and dividends.
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Move the Right Margin
A movable right margin allows you to move the chart data to the left while still allowing studies and
trendlines to continue into the future.

To move the right margin
1. Hover your mouse along the right margin until the cursor changes to a double-sided blue arrow
and the margin line turns purple.
2. Click and drag the margin to the left.
3. Release to reposition the margin at a new point.
To reset the margin
l

Right-click on the margin line and select Reset Margin.
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Add Alerts in Charts
You can set price alerts quickly within a chart using the Alerts hot button.

To create an alert from within a chart
1. Ensure that you have Hot Buttons activated from the View menu.
2. Click the Alert hot button. The curser becomes a dotted line.
3. Click at the price level you want to use for the alert.
4. In the Configure Chart Alert dialog box, verify or change the trigger Method, Operator and Price
trigger.

For more details on setting Alerts, see the Alerts and Notifications topic.
A labeled Alert line is positioned on the chart.
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Chart Types & Tools
l

Chart Arithmetic

l

ChartTrader

l

Create a Bar Chart

l

Create a Line Chart

l

Time and Sales Data

l

View MarketWatch Historical Charts

l

Apply Fibonacci Trend Lines

Chart Arithmetic
You can add or subtract the bid/ask average prices for two or more contracts, and chart the sum as a
single value.
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To chart combined contracts
1. Select an underlying and use the right-click menu to select Charts then New Chart.
2. Select the Combined Contracts radio button at the top of the New Chart window.
Note: If the Combined Contracts selection at the top of the parameters window is not available, you will need to disable the last checkbox on the
page, Bypass this dialog when opening a new chart which is enabled by
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default. Disable this feature and click OK, then create your new chart.
The Combined Contracts feature will now be available.
3. In the contracts table, define multiple contracts.
4. To subtract a value, use the Ratio field to enter a minus sign in front of the ratio, or check Show
difference at the top of the window.
5. If desired, enter an offset amount.
6. Choose the Time Period.
7. Click OK.
A combined chart looks like this:

Autofit Combined Charts
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The chart arithmetic feature includes the ability to mathematically calculate the ratios for one or
more contracts to approximate as closely as possible the chart for a single contract or index. You can
elect to show both the primary and the autofitted charts, or just see the difference by checking Show
Difference. The ratios and offsets for the autofits are calculated using the algorithm for fitting least
squares regression problems under non-negativity constraints. Details are described by Lawson &
Hanson in "Solving Least Squares Problems."
To use the Autofit Chart feature
1. Check the Autofit checkbox at the top of the window.Use the Show difference checkbox to see a
single autofitted chart equal to the difference between the primary chart and the autofit.
2. In the contracts table, define multiple contracts. The first instrument you list will be the
primary, and those that follow will be autofitted to the primary.
You must either check the Autofit box before you list the instruments you want to chart, or
select all underlyings you want to include in the autofit before you check the box.
A chart using just Autofit looks like this:
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A chart using both Autofit and Show difference looks like this:
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ChartTrader
Transmit orders instantaneously from a chart using the armed Hot Buttons, or create an order from
the buttons panel and modify it on the Orders tab.
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To create an order in ChartTrader
1. Click the blue Buy button to create a buy order, or the Red sell button to create a sell order.
The cursor becomes a dotted line.
2. Move your cursor into the chart and position the dotted line at the order price you want. Note
that your exact price position is highlighted along the price axis.
3. Click to create an order. The order is displayed in the Quote panel, and can be modified. If the
order was not transmitted instantaneously, you must transmit the order.

Orders are transmitted instantaneously when an asterisk(*) appears next to the button title, or when you activate
the cursor using the armed Hot Buttons.
Orders that you create using ChartTrader also display on the Trading page that displays the contract
data. Trading pages that hold an order display the page title in red.
Create a Bar Chart
To create a bar chart
1. Select the contract for which you want to create a chart, and from the right-click menu select
Charts and then New Chart.
2. In the Time Period selector, choose a "bars" interval.
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3. Define remaining chart parameters and click OK to display your chart.

To create a candlestick chart, choose Candlestick as the Bar type.
Create a Line Chart
To create a line chart
1. Select the contract for which you want to create a chart, and from the right-click menu select
Charts and then New Chart.
2. In the Time Period selector, choose a "line" interval.
3. Click OK to view the chart. For details on all of the setting you can use, see the Create a Realtime Chart overview topic.
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Apply Fibonacci Trend Lines
The Fibonacci trendlines may be used to help determine price support/resistance at or near certain
levels. The Fibonacci lines occur at 0.0%, 23.6%, 38.2%, 50.0%, 61.8%, 76.4% and 100.0%. Retracements occurring at these points within a trend could be used to help determine entry and exit points
for a contract.
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To add Fibonacci lines to a chart
1. From within a chart, use the Annotate menu to select Fibonacci Retracement/Extension.
2. Click your mouse at a peak or low point in the chart and pull to down/up and to the right across
the chart.
3. A series of seven colored trendlines are drawn at 0.0%, 23.6%, 38.2%, 50.0%, 61.8%, 76.4%
and 100.0%.

TWS Users' Guide

874

Technical Analytics

Charts

To delete a Fibonacci series of trendlines
l

Click the Remove All Trendlines icon, located three icons to the right from the Add Fibonacci
Line icon.

View MarketWatch Historical Charts
Define a historical chart using a time period from 1 day to one decade. You can also create interactive
charts that update in real-time.
To view historical charts
1. On a quote monitor, highlight a contract and use the right-click menu to select Charts, then
select MarketWatch Chart.
2. Define chart parameters such as time frame, events, index comparison and moving average,
then click Draw Chart.
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Any time you modify chart parameters, you must click Draw Chart to update.
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Chart Indicators
Apply these studies to your chart:
l

ADX/DMI Indicator

l

Accumulation/Distribution Line

l

Average True Range Indicator

l

Chaikin Money Flow Oscillator

l

Commodity Channel Indicator

l

Keltner Channel Indicator

l

Momentum Indicator

l

Money Flow Index Study

l

MACD Indicator

l

On Balance Volume Indicator

l

Rate of Change Indicator

l

Relative Strength Indicator

l

Stochastic Oscillator Indicator

l

Ultimate Oscillator Indicator

l

Williams Oscillator Indicator

l

Bollinger Band Indicator

l

Envelope Indicator

l

Exponential Moving Average Indicator

l

Parabolic SAR Indicator

l

Pivot Points

l

Simple Moving Average Indicator

l

Weighted Moving Average Indicator

Apply ADX/DMI Indicator
To apply an ADX/DMI Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose ADX/DMI and Add the study.
3. Complete parameters as necessary.
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The ADX/DMI is represented by three lines +DM, -DM and ADX.
The Directional movement
If today's High is higher than yesterday's High then:
+DM = today's High - yesterday's High
If today's Low is lower than yesterday's Low then:
-DM = yesterday's Low - today's Low
If +DM is greater than -DM then: -DM = 0
If +DM is less than -DM then: +DM = 0
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The true range
True range is the largest of:
l

|today's High - today's Low|

l

|today's High - yesterday's Close|

l

|yesterday's Close - today's Low|

Moving average of +DM, -DM and True Range
l

+DMMA = exponential moving average of +DM

l

-DMMA = exponential moving average of -DM

l

TRMA = exponential moving average of True Range

The Directional Indicators
l

+DI = +DMMA / TRMA

l

-DI = -DMMA / TRMA

Directional Index
l

DX = |(+DI - (-DI))| / (+DI + (-DI))

The Average Directional Movement Index
l

ADX = the exponential moving average of DX

l

ADX = SUM[(+DI-(-DI))/(+DI+(-DI)), N]/N

Where:
N — the number of periods used in the calculation.

Apply an Accumulation/Distribution Line
This indicator attempts to quantify the flow of money into and out of a given stock. In theory, knowing
this money/volume flow may help you to recognize an upcoming move in the stock price.
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To apply an Accumulation/Distribution line
1. From within a chart, from the Edit menu select Studies.
2. Choose Accumulation/Distribution and Add the study.
3. Complete parameters as necessary.

Apply an Average True Range Indicator
The Average True Range indicator is used to determine the volatility of the market. The idea is to
replace the high-low interval for the given period, as the high-low does not take into consideration
gaps and limit moves. You set the period when you create the study.
The True Range is the largest of:
l

difference between the current maximum and minimum (high - low)

l

difference between the previous closing price and the current maximum

l

difference between the previous closing price and the current minimum
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The Average True Range is a simple moving average of the true range values.

To apply an Average True Range
1. From within a chart, from the Edit menu select Studies.
2. Choose Average True Range and Add the study.
3. Complete parameters as necessary.

Apply Chaikin Money Flow Oscillator
The Chaikin Money Flow Oscillator is calculated using the Accumulation/Distribution Line. It takes the
cumulative total of the Accumulation/Distribution values for 21 periods (or X number of periods if you
elect to change this value) divided by the cumulative total of volume for 21 (or X) periods.
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To apply a Chaikin Money Flow Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Chaikin Money Flow and Add the study.
3. Complete parameters as necessary.
Apply a Commodity Channel Indicator (CCI)
The CCI price momentum indicator is designed to identify cyclical turns in commodities pricing, and
represents the position of the current price relative to the average of the price over a specified
period.
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To apply a CCI
1. From within a chart, from the Edit menu select Studies.
2. Choose Commodity Channel and Add the study.
3. Complete parameters as necessary.

Apply a Keltner Channel Indicator
The Keltner Channel indicator is sensitive to volatility, and plots an "envelope" of two bands above
and below the middle line, which represents a 20-period Exponential Moving Average (EMA). The
upper and lower bands define the area inside of which the price should generally fall. The price crossing or floating towards these lines could indicate a trading opportunity.
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The Keltner Channel bands are calculated as follows:
Middle Line = EMA(TP)
Top Line = EMA(TP + Dev x TR)
Bottom Line = EMA(TP - Dev x TR)
Where:
EMA - exponential moving average
TP = typical price
TR - true range
Dev — the deviation factor.
To overlay a Keltner Channel Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Keltner Channel and Add the study.
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3. Complete parameters as necessary.
Note that you can increase the thickness and color of the indicator lines by right-clicking a line
and using the edit menu to select Change Indicator Thickness or Change Indicator Color. A thickness of "1" is the thinnest; 4 is the thickest.
Apply a Momentum Indicator
The Momentum is the difference between the current point (price or something else) and the point N
periods ago. Momentum is calculated as a ratio of today’s price to the price several (N) periods ago.
Momentum = CLOSE(i)-CLOSE(i-N)
Where:
CLOSE(i) — is the closing price of the current bar.
CLOSE(i-N) — is the closing bar price N periods ago

To apply a Momentum Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Momentum and Add the study.
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3. Complete parameters as necessary.

Apply MACD Indicator
This is a trend-following dynamic indicator that shows the correlation between two moving averages,
generally a 26-period and 12-period SMA or WMA or EMA. You can modify the period length when you
create the study. To help illustrate opportunity, a 9-period EMA "signal line" is plotted on top of the
MACD.
The MACD and signal line are plotted using the following calculations:
MACD = MA(CLOSE, 12)-MA(CLOSE, 26)
SIGNAL = EMA(MACD, 9)
MACD Histogram/OSMA = MACD - SIGNAL
Where:
MA — Simple or Weighted or Exponential Moving Average;
SIGNAL — the signal line of the indicator.
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To apply a Moving Average Convergence/Divergence Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Moving Avg Conv Div and Add the study.
3. Complete parameters as necessary.

Apply an On Balance Volume Indicator
The concept behind the OBV indicator is: volume precedes price. OBV is a simple indicator that adds a
period's volume when the close is up and subtracts the period's volume when the close is down. A
cumulative total of the volume additions and subtractions forms the OBV line.
If today’s close is greater than yesterday’s close then:
OBV(i) = OBV(i-1)+VOLUME(i)
If today’s close is less than yesterday’s close then:
OBV(i) = OBV(i-1)-VOLUME(i)
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If today’s close is equal to yesterday’s close then:
OBV(i) = OBV(i-1)
Where:
OBV(i) — is the indicator value of the current period.
OBV(i-1) — is the indicator value of the previous period.
VOLUME(i) — is the volume of the current bar.

To apply an On Balance Volume (OBV) indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose On Balance Volume and Add the study.
3. Complete parameters as necessary.
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Apply Rate of Change Indicator
ROC is a refined version of Momentum. The readings fluctuate as percentages around the zero line.
You set the number of periods when you create the study.
Rate of change =100(V/Vx)
where:
V - the latest closing price.
Vx - the closing price of x bars ago.

To apply a Rate of Change indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Rate of Change and Add the study.
3. Complete parameters as necessary.
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Apply a Relative Strength Indicator
The RSI indicator is for overbought/oversold conditions. It goes up when the market is strong, and
down when the market is weak, and oscillates between 0 -100. The RSI calculation is:
RSI = 100-(100/1+RS)
Where:
RS - Average of X bars Up Closes/Average X bars Down Closes (X=number of bars set by user)

To apply a Relative Strength Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Relative Strength Ind and Add the study.
3. Complete parameters as necessary.
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Apply a Stochastic Oscillator Indicator
The stochastic oscillator provides information about the location of a current close in relation to the
period's high and low. It ranges between 0% and 100%. A reading of 0% indicates that the close was
the lowest price at which the security traded during the preceding x number of time periods. A reading of 100% indicates that the close was the highest price at which the security traded during the preceding x number of time periods.

You can specify the method (SMA, WMA or EMA), observation period, period of slow average and period of
fast average when you create the study.

To apply a Stochastic Oscillator
1. From within a chart, from the Edit menu select Studies.
2. Choose Stochastic Osc. and Add the study.
3. Complete parameters as necessary.
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Apply an Ultimate Oscillator Indicator
The Ultimate Oscillator combines the price action for three different time frames. You set the observations periods 1, 2, and 3 when you create the study.
Time Frames:
l

true low = min(low or prev close)

l

buying pressure = close - true low

l

true range = max(high - low, high - prev close, prev close - low)

Buying pressure sum 1, buying pressure sum 2 and buying pressure sum 3 are calculated by adding
up buying pressures for 3 different time frames.
The same applies to the true range sum 1, 2 and 3.
raw ultimate oscillator = 4 * (buying pressure sum 1 / true range sum 1)
+ 2 * (buying_pressure_sum_2 / true_range_sum_2) + (buying_pressure_sum_3 / true_range_
sum_3)
ultimate oscillator = raw ultimate oscillator / (4 + 2 + 1) ) * 100
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To apply a Ultimate Oscillator indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Ultimate Osc. and Add the study.
3. Complete parameters as necessary.

Apply a Williams Oscillator Indicator
The Williams Percent Range (%R) indicator identifies the overbought/oversold levels. The scale
extends from 0 to -100.
%R = (HIGH(i-n)-CLOSE)/(HIGH(i-n)-LOW(i-n))-100
Where:
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l

CLOSE — is today’s closing price.

l

HIGH(i-n) — is the highest high over a number (n) of previous periods.

l

LOW(i-n) — is the lowest low over a number (n) of previous periods.

To apply a Williams Oscillator indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Williams Osc. and Add the study.
3. Complete parameters as necessary.
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Apply Bollinger Band Indicator
Bollinger Bands measure volatility by plotting a series of three bands. The middle band represents the
moving average (SMA or WMA or EMA). The upper band is a set number of standard deviations higher
than the middle band (generally 2), and the lower band is a set number of standard deviations (generally 2) lower than the middle band. You set the distance of standard deviation when you create the
study.

To apply Bollinger Bands
1. From within a chart, from the Edit menu select Studies.
2. Choose Bollinger Bands and Add the study.
1. Complete parameters as necessary.
Bollinger Bands are calculated like this:
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ML = Avg. (N)
TL = ML + (D*StdDev)
BL = ML — (D*StdDev)
Where:
ML - middle line
Avg(N) - SMA or WMA or EMA
TL - top line
BL - bottom line
N — is the number of periods used in calculation;
StdDev — the Standard Deviation.
StdDev = SQRT(SUM[(CLOSE — SMA(CLOSE, N))^2, N]/N)

Apply Envelope Indicator
SMA/WMA/EMA Envelopes plot a band composed of two moving averages, one which is shifting
upwards, the other shifting downwards, to help define a stock's upper and lower boundaries. The
bands of an envelope are calculated as follows:
Upper Band = MA(CLOSE, N)*[1+K/100]
Lower Band = MA(CLOSE, N)*[1-K/100]
Where:
MA — Simple (or Weighted or Exponential) Moving Average;
N — averaging period;
K/100 — the value of shifting from the average (measured in basis points).
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To apply an Envelope indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Envelope and Add the study.
3. Complete parameters as necessary.

Apply Exponential Moving Average Indicator
The exponential moving average gives more weight to the latest prices and includes all of the
price data in the life of the instrument. It is defined by taking:
(previous period's exponential moving average)/(N+1) and adding (current price)*2/(N+1).
For the first period we take the simple average as above.
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To apply a Exponential Moving Average
1. From within a chart, from the Edit menu select Studies.
2. Choose Exponential Moving Avg and Add the study.
3. Complete parameters as necessary.
Apply Parabolic SAR Indicator
For use in trending markets, parabolic SAR uses a trailing stop and reverse method to help determine
good exit and entry points. The Parabolic SAR calculation is:
SARt+1 = SARt+ AF x (EPtradex SARt)

Where:
SARt+1 — next period's SAR
SARt - current SAR
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AF - acceleration factor, begins at .02 and increases by .02 to a maximum of 0.20.

You can reset the initial, increments and maximum acceleration factor when you create the study.
EPtrade — the extreme price (HIGH for long positions and LOW for short positions).

To apply a Parabolic SAR indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Parabolic SAR and Add the study.
3. Complete parameters as necessary.

Pivot Points
The Pivot Point indicator calculates the numerical average of a stock's high, low and closing prices,
and is used to help identify resistance and support levels. We calculate pivot points using the fivepoint system, which uses the previous day's high, low and close to get the pivot point, and then calculates two resistance levels and two support levels, as follows:
R2=P + (H-L) = P + (R1-S1)
R1 = (P x 2) - L
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P = (H + L + C) /3
S1 = (P x 2) - H
S2 = P - (H - L) = P - (R1 - S1)
where "S" is the support levels, "R" is the resistance levels, "P" is the pivot point, H, L, C are high, low
and close, respectively.

To add a Pivot Point indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Pivot Points and Add the study.
3. Complete parameters as necessary.
Apply Simple Moving Average Indicator
The simple moving average sums the prices (you can choose from the closing price, the VWAP
time-weighted price or the high/low/close average price) for a specific number of data points and
divides by that number. The calculation for a 3-bar simple moving average is:
(price_1) + (price_2) + (price_3) divided by 3
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To apply a Simple Moving Average
1. From within a chart, from the Edit menu select Studies.
2. Choose Simple Moving Avg. and Add the study.
3. Complete parameters as necessary.

Apply Weighted Moving Average Indicator
The weighted moving average gives each data point a weight proportionate to its number in the
sequence and divides by the sum of its weights. The calculation for a 3-bar weighted moving average
is:
(1 x price_1) + (2 x price_2) + (3 x price_3) divided by 6, where 6 is the sum of the weights (1
+ 2 + 3).
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To apply a Weighted Moving Average
1. From within a chart, from the Edit menu select Studies.
2. Choose Weighted Moving Avg. and Add the study.
3. Complete parameters as necessary.
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Bond Search
The external Bond Search tool is an advanced query tool that allows you to search for bonds using specific filter
criteria based on two different queries: the OAS (Option-Adjusted Spread) and YTW (Yield to the Worst). Results display in a separate Bond Details table which can be exported to the Risk Navigator and opened as a whatif portfolio for further risk analysis.
Although the query is external (and works best with Firefox) access to the Bond Search can only be gained
through TWS.

To access the Bond Search tool
l

From the Analytical Tools menu, select Bond Search.

The query opens in the browser, and comprises three main parts:
l

the Query

l

the Scatter Plot

l

Bond Details
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Bond Search Query
You can query for bonds issued by agencies, government or corporate bonds. Use these fields to define bond
search criteria (similar to scanners). The less criteria you specify the larger the number of bonds that will be
returned. You must define at least one criterion for the search to begin.

Using the Query Criteria

As you define the search criteria for bonds, the Search button on the bottom right of the tool will return the number of bonds that meet your criteria.
Criteria is optional, but at least one criterion must be specified to make the search valid. Filter fields includes:
Filter

Description

Issuer Name

Specify a ticker or group of tickers, separated by commas.
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Moody's RatSelect one or multiple choices.
ing/Collateral Type
Option Flag

Select one or multiple flags (definitions
from Investopedia):
Bullet: A debt instrument whose entire face
value is paid at once on the maturity date.
Bullet bonds are non-callable. Bullet bonds
cannot be redeemed early by an issuer, so
they pay a relatively low rate of interest
because of the issuer's exposure to interestrate risk. Both corporations and governments issue bullet bonds, and bullet
bonds come in a variety of maturities, from
short- to long-term.
Callable: The main cause of a call is a
decline in interest rates. If interest rates
have declined since a company first issued
the bonds, it will likely want to refinance
this debt at a lower rate of interest. In this
case, company will call its current bonds
and reissue them at a lower rate of interest.
Puttable: A bondholder can redeem puttable bonds on certain dates and at certain
prices. The advantage of these bonds to an
investor is that if market yields rise and the
value of the bond falls below the put price,
the investor can exercise the put option and
stem his losses to the put price. Of course,
the special advantages of put bonds mean
that some yield must be sacrificed.
Sinkable: A sinkable bond issuer is
required to buy a certain amount of the bond
back from the purchaser at various points
throughout the life of the bond, at a set sinking price. Issuers set aside money in their
sinking fund to repay the money owed based
on the bond's par value. If interest rates fall
below the nominal rate of the bond, sinking
fund provisions can allow the company to
repay all or part of the amount owed, and
refinance the remaining balance to the
lower rate.

Issuer Type
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or All.
Coupon Frequency The per-year frequency of coupon payments.

Open Amount
Coupon Rate
Maturity
Issue Date

Specify a range to search.

Query Type

Option-Adjusted Spread - A measurement
tool for evaluating price differences
between similar products with different
embedded options. A larger OAS implies a
greater return with greater risk. For an OAS
scatter plot, toggle the x-axis to display to
Duration.
Yield to the Worst - Yield to worst is calculated on all possible call dates. It is
assumed that prepayment occurs if the bond
has call or put provisions and the issuer can
offer a lower coupon rate based on current
market rates. The yield to worst will be the
lowest of yield to maturity or yield to call
(if the bond has prepayment provisions);
yield to worst may be the same as yield to
maturity but never higher.

Industry
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Bond Search Scatter Plot
The results of a bond search are presented in a scatter plot, where each green dot represents a bond that meets
the specified criteria.

To display a scatter plot
l

After filters are defined, click the Search button.

To zoom in, click in the plot and drag. The area to be enlarged is appears highlighted in yellow. To unzoom, click
Reset Scale.
By default, the X-axis displays maturity in years. For an Option Adjusted Spread, the scatter plot can be toggled
between Time to Maturity (in years) and Duration (price sensitivity to interest rate movements).
The Y-axis represents the query type: Option-Adjusted Spread (to evaluate bond price) or Yield to the Worst
(lowest potential yield on a bond). The higher the YTW – the more risk.
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Bond Details Table
See the risk measures and bond attributes. Add or remove columns in the table and reset units/decimals for scaling using the buttons in the table.
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Export Bond Details to Risk Navigator
Once you have finished populating the Bond Details table, you can import all bonds from the table in the Risk
Navigator in the form of a What-If portfolio.

To export bond details to Risk Navigator
1. From the Bond Details table, click Export What-If.
2. Choose to Save the file and click OK.
3. Choose the directory (or note the default directory) where the file will be saved. For example,
Firefox saves files to C:\Downloads by default.
Open the Bond Details using a what-if portfolio in Risk Navigator. You can modify the position and initiate trades from within the What-If.
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To open Bond What-If in Risk Navigator
1. Open the Risk Navigator from the Analytical Tools menu.
2. From the Portfolio menu, select Open and find the saved file. Click Open.
3. Select the Bond tab to see the new What-If bond portfolio.
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Global Configuration
TWS is completely customizable. Global Configuration settings let you set defaults and change details
on all TWSwindows.

To access Global Configuration, from the TWS Edit menu select Global Configuration.
l

Configuration

l

API

l

Display

l

Trading Tools

l

Information Tools

l

Charts

l

Order Defaults and Presets

l

Account Window

l

Features

l

Workspaces
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Introduction

Every TWS page or tool has configuration settings to allow you to customize. Global Configuration is
the starting point to configuring any and all TWScomponents.
l

Using Global Configuration

l

Configure Auto Export

l

eSignal Market Data

l

General Configuration

l

HotKeys

l

Configure Lock and Exit Parameters

l

Display TWS Messages

l

Quick Stock/Bond Entry Exchange Configuration

l

Configure SmartRouting

l

Assign Sounds to Events

l

Configure Volatility and Analytics Settings

l

Display

l

Configure Font Size Per Window

l

API
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Using Global Configuration
The global Configuration window is your starting point for defining system-wide default configuration
settings.

To access Global Configuration
1. From the Edit menu, select Global Configuration, or click the configuration wrench icon from
any screen.
2. Scroll down the left pane to select an item and open it in the right pane.
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You can also use the text search box at the top of the window to find the page you want to configure.
The list is filtered to show only those pages which include the text you've entered in their title.
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Configure Auto Export
Use the Auto Export configuration page to define settings for automatically exporting trade reports.

To define auto export configuration settings
1. On the Edit menu select Global Configuration.
2. Click Auto Export in the left pane.
3. Use the right panel to set these parameters:
Field

Activate
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auto export
Start time

Enter the time to start the export in the format HH:MM.

Stop time

Enter the time to stop the export in the format HH:MM.

Interval

Set the interval (in minutes) to be used for checking for
and exporting reports.

Export directory

Define the directory to which you want to export the file,
for example c:\desktop

Export filename

Enter the name for the exported file. To use the systemassigned default name, leave this field blank.

ID

Check this box to include the ID field on exported execution reports.

Default
Column/
Extended
Form/ Custom
Columns

Select one column format. Extended mode includes the
type, expiry, strike, right and premium currency fields as
well as the default columns, and custom allows you to
define all fields that will be included in the report.

Write trade
times...

If checked, shows the local time for executed trades
regardless of the time zone in which the order filled.

Symbol

Select the display type for the symbol, either the underlying, the local, or both.

Field delimiter

Allows you to specify a field delimiter other than comma.
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eSignal Market Data
Use the eSignal page to configure and use eSignal market data. Please note that to connect to eSignal
data, you must subscribe to eSignal, and download and install the eSignal application www.esignal.com.

To define eSignal settings
1. On the Edit menu select Global Configuration.
2. Click eSignal in the left pane.
3. Use the right panel to set these parameters:
l

Use eSignal for Market Data - check to use your eSignal subscription to receive market
data in TWS. If checked, enter eSignal username, password and host address.

Connectivity
l

Enter username, password and Host Address for eSignal connection.

You must restart your system for changes to take effect.
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l

Change the update frequency if desired.

Market Data

For available security types, check appropriate boxes to receive top level and/or deep data.
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General Configuration
Use the General configuration page to set miscellaneous defaults such as automatic future rollover
notification, audit trails and language settings.
To define general configuration settings
1. On the Edit menu select Global Configuration.
2. Click General in the left pane.
3. Use the right pane to set these parameters:
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Field

Description

Keep application on top

Check to keep the main trading screen on top of
all other active windows.

Auto Roll Data for Expiring
Futures Contracts

When checked, all futures data lines that are about
to expire will be rolled to the lead month's futures
contract. In addition, if you have orders on expiring contracts you will receive a message asking if
you would like TWS to cancel those pending
orders.

Create audit trail

When checked, you can elect to view a condensed
or extended version of your audit trail, which
includes all trade activity for your account. Find
the Audit Trail command under the TWS Account
menu.

Sort tables by clicking column
headers

Uncheck to disable the auto-sort by column header
feature. If checked, clicking a header will sort the
tickers by the value in that column. Click once to
sort by ascending, twice to sort by descending, and
a third time to return to the original sort.

Show icons on column headers...

Uncheck to disable the quick add/remove feature
that displays the “+” and “x” icons on a field
header when you hold your mouse over the field.

Simplify combination ratios

If checked, TWS will simplify the display for combination ratios.

Display buy/sell mouse pointer...

If checked, holding your mouse over the bid value
will display the tip “Sell” and holding it over the
Ask value will display “Buy” to indicate the order
action result of clicking the bid or ask value.

Desktop notifications

Instruct TWS to notify you when an order fills
using a subtle, transparent notification pop up in
the bottom right corner of your screen. This notice
displays on top of your open desktop applications
and is visible for ten seconds, but it doesn’t take
focus away from your current task. If you want
more details simply click the pop up to be taken
into the orders section of Mosaic or legacy TWS
(based on the most recently used active workspace).
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Configuration

Description

Completed orders - Orders that fill completely.
Any trade - Includes partial fills or specific legs
filled on combination orders.
Never - Will not notify for any order activity.
Display account number - For users who have
multiple instances connected to different
accounts, for example a production trading
account and a paper account, check Display
account number to show the number of the
originating account.
Browser
l

Enter complete path to browser - for standalone users, modify the browser location if
necessary.

Language
l

Current Language - displays the current TWS language. Click Select to choose another language. Click OK, then log out of TWSto activate the language change.

Table Editing
l

Enable keyboard entry on order lines - when checked, you can tab through an order line
and modify field values without using your mouse. Each field becomes editable when you land
in it, and the Enter key works like the left mouse click.

Order Wizard
l

Use the radio buttons to have TWS open the wizard automatically, or to manually control the display of the wizard using the toggle icon on the trading toolbar.
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HotKeys
Assigning actions to specific keys and key combinations helps you rapidly create and transmit orders
to the marketplace. You can assign any keystroke, or a combination of the "Ctrl" and "Shift" keys with
one of the 26 keyboard letters, to map specific order creation and order transmission commands,
such as buy, sell, transmit and cancel.

To record hot keys
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1. On the Edit menu, select Global Configuration, then select Hotkeys from the left pane.
2. In the Possible Actions area, choose an action to which you want to assign a hot key and click
Create Shortcut.
3. In the Keyboard area, click Record. If you already have a hot key recorded for the selected
action, it is displayed in the Current Key Shortcut field.
4. Press the actual keystroke or keystroke combination you will use to complete this action. The
system records your keystroke and displays it in the Current Key Shortcut field.

If the Customize tab is visible, you can customize your hot key to be more specific. For example, after you
record a Buy hot key, customize it to create a bracket or trailing stop limit order.
After you record the desired hot keys and click Close, the mapped keys are displayed on the status
line at the bottom of the screen. To re-record a hot key assignment, follow steps 1-4 above. To
remove a hot key assignment from an action, click Clear.

How to define specific Hot Keys
The procedures below pertain to specific hotkey functionality, including:
l

To create a Buy/Sell hot key for a specific order type (i.e. Buy Limit Order, Sell Stop Order)

l

To create a Buy/Sell hot key for a specific contract (i.e. Buy Limit Order for XYZ)

l

To use instantaneous transmission

l

To attach bracket orders

l

To create Increase (or Decrease) order size hot key

l

To create Increase (or Decrease) Limit (Aux.) Price hot key

l

To use All Available for Buy/Sell order quantity

l

To change order type/time in force

l

To open the Alerts box to view/set alerts

l

To set an Auto Stop hotkey

l

To set an Auto Trailing Stop hotkey

To create a Buy/Sell hot key for a specific order type (i.e. Buy Limit Order, Sell Stop
Order)
1. On the Edit menu select Global Configuration.
2. In the left pane select click Hot Keys
3. Select Buy or Sell as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Order Type drop-down select the order type for which you want to create a hot key.
6. Populate any necessary order type-related fields.

TWS Users' Guide

923

Global Configuration

7. Click the Shortcuts tab.
8. Click Record and press the keystroke combination that will represent the order type hot key.
9. Verify that the hot key has been properly recorded in the Shortcuts section.
To create a Buy/Sell hot key for a specific contract (i.e. Buy Limit Order for XYZ)
1. On the Edit menu select Global Configuration.
2. In the left pane select Hot Keys
3. Select Buy or Sell Specific Product as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Underlying field, enter an underlying symbol.
6. Populate the Order related fields.
7. Click the Shortcuts tab.
8. Click Record and press the keystroke combination that will represent the order type hot key.
9. Verify that the hot key has been properly recorded in the Shortcuts section.
To use instantaneous transmission
When you create a buy or sell hot key for any order type, you can elect to "Transmit the order instantaneously" by checking this feature at the bottom of the Customize page. When you activate instantaneous transmission, using the hot key combination creates and transmits the order without giving
you time to review and modify order parameters.
Leave this feature unchecked to have the hot key combination create an order and leave it on the trading screen for you to manually transmit.
To attach bracket orders
1. On the Edit menu select Global Configuration.
2. In the left pane select Hotkeys.
3. Select Buy or Sell as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Attached Orders area, check Add Simple Bracket.
6. In the Bracket Orders area:
7. In the Lmt Price (+/- offset) field select Bid, Ask, Last or None as the basis for the Limit
Price portion of the bracket order, and enter an offset amount if desired.
8. Select a Stop Type.
9. Set the Stop price and offset for the stop trigger price.
10. For Stop Limit orders, set the Stop Limit price and offset.
11. On the Shortcuts page record the hot key combination, and click OK.
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To create Increase (or Decrease) order size hot key
1. On the Edit menu select Global Configuration.
2. In the left pane select Hotkeys.
3. Select Increase (Decrease) price or size and click Create Shortcut.
4. On the Customize tab select Size in the Field drop-down.
5. Set the Num Ticks value to represent the increment by which to increase (decrease) the
default order size.
6. On the Shortcuts page, click Record and press the hot key combination to represent Increase
(Decrease) order size.
7. Close the dialog box.
To create Increase (or Decrease) Limit (Aux.) Price hot key
1. On the Edit menu select Global Configuration.
2. In the left pane select Hotkeys.
3. Select Increase (Decrease) price or size and click Create Shortcut.
4. On the Customize tab select Limit Price (Aux. Price) in the Field drop-down.
5. Enter the Num Ticks increment by which you want the hot key to increase (decrease) the price
value.
6. On the Shortcuts page, click Record and press the hot key combination to represent Increase
(Decrease) Limit (Aux.) Price.
7. Close the dialog box.
To use All Available for Buy/Sell order quantity
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. Select Buy or Sell as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Size field, select Available, then click OK.Now when you use the Buy or Sell hotkey, the
order quantity will be determined by the number of available contracts as shown in the Ask Size
or Bid Size field.
To change order type/time in force
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Modify/Transmit Order section, select Modify Order Type or Modify Time in Force and
click Create Shortcut.
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4. On the Shortcuts page, click Record and press the hot key combination.
5. Close the dialog box.
To open the Alerts box to view/set alerts
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Real-time Activity Monitoring section, select View Alerts and click the Create Shortcut button.
4. On the Shortcuts page, click Record and press the hot key combination, for example Ctrl + A.
5. Close the dialog box.
6. Click OK.
When you use Ctrl + A from the TWS, the Alerts box opens displaying your current alerts. To create
an alert, click the New button.
To set an Auto Stop hotkey
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Real-time Activity Monitoring section, select Add Auto Stop Order.
4. Click Record and press the hot key combination, for example Ctrl + A.
5. Close the dialog box.
6. Click OK.
Now when you use Ctrl + A from the TWS, you will attach a Stop order to the selected order.
To set an Auto Trailing Stop hotkey
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Real-time Activity Monitoring section, select Add Auto Trailing Stop Order.
4. Click Record and press the hot key combination, for example Ctrl + T.
5. Close the dialog box.
6. Click OK.
Now when you use Ctrl + T from the TWS, you will attach a Trailing Stop order to the selected order.
The trailing amount used is the value defined in the order defaults.
Several keyboard keys cannot be used as hot keys, including: Alt, Page Up, Page Down, Print Screen,
Home, Backspace, and the Windows key. We reserve the right to activate these keys or to remove
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hot key functionality from a key at any time without notice. Attempted use of invalid keys invokes the
message "The hot key you selected is not valid. Please select another hot key combination."

The standard hot keys do not function within the Rapid Order Entry panel. When you record a hot key for one of
the rapid order entry actions, you must use "Ctrl" plus a character key, or the Escape key.
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Configure Lock and Exit Parameters
Use the Lock and Exit configuration page to define auto lock and exit options such as whether or not
you want a confirmation message before the application closes.

To define exit configuration settings
1. On the Edit menu select Global Configuration.
2. Click Lock and Exit in the left pane.
3. Use the right panel to set these parameters:

Lock Trader Workstation
l

l

Lock Trader Workstation after ___ minutes of inactivity - locks your workstation if no
activity has occurred for a defined number of minutes. Once locked, you must unlock the application using your TWS password.
Never lock Trader Workstation - check to remove auto-locking mechanism. Note that you
can manually lock the workstation at any time by selecting Lock Application from the File
menu.

Exit Options
l

l

Warn on exit with position - check to display a warning message when you exit that lets you
know you are holding positions, and verifies that you still want to exit.
Prompt when exiting - check to have TWS display a confirmation message "Are you sure you
want to exit?" before shutting down the application.
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Auto save settings - check to have any changes to your settings, including the addition of
new tickers or Quote pages, automatically saved.
Use/Store settings on server - check to save the latest settings to the IB server, and to
download the latest settings from the IBserver on login. Checking this feature ensures that TWS
will always have the same content when you log in regardless of the machine you are using.
Save watchlists to cloud - check to save your TWS watchlists to the cloud. These watchlists
can then be imported into mobileTWS using the "Import" feature in mobileTWS configuration.

Auto Logoff Timer
l

Set Auto Log Off Time - specify a time of day for TWS to automatically log off. You must specify a time.
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Display TWSMessages
Each time you receive an information or confirmation message in TWS, we include a checkbox in the
bottom left corner with the text "Don't display this message again." If you elect to hide a message,
you can enable it again at any time using the Messages section of the Global Configuration tool.
To enable a TWS message
1. On the Edit menu select Global Configuration.
2. Click Messages in the left pane.
3. Use the right panel to check any messages you want to enable.

This page can only be used to enable messages that you have turned off, not to disable messages. We want to
ensure you have read each message at least one time before you elect to disable it.
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Quick Stock/Bond Entry Exchange Configuration
Quick Stock/Bond Entry is a page-level feature which automatically completes a market data line for
a stock or bond based on the underlying symbol or CUSIP you enter. To use Quick Entry, you must:
l

Create a list of order destinations.

l

Enable a trading page for Quick Stock/Bond Entry.

To configure Quick Stock Entry destinations
1. On the Edit menu select Global Configuration.
2. Click Quick Stock/Bond Entry in the left pane.
3. In the right pane, click Add, enter a destination and click OK.
4. Add as many order destinations as you would like to have available. You can add more destinations at any time.
Note: Add Smart to the list to be able to route Quick Stocks and Bonds via Smart
order routing.
Clarify aggregate exchanges such as Smart by specifying the primary exchange also. For
example, Smart/NYSE.

TWS Users' Guide

931

Global Configuration

You can enable Quick Stock Entry for an existing or new Quote Monitor. Ensure that the feature is
enabled by opening Global Configuration from the Edit menu. From the Features menu, expand the
Market Data Tools section and ensure that Quick Stock/Bond Entry is checked.
To enable Quick Stock/Bond Entry for a Quote Monitor
1. Right-click the tab and select Settings.
2. In the Order Origin area of the page settings, check Quick Stock/Bond Entry.
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Configure SmartRouting
You can define event-specific directives for contracts routed through IB SmartRouting, such as excluding quotes, setting a price cap by defining the acceptable distance from the NBBO, and specifying a
strategy for non-marketable orders.

To modify SmartRouting functionality
1. On the Edit menu select Global Configuration.
2. Click Smart Routing in the left pane.
3. Use the right panel to set these parameters:

Excluded Quotes
l

l

Exclude exchanges with non-firm quotes.
Exclude exchanges whose quotes are not automatically executable. If this option is selected, IB
will use its best efforts to determine which exchanges’ quotes are immediately automatically
executable, and which exchanges’ quotes would require manual (human) handling, and IB will
route only to those exchanges offering automatic execution. Please note that while IB will use
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its best efforts, it is not always possible to determine whether a quote is automatically executable.
l

Define the NBBO price cap by entering the "maximum allowable distance from NBBO." Note
that NBBO price capping supersedes the exclusion of non-firm quotes, i.e. your order will be
routed to a non-firm quote within the price cap over a firm quote outside the price cap.

IMPORTANT If you choose to: a) exclude quotes from certain exchanges; b) exclude non-firm quotes; or c)
exclude exchanges whose quotes are not automatically executable, your order may not be executed at the best
posted price nationally (the “NBBO”). This is because one of the exchanges that you chose to exclude might
have the best posted price but that exchange will be bypassed by the IB SmartRouting system on your instruction.
In addition, if you exclude certain exchanges from the eligible SmartRouting destinations and your
order is routed to another exchange with an inferior posted price, your order may not be executed by
the exchange to which it is sent because that destination may not be willing to execute at an inferior
price, or your order may not be marketable at that exchange. You should carefully evaluate all of
these factors before deciding whether to exclude certain exchanges from the eligible IB SmartRouting
destinations.
Routing Configuration
Seek Price Improvement

If checked, Smart routing will sweep certain exchanges for hidden liquidity at more favorable prices.
This may result in slower executions.
Pre-Open Re-route

This allows you to route orders to major exchanges three minutes before the open. For orders submitted before the open, checking this box ensures your orders are routed prior to the open. This directive only applies to stocks listed on a major exchange, and cannot be used if the Ignore Opening
Auction order attribute is set.
SMART Stock Routing Algorithms

Customers who have the unbundled "Cost Plus" commission structure for stocks have the ability to
choose from a list of Smart routing strategies for non-marketable stock orders to complement their
trading strategy.

Use the checklist to select a single "Default" strategy which will automatically be applied to any non-marketable, Smart routed stock order, and any number of "Display" strategies, each of which will be available from
the Destination field as a per-order selection.
Available strategies include:
l

l

SMART Multipurpose (SMART) - this is the basic smart-routing algorithm. Routes your non-marketable order to the default exchange for the contract.
Highest Rebate (SMART Rebate) - Routes your non-marketable order to the exchange offering
the highest rebate for added liquidity.
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Primary exchange (SMART Primary) - Routes your non-marketable order to the listing
exchange for the contract.

Highest volume exchange with rebate (SMART VRebate) - Routes your non-marketable order to the
exchange with the most volume that also offers the highest rebate for added liquidity.
Note: On a best efforts basis, the IB SmartRouting system will attempt to capture a rebate on your order. However, not all trades will receive a
rebate, as best execution at the best possible price remains the top priority.

l

Highest volume exchange with lowest fee (SMART VLowFee) - Routes your non-marketable
order to the exchange with the most volume that also charges the lowest fee for taking liquidity.

To change your pricing structure from bundled to unbundled and take advantage of this feature, log in
to Account Management, and select Account Administration and then Pricing Structure from the
left contents pane.
SMART Option Routing Algorithms

Choose how to route a smart-routed, non-marketable options order.
l

l

SMART Multipurpose (SMART) - this is the basic smart-routing algorithm. Routes your non-marketable order to the default exchange for the contract.
SMART Highest Rebate - (SMART Rebate) Routes your non-marketable order to the exchange
offering the highest rebate for added liquidity.

Try to post where the order will be on the top

Smart-routing will attempt to post your order to an exchange where it will be at the top of the book.
Enabling this feature does not guarantee that the order will be at the top of the book, and may reduce
the likelihood of getting a fill on the order.
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Assign Sounds to Events
Use the Sound Manager to modify sounds assigned to trading events.
Note: To hear sounds other than a beep on your computer, you must have a sound
card installed.

To configure the Sound Manager
1. On the Edit menu select Global Configuration.
2. Click Sound Manager in the left pane.
3. Check to enable a sound. Uncheck to disable a sound.
4. To modify the default beep, use the dropdown arrow and choose a beep type.
5. To use a new sound file, click the Browse button and navigate to the .wav sound file. Use the
Play arrow to hear the sound you have chosen.
6. Enter the number of times you want the sound to repeat when it is invoked.
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Configure Volatility and Analytics Settings
Use the Volatility and Analytics configuration page to define default settings for both volatility orders
and Price/Risk Analytics.

To define default Volatility configuration settings
1. On the Edit menu select Global Configuration.
2. Click Volatility and Analytics in the left pane.
3. Use the right pane to set these parameters:
Volatility

Field

Description

Volatility
units

Choose either Annual or Daily.

Reference
price type

Choose Bid or Ask to use the NBB (bid) when buying a call
or selling a put and the NBO (ask) when selling a call or buying a put. Choose Average to use the average of the best Bid
and Ask. This price is also used to compute the limit price
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sent to an exchange (whether or not Continuous Update is
selected), and for stock range price monitoring.

Show
prices on
volatility
layout

When checked, the volatility page displays prices rather than
volatility, with volatility in parentheses. If unchecked (which
is the default) values in the Price columns will be the volatility.

Continuous
Update

when checked, the checkbox in the Continuous Update field is
automatically checked and enabled. You can de-select
Continuous Update on a per order basis.The Continuous
Update feature monitors the underlying price and will update
the price of the order if the price of the underlying instrument
changes significantly. Note that you can only use Continuous Update for three active orders at a time.

Price
index
options relative to
futures contract

when checked, you can price smart-routed Volatility index
option orders off a selected futures price from the Reference
Contract field on the order line.

Show
option
prices and
volatility
in tooltip

Check to display the option price or volatility as a mouse tip
when you hover over the value in an order line.

Analytics

Field

Description

Option
Value
Curve Volatility
up

Shows a different scenario on the Option Analytics plot.
Uses a blue line to show a raise in the implied volatility
by 15% in relative change* using a blue line.

Option

Shows a different scenario on the Option Analytics
plot. Uses a red line to show a reduction in the implied
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Value
Curve Volatility
down

volatility by 15% in relative change*

Option
Value
Curve Time down

Decreases the time to expiry by one calendar day.

Cache
Check
Risk on
TWs startup

Choose to Always cache, Never cache, or make the
choice based on your last selection (Auto).

Configuration

*For an example of a relative percent change, if the current implied volatility of an option is 10%, a
15% relative change would result in an implied volatility of 11.5%, calculated as follows:
10% * (1 + 0.15) = 11.5%.
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Introduction

Use the API configuration pages to define general connection settings and specify whether or not to
bypass order precautions.
l

API Settings

l

API Precautions
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API Settings

To configure API settings
1. On the Edit menu select Global Configuration.
2. Click API in the left pane, and select Settings.
3. Use the right panel to set these parameters:
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l

l

l

l

l

l

l

l

l

l

l

l

Enable Active X and Socket Clients - Check to enable integration with TWS using ActiveX or
socket clients including Java and C++. Download sample programs from the Software page on
the IB website.
Enable DDE clients - Check to enable integration with TWS through DDE. Download sample
files from the TWS Software page on the website.
Download open orders on connection - uncheck if you do not want to download all open
orders when you connect to your API.
Include FX positions when sending portfolio - If you have the Include FX Positions feature
activated, all FX positions will be included when portfolio updates are sent the to API client.
Uncheck this box if you don't want FX positions sent to the API client when the portfolio updates
are sent.
Send status updates for EFP and Volatility orders with "Continuous Update" flag - If
you have Continuous Update activated for EFP or Volatility orders, all updates are sent to the
API client by default. Uncheck if you don't want these updates sent from TWS to the API client.
Use negative numbers to bind automatic orders - if checked, all orders that are automatically bound to an API client via the reqOpenOrders or reqAutoOpenOrders calls or via system-generated orders (i.e. volatility hedging orders) will be assigned negative API order IDs.
Otherwise, these orders will be assigned incremental API order IDs. Volatility hedging orders
will have the order ID “parent API order ID + 1” when possible.
Create API message log file - check to create a message log file. Use the Logging Level
selector to define the level of detail in the log.
Include market data in API message - shows market data in the API log file.
Socket port - Enter a socket port number which allows you to sync up multiple versions of
TWS in your ActiveX spreadsheet.
Logging Level - Set the level of log detail for the API text log. System gives the most general
level of logging; Detail gives the most detailed level.
Master API client ID - The API client with the specified client ID will receive all orders, even
those placed by other API clients. This differs from the Client ID of “0” which will receive all
orders sent from the TWS GUI.
Timeout to send bulk data to API - define the time in seconds that TWS will wait before disconnecting the API client if data cannot be sent quickly enough.

Trusted IP Addresses

If you connect to the API through a trusted IP address, the connection is not questioned. Otherwise,
you will get a verification message asking if you are sure you want to make the connection.
l

Click Create to add a new trusted IP address to the list.

l

Click Edit to modify the selected address.
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Click Delete to remove the selected address.

TWS Users' Guide

943

Global Configuration

API Precautions
Specify whether or not to bypass precautionary warnings for API orders that trigger a red flag.

l

l

l

l

Bypass Order Precautions for API Orders - check to allow orders that fall outside the size
or value limits to be submitted without a warning.
Bypass Bond warning for API Orders - check to allow bond orders that fall outside the specified face value and other limits to be submitted without a warning.
Bypass negative yield to worst confirmation for API Orders - check to bypass any warning that your API order will result in a negative yield to worst excluding commissions.
Suppress market cap - check to suppress the existing market cap for API stock and warrant
orders.
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Display
Introduction

Use the Display configuration page to define display settings such as hiding or showing the index arbitrage meter, enabling column tooltips and applying colors to options based on in-the-money status.
l

Display Settings

l

Style Settings

l

Ticker Row Settings

l

Toolbar
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To define display configuration settings
1. On the Edit menu select Global Configuration.
2. In the left pane, click Display and then Settings.
3. Use the right pane to set these parameters:
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Display Settings
l

Show arbitrage meter - check to automatically show the index arb meter if you have index
instruments listed in your market data.
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l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

Show leg trades only - When checked, spreads and combination executions will be shown in
individual legs. If unchecked, the entire combination will be displayed, and you can click to
expand the line and show the individual leg executions.
Titlebar Text - Text entered here will be used in place of your account number in the TWS titlebar.
Use consolidated status column - When checked, the Status column will split and show both
the Transmit/Cancel buttons and the status color. You must manually remove the Transmit field
to activate this feature.
Allow order sorting on Pending page - When checked, the pending page will go into compressed view when you click an order field header to sort orders. Compressed view displays
only orders, no market data lines and no blank lines are shown.
Rename Relative order type to Pegged-to-Primary - If checked, "relative" orders will display as "Pegged-to-Primary" orders wherever the title occurs. This only changes the name. The
relative functionality remains the same.
Basic display mode - When checked, the display mode remains basic to potential improve
system performance. Check to turn off animation and other aesthetic actions.
Show combo strategy title first - When checked, the strategy title of a combo will display
first in the description, as in Calendar Spread + Feb 19 ‘10, - JAN 15 ‘10 14 Call. Uncheck to display the title last, as in + Feb 19 ‘10, - JAN 15 ‘10 14 Call Calendar Spread.
Auto Show Price/Size Wand - When checked, the price and size wands will display automatically when you put the cursor into an applicable field. If unchecked, the wand will display
when you click and hold the mouse in the field.
Flash bulletins - Check to have trading notifications flash in red at the top of the screen.
Use condensed combo description - When checked, only the local symbols are displayed in
the Description field for combination and spread orders.
Display X icon in tab header - When checked, the X icon to delete a trading page will appear
on the active page, next to the trading page title.
Allow pages to be detached - When checked, you can detach trading pages from the main
trading window.
Insert pages in alpha order - When checked, newly added pages are automatically inserted
alphabetically into your existing tabset of page names.
Auto-resize columns - When checked, tables such as the trading window etc. will automatically resize table columns when a field has been added or removed.
Show symbol for derivatives - When checked, the local symbol will be shown as part of the
contract description.
Show daylight/summer time indication - When checked, the visible, displayed time zone
reflect change for daylight's savings (EST to EDT). When unchecked, this change occurs in the
background. Enabling a change to this setting requires you to restart TWS for it to take affect.
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Display

Rename Quantity column to "Leaves" - If checked, the Quantity column across all tools
will be renamed to "Leaves" but ONLY IF the Total Quantity column is also displayed.

Windows Handling
l

l

l

Workspace windows snapping - When checked, newly opened windows will easily snap to
the primary application window and become grouped.
Bring all windows to front if one is selected - When checked, all windows in the application are functionally linked, so that selecting one window will bring all windows to the front.
This feature is automatically enabled if you enable Workspace windows snapping (above).
Open new windows near action spot - When checked, new windows or tools will open next
to the spot where you initiated the action. This feature is especially helpful for smaller windows
and tools that might otherwise open behind or away from the current window, making it difficult
to find.

Status Bar
l

l

l

l

Display server time - Check to display the current time in the bottom right corner of the
status line which displays at the bottom of the Advanced Order Management interface. Check to
use large text if needed.
Display action buttons - When checked, the action buttons (Minimize all windows, Bring all
open windows into view, and Display current hotkey definitions) are displayed along the bottom
of the Advanced Order Management interface.
Display last login time - When checked, the last time you logged in is displayed along the
bottom of the Advanced Order Management interface.
Display mini icons - When checked, mini icons that make it easy to quickly switch to other open
TWS windows are displayed along the bottom of the Advanced Order Management interface.

Tooltips
l

l

l

l

l

Show for column headers - When checked, you will see descriptive text when you hold your
cursor over any of the main Trading screen column names.
Show timestamps - If checked, when you mouse over the last price you will also see the time
of the trade.
Show tooltip for order reversal - If checked, you will see a tooltip when you elect to
reverse an order from the trading window.
Show mouse hotkey - When checked, you will see a description of the hotkey when you
mouse over any fields for which you have created a mouse-click shortcut.
Show order status information - If checked, when you mouse over the Status field for an
order the status of the order, such as Submitted, Pending, Filled, is shown.

Blink "Trades" toolbar icon after execution
l

Blink always on new trade - If selected, the Trades icon on the trading toolbar will blink
each time an order executes.
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l

l

Blink if Trade window is closed - If selected, the Trades icon on the trading toolbar will
only blink on new executions if you have the Executions window closed.
Never blink - If selected, the Trades icon on the trading toolbar will never blink.

Options Colors
l

l

Color options based on in-the-money status - Check this box to use color-coding to
identify an option's in-the-money status at a glance.
Use the Change button to modify the default in-the-money or out-of-the-money background colors.
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Style Settings
Use the Style configuration page to define style settings such hiding or showing gridlines, changing
fonts and modifying the color palette.

To define style configuration settings
1. On the Edit menu select Global Configuration.
2. In the left pane, click Display and then Style.
3. Use the right panel to set these parameters:

Style Settings
l

Use system title bar - if checked, the TWS menus will be moved down a level and the original system title bar will be displayed.

l

Large menu text - if checked, the menu titles on the titlebar will display larger.

l

Show grid lines in tables- check to display solid gridlines on your trading pages.
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l

l

l

Color Text- check to display a text description of status colors on top of the colored field. For
example, the status field turns red when you transmit an order. With this feature checked, the
colored area will display the word "red" as well as displaying the color.
Auto Alignment - if checked, text will align left and numerical values will align right in all TWS
fields.
Alternating row brightness - this setting provides a contrast level for better row by row
readability on trading pages. A setting of "4" provides the brightest contrast between alternating rows, "0" provide the least contrast.

Font
l

Select Font Style - choose a new font.

l

Font Size - choose a new font size.

l

Mosaic Font Size - choose a font size that will be applied only to Mosaic windows.
Note: If you "lock" the sizes, this will keep the ratio between Advanced Order Entry
and Mosaic fonts intact. For example, if current sizes are 11 and 13 and you
change "11" to "12," the font size for Mosaic will automatically change from
"13" to "14" to keep the ratio intact.

l

Reset- click to reset font style and size to the default values.

Application Color Adjustment
l

Select a palette to apply a color scheme across the application. Please note that the new setting
will not be applied until the next time you log in. A sample view of your selection is shown using
the TWS image.
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Ticker Row Settings
Use the Ticker Row configuration settings to specify the look of tickers on your trading pages.
To define Ticker Row configuration settings
1. On the Edit menu select Global Configuration.
2. In the left pane, click Display and then Ticker Row.
3. Use the right panel to set the custom ticker row parameters.
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Ticker Row Settings
l

l

l

l

l

l

Display stocks with options available in bold - when checked, stocks that have options
will display in bold font on the trading screen.
Show hedging icon in size column - check to have the delta hedge icon shown in the Quantity field for volatility orders with an attached delta hedge.
Display tick-dots instead of colored prices - when checked, price display on the Quote
Monitor will be in white with a colored tick dot indicating upward or downward price movement.
Show position values in base currency - If checked, all position and P&L values are recalculated to display in your base currency, and are shown in italics to identify them as having
been converted from the local currency to your base currency.
Highlight high or low for the day - when checked, the Last price will display in RED if it is
also the day's low, and will display in BLUE if it is also the day's high.
Display trading class for derivatives - displays the trading class for options and futures to
help distinguish from other similar-looking products.

Home Exchange

Set a Home Exchange Group that identifies your most-used exchange groups. Each time the primary
listing exchange for a contract matches a home exchange group, that exchange is hidden from the
contract description on the ticker line. This feature can help to clean up your trading page by removing the repetitive listing of your most-used exchanges.
Fixed Income Minimum Size Increment

Customize the quantity display for fixed income products.
l

Select $1 to size in face value.

l

Select $1 K to size in multiples of 1000.

Fixed Income Pricing

Shows the bond price including or excluding the away platform fees. Bond orders are frequently created on the
condition that they should only trade when the quantity meets or exceeds a minimum acceptable trade size (set
when the order is created) becomes available at their price. IB calculates and displays the net price for each
order or quote that it receives from away platforms assuming that the quoted price will trade in full.
Note: Given the platform fee and any possible minimum size requirements the displayed "total" bid or ask prices may only be achieved by trading the full size.
l

Show Net Price - Displays full bond price including away platform fees.

l

Show Raw Price - Displays the bond price only, exclusive of away platform fees.
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Forex Size Display Settings
l

l

Full display shows all digits - if selected, a sample size would show as 5,000,000.
Abbreviated display shows “K” for thousands and “M” for millions - if selected, the
above size of 5,000,000 would display as 5M.

Position and P&L Display Settings
l

Include Away positions to Portfolio and P&L - check to show away positions on a new tab
in the Positions section of the Account window, in the Positions field displayed on any TWS trading page, and on the Portfolio page.

For display purposes, position values are aggregated to include both IB-held positions and “away” positions on
the same contract. However for trading purposes, if you elect to “close” a position, only the portion held at IB
will be traded.
l

l

l

Include today’s opening position in P&L calculation - check to include existing positions
in the calculation for the P&L column only.
Round values to nearest whole number - when checked, the Cost Basis, Market Value and
all other P&L value column will be rounded to the nearest whole number.
Color-code position and P&L columns - when checked, the Position and all P&L columns
will use color-coding to indicate positive and negative values at a glance. Set the colors using
the selection boxes below.

Borrow/Loan Rate Format
l

l

The default Fee Rate format shows the borrow/lend rate from the perspective of a fee owed.
The Rebate Rate mode shows the borrow/lend rate from the perspective of a rebate received.
When in rebate mode, data is italicized.

Volume Column Display Settings
l

l

l

Prefer native volume - does not update with every tick, but will include delayed transactions, busts, late-reported trades and combos.
Prefer calculated volume - updates with every tick, but may not include delayed transactions, busts, late-reported trades and combos.
Abbreviated display shows "K" for thousands and "M" for millions - check to show
abbreviated instead of exact volume display using letters. This display saves space but may not
show enough detail for all cases.

Native/Calculated Index Prices
l

Enable Native Index Prices Indication - check to display calculated index prices, but show an
indicator per index that the exchange-native price is available. When checked, the Contract
field displays a “c” to indicate the calculated price, and the tick dot is purple if exchange-native
price is supported.
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l

Prefer Native Index Prices - check to display the exchange-native index price for indexes
whenever available.

Market Data

Click Reset Subscription to modify settings for delayed market data.
l

l

l

Show last known market data quotes - if checked, a static snapshot of the bid, ask, bid
size and ask size is displayed when the markets are closed, for all tickers that are subscribed to
market data.
Do not prompt for market data subscriptions - if checked, you will not be prompted to
see delayed market data for those tickers that have no market data subscription. A change to
this parameter requires that you restart your system before the change takes effect.
Format prices with commas - check to see commas in price quotes where applicable.
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Toolbar
Use the Toolbar configuration page to define settings for the main Trading toolbar.

To define toolbar configuration settings
1. Open Global Configuration
l

From within Mosaic, use the File menu.

l

From within Classic TWS, use the Edit menu.

2. In the left pane, click Display and then click Toolbar.
3. Use the right pane to set the below parameters.
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Simplify menu and toolbar - when checked, the Classic TWS layout will use the simplified Mosaic menu
instead of the traditional TWS menu and toolbar.
Options
l

Show toolbar - check to display the main Trading toolbar.

l

Show icons - check to display icons on the main Trading toolbar.

l

Use large icons - check to increase the size of the icons on the main Trading toolbar.

l

l

Show text - check to display text descriptions of buttons on the toolbar. Use this feature in conjunction with the Show icons selection to see both the icon and the text name of the toolbar buttons.
Show toolbar on detached pages - if you elect to detach some trading pages, the toolbar
will remain visible.

Font
l

Font name - choose a new font.

l

Font Size - choose a new font size.

l

Default - click to reset font style and size to the default values.

Toolbar Items
The items in the screen can be added to/removed from the trading toolbar. Change the order of the
buttons and separators using the Move Up and Move Down buttons on the right. Use the Remove button to remove a feature from the toolbar. Use the Add Separator button to add a line separator above
the selected toolbar feature. Click Reset to put back all removed features and separator lines. Click
Default to configure the toolbar based on the default layout.
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Trading Tools
Introduction
l

Accumulate/Distribute

l

BasketTrader

l

BookTrader

l

FXTrader

l

ISW

l

Option Portfolio

l

OptionTrader

l

Portfolio Window

l

Rebalance Window

l

SpreadTrader

l

Trading Window
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Accumulate/Distribute
Configure the Quote Panel, the Orders tab and the Trades tab.

To configure Accumulate/Distribute
1. Click the Configure wrench icon from Accumulate/Distribute, or from the Edit menu select
Global Configuration.
2. In the left pane under Trading Tools, click Accumulate/Distribute, and then choose Quote
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Trade Columns or Trade Columns.
3. Use the right pane to set the Accumulate/Distribute parameters.
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BasketTrader
Use the BasketTrader configuration section to modify the layout of existing pages, or apply a new layout to a page.
To define BasketTrader configuration settings
1. On the Edit menu select Global Configuration, or click the configure wrench icon from the BasketTrader window.
2. Click BasketTrader Layout in the left pane.
3. Use the right pane to configure the following fields:

Settings
l

l

Show total row on basket pages - Check to display the Total row on the BasketTrader. The
Total row displays the total P&L values for all P&L fields you have displayed.
Instant removal of basket orders from pending page - Check to have executed trades instantly
removed from the pending page.
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BookTrader
Use the BookTrader configuration page to define basic settings, hotkeys, buttons and to control the
visibility of column fields.
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To define BookTrader configuration settings
1. Click the Configure wrench icon on any window.
2. Click BookTrader and then Settings in the left pane.
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3. Use the right pane to set the following:
Components
l

Display menu - Check to see the BookTrader menu.

l

Display toolbar - Check to see the BookTrader toolbar.

l

Display user-configurable buttons - opens the Buttons panel on the BookTrader window.

l

l

Display Deep Book Buttons - check to show the Deep Book buttons panel in BookTrader.
Depress a button on the panel to include that data in the price ladder.
Show Deep Book buttons without permissions - check to display buttons for any subscribable deep book data to which you don’t currently subscribe.

Price Ladder Status Column
l

l

l

Show single status column - check to display one Status column on the Bid side, and one
Status column on the Ask side. When this status is selected, use the Order control section to
tell TWS how to handle multiple orders on the same side.
Show separate status column for each order - check to have a new Status column created
for each order. When this status is selected, the Order control section is unnecessary and
becomes inactive.
Do not show status column - check to hide the status from BookTrader. When this status is
selected,use the Order control section to tell TWS how to handle multiple orders on the same
side.

Price Ladder Order Control
l

l

l

l

Move existing order - select if you want an existing order to be moved when an empty price
level on the same side is clicked. This selection does not allow multiple orders on the same
side.
Create new order - select if you want to allow multiple orders on the same side at different
price levels.
Cancel order - select if you want to cancel an existing order at a specific price level when that
same price level is clicked. This selection does not allow multiple orders on the same side at
the same price level.
Create new order - select if you want to allow multiple orders on the same side at the same
price level.

Re-center
l

l

Center around last price - If selected, when you click the Re-center button the BookTrader ladder puts the central focus back around the last traded price.
Center around midpoint of bid/ask - If selected, when you click the Re-center button the
BookTrader ladder puts the central focus back around the midpoint of the bid/ask price.
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l

l

l

l

l

l

l

Number of rows to display - Enter a value that defines the number of rows, or prices, you will
see.
Jump to order - If checked, your cursor will jump to the order in the Orders panel after you
transmit.
Allow multiple untransmitted orders - If checked, you can create more than one order in the
Underlying panel. Otherwise, only one untransmitted order is allowed.
Show Cumulative Size in Bid/Ask - If checked, the cumulative size is shown at the top of the Bid
column and Ask column.
Display Size column in Price Ladder - check to display a Size column on the Bid side and
Ask side. Note that this checkbox is only active if Cancel order when Bid Size /Ask Size column
is clicked at a price level that already has an existing order is selected in the Order control
section.
Display P&L column - Click to display the P&L column on both the bid and ask sides of the
BookTrader ladder. The P&L column.
Show High/Low - When checked, identifies the high and low prices by displaying different
colored backgrounds.

l

The High price is highlighted by a Bright Blue background.

l

The Low price is highlight by a Red background.

l

l

l

l

l

l

l

l

Show bold prices every 5 lines - Use this feature to help make prices easier to follow by having
every 5th row bolded.
Show price histogram - Checked by default. If checked, a colored field displays the volume of
trading each day at each price level on the BookTrader price ladder. The bar colors coincide
with colors in the Price field, for example the last trade is teal blue, the current best ask is
green, etc. See the topic on BookTrader colors for details.
Use context cursors in armed mode - Check to include a text description below your cursor. For
example, if you hold your cursor in the yellow Bid Size column, the text Buy appears to let you
know that clicking at a price level in this field will initiate a buy order.
Retain filled order columns - Valid only in Advanced Mode. When checked, the new Order
column will remain visible after the order has filled.
Show tooltips for order columns - Valid only in Advanced Mode. When checked, displays an
order-relevant tooltip when you hold your mouse cursor over a field in the Order column.
Display P&L in Order Columns - Valid only in Advanced Mode. When checked, the P&L will display in the new Order column when an order executes
Order type select Buttons - Valid only if Show separate status column for each order is select in
the Status section. Displays a toolbar with order type buttons. Click a button to put the mouse
cursor into that specific order type mode.
Remember armed state between sessions - check to keep BookTrader armed so that it is
in armed mode the next time you log in to TWS.
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Display auto-scroll countdown after scrolling - When the inside market (or last trade
price) moves outside the display area, the ladder will automatically re-center on the inside market (or last trade price). When the user is scrolling the ladder using either the Up/Down arrow
keys or the scrollbars, and the inside market (or last trade price) falls outside of the display
area, auto-recentering will occur five seconds after the user has completed scrolling. Check this
feature to see an animated progress countdown bar.

Hotkeys

Opens the Hotkeys and Mouse Shortcuts dialog box. You can modify the configuration of existing
shortcuts by selecting an action and clicking Configure. For more information see the BookTrader
Hotkeys topic.
Buttons

Create custom buttons to add to the toolbar, or edit existing buttons.
Quote Panel

Hide or display fields in the Quote Panel using the Columns page of the Page Layout. Modify text and
background colors using the Colors page.
Order Columns

Hide or display fields in the Orders area using the Columns page of the Page Layout.
Trade columns

Hide or display fields in the Trade panel.
BookTrader Colors

Allows you to change text/ background colors for many of the BookTrader fields. To change a color,
click the Text or Background button in the appropriate row and select a new color from the palette.
BookTrader Sound Manager

Opens the Sound Manager for the BookTrader where you apply sound settings for placing a limit order
(click bid or ask price), cancelling an order, and placing a stop order (right-click bid or ask price). You
can also elect to disable an event sound by unchecking the checkbox in the appropriate row.
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FXTrader
FXTrader is customizable on many levels, from the color and number of cells to the method used to
calculate order quantity.
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To define FXTrader configuration settings
1. On the Edit menu select Global Configuration, or click the Configure wrench from the FXTrader
page.
2. Click FXTrader in the left pane.
3. Use the right panel to set these parameters:
Settings Page
Components
l

Display menu - Check to see the FXTrader menu.

l

Display toolbar - Check to see the FXTrader toolbar.

l

l

Display Quote panel -Check to show the Quote panel with market data at the top of the window.
Display user-configurable buttons - check to show customizable buttons.

General
l

l

l

Jump to order- Automatically positions the cursor on a newly created order in the Orders
panel.
Allow multiple untransmitted orders - If checked, you can create more than one order in
the Underlying panel. Otherwise, only one untransmitted order is allowed.
Allow numerator sizes - adjusts the display to allow trading the numerator instead of the
denominator.

Color Schema - Use these settings to change the look of your FXTrader interface by changing the
color of cells and text.
Position Information and Cell Layout
l

l

l

l

Show Position - When checked, the position is displayed at the bottom of the trading cell.
Show Average Cost - When checked, the average cost of the position is displayed at the bottom
of the trading cell.
Show Profit and Loss - When checked, the unrealized P&L is displayed at the bottom of the trading cell.
Cell Layout Grid - Modify your FX Trader grid to be as small as one cell or as large as 4x4. The
blue cells will display in your FX Trader.
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OptionTrader
Use the OptionTrader configuration page to define basic settings, order presets, hotkeys, buttons and
to control the visibility of column fields.
To define OptionTrader configuration settings
1. Click the Configure wrench from any window.
2. Click OptionTrader in the left pane and then click Settings.
3. Use the right pane to set these parameters:

Settings
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Components
l

Display menu - check to see the OptionTrader menu.

l

Display toolbar - check to see the Option Trader toolbar.

l

Display Quote panel - check to display the Quote Panel, which displays a single line of market
data for the asset. You can create an order from the Quote panel by click the bid or ask price.

l

Display user-configurable buttons - hide or display buttons you create using the Buttons panel.

l

Display Statistics - a configurable, optional panel that shows option-related data and statistics.

Miscellaneous
l

l

Jump to order- automatically puts the cursor on the newly created order in the Orders panel.
Allow multiple untransmitted orders - if checked, you can create more than one order in the
Underlying panel. Otherwise, only one untransmitted order is allowed.

l

Show all orders - check to view all orders for the underlying.

l

Show option prices in volatility - check to view volatility instead of dollar prices.

l

l

l

Show expiration headers - check to sort option chains using a single header for the expiry
followed by a list of strike prices. This helps save room in the option chain Description column.
Order Ref - a user-defined reference name to help identify where the order originated.
Order Presets - OptionTrader-specific default order settings. The OptionTrader preset is
linked to the selected Order Ref. above. Create a preset for both Stock and Options with the
same title and link to the Order Ref by selecting it or by creating a new preset. These presets
will control the default order parameters for any stock and options orders created from the
OptionTrader. If you do not create a stock preset for the OptionTrader, the default stock preset
will be used for stock orders created in the OptionTrader.

Auto-Loading
OptionTrader automatically loads option chains based on the criteria you set in this area.
l

l

l

Assume underlying is a SMART stock - uses smart instead of a specific exchange.
Quick stock entry - check to auto load stock and bring up the exchange dialog immediately
when you enter an underlying.
Load the closest N strikes to the money - choose a number to limit how many options load in
the chain.

l

Load the nearest N expiries - only shows you those options with the N closest expiries.

l

Load specific months - hard-code the exact months whose options you want to see.
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Portfolio Window
The Portfolio window is an automated trading page you can elect to create based on the current content of your portfolio. Configure the Portfolio window to hide or show panels, market data and order
management columns by default. You can modify any of these settings directly from the window at
any time.
To configure the Portfolio window
1. On the Edit menu select Global Configuration.
2. Click Trading Tools and then Portfolio Window in the left pane.
3. Configure Settings, Trade Columns, Order Management columns or the Market Value panel.
4. Use the right panel to set these parameters:
Settings
l

l

l

l

Display market value panel - opens the Market Value panel populated with data from the
Account Information window.
Display orders panel - Opens the Orders panel in the Portfolio window. New orders will be displayed in this separate panel rather than directly below the ticker.
Display trades panel - Opens the Trades panel to display executions.
Jump to order - if checked, automatically places the cursor on newly created orders in the
Orders panel.

Trade Columns

Check the columns you want to show in the Trades panel.
Order Management

Customize the layout of the main window by adding or removing columns from the Market Data and
Order columns.
Market Value

Check the columns you want to show in the Market Value panel.
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Create a Page Layout
The Layout feature lets you create custom layouts that you can then apply to your trading pages. Use
the Layout editor to identify which columns you want to display, where you want the columns to be in
relation to each other, and the text and background colors used to convey trading information for a
specific layout.
If you want to change the way your pages display but want them all to look the same, you can simply
change the Default page layout. If you want to apply different layouts to specific pages or save the
default settings, create a new layout by copying the Default, renaming and editing it.

To create a page layout
To create a new layout, you must copy an existing layout, rename it, and then edit it to your specifications.
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1. On the Edit menu, click Global Configuration and then click Trading Window.
2. Select Other Layouts in the left pane, and then click the New button in the right pane.
3. Enter a name for the new page layout and click OK.
4. Click Edit to open the Page Layout editor.
5. Modify column visibility, column order, and text and background colors and click OK. The layout
remains unused until you apply it to a page.
Create a Page Layout
The Layout feature lets you create custom layouts that you can then apply to your trading pages. Use
the Layout editor to identify which columns you want to display, where you want the columns to be in
relation to each other, and the text and background colors used to convey trading information for a
specific layout.
If you want to change the way your pages display but want them all to look the same, you can simply
change the Default page layout. If you want to apply different layouts to specific pages or save the
default settings, create a new layout by copying the Default, renaming and editing it.
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To create a page layout
To create a new layout, you must copy an existing layout, rename it, and then edit it to your specifications.
1. On the Edit menu, click Global Configuration and then click Trading Window.
2. Select Other Layouts in the left pane, and then click the New button in the right pane.
3. Enter a name for the new page layout and click OK.
4. Click Edit to open the Page Layout editor.
5. Modify column visibility, column order, and text and background colors and click OK. The layout
remains unused until you apply it to a page.
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Apply a Page Layout
You can apply a layout to existing trading pages one page at a time, or to a new page when you create
it.

To apply a layout to an existing page
1. On the Edit menu, select Global Configuration.
2. In the left pane, select Trading Window and then Pages.
3. Choose the page on which you want to apply a layout.
4. In the Layout dropdown list, select the layout you want to apply.
5. Choose an order default strategy.
6. Click OK.
Note: All pages use the Default layout and Default strategy until you specify otherwise.
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Edit a Page Layout
The Layout feature lets you create custom layouts that you can then apply to your trading pages. Use
the Layout editor to identify which columns you want to display, where you want the columns to be in
relation to each other, and the text and background colors used to convey trading information for a
specific layout.
If you want to change the way your pages display but want them all to look the same, you can simply
change the Default page layout. If you want to apply different layouts to specific pages or save the
default settings, create a new layout by copying the Default, renaming and editing it.
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To edit a page layout
1. On the Edit menu, click Global Configuration and then click Trading Window.
2. In the left pane, select the layout you want to edit.
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3. Use the Market Data Columns and Order Columns tabs to Add or Remove fields.

4. Fields in the Market Data Columns page display along the TOP row of field headings on a Trading page. Fields in the Order Columns page display along the bottom row of fields headings. If
you display the same field on both the Market Data and Order row pages, it appears as a single
field like the Underlying, Exchange and Description fields above.
5. If desired, change text and background color using the Colors tab and click OK.
The layout remains unused until you apply it to a page.
Display Market Data Columns
You can choose to display or hide many of the columns on the trading page using the Layout manager
in Global Configuration.
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To display/remove market data columns on a page
1. Right click and column heading on a trading page, and select Customize Layout.
2. Click the Market Data Columns tab to view columns.The columns already displayed on your
trading window appear in the Shown Columns list on the left side of the page. The remaining
columns are grouped by category in the Available Columns list to the right.
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3. To display columns, select one from the Available Columns list and click the Add button to
move the column into the Shown list.
4. To remove a column, select a column in the Shown Columns list and click the Remove button.
Column titles in bold are always visible and cannot be removed. Use the Filter field to help find the
column you’re looking for, or click the Sort radio button to list all columns alphabetically.
For descriptions of data displayed in Market Data columns, see the Market Data Fields topic.
Configure Columns
You can configure the text and background on individual columns in the trading window.
For price and size columns, you can turn off the dynamic coloring, which indicates upward movement
in price or size in green and downward movement in red, by unchecking the Use Dynamic Colors box.

To configure columns
1. Right click the column name and select Configure xyz Column.
2. If dynamic coloring is available, you can uncheck the feature if desired.
3. Modify the background and text color of the column using the Text and Background color-pickers. Click User Defaults to return to original TWS colors.
4. Alignment moves the data within the column.
5. Width controls the column size.
Display Order Management Columns
You can choose to display or hide many of the columns on the trading page using the Layout manager
in Global Configuration.
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To display/hide order columns on a page
1. Right click the field labels on a trading page, and select Customize Layout.
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2. Click the Order Columns tab to view columns.The columns already displayed on your trading
window appear in the Shown Columns list on the left side of the page. The remaining columns
are grouped by category in the Available Columns list to the right.
3. To display columns, select one from the Available Columns list and click the Add button to
move the column into the Shown list.
4. To remove a column, select a column in the Shown Columns list and click the Remove button.
Column titles in bold are always visible and cannot be removed. Use the Filter field to help find the
column you’re looking for, or click the Sort radio button to list all columns alphabetically.
For a description of data displayed in Order columns, see the Order Management Fields topic.
Rearrange Trading Page Columns
You can reposition columns on a trading page by dragging and dropping a column into a new location.
Since order management and market data columns are stacked, you will be asked if you want to
move one of the columns, or both together.

To reposition a column
1. Click your mouse on the column you want to move.
2. Holding the mouse key, drag the column left or right to its new position.
3. Release the mouse button.
4. In the confirmation message, select a single column, or elect to move both columns together.
Change Background and Text Colors
You can modify the background and text color for specific columns and rows using the Layout Editor.
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To change colors in a page layout
1. On the Edit menu, click Global Configuration, then click Trading Tools and then Trading Window
in the left pane.
2. Select a layout (use Default to change the basic layout, click Other Layouts to find a custom
layout you designed).
3. Click the Colors tab and elect to modify either the text or the background color.
You can modify text and/or background colors for the following items:
l

Ticker Row (text & background) - row that contains the market data for the product.

l

Up-tick (text only) - a tick that is moving up.
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l

l

l

l

l

l

l

l

l

l

Trading Tools

Down-tick (text only) - a tick that is on the decline.
Implied-tick (text only) - the implied tick for a combo order that is \simulated by adding the values of the legs, as opposed to market data which represents an actual order for the combo.
No auto-ex (text only) - for options, tells you that orders placed against this market will not
execute electronically.
Alarm set (background) - tells you that this line has an alarm set against it.
Order Row (text & background) - the order row that is created when you click on a bid or ask
price for a product.
Modified (background) - the background for orders that have been modified.
Selected modified (background) - the background for modified orders you have highlighted (to
transmit or cancel, etc.)
Total Row (text & background) - the optional total rows displays in different color to help it
standout.
Background Grid (background) - the background of the entire trading page grid.
Background Auction (background) - the background of an order row whose instrument is participating in an auction, and cannot be cancelled.

Modify Rapid Order Entry Settings
The Rapid Order Entry panel is one component of a trading page, and consequently its settings are
managed through the Page Layout Manager. Any changes you make to the Rapid Order Entry settings
are applied via that page's assigned page layout. If you have not created or applied page layouts to
specific pages, all pages are controlled through the default page layout. The procedure below
assumes some familiarity with the page layout manager.
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To modify Rapid Order Entry settings
1. On the Edit menu, select Global Configuration.
2. Select Trading Tools then Trading Window in the left pane.
3. Click the Rapid Order Entry tab to view the current settings.
4. Use the checkboxes, editable fields and Display Settings described in the table below to
enable/disable features, set default values and select a default order type.
5. Click OK.

Note that you are making changes to a component of a page layout, not to a specific page. These changes will
also be applied to all other pages using this layout.
Rapid Order Entry Settings
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You can record hot key assignments for rapid order entry actions. Note that your standard hot keys
(Buy, Sell etc) are not valid within the Rapid Order Entry panel.
Display
l

Show - displays the Rapid Order Entry panel at the top of any pages using the layout.

l

Hide - hides the Rapid Order Entry panel at the top of any pages using the layout.

Contract type
l

l

l

Stocks - automatically configures the Rapid Order Entry panel to allow you to trade stocks. You
will see the Display Settings list to the right from which you can select the fields you want to
use.
Stocks/Options - automatically configures the Rapid Order Entry panel to allow you to trade
stocks or options. You will see the Display Settings to the right from which you can select the
fields you want to use.
Combos - automatically configures the Rapid Order Entry panel to allow you to create and trade
combination and spread orders. The Display Settings list is not relevant to this layout.

Miscellaneous
l

Primary Exchange - enter the default routing exchange. We recommend using Smart to get the
best execution.

l

Default size - set the default order size. You may edit the value in this field from the panel.

l

Default order type - sets the default order type. You may edit this value from the panel.

l

l

Request market data - controls whether you will see a line of market data above the order management line that is created when you transmit an order.
Save contract info - when checked, the information for the current contract will remain after
you transmit an order. Unchecked, all fields are cleared after you transmit an order.

Display Settings
Check any fields that you want to appear on the Rapid Order Entry panel.
l

l

Move up/move down - puts the checked fields in order. The order in which they appear in this
list determines the order in which they will appear on the Rapid Order Entry panel, and the
order in which the cursor will be inserted as you tab through the fields if Include in tab order is
checked.
Include in tab order - this box must be checked or unchecked for each of the selected fields in
the list. Checking instructs your cursor to land in that field as you tab through.
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Introduction

Configure settings account information and data tools, including alerts, charts, market depth, scanners and news.
l

Configure Alerts

l

Fundamentals

l

Configure Market Depth

l

Configure News Feeds

l

Time & Sales

l

Trader Dashboard
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Configure Alerts
Use the Alerts configuration page to define basic settings, hotkeys, buttons and to control the visibility of column fields.
To define Alerts configuration settings
1. On the Edit menu select Global Configuration, or click Configure from the Alerts menu.
2. Click Alerts in the left pane. You can expand the options in the left pane or in the right panel.
3. Use the right panel to set these parameters:

Settings
Components
l

Display menu - check to see the Alerts menu.

l

Display toolbar - check to see the Alerts toolbar.

l

Display message as pop up - if checked, the default for Alerts is a pop up message.
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l

Flash rows - if checked, the rows of market data used for the Alerts will flash when the Alert
has been activated.

l

Play sound - if unchecked, None is selected by default on the Audio tab of the Alerts page.

l

Sound - select a default alert sound.

l

Delete Timeout - set the time after which the alert notifications will stop.

l

Repeatable - if checked, this feature will be checked by default in the Duration area of the
Alerts page.

Hotkeys

Opens the Hotkeys and Mouse Shortcuts dialog box. You can modify the configuration of existing
shortcuts by selecting an action and clicking Configure. For more information see the Assign Mouse
Shortcuts topic.

Buttons
Create custom buttons to add to the toolbar, or edit existing buttons. Click New to create a new button.

Order Columns
Hide or display fields in the Orders area using the Columns page of the Page Layout.

TWS Users' Guide

990

Global Configuration

Information Tools

Configure Alerts
Use the Alerts configuration page to define basic settings, hotkeys, buttons and to control the visibility of column fields.
To define Alerts configuration settings
1. On the Edit menu select Global Configuration, or click Configure from the Alerts menu.
2. Click Alerts in the left pane. You can expand the options in the left pane or in the right panel.
3. Use the right panel to set these parameters:

Settings
Components
l

Display menu - check to see the Alerts menu.

l

Display toolbar - check to see the Alerts toolbar.

l

Display message as pop up - if checked, the default for Alerts is a pop up message.
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l

Flash rows - if checked, the rows of market data used for the Alerts will flash when the Alert
has been activated.

l

Play sound - if unchecked, None is selected by default on the Audio tab of the Alerts page.

l

Sound - select a default alert sound.

l

Delete Timeout - set the time after which the alert notifications will stop.

l

Repeatable - if checked, this feature will be checked by default in the Duration area of the
Alerts page.

Hotkeys

Opens the Hotkeys and Mouse Shortcuts dialog box. You can modify the configuration of existing
shortcuts by selecting an action and clicking Configure. For more information see the Assign Mouse
Shortcuts topic.

Buttons
Create custom buttons to add to the toolbar, or edit existing buttons. Click New to create a new button.

Order Columns
Hide or display fields in the Orders area using the Columns page of the Page Layout.
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Configure Market Depth
Use the Market Depth configuration page to define basic settings, hotkeys, buttons and to control the
visibility of column fields.
To define Market Depth configuration settings
1. On the Edit menu select Global Configuration, or click Configure from the Market Depth menu.
2. Click Market Depth in the left pane. You can expand the options in the left pane or in the right
panel.
3. Use the right panel to set these parameters:

Settings
Components
l

Display menu - check to see the Market Depth menu.

l

Display toolbar - check to see the Market Depth toolbar.
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l

l

l

l

l

l

l

Display Quote panel - check to display the Quote Panel, which displays a single line of market
data for the asset. You can create an order from the Quote panel by click the bid or ask price.
Display user-configurable buttons - if checked, the buttons that allow configuration are displayed.
Display Deep Book Buttons - if checked, the Deep Book Buttons panel will display, with a
button for each market center for which you have deep book data permissions.
Display Deep Book buttons without permissions - if checked and Deep Book Buttons
panel is also displayed, the buttons for deep data will display even if you do not have permissions. These buttons will be visible but inactive.
Show pending orders in the book - if checked, any orders you transmit from the
DepthTrader window will show, highlighted in white, in the Deep Book data.
Jump to order - automatically puts the cursor on the newly created order in the Orders panel.
Allow multiple untransmitted orders - if checked, you can create more than one order in the
Underlying panel. Otherwise, only one untransmitted order is allowed.
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Configure News Feeds
You can elect to add more pre-configured news feeds to your workstation browser. You can also subscribe to Reuters News Service via the Market Data subscriptions page in Account Management.
To view Reuters News
1. On the Edit menu, select Global Configuration.
2. In the left pane, click the horizontal key to expand the News Configuration feature, then
select News Suppliers.
3. In the Pre-configured Providers section at the top of the right page, check Reuters News Service.
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If this selection is grayed-out, it means you have not subscribed to this service in Account Management.
To add existing news feeds
1. On the Edit menu, select Global Configuration.
2. In the left pane, click the horizontal key to expand the News Configuration feature, then
select News Suppliers.
3. The right pane displays the current list of news suppliers whose headlines you can access. Click
the Add button to configure a new supplier.
4. Select a supplier name from the dropdown list. The RSS Link is automatically loaded. Click OK.
5. The new supplier appears in the list of available news feeds.

You can elect Refresh Intervals of 1, 2, 3, 4, 5, 10 and 15 minutes. Note that refreshing the news feeds requires
some system resources, and more frequent refresh intervals may have a minor impact on your system performance depending on your connection type.
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Time & Sales
Define the layout of the Time & Sales page that you can display for a chart.
l

Settings - choose to show quote line and show last only.

l

Hotkeys - define Time & Sales hotkeys and shortcuts.

l

Quote Panel - Hide or display fields in the Quote Panel area.

l

Colors - modify colors.

l

Columns - uncheck to remove columns from the Time & Sales main data area.
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The real-time Trader Dashboard is an optional tool that can be displayed at the top of the pages tabset. This customizable panel allows you to monitor data fields from your Account Information window, keep abreast of the most recent activity for specific contracts, and view current real-time news
headlines for products in your portfolio and for any tickers you are watching.

To configure the Trader Dashboard
1. On the Edit menu, select Global Configuration.
2. In the left pane, click Trader Dashboard.
3. Use checkboxes in the right pane to set the following:
l
Check Show news to display news headlines for any products in your portfolio and to alert
you to recent news on any tickers you elect to display.
l

To see only portfolio-relevant news, check Display News for products in portfolio only.
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l

l
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To only see indicators of recent news next to individual tickers that you are watching,
check Display recent news indicator only.
Check Show price change in percentage to view the last price and price change values as
percentages in ticker lines.
Check Show price change in value to view the last price change as an absolute value.

4. Click the Add Account Data button, and scroll down the list. Double-click each Account field
that you want to add to the dashboard. Each field you double-click is added to the Display
Item list on the configuration pane. Click OK to close the Add box.
The descriptions for Account Information fields are in the Account Information topic.
5. To add a last price/price change field for a contract, enter the underlying in the Symbol field
and click Add Ticker, then define the contract parameters just as you do when you add market
data to the trading page. The last price/price change displays in red to indicate downward movement and blue to indicate upward movement.
6. Click OK. The Trader Dashboard is displayed at the top of your trading window, just above
the pages tabset.
You can change the display name for selected dashboard fields using the Change Label feature.
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Introduction

Use the Charts configuration page to define basic settings, hotkeys, buttons and to control the visibility of column fields.
l

Charts Settings

l

Charts Toolbar

l

Charts Colors

l

Charts Quote Zone

l

ChartTrader
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Charts Settings
To define Charts configuration settings
1. On the Edit menu select Global Configuration, or click the configure wrench from within a chart.
2. Click Charts in the left pane. You can expand the options in the left pane or in the right panel.
Sections of the Settings page include:
l

Display

l

l

Layout

l

Highlight

l

What to show when switching contract

l

Trendlines

l

Tooltips

l

Graphical position indicator

l

Order Display

l

Miscellaneous

Display

Define global default display settings for charts.
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Name - Description

Name - Description

Market clock - if checked, displays the time in the top title
bar.

Toolbar - check to display theChartstoolbar.

Chart value label - if
checked, the Price, Volume
and other axis labels are displayed.

Buttons Panel - check to display configurable
ChartTrader buttons.

Hot Buttons - check to display the floating
Buy/Sell/Alert set of hot buttons that you use to create
orders. Hot buttons can be
armed to transmit instantaneously.

Chart key (legend)- if checked, displays a key to
the color, type of chart and asset charted along the
bottom of the chart.

Quote panel- if checked,
the Quote panel, which
shows market data for the
contract, displays at the bottom of the chart window.

Quote Zone - check to display the Quote Zone,
which floats within the chart along the top.

Crosshair - puts the cursor into
crosshair mode and displays the
vertical crosshair line.

Horizontal Crosshair Line - when checked, both the
vertical and horizontal crosshair lines are displayed on a
chart when you are in Crosshair Mode. When unchecked,
only the vertical crosshair line displays.

Margin area - check to display
a small, left-facing arrow at the
bottom of the chart. Drag the
margin in to increase the horizontal buffer.

VWAP on bar - check to show the volume- weighted
average price on the bar.

Bypass parameter window check to open charts using specified data without opening the
Chart Parameters window.

Show candle outline - check to shows outlines for candlesticks.

Prior close - check to show the
prior close price on the chart.

Intersection between trading days - check to show a
dotted line as a separator

ChartTrader - Displays the
Orders, Log, Trades and Portfolio tabs along the top of
the chart. These panels will
also open automatically
when you create an order.

Logarithmic Scale - Change the increments on
the price axis to represent price change by "percentage change"- rather than "dollar-value"
change. Using Log Scale, a $5.00 change from 10 to
15 represents a 50% price change, while a $5.00
change from 20 to 25 is a 25% change.
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Display Vertical Scrollbar - Adds a vertical scrollbar.
Create multiple charts as

Specify the layout for multiple charts.

Tabs - each charts goes into its own tabbed page.
Internal windows - charts are tiled within the same frame.
Layout

Set up global default layout options for charts.

Price axis on: Left, Right, or Both

Quote panel on: Top or Bottom

Time axis on: Top, Bottom or Both

ChartTrader on: Top or Bottom

Fibonacci label at: Left, Middle or Right side
of the top red Alerts bar.

Alert label at: Left, Middle or Right side
of the top red Alerts bar.

Horizontal trendline label at: Left, Middle,
Right or None
Highlight on ...

Define which items you want highlighted on the Y (price) axis and on the chart.
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Check the prices to highlight along the price axis. “Cursor price” is the price over which your cursor is
currently hovering within the chart.
Check the events to highlight in the chart itself. Holding your cursor over any of the highlighted
events will display a text description of the event.
What to show when switching contract

When adding a new chart, choose to either use the default “What to show” selection (i.e. Trades for
stocks, Midpoint for Forex) or keep the selection from the current chart.

Trendlines

Set trendline characteristics for charts.

Field

Auto-complete trendline
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If checked, you can instruct TWS to complete a freehand
trendline. Begin your trendline by clicking and holding the
mouse. To use auto-complete, release the mouse key, then
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click again. TWScompletes the trendline across the chart, following your trajectory.

Share
trend line
among
charts

If checked, a trendline drawn on one chart will appropriately
be reflected on other active charts using the same contract.

Share
when bar
size is
the same

Check to share trendlines only when the bar size on charts is
the same, e.g. 5 min bar, 4 hour bar, daily bar etc.
This feature is only enabled when Share trend line among
charts is checked.

Tooltips

Specify whether to show tooltips on the chart, and how to display.

Field

Description

Display
ChartTrader
button tooltip

Check to see mouse-over tooltips of the buttons on the
button panel.

Display bar
details

Check to show details for bars in a bar chart. Use the
radio buttons to specify where the information will be
displayed.
If you select "bar details zone" you can pick the data
fields that display.
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l

l

l

"tooltip" shows details in the mouse-over
information.
"separate window" opens a small pop-up
window in the chart each time you mouse
over a bar.
"bar details zone" displays information in
the bottom right corner. Details change as
you mouse over each bar.

Display any of the following fields in the Bar Details
Zone: Date/Time, High, Low, Close, Open, Volume,
VWAP and Studies.
Graphical position indicator

Use colors to show the current position in the chart.

l

Check to indicate your current position using lines or color in the chart

l

Line - draws a line at the price point of the position.

l

Field - shades the chart from the position up (long position) or down (short position).

l

Custom - define the height of the shaded field.

Order Display

Define display features for orders shown in your chart. Set for both ChartTrader orders (orders submitted from within the chart) and for all other orders (including orders submitted from any tool or window other than ChartTrader).
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Charts

Description

Show live orders

Display working orders on the chart.

Show filled orders

Display filled orders on the chart.

Show cancelled orders

Display cancelled orders on the chart.

Miscellaneous

Define other miscellaneous chart features.
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Field

Description

Allow more
than 500 bars

Enables smaller bar size for the same time
periods. Note that some bars may be too
small to read.

Arrow-Key
Candle Selection

Moves the control for moving from bar to bar
from the mouse cursor to the keyboard
arrow keys.

Show selected
time

When checked, the specific time displays in
highlighted yellow along the bottom axis of
the chart as you move the cursor.

Bar chart spike
protection (max.
% change from
previous bar)

If you want to apply spike protection, enter a percentage value. If any bar exceeds this percentage
relative to the previous bar, it is automatically
eliminated from the chart.

Line chart
spike protection (max.
% change from
previous point)

If you want to apply spike protection, enter a
percentage value. If any point exceeds this
percentage relative to the previous point, it
is automatically eliminated from the chart.

Line grab sensitivity

The higher the sensitivity, the more precise
you will need to be to grab and move lines.
Higher sensitivity makes it easier to draw
trendlines close together.

Show sub-chart
security selection
box

When checked, a box asking if you want the subchart to use the same security as the selected
chart is displayed when you elect to Add New
Chart.

Always chart
all combos

Check to chart combos. If you leave
unchecked, you will be asked on an individual basis. Charting combos uses more system resources than charting individual
contracts.

Gap between trading days

Define the number of missing bars (up to 9)
allowed between trading days.

Axis label font
size

Select a font size to be used along the price and
time axes.

Quote zone font
size

Select a font size to be used in the chart’s Quote
Zone.
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Charts Toolbar
Configure the toolbar by adding, removing and re-ordering toolbar icons.
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Charts Colors
You can customize the display and print colors for many aspects of your charts using the Chart colors
matrix. Note that your changes are global and will be applied to all charts.
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You can restore the original colors by clicking Restore Defaults at the bottom of the colors list.
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Charts Quote Zone
Specify the fields you want displayed in the middle and right areas of the Quote Zone. Note that the
left area cannot be modified.
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To add and remove Quote Zone fields
1. Select the Middle or Right tab to edit the appropriate Quote Zone area.
l

l

To display a field, use the Add button to move a field from the Available Columns list to the
Shown Columns list.
To remove a field, select the field in the Shown Columns list and use the Remove button to put
the field back into the Available Columns list.
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Create hotkeys and shortcuts and action buttons, and add/remove fields from the Quote panel, Orders
panel and Trades panel.
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Order Presets

Order Presets
Introduction

The order Presets feature allows you to create and save multiple, named order strategies with default
values, per instrument type and per symbol. The Active preset is used as the default for all instrument types. Use the Preset drop-down field from the ticker line to set a preset strategy for all new
orders on the ticker.
l

About Order Presets

l

Create Order Presets

l

Define Order Preset Values

l

Using Presets from the Trading Window

l

Configure Order Defaults and Presets

TWS Users' Guide

1015

Global Configuration

Orders - Default Settings
Use the Orders page to define general, global default settings.

To define General order configuration settings
1. On the Edit menu select Global Configuration.
2. Click Orders in the left pane.
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3. Use the Orders page to set the following parameters:

Orders
l

l

l

l

l

l

l

l

l

l

l

l

l

Auto-save default size- when checked, any change you make to the quantity of an order is
saved as the default size for that instrument type, after the order is transmitted.
Big Scale prices - when checked, the increment used in the price wand is increased. The price
wand presents a selection of prices above and below the order price, and is invoked when you
click and hold the cursor in the Price field on an order line.
Big scale sizes - when checked, the increment used in the size wand is increased. The size
wand presents a selection of quantities higher and lower than the order size, and is invoked
when you click and hold the cursor in the Quantity field on an order line.
Auto-sort submitted orders - this feature is checked by default. When unchecked, orders created on the same underlying are no longer sorted by limit price.
Auto-adjust limit price for STP LMT and LIT orders - if checked, the limit price in stop
limit and limit if touched orders will automatically be adjusted when you modify the stop price.
The limit price adjusts based on the offset amount you define when you create the order.
Round shares to nearest 100 when entering amount in “Quantity Value” column - if
checked, the system will round the order quantity to the nearest 100 shares.
Display pending day and GTC orders on separate pages - if checked, pending orders will
be separated by GTC and DAY times in force to display on different pages.
Continuously update limit price for EFP orders in percent yield - if checked, TWS will
continuously update the limit price for EFP orders where the price is entered in "percent yield."
To enter price in percent yield, right-click on price column header and select Show Percent.
Reset Short Sell Locations button - for non-cleared customers or customers who can clearaway only. By default, TWS remembers how many shares you located when doing a sell short
order. Clicking this button clears out that memory.
Disable auto-expand editor for orders with Presets - if checked, orders that generally
invoke the inline order editor that displays when you create an order (for example, algo orders)
will not display IF an order preset is assigned. Only check this if you will not want to edit these
orders on a per-order basis.
Auto adjust algo times - If checked, algos that are submitted at the close or use an invalid
start or end time will be automatically adjusted to use the valid trading date. This setting could
be useful for VWAP orders entered when the markets are closed.
Use multi-level structure in Order Destination field - if checked, the display of order destinations in the Destination field will use collapsible categories with sub-entries.
Set order ref for attached hedging order same as the parent order - if checked, child orders will
be assigned the same order reference number as the parent order. If unchecked, the child
order reference will show a message that includes the parent ID.

Completed Orders Settings
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l

l

l

l

l

Auto-remove orders - this feature is checked by default. When unchecked, executed and cancelled orders remain on the both the trading and the pending pages.
Reuse rejected order - if checked, rejected orders will remain on the trading page.
Leave filled orders on the screen for - lets you increase or decrease the number of
seconds before filled orders are deleted from the Trading window.
Leave cancelled orders on the screen for - lets you increase or decrease the number of
seconds before cancelled orders are deleted from the Trading window.
Use auto-logoff time instead of midnight when downloading completed orders - if
checked, TWS will download orders from the time of the last auto-logoff. Otherwise completed
orders from midnight to the current time are downloaded.
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About Order Presets
Order presets present a hierarchical layout of order strategies whose characteristics and values are
set ahead of time, and can be set as the default order strategy or can be selected prior to the creation
of an order. The below sections explain the hierarchy of presets and the function of each section on a
preset page based on its position in the hierarchy.
The Hierarchy

Order presets are laid out as shown below, in a three-level hierarchy. Each sub-level inherits the settings from its parent preset. In the image below, the named preset Scale inherits the default values
from its parent Stocks(2) preset, while the Stocks preset inherits applicable default values from the
highest level Presets(1) preset. This hierarchy is described in more detail below.

The top level preset contains settings that apply to orders of all types on all asset classes. If you create named presets at the top level, the preset can be applied to orders on all asset types. Settings at
the top level are inherited by and can be changed on the asset-level presets. Use this level to make a
change that you want to affect all presets; for example, you may want to allow all orders to activate
outside regular trading hours. Define this setting at the top level and elect to propagate some or all of
the changes to other applicable presets using the Propagate Settings box shown below:
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The Propagate Settings box is displayed any time you make a change in a higher level preset that
could be applied to sub presets.
The second level, or asset-level presets, contain both the top level settings and asset-specific settings. For example, the Stock preset contains all the fields on the top level preset as well as
Algorithm and Display Settings areas that are valid only for stocks.
Under the asset-level presets, you can create named and ticker-specific presets.
Named presets inherit all settings from the asset-level preset, and also include contract-specific settings you can define for your strategy. You can create multiple named presets for an asset type, for
example one that creates a trailing stop order, one for scale orders, one for bracket orders, and
select the preset strategy from the market data line before you create an order.
Ticker presets will be active by default for that ticker. As with all presets you can select a different
strategy on a market data line before you create an order.
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Create Order Presets
Presets expand the usefulness of default order settings by allowing you to create multiple sets of
order defaults at the instrument level or ticker level, and apply them from the trading page prior to
creating an order using the drop down selection in the Presets field.

To configure presets
1. From the Configure menu, select Order and then Order Presets.

Note: Global Configuration opens with focus in the Presets category in the left pane.
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2. Select the instrument for which you want to define a preset.
3. Use the right-click menu and select Create new.
4. Enter a name and click OK.
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The settings for the new preset are derived from the default settings defined at the main preset
level identified by the crown. This upper level page includes all possible settings. When you create a sub-preset and modify the basic settings, you can elect to view only the differences
between the sub and main presets by depressing the Overridden fields only button.

The asterisk next to a group label indicates that you made changes but haven’t yet saved your settings.

5. The new strategy is highlighted in the left pane with its associated order defaults page in the
right. Edit the order fields you want to associate with the order strategy and click OK. The
numbered descriptions in the table below correspond to the image above:
1

Strategies defined at the top Preset level, such as Trail-Stop in this example, can be
applied to any instrument type, but cannot be designated as “Active.”

2

The top-level instrument type is the default order preset for all contracts of that type,
until another is made Active. Instrument-level presets appear below the top-level instrument type and will only be available from the Preset drop-down for tickers of that
instrument type.

3

One preset for each instrument can be active. The Active preset is identified by the
green ball, and becomes the default order strategy for all contracts of that type. In the
above example, all Stock contracts on all pages will use the Stk-Scl-Strat order
defaults when you create an order. Select a different preset for any contract using the
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Preset drop-down list on the market data line.

4

Ticker-level presets become the default for that ticker and are not available for any
other tickers even on the same instrument.

5

The Preset icons function as follows:
Strategy - click to create a new preset strategy for the selected level, either top, instrument-level, or ticker-level.
Ticker - becomes available when you select an instrument type. Click to create a
ticker-level preset.
Make Active - click to make the selected preset active for all symbols of the instrument
type, except those with a ticker-level preset defined.
Copy - copies the strategy settings from the selected preset.
Paste - overwrites the settings from the selected preset with the copied settings.
Delete - removes the selected preset strategy with no confirmation message.
Rename - change the name of the selected preset.

The default values that you can define for each Preset vary slightly based on the instrument/contract
you select. The defaults you can set are defined in the tables in the Define Order Preset Values topics.
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Define Order Preset Values
The presets pages are broken into categories, including:
l

Timing and Size Settings

l

Primary Order Settings

l

Scale and Adjusted Stop Fields

l

Target Order (Profit-taker) Settings

l

Attached Stop Order Settings

l

Miscellaneous Defaults

l

Define Precautionary Settings

l

Algorithm Settings

l

Default Display Settings
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Primary Order Settings
The primary order is also called the parent order. Values you set will be used when you select the
associated order type, for example, the Stop Price value will only be used if you select Stop as the
order type. Based on the settings below, the default order type is a LIMIT order.

Field Name

Description

Values entered
are for buy
orders and will
be flipped for
sell orders.

Relevant properties will be inverted for sell
orders.

Order Type

The default order type that will be used any
time you create an order using this preset.

Limit price

The value used for the default limit price, if
your order uses a limit price. Pick from Bid,
Ask, Last or Bid/Ask Midpoint.
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added to/subtracted from the
price. Note that you can
enter a positive or negative
value.

Stop Price

The value used for the default stop price. Pick
from Bid, Ask, Last or Bid/Ask Midpoint. This
value is used if the default order type is a stop
order, and also if the default order type is not a
stop order, but in the order line you elect to
change the order type to a Stop order.

Use the +/- offset field to
enter an offset amount, percentage or ticks that will be
added to/subtracted from the
price. Note that you can
enter a positive or negative
value.

Stop-limit price

The value used to determine the limit price in a
stop limit order. Pick from Bid, Ask, Last or
Bid/Ask Midpoint.

Use the +/- offset field to
enter an offset amount, percentage or ticks that will be
added to/subtracted from the
price. Note that you can
enter a positive or negative
value.

Offset Amount

The relative offset amount used for relative
orders. This amount will be added to the best
bid (for a buy order) and subtracted from the
best ask (for a sell order) to create the limit
price at which the relative order will be submitted.

Relative limit
price

The value used to calculate the starting price
for a Relative order. Choose from Bid, Ask,
Last, Bid/Ask Midpoint or None.
If you choose None, the price defaults to the
Bid price for Sell, and the Ask price for a Buy.

Trailing amount

The trailing value used for a trailing stop order.

Touched trigger

Value used to calculate the Trigger Price for
Limit if Touched and Market if Touched orders.
Pick from Bid, Ask, Last or Bid/Ask Midpoint.

Discretionary
Amt.

The default value that will be applied when
you use the discretionary order attribute.
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Scale and Adjusted Stop Fields
These fields show only for named presets and apply to the primary order.

Field
Name

Description

Initial Component Size

Set a default size for the initial component of a
scale order.

Price Increment

The incremental amount by which the price of
each successive component will change.

Subsequent
Component
Size

Set the component size for all remaining order
components of the scale order.

Profit-taker

Define the amount that will be added to/subtracted from the last filled component price for
the opposite side profit order.

Restore size
after taking
profit

Check to have the size of the order restored at a
specific price level after the profit order fills.
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Field
Name

Adjusted
order
type

Description

Order Presets

Notes

When you select an adjusted order type, the stop order you're adjusting will
not trigger when the stop price is hit. Instead, it will be changed to this order
type, and use the other parameters below.
Select one of the stop order types. When your current stop price is penetrated,
it will change to this order type and use the instructions you set in the following fields.

Adjusted
stop
price

When the trigger price is hit, the adjusted stop price is implemented for the
new order.

Adjusted
stop limit
price

Used for Stop Limit and Trailing Stop Limit orders. This value will be the
limit price of the order if it is triggered and submitted.

Adjusted
trailing
amount

Used for Trailing Stop and Trailing Stop Limit orders. This value will replace
the original trailing amount if the adjusted order is triggered.
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Target Order (Profit-taker) Settings
The target order fields are linked to the parent or Primary order, and will not be available if you elect
a scale primary order with Restore size after taking profit enabled.
Note that you must enter these values as if the parent order were a Buy order. In the case that the
parent order is a sell, the values will automatically be flipped.

Field
Name

Description

Notes

Order
Type

The order type for the child profit-taking
order.

If you select None no target order
will be created.

Limit Price

The limit price for the profit taker.

Select Parent order to create a target price equal to the price of the
parent order +/- a defined offset
amount or percent.

Apply offset to parent

If you elect to apply the offset to the
parent order price, check to have the
offset applied to the actual fill price
of the parent order.

Offset
Amount

If the Relative order type is selected,
define the relative offset amount.

Initial Component Size

Set a default size for the initial component of a scale order.

Price Increment

The incremental amount by which the
price of each successive component will
change.

Subsequent
Component
Size

Set the component size for all remaining
order components of the scale order.
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Attached Stop Order Settings
The attached stop fields are related to the parent order.

Field
Name

Description

Notes

Order
Type

The order type for the attached child
order.

If you select None no attached order will
be created.

Stop
Price

The stop trigger price for the attached
stop order.

Select Parent order to create a stop price
equal to the price of the parent order +/a defined offset amount or percent.

Stoplimit
Price

The limit price at which the attached
order will be submitted when
triggered.

Only used if the order is a stop limit or
trailing stop limit order type.

Trailing
Amount

If the order is a trailing order, this
value represents the amount by which
the order will trail the market price.

The order trails in only one direction.

Attached Stop Order
Adjusted Stop Fields
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These fields are used if the Attached Stop Order type above is Adjustable Stop.
Field Name

Description

Adjusted Trigger Price

The trigger price that triggers adjustments to the existing stop
order.

Adjusted Stop
Price

The adjusted stop trigger price for the order.

Adjusted Stop
Limit Price

The adjusted limit price at which the order will be submitted.

Adjusted Trailing Amount

The new trailing amount which defines the amount by which
the order will now trail the market price.

TWS Users' Guide

Notes

1032

Global Configuration

Order Presets

Miscellaneous Defaults

Field
Name

Description

Notes

Trigger
Method

The trigger method is used to trigger Stop, Stop Limit,
Trailing Stop and Trailing Stop Limit orders.

You can Modify the
Stop Trigger
Method.

Open/Close

Identifies the default action to either open or close a
position.

For non-cleared customers.

Order Ref.

A user-controlled field to identify orders.

This setting will be
overridden by the
page level setting.
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Clearing
Acct

Select the clearing account.

For non-cleared customers.

Order Origin

Defines the origin of your order in relation to the market.

ISE Order
Type

The Standard order is completely anonymous. The
SOI order broadcasts the symbol to other ISE MPM
members and may get execution priority.

Bypass
market cap

If checked, the IB price cap (for buy orders) and
price floor (for sell orders) will be ignored.

Please note that
checking this feature
could result in an
execution price that
is outside of what is
considered fair or
consistent with an
orderly market.

Post only

If checked, when there is non-displayed liquidity at
the same price point, the order price is adjusted low
(for a buy) or higher (for a sell) by one penny to avoid
taking that liquidity. If the order comes in at a price
higher (for a buy) or lower (for a sell) than an order
already sitting on the book, it becomes an IOC (immediate-or-cancel) order at the better price.

For smart-routed US
stocks and options.

Prefer
SMART

If checked, TWS will SMART route all orders if
Smart-routing is available, regardless of the routing
selection defined for the ticker.

No default
destination

If checked, all orders using this preset will be created
with a blank default routing destination.

Consider
cost when
routing

If checked, Smart routing will consider the total cost
of executing the order, including commissions and
other fees, when deciding where to route the order. If
unchecked, only the exchange price is considered.

For smart-routed
European stocks.

OCA Group Defaults
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Use the One-Cancels-All order attribute to work related orders in conjunction with one another.
Field
Name

Description

Notes

If one order in group is partially filled, other orders should be...
Reduced
in size

The default is to have other orders in the OCA group proportionately
reduced in size based on the quantity of the filled portion.

Cancelled

All other orders in the group are cancelled

Overfill
Protection

If checked, this dictates that only 1 order in the group will be routed to an
exchange at a time. This strategy completely removes the possibility of an
overfill.
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Define Precautionary Settings
Precautionary values are used by the system as safety checks. If you submit an order that violates
any of these custom settings, you will have to confirm your intent to transmit the order before TWS
submits it.

Field
Name

Description

Percentage

This option was created as a safety net to prevent you from transmitting
a limit order that has a mistyped limit price. If you attempt to transmit a
limit order with a price outside of this calculated percent off the market
price, you will receive a message asking you to verify that you meant to
enter that off-percentage price before it will transmit the order. The market price used is the price displayed in either the bid (sell) or ask (buy)
field at the time you transmit the order. This option can be left blank.

Total
Value
Limit

If you transmit an order with a price that exceeds the total dollar amount
you specify, you will receive a message informing you that the Total
Value constraint has been violated, and you must confirm that you want
to submit the order regardless.

Size Limit

Limits the value in the Quantity field. If you enter a higher value, you
can override the default size limit by clicking Yes in the warning box.
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Number of
Ticks

Like the Percentage option above, number of ticks is also a safety net to
prevent you from transmitting a limit order that has a mistyped limit
price. If you attempt to transmit a limit order with a price outside of this
calculated number of ticks off the market price, you will get a message
asking you to verify that you meant to enter the off-percentage price
before it will transmit the order. The market price used is the price displayed in either the bid (sell) or ask (buy) field at the time you transmit
the order. This option can be left blank.

Algorithm
Total
Value
Limit

If you transmit an algo order with a price that exceeds the total dollar
amount you specify, you will receive a message informing you that the
Total Value constraint has been violated, and you must confirm that you
want to submit the order regardless.

Order Presets

Enter “0”
to disable
the limit.
If you do
not enter
a value,
the algo
value
limit
defaults to
the Total
Value
Limit
(above) x
10.

Algorithm
Size Limit

Limits the value in the Quantity field for algo orders. If you enter a
higher value, you can override the default size limit by clicking Yes in
the warning box.

Enter “0”
to disable
the limit.
If you do
not enter
a value,
the algo
size limit
defaults to
the Size
Limit
(above)x
10.
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Algorithm Settings
Choose an algo destination to use the algo order as the default order type.
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Default Display Settings

Display settings change the way values are displayed on the trading window.
Field
Name

Description

Multiplier

Multiplies the price by this value.

Offset

You can use this to offset a displayed price for
instance for a specific futures contract. Say ES
bid/ask is 1314.75/1315.00. First, select Futures in the
middle pane, then click the Add button at the bottom
of the column and enter ES. Enter an offset of 1300.
To see how this will display, in the Test box enter
1314.75 and click the Test button. The example displays as 14.75.

Rounding

Change the default of None to Round, Nearest Valid
Price or Truncate. Use the Test entry field to enter a
value, can click Test to see the result.

Decimals

Overrides the default 2 decimal-place price display.

Show
using italics

Displays price data italicized.

Show
Reciprocal

Re-calculates the quote to 1/quote. This setting allows
Asian contracts to be viewed in the familiar local
format.
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Test
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Using Presets from the Trading Window
To use a Preset order default strategy, simply select it from the Preset field in the ticker line on your
trading window. Note the following:
l

Presets created at the top Presets level are available on any instrument.

l

Presets created at the instrument level are available only for that instrument.

Ticker level - only one preset can be created for a specific symbol, and it can only be used for that symbol. A
ticker-level preset is used as the default for the symbol.
Alternatively, you can associate a preset strategy with a Quote Monitor to guarantee that all orders created on a
specific page will use a specified preset.

To associate a Preset with a Quote Monitor
Note: This procedure assumes that you have already created the preset you want to
associate. If you have not, please See Create Order Presets for more information.
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1. Right-click the title of a page and select Settings.
2. In the Order Presets field, select the name of the preset to associate with the page.
3. Click OK.
To use the Preset field from the Trading Window
1. Right-click the row of field headings and select Customize Layout.
2. From the Order Presets category, select Preset and Add to the Shown Columns list.
3. Click the Preset drop-down from a market data line to see the preset strategies available for
the selected ticker.

Existing customers: Each top level instrument strategy uses the original order defaults you defined, unless you
elect to copy and paste a new set of values.
The displayed value is the default strategy for that instrument or ticker; select a new strategy from
the drop-down list. The list includes all global presets and all instrument-level presets. The Default is
the current active strategy defined in Global Configuration. New orders will use the displayed preset
strategy. If you change the strategy, the change will not apply to existing orders.
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If the page does not have the Preset column displayed, a Strategy icon appears next to any tickers
that have a custom strategy applied. If no strategy icon is displayed, the ticker uses the default instrument-type set of order defaults.
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Modify the Stop Trigger Method
You can modify the trigger method for Stop, Stop Limit, Trailing Stop and Trailing Stop Limit orders
on a per-order basis using the Order Ticket. You can also set the default trigger method for a strategy
using the Trigger Method dropdown in the Miscellaneous section of the order Preset.

To change the default Trigger Method
1. On the Edit menu, select Global Configuration.
2. In the left pane, select Presets.
3. In the Trigger Method dropdown list, select the preferred trigger method that will be used for
all orders affected by the preset.
To modify the stop trigger method for the current order
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1. Display the Trigger Method field on the trading window.
2. Highlight a stop, stop-limit, trailing stop or trailing stop limit order and select a method from
the Trigger Method field.
Trigger
Method

Default

Description

Unless the customer modifies any of these features, the default trigger method for all
stocks is the Last method, described below.
For US options, the default trigger method is the double bid/ask method, where two
consecutive ask price (bid price) values must be less than (greater than) or equal to
the trigger price, and the second bid or ask must have greater size if it is at the same
price level as the first bid or ask.
For Forex contracts (for example EUR/USD currency pair), the default trigger
method is bid/ask, where the ask price (bid price) value must be less than (greater
than) or equal to the trigger price.
For all other contracts, the default trigger method is the Last method, described
below.

Last

For a buy (sell) order to be triggered:
l

l

l

l

Double
Last

One last price value must be greater than (less than) or equal to the
trigger price; and
The exchange or other market center where the order is to be
executed must also publish (and the system must also receive) an ask
price equal to or higher than, and a bid price equal to or lower than,
the trigger price; and
Last must be within the bid/ask (i.e. >=bid and <= ask) or within leeway percentage outside the bid/ask (i.e. >=bid-0.5% of last and
<=ask+0.5% of last). This 0.5% amount of leeway is subject to
change at any time without notice.
With the exception of OTCBB- and Pink Sheets-listed stocks, stop and
stop-limit order in US stocks will also only be triggered if the primary
exchange on which the stock trades is open, is holding regular trading
hours, and has a valid bid/ask quote for the stock. Regular trading
hours are usually between 9:20 am - 4:00 pm Eastern Time, Monday
through Friday for exchange-listed stocks. NOTE: This limitation does
not apply to stop or stop-limit orders in futures contracts).

For a buy (sell) order to be triggered:
• Two consecutive last price values must be greater than (less than) or equal to the
trigger price; or
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• The last price value must be greater than (less than) or equal to the trigger price
and the last size must be an increase.

Bid/Ask

For a buy (sell) order to be triggered:
• A single bid (ask) price must be greater than (less than) or equal to the trigger
price.

Double
Bid/Ask

For a sell order to be triggered:
•

Two consecutive ask prices must be less than or equal to the trigger price; or

• One ask price value must be less than or equal to the trigger price and the ask
size must be an increase.
For a buy order to be triggered:
•

Two consecutive bid prices must be greater than or equal to the trigger price; or

• One bid price value must be greater than or equal to the trigger price and the bid
size must be an increase.
Last or
Bid/Ask

For a buy (sell) order to be triggered:
• A single bid (ask) or a single last price must be greater than (less than) or equal
to the trigger price.

Mid-point

For a buy (sell) order to be triggered:
• The midpoint of the bid/ask must be greater than (less than) or equal to the trigger
price.
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Configure the Account Window
Specify the fields you want to include in the sections of the Account information window.
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Features
Introduction
l

Open the Feature Selector

l

Enable Features through Menus
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Open the Feature Selector
The Feature Selector groups features in categories and subcategories. To help you find what you're
looking for, use the text Search box at the top of the window. The list is filtered to show only those
features which include the text you've entered in their title. To clear the search and display all categories again, click the Clear icon that appears to the right of the Search box.

To open the Feature Selector
l

On the Edit menu select Global Configuration and then choose Features in the left pane.

You can disable an entire category of features with a single click, or drill down to a specific feature
within a group using the expand/collapse icon.
To disable/enable a feature using the Feature Selector
1. Click to remove the checkmark next to a feature or a feature group.
2. Click the expand icon to drill down in a group.
You can also enable features from the menus.
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Enable Features through Menus
The Feature Selector, accessible through the Configuration menu or by clicking the Configure icon
on the toolbar, allows you to disable features you don't use. These disabled features are hidden from
the menus and screens. You can now enable these features at any time without having to search for
them within the Feature Selector by expanding the menu to show disabled features.
Enable a feature from its menu
Menus which contain disabled features show a double "expand" arrow following the final menu command.
1. Click the double arrows at the bottom of the selected menu.
2. Disabled features now appear in the menu, highlighted in dark grey. Select the feature you
want to use.
3. Click Yes to the question "Would you like to enable this feature now?"
The feature is enabled, and will become active if appropriate. For example, if you have an underlying
selected and elect to enable Market Depth, the Market Depth window will open for the selected underlying after you click "Yes." If you don't have an underlying selected, the Market Depth feature will be
enabled but will not open since it has no data to display.
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Workspaces and Panels
Introduction
l

Managing Workspaces

l

Quote Panel

l

Orders Panel

l

Log Panel

l

Trades Panel

l

Portfolio Panel
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Managing Workspaces
Create a custom trade environment on your desktop based on your trading needs. When you log in,
select a workspace from the set of buttons on your toolbar. You can create a workspace that includes
any of the TWS self-contained windows.

Create a workspace
1. Arrange windows on your desktop in any combination and any design.
2. On the bottom status bar, click the Manage Workspaces icon.
3. Click New Workspace and enter a workspace name.
4. Click OK, and the new workspace appears in the list. The last used workspace is loaded when
you login.
To delete a workspace, right-click on the appropriate workspace icon on the status line at the bottom
of the application, and select Remove Workspace.
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Workspaces and Panels

Quote Panel
The Quote panel appears at the top of the self-contained trading modules (such as the Order Ticket,
OptionTrader, BookTrader, FXTrader, Market Depth Trader etc) and displays market data for the specified contract. This panel works similar to the market data line on the Quote Monitor as it creates a
sell order when you click the Bid and a buy order when you click the Ask, but instead of creating the
order directly below the market data line, the orders are created in the Orders panel. You can customize by adding fields to and removing fields from the Quote Panel.

Add and Remove Fields
1. Hold your mouse over a field title until the "+" and "x" signs appear.
a. Click the "+" sign to invoke a drop-down list of available fields. The new field will be added to
the left of the selected field.
b. Click the "x" to remove the selected field.
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Orders Panel
Use the Orders panel to manage orders created from the Quote Panel in a self-contained trading module. Manage your orders just as you would from the main trading screen. You can configure the
Orders panel to hide or display columns.

To configure the Orders Panel
1. Click the Configure wrench icon in the top right corner of the panel. This opens Global Configuration for the module-specific panels.
2. Add fields for display by selecting a field from the Available Columns list, and clicking Add.
3. Remove fields by selecting a field from the Shown Columns list and clicking Remove.
4. Click OK.
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Log Panel
The Log Panel displays all order actions including transmission, exchange acknowledgement, fills, and
cancellations from a tab in one of the self-contained trading modules. You can delete the content of
the log by clicking the Clear Log icon at the top of window.
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Trades Panel
The Trades panel shows real-time trade reports for orders transmitted from the active tab.

To configure columns on the Trades panel
1. Click the Configure wrench icon in the top right corner of the panel. This opens Global Configuration for the module-specific panels.
2. Add fields for display by selecting a field from the Available Columns list, and clicking Add.
3. Remove fields by selecting a field from the Shown Columns list and clicking Remove.
4. Click OK

TWS Users' Guide

1056

Global Configuration

Workspaces and Panels

Portfolio Panel
The Portfolio panel shows displays position-relevant information as seen in the Portfolio section of the
Account window, but only for positions in the active contract in the Quote panel.

To configure columns on the Portfolio panel
1. Click the Configure wrench icon in the top right corner of the panel. This opens Global Configuration for the module-specific panels.
2. Add fields for display by selecting a field from the Available Columns list, and clicking Add.
3. Remove fields by selecting a field from the Shown Columns list and clicking Remove.
4. Click OK.
For more information on the fields in the Portfolio panel, see the Account Information topic.
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Menus
l

File Menu

l

Edit Menu

l

Trade Menu

l

Account Menu

l

Trading Tools

l

Analytical Tools

l

View Menu

l

Help Menu

l

Right-click in a Blank Line

l

Right-click on a Market Data Line

l

Right-click on an Order Management Line
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File Menu

File Menu
Use the File menu commands to export reports to your PC, save settings and create a basket file.
The File menu commands are described in the table below.

Menu Command

Description

Import/Export

Allows you to import or export a comma-delimited or .csv text file to or
from your trading page.

Open Settings
File

Opens the Restore Settings box, where you can choose to restore a settings
file from a previous session.

Open Saved
Chart

Allows you to select and open a previously saved chart.

Save Settings

Locally saves any changes you made to your trading screen layout, defaults,
and menu selections.

Save Settings
As

Saves your changes to a location you specify in the Save dialog box.

Print

Prints the active page.

Lock Application

Locks TWS and requires a password to unlock.
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Exit

TWS Users' Guide
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Edit Menu

Edit Menu

Test if putting in conditional text adds javascript to file.
Menu Command

Description

Cut

Cuts the selected ticker.

Copy

Copies the selected ticker.

Paste

Pastes the last copied or cut ticker as a new row.

Insert Row

Inserts a blank row above the selected row.

Delete Row

Deletes the row you have selected.

Create Group
Header

Inserts a non-data row into the page. Enter a title or
label to use this row as a separator or label for a group
of tickers.

Mutual Fund
Selector

Opens the Contract Selection box showing available families of no-load mutual funds.

Treasury Bond
Selector

Opens the Contract Selection box showing available TBonds, Bills and Notes.

Contract Descrip-

Displays the Ticker Description box which contains
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tion Detail

information about the selected underlying.

Edit Dividend
Schedule

Opens the Dividend Editor window.

Futures Rollover
Tool

If you have futures contracts that will be expiring, use
this feature to roll them over prior to expiration.

Global Configuration

Opens the TWS Global Configuration tool which
includes the Feature Selector.

TWS Users' Guide

1062

Menus

Trade Menu

Trade Menu

Menu
Command

Description

Buy

Creates a buy order for the selected contract; opens the
order ticket when used from a blank line.

Sell

Creates a sell order for the selected contract; opens the
order ticket when used from a blank line.

Close Selected Positions

Submits a closing order for all selected positions. Choose
to close:
• 50% of each selected position
• 100% of each selected position
• A customer percentage of each selected position.
Note that orders are transmitted instantaneously.

Close All
Positions
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"Default" selection pulls the Time in Force from the order
presets. The Limit Price drop-down selections include
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None, Bid, Ask, and Bid/Ask Midpoint. "None" is valid
only if the order type is set to REL.
RFQ

Use to request market data for instruments not showing
data, or to get a size quote.

Check Margin Impact

Shows a preview of the created order and how it would
affect your margin requirements.

Check Risk

Checks how the order will affect your total portfolio risk
(in the Risk Navigator).

Transmit

Submits the selected order.

Pause Execution

Submits a cancel request on the working order without
removing the order line.

Cancel

Submits a cancel request on the working order.

Modify Multiple Orders

Define parameters to automatically update the order type,
time in force, limit price (with or without a limit offset)
for one or multiple orders. Additionally, specify a validation procedure to be used when attributes are not applicable to all orders.

Save
Orders as
Basket

Saves the selected group of orders as a basket file that can
be accessed via the BasketTrader.

Option Exercise

Opens the Option Exercise window where you can exercise an option prior to expiration.
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Account Menu

Menu Command

Description

Account Window

Displays your balances, margin, P&L, equity, market
value and more.

Portfolio Window

Creates a Portfolio trading page that includes all current
positions.

Trade Log

Displays trade reports and a trade summary of up to
seven days’ activity.

Statement
Viewer

Displays your account activity statement within Account
Management.

Audit Trail

View a log of your daily trade activity for the current
week in HTML. Choose from condensed or expanded version. Each week’s audit trail overwrites those from the
previous week.

Completed
Orders

Shows all completed orders in a new tab.

Account Man-

Puts you directly into %COMPANY_NAME% Account
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agement Home

Management.

Market Data
Subscription
Manager

Puts you into the Market Data Subscription section of
Account Management.

Mistrade
Request Form

Enter a Trade Cancellation Request from the Customer
Service tools section of Account Management.

Clearing Instruction Modification
Form

Add or modify settlement instructions from within
Account Management.
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Trading Tools

Trading Tools
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Menu

Description

Launch
Mosaic

Opens Mosaic, the alternative trading interface.

Quote Monitor

A trading page that holds market data lines for all
products, and algo provides complete order management.

Watchlist

Opens a new floating watchlist window that allows
you to view multiple tickers in a single, small window.

Market Depth
(Level II)

Shows Level II quotes with no trading capabilities.

Market Depth
Trader (Level
II)

Displays aggregated Level II market data. The Market Depth Trader also displays shows the Quote Panel
and allows for complete order management.

BookTrader

Create, modify and transmit orders for a single contract from within the book price ladder.

Integrated Stock
Window

A dynamic, customizable tool that includes all of the
data and order management tools to analyze the current market, track activity, make trading decisions and
place orders for a selected security.

Merger Arbitrage

Use the Merger Arb window to take advantage of
arbitrage opportunities associated with takeovers or
mergers.

ScaleTrader

An automated trading algorithm designed to help you
effectively buy into a declining market at ever-lower
prices, scale into a toppy market, or scale out of a
long position.

Accumulate/ Distribute

An automated trading algorithm that helps you effectively trade large blocks of stock without being detected in the market.

Option Chain

Displays the Option Chain section of the
OptionTrader, with data only (no order management).

OptionTrader

An integrated suite of options tools that allows
provides market data and statistics, lets you create
and manage options orders and view available option
chains, all in a single screen.

Write Options

Opens the Write Options tool.
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Trading Tools

Description

Rollover Options

Opens the Rollover Options tool.

Option Portfolio

An automated trading algorithm that helps you adjust
the risk profile of your portfolio by any of the Greek
risk dimensions.

Volatility
Trader

Creates a trading page that lets you trade in terms of
volatility rather than price.

FXTrader

Custom-designed trading tool with optimized display
for FX traders that emphasizes the key price component.

FX Matrix

Light version of the FXTrader that shows FX
pairs quotes with no trading capabilities.

BasketTrader

Designed to trade previously-created basket files or
baskets based on a selected index.

IndexTrader

Easily create and trade a basket based on a selected
index.

Rebalance Portfolio

Simplifies periodic portfolio balancing.

SpreadTrader

Create futures spreads, EFPs and option combos.

AQS Marketplace

Creates a Stock Borrow/Loan page that provides
access to the AQS borrow/loan marketplace.

Yield Optimizer

Compare borrow rates on hard-to-borrow stocks using
different borrow strategies, view the best rates for
lending your own shares, and see the most cost-effective EFPs for investing your excess cash.

Blotter

Institutional only - Receive and manage large volume
electronic orders.
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Menu Command

Description

Chart

Opens the new chart window with the Contract Description populated based on the
contract you selected in the trading window.

Quote Details

Opens a floating window that shows quote, high/low and volume data for a single
underlying.

Market Scanner

Scan the markets for the top-performing products based on user-selected criteria.

Bond

Opens the Bond Search query in a browser window.
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Search

Option Analytics

Displays the Greeks for puts and calls on the selected contract.

Time & Sales

Displays Time & Sales for the selected contract.

Alerts

Set time, price or margin-based alerts.

Set Alarm

Define an alarm for the selected underlying.

Model Navigator

Edit pricing assumptions to calculate model prices.

Arbitrage
Meter

The Arbitrage Meter illustrates the extent of the premium (or discount) of the lead
month futures price above (or below) its fair future value with respect to the index
price.

Event Calendar

Available to subscribers to Wall Street Horizon. View events for the selected contract.

Company Fundamentals

Displays business and financial summary data, charts, scanners and more for the
selected contract.

MarketWatch

Displays MarketWatch fundamentals for the selected underlying.

General News

Shows all current news.

Company
News

Displays industry-related news and commentary for the selected underlying.

News Topics

Opens the New Topic Chooser that allows you to include industry-specific news in
the ticker lines.

Risk Navigator

Opens the Risk Navigator real-time risk management tool.

Portfolio Analyst

Opens the Portfolio Analyst reporting tool in Account Management.
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View Menu

Menu Command

Description

Trader Dashboard

Monitor key data from your Account window and view current real-time
news headlines.

Rapid Order
Entry

Allows for quick entry of stocks, options futures and combos.

Order Wizard

Provides assistance in modifying order parameters.

Button Panel

Provides access to quick-click trade buttons. Activate buttons for instantaneous transmit.

Workspace
Panel

Set up multiple workspaces to quickly switch between product-focused
trading environments.

Data Connections

Shows the status and purpose of your market data connections.

IB Systems

Shows the current system status.
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View Menu

Bulletins

Shows the current customer bulletins.

OS Window
Bar

Inserts the title bar back on the top of the TWS windows.
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Menu Command

Description

Guides and Documentation
• Quick Start
Guide

Opens the TWS quickstart

• Online
Users’ Guide

Opens the complete online help set for TWS.

• Tutorials

Opens the suite of tours that focus on specific TWS tools
and features.

• Algo Documentation
Center

Displays information on our automated algos including
ScaleTrader and Accumulate/Distribute.

• Release
Notes

Opens the TWS Release Notes page.

Show Help

Opens TWS Javahelp.

Customer Service
• Customer
Service Info

Displays the Customer Service information web page.

• Customer
Service Chat

Connects you to the live chat accessed from within Account
Management.

• Open Message Center

Opens the customer service message center within Account
Management.
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Features Poll

Use the Features Poll to suggest new features and to vote
on suggestions made by other IB customers.

Traders’ Chat

Brings up the login for Traders’ Chat. To create a chat
account, log into Account Management and select the User
Management menu, then Voting Subscription.

Show Hotkey
Popup

Displays a key to the current hotkeys set up in TWS.

About Trader
Workstation

Display TWSversion and other information.
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Right-click in a Blank Line
To see a right-click menu, select a line and then click the right mouse button. Select an item from a
right-click menu using your mouse. The Right-click menu on in a blank line contains the following
menu commands.

Menu Command

Description

Order

Opens the Order Ticket window which you use to create and transmit
orders.

Ticker

Opens the Request Ticker box where you enter contract information.
This creates a new market data line.

Generic
Combo

Opens the Combo Composition box to the Underlying field. Begin defining legs for a spread order.

Merger Arbitrage

Create a combination order for an anticipated merger.

RFQ

Enter contract information to request a quote.
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Treasure Bond
Selector

Opens the Contract Selections box, showing available T-Bonds, Bills
and Notes.

News Topics

Opens the News Topic Chooser, which lets you filter news by source,
type and category.

Mutual Fund
Selector

Opens the Contract Selections box, showing available fund families.

Insert Row

Inserts a blank line above the selected line.

Delete Row

Deletes the selected row or rows. This command deletes both blank
lines and market data lines without a warning.

Create Group
Header

Insert a row with a label that can be used to help organize tickers
within a page.

Create Cash
Balance Row

Select a currency to create a row that shows the total cash balance for
that currency.

Contract Display Mode

Choose from the default “Underlying” mode and Symbol mode, which
shows the exchange symbol.
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Right-click on a Market Data Line
To see a right-click menu, select a market data line and then click the right mouse button. The Quick
menu displays limited selections and adds commands that you use. Click the Expand arrow at the bottom of the Quick list to see all commands.
The right-click menu on a Market Data line contains the following menu commands. Please note that
the menu is context sensitive and may not show all of the items in the list below for a selected data
line.
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Menu
Command

Right-click on a Market Data Line

Description

BUY hotbutton

Creates a buy order for the selected contract.

SELL hotbutton

Creates a sell order for the selected contract.
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Action Toolbar

Quickly open the Quote Details, Chart, News, Company Fundamentals,
Time & Sales, OptionTrader or Alert window for the selected ticker.

Trading
Tools

Access available order entry tools.

Analytical
Tools

Access available analytical tools.

Trade

• Close Position - creates a closing order on the contract. Only available if
you currently hold a position.
• Pre-borrow Shares for Shorting - opens the Stock Borrow/Loan window.
where you can check borrow rates on different stocks via the AQS marketplace.
• Order Ticket - opens the Order Ticket from which you define order parameters.

Show
Underlying

Available on options lines. Displays the underlying asset in a data line above
the selected option, and disappears when you move your mouse off the
option line. To keep, right-click the underlying row and select Make Permanent.

RFQ

Use to request market data for instruments not showing data, or to get a size
quote.

Show Legs

Displays each separate leg of a combination order, with market data.

Adjust
Combo
Ratio

Allows you to modify the ratio of legs in a combination ticker.

Next Expiry

Options and Futures: Adds a new line below the selected contract for the
next expiry.

Previous
Expiry

Options and Futures: Adds a new line below the selected contract for the
previous expiry.

Next Strike

Options: Adds a new line below the selected contract for the next strike.

Previous
Strike

Options: Adds a new line below the selected contract for the previous strike.

Charts

Create a chart for the selected contract.

What-If

Opens a what-if scenario in Risk Navigator.

Contract
Info

Shows the contract description, details and the margin requirements for contracts in which you currently hold a position.
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Dividend
Schedule

Opens the Dividend Editor window.

Configure
Order Presets

Opens the order preset configuration page for selected product type.

Contract
Display
Mode

Choose from the default “Underlying” mode and Symbol mode, which
shows the exchange symbol.

Trade Log

Opens the Trades window which displays execution reports for up to seven
days.

Insert Row

Inserts blank row above the selected row.

Delete Row

Deletes the selected row and its data.

Clear Row

Deletes data from row and leaves a blank row.

Cut

Cut the selected market data line.

Copy

Copy the selected market data line.
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Right-click on an Order Management Line
To see a right-click menu, select an order management line and then click the right mouse button.
Select an item from a right-click menu using your mouse. The right-click menu on an Order Management line contains the following menu commands:

Menu
Command

Description

Transmit

Transmits the selected order to the order destination.

Discard

Removes the order from the order management line.

Check Margin

Opens the Preview Order box which shows the order parameters, commissions and margin impact of the order before you transmit.

Attach

• Bracket Orders - Attach a set of opposite-side orders that "bracket" the
current order in an attempt to limit loss.
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Right-click on an Order Management Line

• Target Limit - Attach an opposite side limit order.
• Target Relative - Attach an opposite side relative order.
• Stop - Attach a Stop order to the selected order.
• Stop Limit - Attach a Stop Limit order to the selected order.
• Trailing Stop - Attach a Trailing Stop order to the selected order.
• Trailing Stop Limit - Attach a Trailing Stop Limit order to the selected
order.
• Adjustable Stop - Attach an adjustable stop order, which will be modified to the adjusted order type when the stop trigger is hit.
• Auto Combo Limit - Flips the parent combination order and submits an
opposite side limit order. You must enter a limit price. For example, if you
have a BUY calendar spread, the parent order looks like this:
Buy 1 XYZ OPT NOV06 80.0 CALL
Sell 1 XYZ OPT OCT06 80.0 CALL
When you attach an auto combo limit, TWS flips the combo and create a
SELL calendar spread order like this:
Sell 1 XYZ OPT NOV06 80.0 CALL
Buy 1 XYZ OPT OCT06 80.0 CALL
You must enter a limit price. Since the attached order is dependent on the
parent order, it will not be transmitted until the parent order executes.
• Auto Combo Market - Flips the parent combination order and submits
an opposite side market order. See above.
• Beta Hedge - Attach a Beta Hedge Order to the selected order.
• FX Order - Attach an FX Order to the selected order.
• Pair Trade - Attach a Pair Trade to the selected order.
Create

• Duplicate - Creates another order management line with the same order
parameters directly below the selected line.
• Scale Orders - Creates a series of orders at incrementally decreasing/increasing price intervals.

Modify
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• Condition - Opens the Conditional tab on the Order Ticket where you
can create or modify a conditional order, which is an order that will automatically be submitted or cancelled ONLY IF specified criteria for one or
more defined contracts are met.

What if

Creates a new what-if scenario in Risk Navigator that includes the proposed
order(s).

Configure
Order Presets

Opens the Presets configuration page for the selected ticker/instrument type.
Note that any changes you make to the order presets do not apply to the current existing order.

Integrated
Stock Window

Opens the ISW.

Remove All
Filled
Orders

Removes filled orders from the page.

Save

Saves the order.
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Right-click on an Order Management Line

Exercise and Rollover
l

Automatic Futures Rollover

l

Exercise Option - Manual File

l

Option Exercise Window

TWS Users' Guide

1085

Exercise and Rollover

Automatic Rollover of Expiring Futures Contracts
When specified in Global Configuration, the system automatically rolls soon-to-expire futures data
lines to the next lead month. Approximately three days prior to expiration, the new lead month contract will be added to quote monitor. Approximately one day after the contract expires it will automatically be removed from the display.
Additionally, you can instruct TWS to cancel open orders on expiring contracts. If you have the autoroll option selected, anytime there are open orders on expiring futures contracts you will receive a
pop-up message asking if you want TWSto cancel the listed open orders in anticipation of expiration.
Once the contracts expire the orders will be canceled automatically.
To activate auto expiring futures rollover
1. Click the Configure wrench icon on the trading window.

2. In the left pane of Global Configuration, select General.
3. In the right pane, confirm thatAuto Roll Data for Expiring Futures Contracts is checked.
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Exercise Options - Manual File

Exercise Options - Manual File
The Option Exercise window includes a Load from File button that lets you import a file with instructions to exercise or lapse specific options. You can create the file using any word processing program,
and the file must include a comma-delimited list of values, one line for each option. You can use one
of two different formats. Table 1 illustrates using the underlying, Table 2 shows fields for symbol
mode.
For each option you want to include in the file, create one line of text and observe the following rules:
l

Include one value for each field described in the table(s) below.

l

Separate field values by commas.

l

List field values in the order in which they appear in the table(s) below.
Field Name

Possible
Values

Field Name

Possible
Values

Table 1 - Underlying Mode

Table 2- Symbol Mode

action

exercise, lapse

action

exercise, lapse

account #

IB acct number, i.e.
U44982

account #

IBacct number,
i.e. U44982

underlying

underlying symbol, i.e. IBM

local symbol

IBMSE

strike

i.e. 50

exchange

i.e. AMEX
(smart is not
accepted)

right

p, c

quantity

i.e. 3

expiry
(yyyymm)

i.e. 200501

override*

yes, no

multiplier

i.e. 100

exchange

i.e. AMEX
(smart is not
accepted)

quantity

i.e. 3

override*

yes, no

* Specifies whether your settings will override the system's natural action. For
example, if you have the action set to exercise an option and that contract is not
in-the-money, you would receive a message saying that the contract was not inthe-money and would not exercise option. However, if you have the override set
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to "yes," this instruction will override the system and the option will exercise.
Your lines in the file based on the examples in the tables above would look like
this:
exercise, U44982, IBM, 50, C, 200501, 100, AMEX, 3, no
exercise, U44982, IBMSE, AMEX, 3, no
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The Option Exercise Window

The Option Exercise Window
Click on the TWS Option Exercise window that looks most like yours"
TWS version 944 and above:

TWS version 943 and below:

To open the Option Exercise window
l

In Mosaic: From the Account menu select Option Exercise.

l

In TWS: From the Trade menu in select Option Exercise.
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Allocations and Transfers
l

Pre-Trade Allocations

l

Soft Dollar Tiers

l

FTP File Instructions

l

Allocating Shares

l

Create a Share Allocation Profile

l

Create an Account Group for Share Allocation

l

Create an Order for Multiple Clients

l

Default Clearing for Allocation Profiles

l

Edit a Share Allocation Profile

l

Rebalance for Advisors

l

Set Default Allocations
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Soft Dollar Tiers

Soft Dollar Tiers
Advisors and hedge and mutual funds have the option to offset the costs of approved research products and services using soft dollars. Once you have requested soft dollars via Account Management and defined the markup
tiers, you can select a markup on a per-trade basis from within TWS. Soft Dollars are available on stock and
option orders only.

Markup tiers can be selected from the Misc tab of the order ticket, or from the Soft Dollars order field directly
from an order row using the drop-down list.
To display the Soft Dollars field
1. Hold your mouse over an order row field for two seconds, or until the green "+" sign appears.
2. Click the "+" sign to invoke the Order Row field list.
3. Select Order Attributes, then select Soft Dollars.

The Soft Dollars field is displayed to the left of the field you originally selected.
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When you create a client stock or option order, you can specify the markup tier for the order by clicking in the
Soft Dollars field and picking a tier.

Note: Please note that this selection is used to calculate all commissions and the
soft dollar amount is the remainder once all IB commissions have been deducted.

Let's look at a simple example on a stock order using the Flat Rate commission structure. On the above order for
1000 shares with Tier 5 selected, total client commissions would be 1000 x 0.05 = $50.00. The IB Flat Rate commission on this order is 1000 x .005 = $5.00. The soft dollar amount would be equal to $45.00 for this order.
To choose a markup tier for an order
1. Click the Bid or Ask price to create a Sell or Buy order.
2. In the Soft Dollars field, select a markup tier.
Note: If you do not select a markup tier for each order, no soft dollar markup is
applied. There is no default value.
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FTP File Instructions
Prime clients who trade with an away executing broker must submit a file reporting those trades to
IB. Files are sent via an FTP login that is provided to you when Prime capabilities are setup. Instructions are as follows:
Files must be submitted on trade date when you execute away. The file has to be submitted in CSV
format with a consistent and unique filename. For example: “[COMPANY]_[YYYYMMDD].csv”.
Note: Options, Futures, and Future Option trades must be submitted no later than
5:00 pm ET.
For each executing broker that IB approves you will be provided with a Broker and DTC/CMTA value
to use in the upload file. The correct symbol format is required to avoid rejects and breaks. The symbol format for equities is self explanatory (MSFT = MSFT). Please see below for the symbology to
use with Options, Futures, and Future Options.
Sample Trade File

To download a sample trade file (shown below) click here.

Stocks
Enter the symbol which can be found on TWS. CUSIP is optional. Example, MSFT = MSFT, IBM =
IBM.
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Options
IB uses the 21-character “Option Symbology Initiative” (OSI) format. The easiest way to find this is
to load the option in TWSand use the Symbol column:

OSI Details

The OSI identifier comprises six data elements arranged in logical order, each with a minimum field
size. Option Root Symbols must have 6 characters (if the symbol has less than 6 characters, spaces
must be added to equal the six character minimum)
Futures & Future Options
Futures and Future Options do not follow a standard convention like OSI for Options. Load the
product on TWS and refer to the Symbol column to see the correct format. Examples below:

Futures
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CL Nov 2011 Future: The TWS symbol has no spaces and would be entered on the trade file as CLX1.
ZN Dec 2011 Future: The TWS symbol has one space between ZN and DEC and between DEC and 11, therefore it would be entered on the file as ZN DEC 11.
Future Options
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CL Nov 2011 87 Calls: The TWSsymbol has one space between LOX1 and C8700, therefore it would be
entered on the file as LOX1 C8700.
ZN Dec 2011 114 Calls: The TWS symbol has one space between C and OZN, between OZN and Dec,
between Dec and 11, & between 11 and 11400. Therefore it would be entered on the file as C OZN
DEC 11 11400.
Note: Futures and futures Options executed at the ICE or NYMEX need to be reported with security type "FUT ICE" or "FOP ICE". Additionally, any zeros in the
strike price should be removed from the symbol, i.e. you would use "KOF3
P1.4" rather than "KOF3 P1.40"
NOTES:
Remember not to trade with your executing broker (with intent to clear at IB) until we notify you that
all agreements and booking instructions are in place.
If an incorrect file is loaded, do not delete or overwrite it. Instead, contact the Prime Services group
at 203-618-4060 or primeserve@interactivebrokers.com to be advised on the best way to
resolve. Depending on the situation, IB may be able to stop processing, correct certain details, or
require a new file be loaded. Certain details can be amended by IB, such as Trade Date, Commission,
Price, and Quantity. The rest will require a new file to be submitted. If a new file is required please
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ensure the filename is unique and does not overwrite the previous file, i.e. add a suffix to the file like
“2” or “B”.
If you do not know how to use FTP or need an FTP program you can use WinSCP – a free FTP management program – to post files to our servers. To download go to http://winscp.net/eng/download.php and select the “Installation Package” (not sponsored).
WinSCP – Store Session
WinSCP allows you to “store a session” allowing future logins without the need to provide the
username/password. To do so enter the following at the WinsSCP login window and select Save
instead of Login. Create a session name, check “save password”, click OK. In the future you will
have the option to log into this session each time you launch WinSCP.
FTP Host name: ftp3.interactivebrokers.com
FTP username/password: Provided by Prime Services
File Protocol: FTP
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Give-up
l

IBExecution - Order Ticket

l

IBExecution - Order Line

l

Configure a Default Give-Up

l

Create DVP/RVP Instructions

l

Short Sale Confirmation

l

Transfer a Position Using DVP/RVP
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IBExecution Services
As an IBExecution Services customer, you can tell TWS where you want to clear your trades on a per
order basis. Note that before you can use IBExecution Services, you must first apply and then provide
us with your give-up instructions which you specify in Account Management. You can use IBExecution
Services from both the Order Ticket and on an order management line to define pre-trade or posttrade give ups.
IBExecution Services on the Order Ticket

1. Right-click on a ticker and select Trade, then select Order Ticket.
2. Set up your order on the Basic tab, then click the Misc. tab to use IBExecution Services.
3. Use the Allocation drop-down to select your give up. Choose from your list of clearing choices
including:
l
Interactive Brokers (IB). This was the previous default clearing destination.
l

l

Pre-trade Give Up. At the time of the trade, choose a third-party clearing give-up location from the instructions in the clearing field, which you defined through Account Management. If you defined multiple DTCID or CMTA settlement instructions via Account
Management, you will see multiple pre-trade choices.
Post Trade Allocation (PTA). This selection is available upon request, and puts your
trades into the PTA pool after execution. Allocate post-trade using the Trading Access
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section of Account Management, which is directly accessible by selecting Post Trade Allocations on the View menu. The clearing choice you select will automatically be used as the
default selection the next time you submit an order.

The clearing choice you select will automatically be used as the default selection the next time you submit
an order.
4. Use the Open/Close indicator for US Options orders to specify whether your order is designed
to close/reduce a position or open/increase a position. You can set a default for this indicator in
the Order Defaults section of Global Configuration.
5. The Clearing Account field is required for US futures and futures options orders that use
PTA or Awayclearing. You must specify the account number or other identity of the true beneficiary of the order. This information is reported to the exchange with the order. IB Execution clients with multiple clearing destinations can configure a default give-up. For Option and Stock
orders, the clearing account number is in the settlement instruction and this field is optional.
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IBExecution Services from an Order Line
As an IBExecution Services customer, you can instruct TWS where you want to clear your trades on a
per order basis. Note that before you can use IBExecution Services, you must first apply, and then
enter your give-up instructions through Account Management. You can use IBExecution Services from
both the Order Ticket and on an order management line to define pre-trade or post-trade give ups.
IBExecution Services from an Order Management Line
1. Click the Ask or Bid price on a market data line to create a BUY or SELL order, respectively.
2. Use the Clearing dropdown to select to select your give up. Elect from one of three (3) types of
clearing choice:

l

l

l

Interactive Brokers (IB). This was the previous default clearing destination.
Pre-trade Give Up. At the time of the trade, choose a third-party clearing give-up location from the instructions you defined through Account Management. If you defined multiple DTCID or CMTA settlement instructions via Account Management, you will see
multiple pre-trade choices.
Post Trade Allocation (PTA). This selection puts your trades into the PTA pool after
execution. Allocate post-trade using the Trading Access section of Account Management,
which is directly accessible by selecting Post Trade Allocations on the View menu. The
clearing choice you select will automatically be used as the default selection the next
time you submit an order.

3. Use the Open/Close indicator for US Options orders to specify whether your order is designed
to close/reduce a position or open/increase a position. You can set a default for this indicator in
the Order Defaults section of Global Configuration.
4. The Clearing Account field is required for US futures and futures options orders that use
PTA or Away clearing. You must specify the account number or other identity of the true beneficiary of the order. This information is reported to the exchange with the order. For Option and
Stock orders, the clearing account number is in the settlement instruction and this field is
optional.

TWS Users' Guide

1102

Allocations and Transfers

Give-up

Configure a Default Give-Up
If you have multiple clearing destinations, you can define a default give-up for each asset type. The default will
be shown each time you create an order, but can easily be changed by selecting another clearing destination.

To create a default give-up
1. From the TWS Edit menu, select Global Configuration.
2. In the left pane select Give-ups.
3. Click "Add" from the top right of the window and fill in the Give-up box.
l

l

Enter the exchange acronym or use "*" as the wildcard to include all exchanges.
Enter the security type.Valid acronyms include:
l
OPT
l

STK

l

FUT

l

FOP

4. Click OK to save the give-up
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Note: To include default give-ups for different security types, click "Add" and specify a separate give-up for each security type.
5. Click OK at the bottom of the pane to close Global Configuration and save the list of all default
give-ups.
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Create DVP/RVP Instructions
Before you can use the DVP feature to transfer or receive a position, you must specify DVP instructions through the Account Login function on the website.
To add DVP/RVP instructions
1. From the Login dropdown list in the upper right corner of the IB website, select Account Management.
2. Enter your account username and password, and click Login.
3. Under the Funds Management section, click Settlement Instructions.
4. Click the Add button under the appropriate section, and complete the instruction fields.

Valid instructions will be approved within 24 hours, after which time you will see it as a selection in
the Clearing dropdown list in a TWS order.
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Short Sale Confirmation
Use the Short Sale Confirmation box to confirm that the shares you want to short are available at the
clearing firm. This confirmation box pops up the first time you elect to short an underlying. If you
enter the number of shares available, it will only require input once per underlying/per TWS session
(a session lasts until you log out of TWS) as long as you stay within the available shares limit.

To confirm availability of shares for short sale
1. Select Short sell as the action on a buy/sell order line.
2. Enter confirmation information in the Short Sale Confirmation box.

Enter the Total Number of Shares available to avoid having to confirm availability each time you short this
underlying.
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3. TWS will track the number of shares available based on the short sell orders you submit on the
underlying. If the number of available shares does not cover the order quantity, you will be
required to confirm availability again.
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Transfer a Position using DVP/RVP
After you have added instructions via the Account Management screen, you can select a prime or
clearing broker account to whom you want to transfer all or part of any positions you currently hold,
or from whom you want to receive positions into your account.

This feature will only transfer and receive positions between accounts of the same type and with the same title
as your account.

To transfer a position

You will only complete these steps if you elected On Demand in the Frequency field when you set up your transfer instructions. If you chose Standing the instructions are carried out automatically.
1. Open the Account window.
2. On the Portfolio menu, select Transfer (DVP/RVP) and define the contract.
3. In the Transfer Information section of the dialog box, select an action, Transfer out of IB (DVP)
or Transfer into IB (RVP).
4. Enter the quantity to transfer. The quantity transferred must be equal to or less than the Available Quantity.
5. The Price field displays the current market price. You can modify the price to within 10% either
side of the current market price.
6. Use the Institution drop-down to select a destination from the list of instructions you created
from the Account Management page.
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7. Click OK.
8. Click the In Transit tab on the Account window to see all pending positions in transit. This tab
will also display any post-trade allocated orders you submitted.

DVP/RVPs settle on the third day after entry. If your contra broker has not accepted the DVP/RVP instructions
by 12:00:00 ET the day prior to settlement date, the transaction will be cancelled. Please click the DVP/RVP
Info button on the Transfer dialog box for complete details.
Also note that you have the option of having your standing instructions implemented in compressed mode, which nets the day's transactions and uses the weighted average price. By
default the transactions are implemented uncompressed, which means that they are not netted,
and are sent as individual transactions. For more details on compressed and non-compressed
modes, please contact your IB Sales Representative.
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Pre-Trade Allocations
l

Create an Order for Multiple Clients

l

Allocating Shares

l

Rebalance for Advisors

l

Create an Account Group for Share Allocation

l

Create a Share Allocation Profile

l

Default Clearing for Allocation Profiles

l

Edit a Share Allocation Profile

l

Set Default Allocations
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Create an Order for Multiple Clients
Advisors can also create orders and allocate shares using the Allocation column on an Order Management line.

To create an order for multiple clients
1. Click the "Ask" or "Bid" price on a market data line to create an order.
l
Click the Ask Price to create a Buy order.
l

Click the Bid Price to create a Sell order.

TWS Users' Guide

1111

Allocations and Transfers

2. Use the Allocation field dropdown list to select an Account Group, Account Profile, a single
account or All accounts.
OR

Right-click on the order and select Modify then select Share Allocation.
3. In the Allocation dialog box, select an Account Group in the Automatic Allocation area, an
Account Profile in the Manual Allocation area, or select a single account.
4. For the Account Group, modify the allocation method if necessary. If you choose the PctChange
method, enter a positive or negative value in the Percentage field. All other automatic allocation methods are calculated using the order size.
5. If you use an Allocation Profile, select a group name.
6. To allocate all shares to one account, select a single account.
7. Click OK to complete the order.
8. To Transmit, click the red "T" in the Transmit field.

TWS Users' Guide

1112

Allocations and Transfers

Pre-Trade Allocations

Allocating Shares
We provide several ways to distribute shares among accounts when you create an order. You can
select an Account Group, which comprises a pre-defined subset of accounts and an associated allocation method. The Account Group allocates shares based on a ratio calculated by the system, or by a
percentage. The numbers used to calculate the ratio derive from the method you chose when you created the group, or by the percent change you set.

A second way to allocate shares is through an Allocation Profile, which distributes shares to each
account in a profile based on a percentage, ratio or absolute number that you define. Both of these
methods require that you create a group, assign accounts to the group, and define the group's allocation method.
You can also direct an order to a single account by selecting that account number or alias from the
Allocation field on the order management line, or to all accounts by selecting All from the Allocation field. Set a default allocation from Global Configuration.
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Rebalance for Advisors
Advisors can elect to have TWS automatically Rebalance ALL accounts, a single subaccount, or a
user-defined Account Group, which includes a subset of accounts, by redistributing percentages of positions in their subportfolio(s) that make up the current (signed) net liquidation value. TWS opens and
closes positions to rebalance the selected accounts' portfolio based on the new percentages you
enter. You can add contracts and create orders just as you would from the main trading screen.

Rebalance a SubPortfolio
1. Open the Rebalance window by clicking the Rebalance icon on the trading toolbar.
2. In the Account dropdown, select: All to rebalance All accounts; Master to rebalance the master
account, an account number to rebalance that account, or an Account Group to rebalance all
accounts in the group.
3. The Rebalance window shows three columns that are different from those on your trading screen:
l

l

l

Deliv Value - this is the deliverable value of the position, which is the same as the Market
Value for the position shown in the Portfolio section of the Account window.
Current % - this is the current signed percent of the position to your net liquidation
value shown in the Balance section of the Account window. This figure is calculated by
dividing the DLV by the NLV (Net Liq. Value).
Rebal% - Percentages are entered in terms of deliverable value.

Please note that puts have a negative deliverable value since they deliver a short position. Consequently,
to increase your put position, you must enter a negative deliverable value percentage.
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4. In the Rebal % field, enter the new percent of the Net Liquidation Value that you want the position to have.
Note: If you have selected "All" in the Account dropdown, the rebalance percent for the instrument will be applied to all of your sub accounts' portfolios.
5. Click the Create Orders button to instruct the application to automatically create the orders to
achieve the percent change.
6. Use the Transmit All button to send all orders, or click "Transmit" on an order line to transmit
a single order.

For options, the rebalance% is based on the value of the underlying stock price.
Open positions from the Rebalance window
1. First, add a ticker line to the Rebalance window by selecting the market data line on your trading screen, and then clicking the selection arrow attached to the Rebalance icon on the trading
toolbar. Click Add to Rebalance Window. Or, enter an underlying symbol into a blank row on the
Rebalance screen as you would on the main trading window.
2. Enter a value in the Rebal % column and click the Create Orders button.
3. Transmit the order.
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Edit Inline Profile on Rebalance
Advisors using the Rebalance Portfolio window to simultaneously reset the Target % allocation for multiple
accounts can edit the inline profile for rebalance orders before submitting. The inline profile for each order identifies the accounts that will be affected by the rebalance order and allows you to delete accounts from the profile
based on user-selection or specified "shares to trade" criterion.

To edit an inline profile
1. From the Rebalance account selector choose Group>All.
2. Reset target percents as needed and click Create Rebalance Orders.
3. Double-click the Allocation field on an order line to view and edit the Inline Profile.
4. Specify criteria that will result in certain accounts being omitted.
5. Click OK when finished.
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Create an Account Group for Share Allocation
You can use an Account Group to automatically calculate ratios and allocate shares to a pre-defined
group of accounts based on a selected allocation method. When you create an order and choose a
group, the order uses the default method to allocate shares among the accounts in the group.

To create an Account Group
1. On the Edit menu select Global Configuration.
2. In the left pane select Advisor, then select Account Groups.
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3. Click the Create button on the right side of the window.
4. Enter an Account Group name. Do not use the name "All" since this is reserved by the system.

When you create an order, the choices displayed in the Allocation list are grouped first by Account Group,
then Allocation Profile, and then individual accounts. However, they are not identified in any other way.
When you create an account group, you may want to include a prefix such as "AG" in the name to identify
the choice as an Account Group.
5. Select a default allocation method. You can change the allocation method for each order.
l
EqualQuantity - Requires you to specify an order size. This method distributes shares
equally between all accounts in the group.
Example: You transmit an order for 400 shares of stock ABC. If your Account Group
includes four accounts, each account receives 100 shares. If your Account Group includes
six accounts, each account receives 66 shares, and then 1 share is allocated to each
account until all are distributed.
l

NetLiq - Requires you to specify an order size. This method distributes shares based on
the net liquidation value of each account. The system calculates ratios based on the Net
Liquidation value in each account and allocates shares based on these ratios.
Example: You transmit an order for 700 shares of stock XYZ. The account group includes
three accounts, A, B and C with Net Liquidation values of $25,000, $50,000 and $100,000
respectively. The system calculates a ratio of 1:2:4 and allocates 100 shares to Client A,
200 shares to Client B, and 400 shares to Client C.

l

AvailableEquity - Requires you to specify an order size. This method distributes shares
based on the amount of available equity in each account. The system calculates ratios
based on the Available Equity in each account and allocates shares based on these ratios.
Example: You transmit an order for 700 shares of stock XYZ. The account group includes
three accounts, A, B and C with available equity in the amounts of $25,000, $50,000 and
$100,000 respectively. The system calculates a ratio of 1:2:4 and allocates 100 shares to
Client A, 200 shares to Client B, and 400 shares to Client C.

l

PctChange - Do not specify an order size. Since the quantity is calculated by the
system, the order size is displayed in the Quantity field after the order is
acknowledged. This method increases or decreases an already existing position. Positive percents will increase a position, negative percents will decrease a position.

BUY
ORDER

Positive Percent

Negative Percent

Long Position

Increases position

No effect

Short Position

No effect

Decreases position

SELL
ORDER

Positive Percent

Negative Percent
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Long Position

No effect

Decreases position

Short Position

Increases position

No effect

Example 1: Assume that three of the six accounts in this group hold long positions in stock XYZ.
Client A has 100 shares, Client B has 400 shares, and Client C has 200 shares. You want to
increase their holdings by 50%, so you enter "50" in the percentage field. The system calculates
that your order size needs to be equal to 350 shares. It then allocates 50 shares to Client A, 200
shares to Client B, and 100 shares to Client C.
Example 2: You want to close out all long positions for three of the five accounts in a group. You
create a sell order and enter "-100" in the Percentage field. The system calculates 100% of
each position for every account in the group that holds a position, and sells all shares to close
the positions.
6. The list of accounts in the Non Group Account section includes all accounts available to you. To
add an account to the group, select a Non Group account and click Add.
7. Click OK to save the group and its settings.
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Create a Share Allocation Profile
You can create profiles that allocate specific percentages or shares of each order to individual
accounts based on the rules you set and values you input.

To create a share allocation profile
1. On the Edit menu, select Global Configuration.
2. In the left pane select Advisor, then select Allocation Profiles.
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3. Click Create and enter a profile name, preferably one based on the way you plan to allocate
shares between clients.
Note: When you create an order, the choices displayed in the Allocation list
are grouped by Account Groups, then Allocation Profiles, and then individual accounts. However, they are not identified in any other way.
When you create a profile, you may want to include a prefix such as "P"
in the name to identify the choice as a profile.
4. In the Allocation Profile specifies area, select a method of allocating shares between accounts:
l

l

l

Percentages - this method will split the total number of shares in the order between
listed accounts based on the percentages you indicate. For example, an order for 1000
shares using a profile with four accounts at 25% each would allocate 250 shares to
each listed account in the profile.
Financial Ratios - this method calculates the allocation of shares based on the ratios
you enter. For example, an order for 1000 shares using a profile with four accounts set
to a ratio of 4, 2, 1, 1 would allocate 500, 250, 125 and 125 shares to the listed
accounts, respectively.
Shares - this method allocates the absolute number of shares you enter to each
account listed. If you use this method, the order size is calculated by adding together
the number of shares allocated to each account in the profile.

5. Click in the Account field to view all accounts. Select an account and tab over to the Value field.
6. Enter the percent, ratio or number of shares to be allocated to the selected account (you may need to

delete the current value). Tab to create a new account line.
Note: If you use percentages to allocate shares, percentages allocated must
equal 100. If you use ratios, The system automatically calculates these
percentages.
7. Continue until you have listed all the desired accounts for the current profile, and click OK.
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Import and Export Groups and Profiles
Advisors and other multi-client account users can import and export Account Groups and Allocation Profiles to
and from an Excel .csv file.

To export account groups and allocation profiles
1. From within Global Configuration, go to the Advisor section and select Account Groups or Allocation Profiles.
2. From the right side of the main pane click "Export."
3. In the Export Groups and Profiles box, select the groups and/or profiles to export.
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4. Modify the file name and location if needed using the Filename field. A default directory and filename are included.
5. Click OK and then OK again to export the file.

The resulting file will display similar to the snippet shown below. Fields are required in the Excel file only if
they are populated.

To import account groups and/or allocation profiles, create a .csv file following the same format as the images
above and below. The image below is only for a new account group called ImportTest.
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To import account groups and/or allocation profiles
From Excel:
1. Open Excel, and create a new file that defines:
l

l

For Account Groups, the file contains the Group Name, Default Method, Group and
Account fields.
For Allocation Profiles, the file contains the Profile Name, Type, Profile and Account
fields (additional fields are required for Ratio and Percentages.

2. Save the file with the .csv file extension.
From within TWS:
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1. From within TWS Global Configuration, go to the Advisor section and select Account Groups or
Allocation Profiles.
2. From the right side of the main pane click "Import."
3. Find the directory and new file to import.
4. Click Open.
5. Say "OK" to the message indicating that the imported data is complete.
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Edit a Share Allocation Profile
After you have created share profiles, you can select one when you create an order.

To edit a share allocation profile
1. From the Edit menu, select Global Configuration.
2. In the left pane, select Advisor then select Allocation Profiles.
3. Select an Allocation Profile and click Edit.
4. In the Allocation Profile window, you can add or delete accounts, select a different allocation method, or

modify the allocated percentage or ratio for any accounts.
5. Click OK to save the edited profile.
Note: Percentages allocated must equal 100. If you use ratios, the system will automatically calculate share percentages based on the ratios.
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Set Default Allocations
The default allocation refers to the allocation that will be used automatically when you create an
order. You can modify the allocation on a per trade basis, and change the default allocations at any
time.

To set default allocations
1. On the Edit menu select Global Configuration.
2. In the left pane, select Advisor then select Default Allocation.
Define settings described below:
l

Use currently subscribed account - check this button to automatically allocate trades to the
account or group selected in the Account dropdown on a trading screen, as shown above.
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l

l

l

l

l
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Pre-Trade Allocations

Use specified default - check this button to set a specified absolute default allocation.
Automatic Allocation - choose a user-defined Account Group and method to use for default allocation.
Manual Allocation - choose an Allocation Profile to use as the default.
Single Account Allocation - choose an individual account to use as the default allocation. NOTE:
To allow the last selected individual account to be used for the default allocation going forward,
select the Use currently subscribed account radio button at the top of the page.
Preserve default - select to always use the default set up in the Default Allocation window
regardless of changes you make on a per-order basis. If this is checked, you will need to use
this window to modify the default allocation.
Use last submitted as a default - select if you want the default allocation to change to the
allocation you set on a per-order basis. If this is checked, the default allocation automatically
changes when you change the allocation on an order.
If one or more accounts fails to meet the margin requirements when an order is
submitted...
For each order, all accounts designated for order allocation are vetted before the order is submitted, to ensure that each account has the capacity to support the designated allocation. In
cases where one or some account(s) cannot hold the allocation as specified, the advisor can
elect to:
Reject the entire order - The entire order is rejected.
Reduce the size of the order - The order size is reduced by the quantity that cannot be held,
and this quantity is deactivated.
Note: Note that once the order has been submitted and is working, the quantity of
the working order may still change. For example, if an unrelated fill results in
one or more of the accounts no longer being able to support the allocation,
the order size will be reduced by that quantity. In an opposite scenario, if an
account whose allocation was deactivated can now support the allocation, a
quantity that was deactivated during the initial order submission may be
reactivated and submitted.

TWS Users' Guide

1129

Allocations and Transfers

Default Clearing for Allocation Profiles
You can set up a default clearing profile as part of a manual Allocation Profile. The clearing defaults
will be validated when you create an order.
To define a default clearing profile
1. From the Advisor configuration group, select Allocation Profiles.
2. In the top half of the window, choose the Allocation Profile for which you want to define clearing
defaults.
3. In the Clearing Defaults section at the bottom of the window click Create.
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Pre-Trade Allocations

By default, all security types and all exchanges are included, indicated by the asterisk (*)
in each selection field. If you prefer to define a clearing profile for a certain security
type/exchange pair, select them from the dropdown lists.
4. Select a security type and exchange if desired. Otherwise, the asterisk indicates “all.”
5. For each account in the Allocation Profile, choose a Clearing selection, and click OK.

Note that the clearing rules are only received when an order is created. Consequently some clearing
defaults will be invalid for some security type/exchange pairs. If the clearing rule is not valid for an
order, you will receive an information message with a link that allows you to modify the clearing
defaults.

Using the Clearing Profile
If you are selecting an allocation, the clearing profile will not be active. You must either have the
Manual Allocation selected in Global Configuration as the specified default, or you must select the
Manual Allocation radio button from the Advisor tab of the order ticket on a per order basis. If you
choose an Allocation Profile from the Allocation dropdown list of an order line, you must also choose
the clearing.
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To set Manual Allocation as the default
1. From the Edit menu, select Global Configuration.
2. In the left pane, select Advisor then select Default Allocation.
3. From the Default Allocation window, select Use specified default.
4. Select Manual Allocation, and choose the Allocation Profile for which you defined the clearing
defaults. Click OK.
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To select Manual Allocation on a per-order basis
1. From the order line, use the right-click menu to select Modify and then select Order Ticket.
2. On the Advisor tab, choose Manual Allocation, and then select the Allocation Profile for which
you have defined the clearing defaults you want to use.
The clearing defaults in the Allocation Profile drive the default entry in the Clearing dropdown field.
This list only contains clearing choices that are valid for ALL accounts in the profile.
l

l

If all clearing choices in the profile are valid but different, the Clearing entry reads Per
Account and each individual clearing entry shows the clearing destination.
If all clearing entries are the same and valid, the Clearing entry shows the clearing destination, and the each individual clearing entry reads Same, indicating it is the same as the
main Clearing entry.
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l

If there is no common, valid clearing choice for all accounts in the Allocation Profile, the Clearing field becomes inactive, and each individual clearing entry shows either the valid clearing
destination from the profile, or the valid default - in the image above it would display the last
valid submitted clearing destination, since Use last submitted as default is selected.

TWS Users' Guide

1134

Introduction to Models

Pre-Trade Allocations

Introduction to Models
Models provide an efficient process for advisors to manage multiple trading strategies for their clients
without requiring them to open multiple accounts. Client investments are allocated amongst instruments in the Model based on the Model's allocation ratios as defined by the advisor.
l

Create a model

l

Initially fund and populate a model

l

Invest client funds in a model

l

Divest funds from a model

l

Reallocate client funds among Models

l

Rebalance a model

l

Withdraw cash from a model

l

Monitor model composition and investors

l

Delete a model
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Set up a Model Structure
Create and manage Models from the Portfolio tab. To get started, first create the structure for the
Model by providing a name and code.

To set up a Model
1. From the Portfolio tab select Model Setup from the Display Selector.
2. Click Create Model to specify a name and code.
3. Enter a name and code, and click OK.
Note: The code cannot be changed once it has been created.
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Set up a Model Structure

The structure for the new Model displays in the Models section of the Portfolio page. At this point the
Model has no funds, no assets and no investors.
Next step: Fund and Populate the Model
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Initial Funding and Populating
When you initially fund a model and populate it with investment instruments, the model's allocation
targets for future investments are created. There are two ways to specify the model's instrument
allocation percents with initial funding:
l

l

You can specify the target percent allocation for each investment instrument first and fund the
model second. In this case the system will automatically create orders to purchase assets in
proportion to the defined target percentages when the model is funded.
You can fund the model first and then trade the investment instruments (and consequently
define the allocation percents) second.

Regardless of the method you use for initial funding, subsequent client investments are allocated
based on these specified percents. To change the target allocation percents, use the Rebalance window.
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Establish Target Percent Allocations
Once define target percent allocations, the initial investment is allocated automatically among the investment
instruments through orders created to achieve the target percents.

To Set Target Allocations
1. Choose the unfunded model and click Set Target Allocations. The Rebalance window opens.
2. Add ticker lines for each asset you want to include in the model.
3. Specify the percent of allocation for each asset.
4. Click Save Target %.
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Next Step: Fund the model.
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Fund a Model
If you have defined target percent allocations, the initial investment will be automatically allocated based on the
defined allocation percents. If you haven't defined target percent allocations, you will need to populate the model
after it has been funded.
To fund a model
1. From the Display Selector, choose the client account that will be investing in the Model.
2. Right-click the Model in which the client wants to invest, and click Invest in [MODEL NAME].
3. Enter the investment amount and click Submit.
l

l

If no target percents have been defined, the model now has funds available to trade
investment assets. Populate the model with tradable assets.
If target percent allocations have been defined, the investment is allocated and Investment Orders are created in the lower panel.
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Fund a Model

If you have defined target percent allocations, the funds will automatically be allocated among the investment
instruments and the appropriate orders will be created. Click "Transmit All" to submit the orders.
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Purchase Model Investments
Note: If you specified Target Percent Allocations before you funded with an initial
investment, your model is already populated.
Once you have received an initial cash investment in a model, you can populate a model with investment instruments. Perform this action as if you were purchasing shares for a client account but select
the Model as the allocation.
To populate a Model
1. From the Select Account dropdown, select the Model you want to populate.
2. In the Quote Monitor, create orders for all assets that you want to include in the selected Model.
3. Transmit the order(s).
The units are allocated amongst all invested accounts according to the percentage each account has
invested in the Model. This also sets up the Model allocation ratios for all subsequent client investments.
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Next Step: Invest in the Model
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Models and Positions
You can view models, accounts and positions sliced in many different ways.
To see the total positions per Model
1. Open the Portfolio tab.
2. From the Display Selector, choose All.
3. Select My positions by model.
4. Click the "+" sign in the Models list to display the drill-down list of all investments per model.

To see model positions per account
1. Open the Portfolio tab.
2. From the Display Selector, choose an account.
3. Click the "+" sign in the Models list to display the drill-down list of all investments per model.
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Invest in a Model
When you invest new client funds into an existing, populated Model, the new capital is invested using
the Model's existing allocation ratios.
The TECH Model has the following investment allocation structure, as shown below. If another client
invests 50,000 in the TECH Model, the investment is allocated to achieve the same percentages.

:
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Invest in Multiple Models
A client can elect to allocate their investment across multiple Models.
To invest in multiple Models
1. From the Display Selector, choose the client account that will be investing in multiple Models.
2. Right-click the Models header row and select Invest in Models.
3. Specify the amount you want to invest in each available model. You can enter values by:
l

l

Entering an investment amount or percentage in the entry field for each model. The system will total the investment in the header row.
Entering a total investment amount in the header row entry field and allowing the system
to evenly allocate the total amongst all models. This method allows you to manually
adjust percentages. Enter 0% for any model in which the client does not want to invest.

The investment is distributed amongst the selected Models based on the existing structure of each.
l

l

l

If the Model is not yet funded, the investment serves as the initial cash investment.
If the Model is funded with cash only, the investment is added to the current funding and will be
used to purchase investment instruments.
If the Model has positions, the investment is used to purchase units in the same ratios currently
held in the Model.
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Invest in Multiple Models

OR
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Divest Funds from a Model
Quickly divest client funds from a Model.
To divest from a Model
1. From the Display Selector, choose the client account that will be divesting from the Model.
2. Right-click the Model from which the client wants to divest, and click Divest from [MODEL
NAME].
3. Enter the divestment amount and click Submit. This action triggers orders to sell assets in the
Model equal to the value being divested, in the same proportion they are held in the Model.
l

The model's available funds is decreased by the divestment amount.

l

The client's cash balance is increased by the divestment amount.
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Withdraw Cash from a Model
You can withdraw cash from a model and transfer it to the independent holdings for all accounts invested in the
model.

To withdraw cash from a model
1. From the Display Selector on the Portfolio page, select Model Setup.
2. Select the model from which you want to withdraw cash.
3. Click "Withdraw Cash from Model."

TWS Users' Guide

1156

Introduction to Models

Withdraw Cash from a Model

4. Enter the percentage of cash to withdraw. Cash will be transferred to the independent holdings
of all accounts that have invested in the model, based on the current amount of cash in the
account.
Note: If account A has 10,000 cash and account B has 20,000, a withdrawal of 25%
would transfer 2,500 to Account A and 5,000 to Account B.
5. Click Finish to initiate the transaction(s).
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Rebalance a Model
You can rebalance the investments within a model at any time using the Rebalance window.

To rebalance a model
1. From the Display Selector on the Portfolio window, select the model you want to rebalance.
2. Click the Rebalance icon on the right side of the window.
3. In the Rebalance window, review and revise the Target percents for each instrument.
Note: The target percents were established with the initial funding of the model.
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4. Define the new target percents for allocation several ways:
l

l

l

Enter a new value in the desired Target % field by clicking the field and entering a number value representing the percentage (i.e. enter 5 for 5%).
Enter new values in all Target % fields by clicking the Clear Target % button.
Use the "Current %" values by clicking the Set Target % button. Once the target percents have been set to the current percents, you can make any modifications by clicking
in the Target % field.

5. Click Create Rebalance Orders. Orders are created in the panel below the Rebalance window.
6. Confirm or modify the order parameters and click Transmit All to submit rebalance orders.
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Reallocate Client Funds Amongst Models
Use the "Reallocate" feature from the subaccount window to quickly redistribute invested funds
among Models.
To reallocate funds among Models
1. From the Portfolio tab, select the client whose investments you want to reallocate.
2. Right-click the Models header row.
3. Select Reallocate.
4. Modify the Percent of Allocation as desired for the existing models.
5. Click Submit to transmit reallocation orders.
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Monitor Model Activity
You can monitor all aspects of your models and investments using the Display Selector and Model
information dropdown lists.

From the Display Selector, choose a Model and see:
l

l

Accounts: Invested accounts and the percentage of each account's total investment invested in
the Model.
Positions: All Positions held in the selected Model, along with the market value and the allocation ratios.

From the Display Selector, choose an account and see:
l

l

My positions by Model: All positions held in each Model for the chosen account.
Total ungrouped positions: All positions held outside of the Models (ungrouped positions) for the
chosen account.
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From the Display Selector, choose All and see:
l

My positions by Model: All positions held by all accounts, sorted by Model.

l

Total ungrouped positions: All positions held outside of the Models (ungrouped positions).

l

Models by account: For each account, shows the market value invested in each Model and the
account's percentage of total market value invested in each Model.
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Delete a Model
If you elect to delete a Model, all holdings will become "Independent" positions for all clients who are
invested in the Model being deleted.
To delete a Model
1. Select Model Setup in the Display Selector.
2. Select the Model you want to delete.
3. Click Delete Selected Model.
Model holdings become "independent positions" for clients invested in the Model, in the proportion
they were held in the Model. In the example below, holdings were held equally between three
accounts.
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